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1 Installing Win2PDF

1.1 Win2PDF and Win2PDF Pro

If you are using a PC with the Windows 8 operating system, please visit our
help topic on "How to install Win2PDF with Windows 8".

If you are using a computer with any other supported operating system,
please use the following instructions to install Win2PDF.

To install Win2PDF, download and run the Win2PDF setup program. After
you run the setup program, you will have a new printer in the printers
folder named "Win2PDF".
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If you are evaluating Win2PDF, you can start creating PDF documents
immediately. The evaluation version is fully functional, but every document
will have an extra trailer page with Win2PDF product information. Also, a
license reminder window will occasionally display. To evaluate Win2PDF or
Win2PDF Pro without the trailer page, contact us for a time limited
evaluation license.

The Win2PDF Pro install program can only be downloaded after you
purchase the product. If you already have Win2PDF evaluation version
installed, you do not need to uninstall Win2PDF before running the Win2PDF
Pro install program. 

https://www.win2pdf.com/trial.html
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If you have purchased Win2PDF, you can enter your license code by
following the instructions in "Entering the Win2PDF license code".

1.2 Win2PDF Terminal Server Edition and Win2PDF Pro Terminal
Server Edition

To install Win2PDF, download and run the Win2PDF setup program. After
you run the setup program, you will have a new printer in the printers
folder named "Win2PDF". All users connecting to the server in using
Windows Terminal Services, Remote Desktop Services, RemoteApp, or
Citrix will have access to the Win2PDF printer on the server. 

If you are evaluating Win2PDF, you can start creating PDF documents
immediately. The evaluation version is fully functional, but every PDF
document will have an extra trailer page with Win2PDF product information.
To evaluate Win2PDF or Win2PDF Pro without the trailer page, contact us
for a time limited evaluation license.

The Win2PDF Pro TSE install program can only be downloaded after you
purchase the product. If you already have Win2PDF TSE evaluation version
installed, you do not need to uninstall Win2PDF TSE before running the
Win2PDF Pro install program. 

If you have purchased Win2PDF, you can enter your license code by
following the instructions in "Entering the Win2PDF license code".

Win2PDF TSE is licensed per server, so once you enter your license code all
users on the server are licensed. There is no limit on the number of users
accessing Win2PDF on a single server.

1.3 Overview of Win2PDF Components

Win2PDF installs a few different software components as part of the default
installation. These are:

oWin2PDF - A printer that will create PDF files from any application

that can print to a Windows printer.

oWin2Image - A printer that will create image files (.JPG, .GIF, .TIFF,

.BMP, and .PNG) files from any application that can print to a Windows
printer.

https://www.win2pdf.com/trial.html
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oWin2PDF Desktop App - A local program that can view and make

page-leveling edits of PDF files. This program can also be used to
make some configuration settings in Win2PDF

To see a brief overview of these different components, please refer to the
following slide show.

Overview of Win2PDF Software
Components

1.4 Deploying Win2PDF

If you are deploying Win2PDF to a large number of computers (50+), Dane
Prairie Systems can create a customized version of the Win2PDF install
program that will automatically enter license codes and company
information for each installed copy of Win2PDF. There are also silent install
flags available for the deployment, which are documented below.

The following command line options are supported by the Win2PDF setup
program:
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/SILENT, /VERYSILENT 

Instructs Setup to be silent or very silent. When Setup is silent the wizard
and the background window are not displayed but the installation progress
window is. When a setup is very silent this installation progress window is
not displayed. Everything else is normal so for example error messages
during installation are displayed and the start up prompt is (if you haven't
disabled it with the '/SP-' command line option explained above) 
If a restart is necessary and the '/NORESTART' command isn't used (see
below) and Setup is silent, it will display a "Reboot now?" message box. If
it's very silent it will reboot without asking. 

/NORESTART 

Instructs Setup not to reboot even if it's necessary. 

If you invoke the install with the following command line, it will bypass all
user intervention, hide the progress bar, and it will not reboot even if
necessary. 

  w2pdf.exe /VERYSILENT /NORESTART

The Win2PDF install only has to reboot if you are upgrading a previous
installation of Win2PDF.

/SUPPRESSWARNINGS=nowarnings

Instructs Setup to suppress Win2PDF specific warnings that can occur
when installing on terminal servers, such as the following message:
"Server operating system detected. If you decide to purchase Win2PDF and
intend on using the product in a multi user server based application, you
must purchase a server license of Win2PDF."
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/SUPPRESSMSGBOXES 

Instructs Setup to suppress message boxes. Only has an effect when
combined with '/SILENT' and '/VERYSILENT'. 

The default response in situations where there's a choice is: 
-Yes in a 'Keep newer file?' situation. 
-No in a 'File exists, confirm overwrite.' situation. 
-Abort in Abort/Retry situations. 
-Cancel in Retry/Cancel situations. 
-Yes (=continue) in a
DiskSpaceWarning/DirExists/DirDoesntExist/NoUninstallWarning/ExitSetup
Message/ConfirmUninstall situation. 
-Yes (=restart) in a FinishedRestartMessage/UninstalledAndNeedsRestart
situation. 

5 message boxes are not suppressible: 
-The About Setup message box. 
-The Exit Setup? message box. 
-The FileNotInDir2 message box displayed when Setup requires a new disk
to be inserted and the disk was not found. 
-Any (error) message box displayed before Setup (or Uninstall) could read
the command line parameters. 
-Any message box displayed by [Code] support function MsgBox. 

/LOG 

Causes Setup to create a log file in the user's TEMP directory detailing file
installation and [Run] actions taken during the installation process. This can
be a helpful debugging aid. For example, if you suspect a file isn't being
replaced when you believe it should be (or vice versa), the log file will tell
you if the file was really skipped, and why.

The log file is created with a unique name based on the current date. (It will
not overwrite or append to existing files.)

The information contained in the log file is technical in nature and
therefore not intended to be understandable by end users. Nor is it
designed to be machine-parse-able; the format of the file is subject to
change without notice. 

/LOG="filename" 

Same as /LOG, except it allows you to specify a fixed path/filename to use
for the log file. If a file with the specified name already exists it will be
overwritten. If the file cannot be created, Setup will abort with an error
message. 

/NOCANCEL 
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Prevents the user from canceling during the installation process, by
disabling the Cancel button and ignoring clicks on the close button. Useful
along with '/SILENT' or '/VERYSILENT'. 

1.5 Updating Win2PDF

If you purchased a license of Win2PDF after September 2009 and have a
20-character alphanumeric license code, you can download and install the
latest version of Win2PDF 10 for free at:

https://www.win2pdf.com/download/download.htm

It is not necessary to uninstall Win2PDF before running the new setup
program. Win2PDF Pro users should use the "Win2PDF Pro Service Pack"
download.

If you purchased a license of Win2PDF before October 2009 and have a 16-
digit number license code, you can upgrade to Win2PDF 3.5 for free. The
Win2PDF 3.5 download is available at:

https://www.win2pdf.com/support/updates.htm

To upgrade to Win2PDF 10 from Win2PDF 3.5 or below, there is a one-time
upgrade fee. Win2PDF 10 fully supports the Windows 7, Windows 8,
Windows 10, and Windows 11, and it includes additional save formats,
including PDF/A, TIFF, JPEG, PNG, GIF, BMP, and Microsoft's XPS file
formats. For more information on Win2PDF 10, please visit the Win2PDF 10
product page.

1.6 Adding a Win2PDF Printer

Settings for each Win2PDF printer are stored separately, so you can set up
multiple copies of Win2PDF for settings required by different applications.

For example, you may have different actions for different types of
documents. You may want to always save invoices to a specific folder and
print a copy to a paper printer. You may want to save sales quotes to a
different folder and automatically email them. At other times, you may
create PDFs interactively and choose the file location in the Win2PDF "File
Save" pop-up window. You can handle these cases by creating separate
Win2PDF printers to handle each work flow. You could create a new printer
named "Win2PDF Invoice" that is configured to automatically name PDF

https://www.win2pdf.com/download/download.htm
https://www.win2pdf.com/support/updates.htm
https://www.win2pdf.com/features.html
https://www.win2pdf.com/features.html


Win2PDF10

© 2023 Dane Prairie Systems, LLC

files and print, a second printer named "Win2PDF Sales Quote" that is
configured automatically name to a different folder and email, and you can
leave the "Auto-Name" feature off for the "Win2PDF" printer so you can still
print interactively.

To add a Win2PDF printer, run the "Add Win2PDF Printer" program from the
start menu under the Win2PDF program group. The following window will
be displayed:

Add A Win2PDF Printer

Type a name for the new printer, or accept the default name and click OK.
Win2PDF will add a new printer to the "Devices and Printers" folder. If you
view printers in the "Devices and Printers" folder on Windows 8, Windows
8.1, Windows 10, or Windows 11, you will only see one Win2PDF icon even
if you have multiple Win2PDF printers installed. If you right click on the
Win2PDF icon, you will see all copies of Win2PDF and Win2Image as shown
below:

Selecting A Win2PDF Printer
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Creating different Win2PDF printers for PDF work-flows can be very
powerful when combined with the Auto-name feature.

How to add a new PDF printer that has unique save settings

There is no cost to add a new Win2PDF printer instance to the same
computer. If creating many instances, you should rename each instance
before configuring the instance.

1.7 Renaming a Win2PDF Printer

To rename a Win2PDF printer, open the "Printer Properties" Window from
the "Devices and Printers" folder.
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Rename Win2PDF Printer

Type the new printer name in the field at the top of the "Printer Properties"
window, and click OK. When you rename a printer, any Win2PDF settings
will be reset to their default values.
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2 Using Win2PDF and Win2Image

2.1 Purchasing Win2PDF

2.1.1 How to Purchase Win2PDF with a credit card

You can purchase Win2PDF online at the https://www.win2pdf.com web
site. We accept all major credit cards (Visa, MasterCard, American Express,
Discover, Diner's Club) and use secure order pages. The Win2PDF license is
perpetual and will never expire.

After you have purchased Win2PDF, you will receive an e-mail receipt
containing a license code. You enter this license code as described in
"Entering the Win2PDF license code" to remove the extra page from each
document. 

If you are purchasing Win2PDF Pro, you will receive a link to download the
Win2PDF Pro setup program as part of your email receipt. If you are
purchasing Win2PDF standard, you do not need to reinstall Win2PDF.

There is a 60 day money back guarantee on all orders.

2.1.2 How to Submit a Purchase Order

To submit a purchase order or receive a sales quote, contact
sales@win2pdf.com.

Our mailing address is:

Dane Prairie Systems, LLC
P.O. Box 24491
Minneapolis, MN, USA 55424-0491

https://www.win2pdf.com/purchase/purchase.htm
https://www.win2pdf.com
mailto:sales@win2pdf.com
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2.1.3 How to Enter the Win2PDF license code

If you are using a PC with the Windows 8 operating system, please visit our
help topic on "How to license Win2PDF with Windows 8".

If you are using a computer with any other supported operating system,
please use the following instructions to license your copy of Win2PDF.

After you have received a license code through email, you can enter the
Win2PDF license code by running 
"Start->Programs->Win2PDF->Enter Win2PDF License". The
following window will appear.

Click on the "Enter license code" button, and enter your name, company,
and license code exactly as they are listed in your email receipt.



Win2PDF16

© 2023 Dane Prairie Systems, LLC



Using Win2PDF and Win2Image 17

© 2023 Dane Prairie Systems, LLC

If you entered the information correctly, you should see a success message
as follows.

New documents created by Win2PDF will no longer include the trailer page
on each document.

The following video shows each step of entering your license.

How to Enter the Win2PDF License Code

2.1.3.1 Activation Error: Upgrade Required

"You entered a license for Win2PDF 3.5 or below, but you have Win2PDF 10
installed (error 10012). Visit www.win2pdf.com for upgrade information."
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Licenses purchased before September 2009 are not compatible with
Win2PDF 10. These licenses are compatible with Win2PDF 3.5 or below
which can be downloaded for free at:

https://www.win2pdf.com/support/updates.htm

Win2PDF 3.5 is not compatible with Windows 10 or Windows 11. If you
would like to upgrade to Win2PDF 10, you can purchase an upgrade at:

https://www.win2pdf.com/support/updates.htm#Win2PDFUpgradePricing

2.1.3.2 Activation Error: Invalid License Code Characters

"The license number is not valid - it contains the wrong characters. Please
enter the license number again."

Double check the license number listed in your email receipt. The Win2PDF
license code should contain 20 letters and numbers separated by dashes in
the following format:
XXXXX-XXXXX-XXXXX-XXXXX

If you repeatedly get this error, please contact support.

2.1.3.3 Activation Error: Invalid License Code Length

"The license number is not valid - it contains the wrong number of
characters. Please enter the license number again."

Double check the license number listed in your email receipt. The Win2PDF
license code should contain 20 letters and numbers separated by dashes in
the following format:
XXXXX-XXXXX-XXXXX-XXXXX

If you repeatedly get this error, please contact support.

2.1.3.4 Activation Error: License Code Blocked

"This Win2PDF license has been activated too many times and has been
blocked (error 13903)."

The Win2PDF activation process allows for Win2PDF to be reinstalled and
PCs to be upgraded, but there is a limit to how many times the license can
be activated. If the number of activations exceeds this limit, this error will
occur.

https://www.win2pdf.com/support/updates.htm
https://www.win2pdf.com/support/updates.htm#Win2PDFUpgradePricing
https://www.win2pdf.com/contact.html
https://www.win2pdf.com/contact.html
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To purchase additional licenses of Win2PDF, see the Win2PDF purchase
page. Volume license discounts are available.

If you only have Win2PDF installed on single PC and believe this is an error,
please contact support support and provide your license code.

2.1.3.5 Activation Error: License Code Disabled

"This Win2PDF license has been activated too many times and has been
disabled (error 1395)."

The Win2PDF activation process allows for Win2PDF to be reinstalled and
PCs to be upgraded, but there is a limit to how many times the license can
be activated. If the number of activations exceeds this limit, this error will
occur.

To purchase additional licenses of Win2PDF, see the Win2PDF purchase
page. Volume license discounts are available.

If you only have Win2PDF installed on single PC and believe this is an error,
please contact support support and provide your license code.

2.1.3.6 Network Error: Unable to Open Session

"Network Error: Unable to Open Session (error 1312)."

Make sure you are connected to the internet. If your computer cannot be
connected to the internet, contact support and supply your license code for
activation instructions.

2.1.3.7 Network Error: Unable to Connect

"Network Error: Unable to Connect (error 1469)."

Make sure you are connected to the internet. If your computer cannot be
connected to the internet, contact support and supply your license code for
activation instructions.

2.1.3.8 Network Error: Unable to Open Network Connection

"Network Error: Unable to Open Network Connection (error 570)"

https://www.win2pdf.com/purchase/purchase.htm
https://www.win2pdf.com/purchase/purchase.htm
https://www.win2pdf.com/purchase/pricing_discounts.php
https://www.win2pdf.com/contact.html
https://www.win2pdf.com/purchase/purchase.htm
https://www.win2pdf.com/purchase/purchase.htm
https://www.win2pdf.com/purchase/pricing_discounts.php
https://www.win2pdf.com/contact.html
https://www.win2pdf.com/contact.html
https://www.win2pdf.com/contact.html
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Make sure you are connected to the internet. If your computer cannot be
connected to the internet, contact support and supply your license code for
activation instructions.

2.1.3.9 Network Error: Unable to Send

"Network Error: Unable to Send (error 1913)."

Make sure you are connected to the internet. If your computer cannot be
connected to the internet, contact support and supply your license code for
activation instructions.

2.1.3.10 Network Error: Unable to Read

"Network Error: Unable to Read (error 30)."

Make sure you are connected to the internet. If your computer cannot be
connected to the internet, contact support and supply your license code for
activation instructions.

2.1.3.11 Activation Error: Win2PDF Pro TSE - Standard TSE

"Win2PDF Pro TSE is installed, but a Win2PDF TSE license was entered
(error 10000). Please uninstall Win2PDF Pro TSE, and download and run
the Win2PDF TSE setup program."

Win2PDF TSE can be downloaded from:

https://www.win2pdf.com/download/download.htm

2.1.3.12 Activation Error: Win2PDF Pro TSE - Standard Desktop

"Win2PDF Pro TSE is installed, but a Win2PDF workstation license was
entered (error 10001). You need to purchase a Win2PDF Pro TSE license for
this server."

To purchase a license for Win2PDF Pro TSE, see the Win2PDF purchase
page.

https://www.win2pdf.com/contact.html
https://www.win2pdf.com/contact.html
https://www.win2pdf.com/contact.html
https://www.win2pdf.com/download/download.htm
https://www.win2pdf.com/purchase/purchase.htm#for-servers
https://www.win2pdf.com/purchase/purchase.htm#for-servers
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2.1.3.13 Activation Error: Win2PDF Pro TSE - Pro Desktop

"Win2PDF Pro TSE is installed, but a Win2PDF Pro workstation license was
entered (error 10002). You need to purchase a Win2PDF Pro TSE license for
this server."

To purchase a license for Win2PDF Pro TSE, see the Win2PDF purchase
page.

2.1.3.14 Activation Error: Win2PDF TSE - Pro TSE

"Win2PDF TSE is installed, but a Win2PDF Pro TSE license was entered
(error 10003). Please download and run the Win2PDF Pro TSE setup
program, and then re-enter your license."

The Win2PDF Pro TSE download link is included in your email receipt. If you
don't have your email receipt, contact support with your license code for
download instructions.

2.1.3.15 Activation Error: Win2PDF TSE - Standard Desktop

"Win2PDF TSE is installed, but a Win2PDF workstation license was entered
(error 10004). You need to purchase a Win2PDF TSE license for this
server."

To purchase a license for Win2PDF TSE, see the Win2PDF purchase page.

2.1.3.16 Activation Error: Win2PDF TSE - Pro Desktop

"Win2PDF TSE is installed, but a Win2PDF Pro workstation license was
entered (error 10005). You need to purchase a Win2PDF TSE license for
this server."

To purchase a license for Win2PDF TSE, see the Win2PDF purchase page.

2.1.3.17 Activation Error: Win2PDF Pro - Pro TSE

"Win2PDF Pro is installed, but a Win2PDF Pro TSE license was entered
(error 10006)."

The Win2PDF Pro TSE download link is included in your email receipt. If you
don't have your email receipt, contact support with your license code for
download instructions.

https://www.win2pdf.com/purchase/purchase.htm#for-servers
https://www.win2pdf.com/purchase/purchase.htm#for-servers
https://www.win2pdf.com/contact.html
https://www.win2pdf.com/purchase/purchase.htm#for-servers
https://www.win2pdf.com/purchase/purchase.htm#for-servers
https://www.win2pdf.com/contact.html
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2.1.3.18 Activation Error: Win2PDF Pro - Standard TSE

"Win2PDF Pro is installed, but a Win2PDF TSE license was entered (error
10007). Please uninstall Win2PDF Pro, and download and run the Win2PDF
TSE setup program."

Win2PDF TSE can be downloaded from:

https://www.win2pdf.com/download/download.htm

2.1.3.19 Activation Error: Win2PDF Pro - Standard Desktop

"Win2PDF Pro is installed, but a Win2PDF standard license was entered
(error 10008). Please uninstall Win2PDF Pro, and download and run the
Win2PDF standard setup program."

Win2PDF can be downloaded from:

https://www.win2pdf.com/download/download.htm

2.1.3.20 Activation Error: Win2PDF - Pro TSE

"Win2PDF is installed, but a Win2PDF Pro TSE license was entered (error
10009). Please download and run the Win2PDF Pro TSE setup program, and
then re-enter your license."

The Win2PDF Pro TSE download link is included in your email receipt. If you
don't have your email receipt, contact support with your license code for
download instructions.

2.1.3.21 Activation Error: Win2PDF - Pro Desktop

"Win2PDF is installed, but a Win2PDF Pro license was entered (error
10010). Please download and run the Win2PDF Pro setup program, and
then re-enter your license."

The Win2PDF Pro download link is included in your email receipt. If you
don't have your email receipt, contact support with your license code for
download instructions.

https://www.win2pdf.com/download/download.htm
https://www.win2pdf.com/download/download.htm
https://www.win2pdf.com/contact.html
https://www.win2pdf.com/contact.html


Using Win2PDF and Win2Image 23

© 2023 Dane Prairie Systems, LLC

2.1.3.22 Activation Error: Win2PDF - Standard TSE

"Win2PDF is installed, but a Win2PDF TSE license was entered (error
10011)."

To purchase a license for Win2PDF, see the Win2PDF purchase page.

2.1.4 How to Remove a Win2PDF license

If you want to remove a Win2PDF license, run "Remove Win2PDF License"
from the Win2PDF Desktop help menu:

Win2PDF Desktop Remove License

This can be useful after purchasing a Win2PDF license when a Win2PDF trial
license is installed.

2.2 Creating a PDF File

The Win2PDF setup program creates a printer in the "Devices and Printers"
folder named Win2PDF. 

https://www.win2pdf.com/purchase/purchase.htm
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How to Create a PDF file using Win2PDF

To create a PDF document:

· Open a document from a Windows application (Word, Excel, Edge, etc.)
· Print the document and select the Win2PDF printer
· The Win2PDF file save window pops up, allowing you to choose a name

and location for the PDF as shown below:
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Win2PDF File Save Window

The default file name is supplied by the printing application. You can choose
the "Portable Document Format (PDF)" format from the "Save as
type:" options. Win2PDF also supports the following formats:
· PDF/A - Portable Document Format for Archiving (PDF/A-1b, ISO 19005-

1:2005)
· XPS - XML Paper Specification
· TIFF (monochrome) - Tagged Image File Format
· SVG - Scalable Vector Graphics
· PDF Image Only - monochrome
· PDF Image Only - color
· Text - Formatted
· Text - Unformatted
· PDF - Searchable (OCR)
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You can choose a number of optional actions to take after the document is
created by selecting the check boxes. The options include:

· View File - Opens the file in the default viewer after the file is created.
· Print File - Prints the file to the selected paper printer after the file is

created to a Windows printer. 
· Send File - Opens a new email message using the default MAPI-

compliant email client and attaches the file to the message. The email
program is specified in the Internet Options icon in the Windows control
panel. Win2PDF can also be configured to send a PDF using Microsoft
Outlook, Mozilla Thunderbird, Gmail, Outlook.com, Yahoo! Mail, or
custom SMTP servers.

· Delete after Sending - Deletes the document after it has been sent
using the "Send File" option.

You can use the file save window to browse to a new location before saving
the document. Win2PDF remembers this location, and will use the same
location the next time you create a document.

If you want to skip the save Window, see the Win2PDF Auto-name feature.

2.3 Creating a PDF/A File

The Win2PDF setup program creates a printer in the "Devices and Printers"
folder named Win2PDF. 

How to Create a PDF/A file using
Win2PDF

To create a PDF/A document:

· Open a document from a Windows application (Word, Excel, Edge, etc.)
· Print the document and select the Win2PDF printer
· The Win2PDF file save window pops up, allowing you to choose a name

and location for the PDF/A as shown below:
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Win2PDF File Save Window

The default file name is supplied by the printing application. You can choose
the "PDF for Archiving (PDF/A)" format from the "Save as type:"
options. Win2PDF also supports the following formats:
· PDF - Portable Document Format
· XPS - XML Paper Specification
· TIFF (monochrome) - Tagged Image File Format
· SVG - Scalable Vector Graphics
· PDF Image Only - monochrome
· PDF Image Only - color
· Text - Formatted
· Text - Unformatted
· PDF - Searchable (OCR)
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You can choose a number of optional actions to take after the document is
created by selecting the check boxes. The options include:

· View File - Opens the file in the default viewer after the file is created.
· Print File - Prints the file to the selected paper printer after the file is

created to a Windows printer. 
· Send File - Opens a new email message using the default MAPI-

compliant email client and attaches the file to the message. The email
program is specified in the Internet Options icon in the Windows control
panel. Win2PDF can also be configured to send a PDF using Microsoft
Outlook, Mozilla Thunderbird, Gmail, Outlook.com, Yahoo! Mail, or
custom SMTP servers.

· Delete after Sending - Deletes the document after it has been sent
using the "Send File" option.

You can use the file save window to browse to a new location before saving
the document. Win2PDF remembers this location, and will use the same
location the next time you create a document.

If you want to skip the save Window, see the Win2PDF Auto-name feature.

2.4 Creating a PDF Image Only File

The Win2PDF setup program creates a printer in the "Devices and Printers"
folder named Win2PDF. 

How to Create a PDF Image Only file
using Win2PDF

The PDF Image Only format can be useful if you don't want the text in the
PDF to be searchable.  It can also be useful to speed up rendering of
complex documents.  To create a PDF Image Only document:

· Open a document from a Windows application (Word, Excel, Edge, etc.)
· Print the document and select the Win2PDF printer
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· The Win2PDF file save window pops up, allowing you to choose a name
and location for the PDF as shown below:

 

Win2PDF File Save Window

The default file name is supplied by the printing application. You can choose
the "PDF for Image Only - monochrome (PDF)" or "PDF for Image
Only - color (PDF)" format from the "Save as type:" options. Win2PDF
also supports the following formats:
· PDF - Portable Document Format
· PDF/A - Portable Document Format for Archiving (PDF/A-1b, ISO 19005-

1:2005)
· XPS - XML Paper Specification
· TIFF (monochrome) - Tagged Image File Format
· SVG - Scalable Vector Graphics
· PDF Image Only - monochrome
· PDF Image Only - color
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· Text - Formatted
· Text - Unformatted
· PDF - Searchable (OCR)

You can choose a number of optional actions to take after the document is
created by selecting the check boxes. The options include:

· View File - Opens the file in the default viewer after the file is created.
· Print File - Prints the file to the selected paper printer after the file is

created to a Windows printer. 
· Send File - Opens a new email message using the default MAPI-

compliant email client and attaches the file to the message. The email
program is specified in the Internet Options icon in the Windows control
panel. Win2PDF can also be configured to send a PDF using Microsoft
Outlook, Mozilla Thunderbird, Gmail, Outlook.com, Yahoo! Mail, or
custom SMTP servers.

· Delete after Sending - Deletes the document after it has been sent
using the "Send File" option.

You can use the file save window to browse to a new location before saving
the document. Win2PDF remembers this location, and will use the same
location the next time you create a document.

If you want to skip the save Window, see the Win2PDF Auto-name feature.

To convert a PDF to PDF Image Only, you can use the Win2PDF Desktop
Export PDF to PDF Image Only feature, or the imagepdf command line.

2.5 Creating an XPS File

The Win2PDF setup program creates a printer in the "Devices and Printers"
folder named Win2PDF. 

How to Create a XML Paper
Specification (XPS) file using Win2PDF
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To create an XML Paper Specification (XPS) document:

· Open a document from a Windows application (Word, Excel, Edge, etc.)
· Print the document and select the Win2PDF printer
· The Win2PDF file save window pops up, allowing you to choose a name

and location for the XPS as shown below:
 

Win2PDF File Save Window

The default file name is supplied by the printing application. You can choose
the "XML Paper Specification (XPS)" format from the "Save as type:"
options. Win2PDF also supports the following formats:
· PDF - Portable Document Format
· PDF/A - Portable Document Format for Archiving (PDF/A-1b, ISO 19005-

1:2005)
· TIFF (monochrome) - Tagged Image File Format
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· SVG - Scalable Vector Graphics
· PDF Image Only - monochrome
· PDF Image Only - color
· Text - Formatted
· Text - Unformatted
· PDF - Searchable (OCR)

You can choose a number of optional actions to take after the document is
created by selecting the check boxes. The options include:

· View File - Opens the file in the default viewer after the file is created.
· Print File - Prints the file to the selected paper printer after the file is

created to a Windows printer. 
· Send File - Opens a new email message using the default MAPI-

compliant email client and attaches the file to the message. The email
program is specified in the Internet Options icon in the Windows control
panel. Win2PDF can also be configured to send an XPS using Microsoft
Outlook, Mozilla Thunderbird, Gmail, Outlook.com, Yahoo! Mail, or
custom SMTP servers.

· Delete after Sending - Deletes the document after it has been sent
using the "Send File" option.

You can use the file save window to browse to a new location before saving
the document. Win2PDF remembers this location, and will use the same
location the next time you create a document.

If you want to skip the save Window, see the Win2PDF Auto-name feature.

2.6 Creating an SVG File

The Win2PDF setup program creates a printer in the "Devices and Printers"
folder named Win2PDF. 

How to Create a SVG file using Win2PDF
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To create an SVG document:

· Open a document from a Windows application (Word, Excel, Edge, etc.)
· Print the document and select the Win2PDF printer
· The Win2PDF file save window pops up, allowing you to choose a name

and location for the SVG as shown below:
 

Win2PDF File Save Window

The default file name is supplied by the printing application. You can choose
the "Scalable Vector Graphics (SVG)" format from the "Save as type:"
options. Win2PDF also supports the following formats:
· PDF - Portable Document Format
· PDF/A - Portable Document Format for Archiving (PDF/A-1b, ISO 19005-

1:2005)
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· XPS - XML Paper Specification
· TIFF (monochrome) - Tagged Image File Format
· PDF Image Only - monochrome
· PDF Image Only - color
· Text - Formatted
· Text - Unformatted
· PDF - Searchable (OCR)

You can choose a number of optional actions to take after the document is
created by selecting the check boxes. The options include:

· View File - Opens the file in the default viewer after the file is created.
· Print File - Prints the file to the selected paper printer after the file is

created to a Windows printer. 
· Send File - Opens a new email message using the default MAPI-

compliant email client and attaches the file to the message. The email
program is specified in the Internet Options icon in the Windows control
panel. Win2PDF can also be configured to send an XPS using Microsoft
Outlook, Mozilla Thunderbird, Gmail, Outlook.com, Yahoo! Mail, or
custom SMTP servers.

· Delete after Sending - Deletes the document after it has been sent
using the "Send File" option.

You can use the file save window to browse to a new location before saving
the document. Win2PDF remembers this location, and will use the same
location the next time you create a document.

If you want to skip the save Window, see the Win2PDF Auto-name feature.

2.7 Creating a TIFF File

The Win2PDF setup program creates a printer in the "Devices and Printers"
folder named Win2PDF. 

How to Create a TIFF file using
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To create a TIFF document:

· Open a document from a Windows application (Word, Excel, Edge, etc.)
· Print the document and select the Win2PDF printer
· The Win2PDF file save window pops up, allowing you to choose a name

and location for the TIFF as shown below:
 

Win2PDF File Save Window

The default file name is supplied by the printing application. You can choose
the "TIFF (monochrome)" format from the "Save as type:" options.
Win2PDF also supports the following formats:
· PDF - Portable Document Format
· PDF/A - Portable Document Format for Archiving (PDF/A-1b, ISO 19005-

1:2005)
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· XPS - XML Paper Specification
· SVG - Scalable Vector Graphics
· PDF Image Only - monochrome
· PDF Image Only - color
· Text - Formatted
· Text - Unformatted
· PDF - Searchable (OCR)

The Win2Image printer supports TIFF (color) and TIFF (color, transparent).

You can choose a number of optional actions to take after the document is
created by selecting the check boxes. The options include:

· View File - Opens the file in the default viewer after the file is created.
· Print File - Prints the file to the selected paper printer after the file is

created to a Windows printer. 
· Send File - Opens a new email message using the default MAPI-

compliant email client and attaches the file to the message. The email
program is specified in the Internet Options icon in the Windows control
panel. Win2PDF can also be configured to send a TIFF using Microsoft
Outlook, Mozilla Thunderbird, Gmail, Outlook.com, Yahoo! Mail, or
custom SMTP servers.

· Delete after Sending - Deletes the document after it has been sent
using the "Send File" option.

You can use the file save window to browse to a new location before saving
the document. Win2PDF remembers this location, and will use the same
location the next time you create a document.

If you want to skip the save Window, see the Win2PDF Auto-name feature.

To convert a PDF to a TIFF, you can use the Win2PDF Desktop Export PDF
to TIFF feature, or the pdf2tiff command line.

2.8 Creating a Text File

The Win2PDF setup program creates a printer in the "Devices and Printers"
folder named Win2PDF. 
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How to Create a Text file using

To create a text only (TXT) document:

· Open a document from a Windows application (Word, Excel, Edge, etc.)
· Print the document and select the Win2PDF printer
· The Win2PDF file save window pops up, allowing you to choose a name

and location for the TXT file as shown below:
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Win2PDF File Save Window

The default file name is supplied by the printing application. You can choose
the "Text - Formatted (TXT)" or "Text - Unformatted (TXT)" format
from the "Save as type:" options. Win2PDF also supports the following
formats:
· PDF - Portable Document Format
· PDF/A - Portable Document Format for Archiving (PDF/A-1b, ISO 19005-

1:2005)
· XPS - XML Paper Specification
· TIFF (monochrome) - Tagged Image File Format
· SVG - Scalable Vector Graphics
· PDF Image Only - monochrome
· PDF Image Only - color
· PDF - Searchable (OCR)
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You can choose a number of optional actions to take after the document is
created by selecting the check boxes. The options include:

· View File - Opens the file in the default viewer after the file is created.
· Print File - Prints the file to the selected paper printer after the file is

created to a Windows printer. 
· Send File - Opens a new email message using the default MAPI-

compliant email client and attaches the file to the message. The email
program is specified in the Internet Options icon in the Windows control
panel. Win2PDF can also be configured to send a file using Microsoft
Outlook, Mozilla Thunderbird, Gmail, Outlook.com, Yahoo! Mail, or
custom SMTP servers.

· Delete after Sending - Deletes the document after it has been sent
using the "Send File" option.

You can use the file save window to browse to a new location before saving
the document. Win2PDF remembers this location, and will use the same
location the next time you create a document.

If you want to skip the save Window, see the Win2PDF Auto-name feature.

To convert a PDF to a TXT file, you can use the Win2PDF Desktop Export
PDF to TXT feature, or the extracttext command line.

2.9 Creating an OCR Searchable PDF

The Win2PDF setup program creates a printer in the "Devices and Printers"
folder named Win2PDF. 

How to Create a OCR Searchable PDF
file using Win2PDF

Normally, when text information is sent to the Win2PDF printer, Win2PDF
converts the text into a searchable PDF. Some applications such as Google
Chrome or Microsoft Edge send text to the Win2PDF printer as graphics.
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This causes the PDFs created from these applications to not be searchable.
To resolve the problem, Win2PDF has an extra downloadable component
called the "Win2PDF OCR Add-on" that adds optical character recognition
capabilities so that Win2PDF can convert the graphics into searchable text.

To create an OCR Searchable PDF document:

· Install the "Win2PDF OCR Add-on" component.
· Open a document from a Windows application (Word, Excel, Edge, etc.)
· Print the document and select the Win2PDF printer
· The Win2PDF file save window pops up, allowing you to choose a name

and location for the PDF as shown below:
 

Win2PDF File Save Window

https://www.win2pdf.com/download/download-win2pdf-ocr.html
https://www.win2pdf.com/download/download-win2pdf-ocr.html
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The default file name is supplied by the printing application. You can choose
the "Portable Document Format - Searchable (PDF)" format from the
"Save as type:" options. Win2PDF also supports the following formats:
· PDF - Portable Document Format
· PDF/A - Portable Document Format for Archiving (PDF/A-1b, ISO 19005-

1:2005)
· XPS - XML Paper Specification
· TIFF (monochrome) - Tagged Image File Format
· SVG - Scalable Vector Graphics
· PDF Image Only - monochrome
· PDF Image Only - color
· Text - Formatted
· Text - Unformatted

You can choose a number of optional actions to take after the document is
created by selecting the check boxes. The options include:

· View File - Opens the file in the default viewer after the file is created.
· Print File - Prints the file to the selected paper printer after the file is

created to a Windows printer. 
· Send File - Opens a new email message using the default MAPI-

compliant email client and attaches the file to the message. The email
program is specified in the Internet Options icon in the Windows control
panel. Win2PDF can also be configured to send a PDF using Microsoft
Outlook, Mozilla Thunderbird, Gmail, Outlook.com, Yahoo! Mail, or
custom SMTP servers.

· Delete after Sending - Deletes the document after it has been sent
using the "Send File" option.

You can use the file save window to browse to a new location before saving
the document. Win2PDF remembers this location, and will use the same
location the next time you create a document.

If you want to skip the save Window, see the Win2PDF Auto-name feature.

If you need to make an existing PDF file searchable, you can use the
Win2PDF Desktop Export to Searchable PDF (OCR), or the Win2PDF
MAKESEARCHABLE command line. 

2.10 Creating a JPEG Image File

The Win2PDF setup program creates a printer in the "Devices and Printers"
folder named Win2Image.
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How to Create a JPG file using Win2PDF

To create a image file in JPEG, TIFF, GIF, PNG, or BMP format:

· Open a document from a Windows application (Word, Excel, Edge, etc.)
· Print the document as you normally do but select the Win2Image printer
· You will be prompted to enter the name of the document, as shown on

this screen:
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Win2Image Save As JPEG

The default file name is supplied by the sending application. You can choose
the format using the "Save as type:" options. Win2Image supports the
following formats in color and monochrome/grayscale:
· TIFF (monochrome, grayscale, color, or color with transparent

background)
· JPEG
· GIF 
· PNG (grayscale, color, grayscale with transparent background, or color

with transparent background)
· BMP
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If the document contains more than one page, a separate file with a page
number appended to the file name will be created for each page for all
formats except TIFF. 

Print to an image (JPEG, GIF, TIF, BMP, &PNG) using the Win2Image printer

You can choose a number of optional actions to take after the document is
created by selecting the check boxes. The options include:

· View File - Opens the file in the default viewer after the file is created.
· Print File - Prints the file to the selected paper printer after the file is

created to a Windows printer. 
· Send File - Opens a new email message using the default MAPI-

compliant email client and attaches the file to the message. The email
program is specified in the Internet Options icon in the Windows control
panel. Win2PDF can also be configured to send a JPEG using Microsoft
Outlook, Mozilla Thunderbird, Gmail, Outlook.com, Yahoo! Mail, or
custom SMTP servers.

· Delete after Sending - Deletes the document after it has been sent
using the "Send File" option.

You can use the file save window to browse to a new location before saving
the document. Win2Image remembers this location, and will use the same
location the next time you create a document.

If you want to skip the save Window, see the Win2PDF Auto-name feature.
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To convert a PDF to a JPEG, you can use the Win2PDF Desktop Export PDF
to JPEG feature, or the pdf2jpg command line.

2.11 Creating a GIF Image File

The Win2PDF setup program creates a printer in the "Devices and Printers"
folder named Win2Image.

How to Create a GIF file using Win2PDF

To create a image file in JPEG, TIFF, GIF, PNG, or BMP format:

· Open a document from a Windows application (Word, Excel, Edge, etc.)
· Print the document as you normally do but select the Win2Image printer
· You will be prompted to enter the name of the document, as shown on

this screen:
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Win2Image Save As GIF

The default file name is supplied by the sending application. You can choose
the format using the "Save as type:" options. Win2Image supports the
following formats in color and monochrome/grayscale:
· TIFF (monochrome, grayscale, color, or color with transparent

background)
· JPEG
· GIF 
· PNG  (grayscale, color, grayscale with transparent background, or color

with transparent background)
· BMP
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If the document contains more than one page, a separate file with a page
number appended to the file name will be created for each page for all
formats except TIFF. 

Print to an image (JPEG, GIF, TIF, BMP, &PNG) using the Win2Image printer

You can choose a number of optional actions to take after the document is
created by selecting the check boxes. The options include:

· View File - Opens the file in the default viewer after the file is created.
· Print File - Prints the file to the selected paper printer after the file is

created to a Windows printer. 
· Send File - Opens a new email message using the default MAPI-

compliant email client and attaches the file to the message. The email
program is specified in the Internet Options icon in the Windows control
panel. Win2PDF can also be configured to send a GIF using Microsoft
Outlook, Mozilla Thunderbird, Gmail, Outlook.com, Yahoo! Mail, or
custom SMTP servers.

· Delete after Sending - Deletes the document after it has been sent
using the "Send File" option.

You can use the file save window to browse to a new location before saving
the document. Win2Image remembers this location, and will use the same
location the next time you create a document.

If you want to skip the save Window, see the Win2PDF Auto-name feature.



Win2PDF48

© 2023 Dane Prairie Systems, LLC

To convert a PDF to a TIFF, you can use the pdf2tiff command line.

2.12 Creating a PNG Image File

The Win2PDF setup program creates a printer in the "Devices and Printers"
folder named Win2Image.

How to Create a PNG file using

To create a image file in JPEG, TIFF, GIF, PNG, or BMP format:

· Open a document from a Windows application (Word, Excel, Edge, etc.)
· Print the document as you normally do but select the Win2Image printer
· You will be prompted to enter the name of the document, as shown on

this screen:
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Win2Image Save As PNG

The default file name is supplied by the sending application. You can choose
the format using the "Save as type:" options. Win2Image supports the
following formats in color and monochrome/grayscale:
· TIFF (monochrome, grayscale, color, or color with transparent

background)
· JPEG
· GIF 
· PNG (grayscale, color, grayscale with transparent background, or color

with transparent background)
· BMP
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If the document contains more than one page, a separate file with a page
number appended to the file name will be created for each page for all
formats except TIFF. 

Print to an image (JPEG, GIF, TIF, BMP, &PNG) using the Win2Image printer

You can choose a number of optional actions to take after the document is
created by selecting the check boxes. The options include:

· View File - Opens the file in the default viewer after the file is created.
· Print File - Prints the file to the selected paper printer after the file is

created to a Windows printer. 
· Send File - Opens a new email message using the default MAPI-

compliant email client and attaches the file to the message. The email
program is specified in the Internet Options icon in the Windows control
panel. Win2PDF can also be configured to send a PNG using Microsoft
Outlook, Mozilla Thunderbird, Gmail, Outlook.com, Yahoo! Mail, or
custom SMTP servers.

· Delete after Sending - Deletes the document after it has been sent
using the "Send File" option.

You can use the file save window to browse to a new location before saving
the document. Win2Image remembers this location, and will use the same
location the next time you create a document.

If you want to skip the save Window, see the Win2PDF Auto-name feature.
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To convert a PDF to a PNG, you can use the Win2PDF Desktop Export PDF
to PNG feature, or the pdf2png command line.

2.13 Creating a BMP Image File

The Win2PDF setup program creates a printer in the "Devices and Printers"
folder named Win2Image.

How to Create a BMP file using

To create a image file in JPEG, TIFF, GIF, PNG, or BMP format:

· Open a document from a Windows application (Word, Excel, Edge, etc.)
· Print the document as you normally do but select the Win2Image printer
· You will be prompted to enter the name of the document, as shown on

this screen:
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Win2Image Save As BMP

The default file name is supplied by the sending application. You can choose
the format using the "Save as type:" options. Win2Image supports the
following formats in color and monochrome/grayscale:
· TIFF (monochrome, grayscale, color, or color with transparent

background)
· JPEG
· GIF 
· PNG (grayscale, color, grayscale with transparent background, or color

with transparent background)
· BMP
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If the document contains more than one page, a separate file with a page
number appended to the file name will be created for each page for all
formats except TIFF. 

Print to an image (JPEG, GIF, TIF, BMP, &PNG) using the Win2Image printer

You can choose a number of optional actions to take after the document is
created by selecting the check boxes. The options include:

· View File - Opens the file in the default viewer after the file is created.
· Print File - Prints the file to the selected paper printer after the file is

created to a Windows printer. 
· Send File - Opens a new email message using the default MAPI-

compliant email client and attaches the file to the message. The email
program is specified in the Internet Options icon in the Windows control
panel. Win2PDF can also be configured to send a BMP using Microsoft
Outlook, Mozilla Thunderbird, Gmail, Outlook.com, Yahoo! Mail, or
custom SMTP servers.

· Delete after Sending - Deletes the document after it has been sent
using the "Send File" option.

You can use the file save window to browse to a new location before saving
the document. Win2Image remembers this location, and will use the same
location the next time you create a document.

If you want to skip the save Window, see the Win2PDF Auto-name feature.
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2.14 Merging to an existing PDF file

If you select a PDF file in the file save window that already exists, Win2PDF
will display the following window:

pdf-prepend-append-replace

The "Prepend" button will create a new document containing the existing
PDF file and will insert the new document information at the beginning of
the file. The "Append" button will create a new document containing the
existing PDF file and will add the new document information to the end of
the file. The "Replace" button will overwrite the existing PDF file, and the
"Cancel" button will cancel the PDF creation without affecting the existing
PDF file. Here is a YouTube video that shows how to append to an existing
PDF file.
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How to append to an existing PDF file using Win2PDF

If the "Overwrite original file" check box is checked, the "Prepend" and
"Append" buttons will overwrite the original document with the new
merged document. This option should be used with caution since it cannot
be undone. If the "Overwrite original file" check box is not checked,
both the "Prepend" and "Append" buttons will display an additional
window to choose a new file name as shown below. In this case, the
original PDF file will not be modified.
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If you selected options to "View File", "Print File", or "Send File" in the
first file save window, they will be performed after the file has been
merged.

If you enabled encryption in Win2PDF Pro, the merged file will be
encrypted. Win2PDF cannot append or prepend to an existing PDF file that
is already encrypted.

You can also append two existing PDF files using the Win2PDF Desktop
App, or using the APPEND command line.
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2.15 Fonts

When creating a standard PDF, Win2PDF 10 automatically embeds all fonts
except for the 14 fonts that are built into Adobe Reader®. These include: 
 
· Courier

· Courier-Bold

· Courier-Oblique

· Courier-BoldOblique

· Helvetica
· Helvetica-Bold
· Helvetica-Oblique
· Helvetica-BoldOblique
· Times-Roman
· Times-Bold
· Times-Italic
· Times-BoldItalic
· Symbol
· ZapfDingbats

When the PDF/A format is selected, all fonts including the font Adobe
Reader built-in fonts are automatically embedded in the PDF file.

2.16 Paper Sizes

Most applications have a "Page Setup" window for configuring the
document paper size. This is best place to change the Win2PDF paper size
if your application supports it.

To set the default Win2PDF paper size, open the "Devices and Printers"
window, right click on the Win2PDF icon, and choose "Printing
Preferences":
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When the "Printing Preferences" window opens, click on the "Advanced"
button:
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Under "Paper/Output", click on "Paper Size:" to select the default paper
size.
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Win2PDF supports the following paper sizes:

· US Letter
· US Legal
· 4A0
· 2A0
· A0
· A1
· A2
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· A3
· A4
· B5
· US Letter Small
· A4 Small
· US Legal Small
· Ebook
· Tabloid 11x17in.
· A-Size 8.5x11in.
· B-Size 11x17in.
· C-Size 17x22in.
· D-Size 22x34in.
· E-Size 34x44in.
· Arch-A 9x12in.
· Arch-B 12x18in.
· Arch-C 18x24in.
· Arch-D 24x36in.
· Arch-E 36x48in.
· 30x42/30x42in.
· 30x48/30x48in.
· 36x60/36x60in.

In addition, Win2PDF supports user defined custom or user defined paper
sizes. The steps required to create a custom paper size vary depending on
the version of Windows.
How to create a custom paper size in Windows XP or Windows Server 2003
How to create a custom paper size in Windows Vista
How to create a custom paper size in Windows 7 or Windows Server 2008
How to create a custom paper size in Windows 8
How to create a custom paper size in Windows 10
How to create a custom paper size in Windows 11

2.16.1 How to create a custom paper size in Windows XP or Windows Server 2003

To create a custom page size in Windows XP or Windows Server 2003:

1. Open the "Printers and Faxes" folder

2. Under the "File" menu, select "Server Properties".
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3. Select the "Forms" tab.

4. Check the "Create a New Form" box, and fill out the "Form
Description" and "Paper Size" fields. It is best to leave the "Printer
Area Margins" fields as 0.

5. Select "Save Form" and close the window. Your form should now be
available to Win2PDF.

2.16.2 How to create a custom paper size in Windows Vista

To create a custom page size in Windows Vista:

1. Open the "Printers" folder
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2. Right click in the background of the printers folder, and select "Run as
administrator->Server Properties...".

3. Select the "Forms" tab.
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4. Check the "Create a New Form" box, and fill out the "Form
Description" and "Paper Size" fields. It is best to leave the "Printer
Area Margins" fields as 0.

5. Select "Save Form" and close the window. Your form should now be
available to Win2PDF.

2.16.3 How to create a custom paper size in Windows 7 or Windows Server 2008

To create a custom page size in Windows 7 or Windows Server 2008:

1. Open the "Devices and Printers" folder from the Start menu. Select
the printer named "Win2PDF" and then click on the menu option "Print
Server Properties".
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2. In the "Print Server Properties" window, name and set the paper size
dimensions.
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3. Select "Save Form" and close the window. Your form should now be
available to Win2PDF. Here is a short video showing how to create and use
this custom paper size.

How to create a custom paper size with Windows 7

2.16.4 How to create a custom paper size in Windows 8

To create a custom page size in Windows 8, Windows 8.1, or Windows
Server 2012:

1. Open the Control Panel by typing "Control Panel" in the start menu
search box. Click "View devices and printers" under "Hardware and
Sound" from the Control Panel.  Select the printer named "Win2PDF" and
then click on the menu option "Print Server Properties" in the window
title bar.
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2. In the "Print Server Properties" window, name and set the paper size
dimensions.
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3. Select "Save Form" and close the window. Your form should now be
available to Win2PDF. Here is a short video showing how to create and use
this custom paper size.

How to create a custom paper size with Windows 7

2.16.5 How to create a custom paper size in Windows 10

To create a custom page size in Windows 10:

1. Open the "Control Panel" from the Windows 10 "Start -> Windows
System" menu. Click "View devices and printers" under "Hardware
and Sound" from the Control Panel. Select the printer named "Win2PDF"
and then click on the menu option "Print Server Properties".
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2. In the "Print Server Properties" window, name and set the paper size
dimensions.
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3. Select "Save Form" and close the window. Your form should now be
available to Win2PDF. Here is a short video showing how to create and use
this custom paper size.

How to create a custom paper size with Windows 7

2.16.6 How to create a custom paper size in Windows 11

To create a custom page size in Windows 11:

1. Search for "Control Panel" from the Windows 11 "Search" menu. Click
"View devices and printers" under "Hardware and Sound" from the
Control Panel. Select the printer named "Win2PDF" and then click on the
menu option "Print Server Properties".
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2. In the "Print Server Properties" window, name and set the paper size
dimensions.
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3. Select "Save Form" and close the window. Your form should now be
available to Win2PDF. Here is a short video showing how to create and use
this custom paper size.

How to create a custom paper size with Windows 7

2.17 Application Settings Vs. Default Settings

Many applications have the ability to change the printer settings from the
print window or from a page setup window. If you change a setting from an
application, it will not change the default setting. 

To change the default printer setting, you need to change the setting in the
"Printing Preferences" window. You can find this by opening the printers
folder, right clicking on the "Win2PDF" icon, and choosing "Printing
Preferences".
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2.18 Resolution

The default resolution for images is 300 DPI. You can change the default
resolution by opening the "Printers" folder, right clicking on the Win2PDF
icon, and opening "Printing Preferences". 
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In the Printing Preferences window, click "Advanced...":



Using Win2PDF and Win2Image 75

© 2023 Dane Prairie Systems, LLC

The resolution (Print Quality) setting us under the "Graphic" section of
this window.
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Set Printer Resolution

Available resolutions are:
· 75 DPI
· 150 DPI
· 300 DPI
· 600 DPI
· 1200 DPI
· 2400 DPI

Increasing the resolution will improve the quality of images, but it will also
increase the document size.

2.19 Win2PDF Pro Settings

2.19.1 Document Information

Set Document Information   
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Win2PDF Pro can set the document information such as Title, Author,
Subject, and Keywords. This information is entered in the "PDF
Options..." window of the Win2PDF File Save window.

Document Summary Settings

The "Author" and "Keywords" fields are saved by Win2PDF and applied to
all subsequent documents. The default value for the "Title" field is set by
the application. The "Subject" field is not saved for future documents, and
must be manually set for each document.

The document information can be viewed in Acrobat Reader by opening
File->Document Properties->Summary
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Document Properties

Information on controlling the document information from a custom
application is available in "Setting Document Information" in the developer
information section.

2.19.2 Document Security

Set Document Security   

Win2PDF Pro supports the standard security options and permissions
available in the PDF file format. Note: security options and permissions are
not valid for the PDF/A file format.
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PDF Security Options

The "Encryption Level" setting controls the type of encryption used in the
PDF file. The 128 bit AES encryption is compatible with Acrobat Reader 5.0
and above and the 256 bit AES encryption is compatible with Adobe Reader
9.0 and above. For best security, the 256 bit encryption option is
recommended.

The "Permissions" setting controls restrictions that can be placed on the
PDF file. To prevent printing of a PDF file, uncheck the "Allow the
document to be printed" option. To prevent the text and graphics from
being copied from the PDF file, uncheck the "Allow text and graphics to
be copied" option. To prevent the document from being modified in a PDF
editor, uncheck the "Allow the document to be modified" option. 

The PDF file format allows two types of passwords, a user password and a
master password. The user password is used to open the document, and
the master password used to encrypt the security options. When a user
password is set, Acrobat Reader displays the following prompt when you
open the PDF file.
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Adobe Reader Enter Password Window

You must always enter a master password when security options
are enabled or if a user password is specified. It is recommended that
passwords be at least 8 characters long and contain at least 1 number.

The password and permissions options are only available when the
"Encryption Level" is set to 128 or 256 bit encryption. Here is a YouTube
video that shows how to set the security options:

Enabling security options in PDF with Win2PDF Pro

Information on controlling the encryption options from a custom application
is available in "controlling encryption options" in the developer information
section.
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An administrator can disable or change the default value  for any of the
security settings using the "Win2PDF Admin Utility" available for
download at:
https://helpdesk.win2pdf.com/index.php?/Knowledgebase/Article/View/18
7/15/win2pdf-admin-utility-download

You can also change PDF security using the Win2PDF Desktop App, or
using the Command Line PDF Encryption.

2.19.3 Applying a watermark

Applying a Watermark  

Win2PDF Pro can overlay an existing PDF file on newly created PDF files
(Add a Watermark) or place an existing PDF file behind text and graphics on
newly created PDF files (Add a Background). The existing watermark or
background PDF file can contain any text or graphics, but it most often
used to apply a "confidential" or "draft" stamp on each page of a document.
To enable the watermark or background feature, select the "Add a
Watermark" or "Add a Background" option in the Win2PDF "PDF Options"
window.

https://helpdesk.win2pdf.com/index.php?/Knowledgebase/Article/View/187/15/win2pdf-admin-utility-download
https://helpdesk.win2pdf.com/index.php?/Knowledgebase/Article/View/187/15/win2pdf-admin-utility-download
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Add a Background or Watermark

When the watermark or background options are enabled, a text box
containing the name of the current watermark or background PDF file is
shown below the options. If you would like to change the file, click the
"Change..." button and select a new watermark or background PDF file.
Win2PDF will always display the last used watermark or background PDF
file when the feature is enabled.  

If the watermark or background PDF file contains more than one page, only
the first page will be applied to each page of the new document. It's best to
use a watermark or background PDF file that has the same page size as the
newly created PDF file. If the watermark or background file has a different
page size, it will be scaled and centered on the page of the newly created
PDF file.

You can create the watermark or background PDF file using Win2PDF and
any Windows application such as Microsoft Word. If you are using Win2PDF
Pro, the watermark or background PDF file must not be encrypted. Some
sample watermark and background PDF files and the corresponding Word



Using Win2PDF and Win2Image 83

© 2023 Dane Prairie Systems, LLC

documents are available on the download section of the support web site
at:
https://helpdesk.win2pdf.com/index.php?/Knowledgebase/Article/View/18
6/17/watermark-samples

If the watermark file has click-able links, you can check the "Allow Links in
Watermark" option to keep these links active in the final watermarked PDF
file.

Allow Links in Watermark

If you only want to apply the watermark or background to the first or last
page, you can select the "First Page Only" or "Last Page Only" options in
the "Apply To:" setting:

https://helpdesk.win2pdf.com/index.php?/Knowledgebase/Article/View/186/17/watermark-samples
https://helpdesk.win2pdf.com/index.php?/Knowledgebase/Article/View/186/17/watermark-samples
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Apply Watermark to First or Last Page

Here is a YouTube video that shows how to set the watermark options:
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Adding a watermark to a PDF file using Win2PDF Pro

Information on controlling the watermark options from a custom application
is available in "watermark options" in the developer information section.

An administrator can disable or set a default watermark PDF file for all users
with the "Win2PDF Admin Utility" available for download at:
https://helpdesk.win2pdf.com/index.php?/Knowledgebase/Article/View/18
7/15/win2pdf-admin-utility-download

You can also add a watermark to an existing PDF using the Win2PDF
Desktop App, or using the Command Line PDF Watermark/Background.

2.20 Document Settings

2.20.1 Scaling

The first setting in the Document tab of the Win2PDF "PDF Options" window
is labeled "Scaling". This option can scale the resulting PDF by a percentage
specified. The scaling percent can be between 1 and 999, and the default is
100.

https://helpdesk.win2pdf.com/index.php?/Knowledgebase/Article/View/187/15/win2pdf-admin-utility-download
https://helpdesk.win2pdf.com/index.php?/Knowledgebase/Article/View/187/15/win2pdf-admin-utility-download
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2.20.2 Auto-name Files and Configure File Save Naming

Win2PDF and Win2Image can be configured to set the default file name that
is shown in the file save window. It can also be configured to automatically
name files and skip the file save window. 

To enable the Win2PDF auto-name feature, print to the Win2PDF printer.
When the file save window pops-up, choose the auto-name folder location:
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Win2PDF Auto-name set folder location

Next, click on the "PDF Options" button:
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Win2PDF Open PDF Options...

Click the "Document" tab display the Auto-name configuration options.
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Auto-name Files and Configure File Save Naming

· When the "Auto-name Files" option is unchecked, the settings in
this window apply to the name displayed in the Win2PDF File Save
window. By default, Win2PDF uses the print document name set by the
application as the PDF file name. If you want to customize the default
name displayed in the Win2PDF file save window, you can add a fixed file
name start, a date stamp, or a time stamp. Advanced users can
customize the order of these items using the user defined setting.

· When the "Auto-name Files" option is checked, the settings in this
window are used to automatically save the PDF file directly and Win2PDF
bypasses the file save window.

The path used by the Auto-name feature is inherited from the currently
selected path when you click on the "PDF Options" button in the file save
window. To change the auto-name path, go back to the file save window
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and browse to the desired folder before clicking on the "PDF Options..."
button.

The Auto-name feature can also be configured or updated by opening the
"Configure Win2PDF Auto-Name" item from the "Win2PDF" group in the
Windows Start menu. 

The available naming options are:
Auto-name: File Name Start
Auto-name: Include Document Title
Auto-name: Include Date
Auto-name: Include Time
Auto-name: User Defined
Auto-name: Always Append
Auto-name Files: Content Based File Naming
Auto-name Files: Content Based File Naming: Search Word
Auto-name Files: Content Based File Naming: Content Field

Enable Win2PDF Auto-name feature

To stop the Auto-name option, either hold down the shift key when printing
to the Win2PDF printer, or run the "Stop Win2PDF Auto-name" program
from the Start menu. When you save the options, the following window is
displayed:
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Disable Win2PDF Auto-name

Once Auto-name is enabled, you will no longer see the Win2PDF file save
window when you print. To turn off the Auto-name feature and resume
prompting for the PDF file save, you will need to either hold down the
SHIFT key when printing to Win2PDF, or go to the Windows Start menu and
go to the Win2PDF program group. There, you will be able to select 'Stop
Win2PDF Auto-name', as shown below. 
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Stop Win2PDF Auto-name from the Windows Start
menu

The auto-name settings only apply to the current Win2PDF printer. You can
add any number of Win2PDF printers and configure each printer with
different auto-name settings.
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On multi-user servers, the auto-name settings only apply to the currently
logged in user. If you open "Configure Win2PDF Auto-name" using "Run as
administrator", the Auto-name settings will apply to all users.

Configure Win2PDF Auto-name
for all users

The "Configure Win2PDF Auto-Name" window title should display "All
Users":

The auto-name configuration is stopped if you hold down the shift key while
printing to the Win2PDF printer. If you are printing to Win2PDF in the
background while typing in another program, you may accidentally stop the
auto-name if you press the shift key. If you want to prevent this from
happening, you can use the Win2PDF Admin Utility "Troubleshooting"
option to "Disable Auto-Name Shift Key check".

2.20.2.1 File Name Start

When the "Auto-name Files" option is enabled, you can specify fixed text
that will be added to the beginning of the PDF file name. 
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Auto-name Settings - File Name Start

The "Sample File Name" listed at the bottom of the window is updated to
show what the resulting file name will be. This option can be combined with
any of the other auto-name options.

2.20.2.2 Include Document Title

When the "Auto-name Files" option is enabled, you can add the document
title to the file name by checking the "Include Document Title" option. 
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Auto Name Settings - Include Document Title

The document title is set by the calling application, and may change for
each document being printed depending on the application. 

The "Sample File Name" listed at the bottom of the window is updated to
show the resulting file name based on the options selected using "Title" as
a placeholder for the application document title. This option can be
combined with any of the other auto-name options.

2.20.2.3 Include Date

When the "Auto-name Files" option is enabled, you can add a date to the
file name by checking on the "Include Date" option. 
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Auto-name Settings - Include Date

The date format can be selected to the right of the option, and available
formats include:

· Year-Month-Day
· Year-Month
· Month-Day-Year (Default)
· Month-Day
· Month-Day - abbr. names
· Year Only
· Month Only - numeral
· Month Only - abbr. name
· Day Only
· Day in Week - abbr. name

The "Sample File Name" listed at the bottom of the window is updated to
show the resulting file name based on the options selected. This option can
be combined with any of the other auto-name options.

2.20.2.4 Include Time

When the "Auto-name Files" option is enabled, you can add a time to the
file name by checking on the "Include Time" option. 
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Auto-name Settings - Include Time

The time format can be selected to the right of the option, and available
formats include:

· 12 Hour-Minute-Second-AM/PM
· 12 Hour-Minute-Second-Millisecond-AM/PM (default)
· 12 Hour-Minute-AM/PM
· 12 Hour Only-AM/PM
· 24 Hour-Minute-Second
· 24 Hour Minute-Second-Millisecond
· 24 Hour-Minute
· 24 Hour Only
· Minute-Second
· Minute Only
· Second Only

The "Sample File Name" listed at the bottom of the window is updated to
show the resulting file name based on the options selected. This option can
be combined with any of the other auto-name options.

2.20.2.5 User Defined

When the "Auto-name Files" option is enabled, advanced users can control
the format of the file name using the "User Defined" option.
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Auto-name Settings - User Defined

When the "User Defined" option is enabled, the field is filled with the currently
selected options in a tag format that is delimited by % characters (e.g. %PDFHour
%). Advanced users can re-order the Win2PDF tags to match their requirements, or
mix and match tags to create their own file name format. The supported tags are:

%PDFTitle% Document title set by the application including the file extension
%
PDFTitleNoExte
nsion%

Document title set by the application, excluding the 3 or 4
character file extension (if any)

%PDFDate% Eight digit date separated by dashes in the format month-day-
year (12-25-2015)

%PDFTime% Six digit 12 hour time separated by dashes in the format hour-
minute-second-AM/PM (12-59-59 PM)

%PDFYear% Four digit number for the current year (2015)
%PDFMonth% Two digit number for the current month (12)
%
PDFMonthName
%

Three character abbreviated name for the current month (Dec)

%PDFDay% Two digit number for the current day of the month (25)
%PDFDayName
%

Three character abbreviated name for the day of the week (Wed)
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%
PDFDayInWeek
%

One digit number for the current day of the week

%PDFHour% Two digit number for the current hour in a 12 hour format (12)
%PDFHour24% Two digit number for the current hour in a 24 hour format (24)
%PDFMinute% Two digit number for the current minute within the hour (59)
%PDFMinute5% Number for the current 5 minute interval within the hour (0, 5,

10,..55)
%
PDFMinute10%

Number for the current 10 minute interval within the hour (0, 10,
20, ..50)

%
PDFMinute15%

Number for the current 15 minute interval within the hour (0, 15,
30, 45)

%
PDFMinute30%

Number for the current 30 minute interval within the hour (0, 30)

%PDFSecond% Two digit number for the current second within the minute (59)
%
PDFMillisecond
%

Three digit number for the current millisecond (999)

%
PDFTimeMarker
%

Two character abbreviation for AM or PM

%
PDFPrinterNam
e%

The name of the Win2PDF printer instance

%PDFIncrement
%

The %PDFIncrement% variable starts at 1, and increments by
one until the expanded file name does not exist.

%
PDFAutoNameC
ontentSearch% 

Used for content based file naming. Win2PDF searches the text
of the current PDF for the word specified in the Win2PDF
Desktop "Define Search Field" command or by the
PDFAutoNameContentSearchWord registry setting. If the word is
found, the auto-name variable %PDFAutoNameContentSearch%
is filled with the word after the search word. 

%
PDFAutoNameC
ontentSearch2%

Used for content based file naming. Win2PDF searches the text
of the current PDF for the word specified in the Win2PDF
Desktop "Define Search Field" command or by the
PDFAutoNameContentSearchWord2 registry setting. If the word
is found, the auto-name variable %
PDFAutoNameContentSearch2% is filled with the word after the
search word. 

%
PDFAutoNameC
ontentSearch3%

Used for content based file naming. Win2PDF searches the text
of the current PDF for the word specified in the Win2PDF
Desktop "Define Search Field" command or by the
PDFAutoNameContentSearchWord3 registry setting. If the word
is found, the auto-name variable %
PDFAutoNameContentSearch3% is filled with the word after the
search word. 
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%
PDFAutoNameC
ontentField%

Used for content based file naming. Win2PDF searches the
content field rectangle defined in the Win2PDF Desktop "Define
Content Field" command. If text is found in the defined rectangle,
the auto-name variable %PDFAutoNameContentField% is filled
with found text.

The "Sample File Name" listed at the bottom of the window is updated to
show the resulting file name based on the options selected. This option can
be combined with any of the other auto-name options.

You can specify an Auto-Name folder using any of the tags. For example, to
place all PDF file in a folder based on the current month and a subfolder
based on the current day in the month, you could set the "User Defined"
field to:
%PDFMonth%\%PDFDay%\%PDFTitle%.pdf

If the folder doesn't exist, it will be created by Win2PDF.

2.20.2.6 Content Based File Naming

Win2PDF allows the file to be named based on the contents of the PDF file.
This can be helpful if the application generating the PDF can't be changed to
use the Win2PDF developer interface to name the PDF files.

There are two ways that Win2PDF can name documents based on the
document contents. 

§ The first content based naming method can search the text of a
document, and then extract a word following the target search word.
It requires that document contains text with a common search word
that exists in all PDF files. 

§ The second content based naming method uses the absolute position
of the text in the document. This is defined by drawing a rectangle
around the desired text using the Win2PDF Desktop Application and
we will refer to it as the content field. 

To determine which method will work best, you'll need to know how the
auto-named files will be formatted when they are printed. If it's a form or
report that has text output in exactly the same position on the page in
each file, then the content field method will work best. If the information to
be used in the file name is always preceded by the same word or sequence
of characters, then the search word method will work best. In other words,
the content field is good for fixed field position and length, and search word
is better for variable positioning and (possibly) variable length.
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For example, suppose you have a form from an accounting system that had
a fixed location for the "Invoice Number"" value in the document, but a
variable length value that followed the text "Purchase Order Number:". If
you wanted to name the file based on the "Purchase Order Number:", you
could use search word since the purchase order number immediately
follows (though it may contain a variable number of characters). It would
grab everything after the search term to the next space or the end of the
line. If you wanted to name the file based on the "Invoice Number:", you
could use content field since it is always in the same location and with the
same number of characters. 

The content based file naming features depend on the text in the document
being searchable. The features will not work for scanned documents, or
from applications that send text to the Win2PDF printer as graphics. To see
the text searched by Win2PDF for both methods, you can create a sample
PDF from your application and use the "extract text" feature of the Win2PDF
Desktop Application to see the search text of the PDF. 

If the document or parts of the document are not searchable, you should
install the "Win2PDF OCR Add-on" setup program from:
https://www.win2pdf.com/download/download-win2pdf-ocr.html
You should also set the file name to end with a .PDFO

Note: For testing, you may try printing an existing PDF to the Win2PDF
printer. Most PDF viewers such as Adobe Acrobat will convert searchable
text to graphics before sending to the Win2PDF printer, and the content
naming features may not work correctly. It is best to test the content
features by printing directly from the reporting application.

Content based file naming cannot be used when PDF encryption is enabled.

See also:
Auto-name Files: Content Based File Naming: Search Word
Auto-name Files: Content Based File Naming: Content Field

2.20.2.6.1  Search Word

To enable the first method, the content search word is specified using the
Win2PDF Desktop Application using the "Define Auto-Name Search Field"
item in the "Auto-Name" menu:

https://www.win2pdf.com/download/download-win2pdf-ocr.html
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Define Auto Name Search Field

Type the search word into the window, and the field following the search
word is displayed under "Found search field".

Define Search Field

Selecting the "Search Direction" controls whether Win2PDF searches to the
right or just below the search term.  If your search field is to the right of
your search term as in:
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Invoice 01357

you should select "Search Right".  

If your search field is below your search term as in:

Invoice

10357

you should select "Search Below". 

Selecting the "Search until space character" option will end the search when
a space, tab, or newline character occurs. Selecting the "Search until space
character" option will end the search when a space, tab, or newline
character occurs.  Selecting "Search up to X characters" will include the
specified number of characters, including any space characters.  The
"Found search field" sample text is updated as you type based on the
current open PDF file.

You can define up to 3 different search fields, and use the fields for either
file names, folder names, or email recipients. The Win2PDF Desktop
"Configure Auto-Name" allows you to use the search fields in either the file
name or the email recipient:
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Configure Auto-Name Content Search Fields

We previously defined the "Search Field 1" as "Invoice:", so checking the
"Include Search Field" option and selecting "Search Field 1" will display the
search field result using the current document. The email recipient can also
be configured by checking the "Send File" option and defining which field to
use as the email recipient.

You can also use %PDFAutoNameContentSearch%, %
PDFAutoNameContentSearch2% or %PDFAutoNameContentSearch3% in
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the "User Defined" configuration, and they can be combined with any of the
other user defined variables to add a date and/or time stamp.

As an example, consider a document that contains the following text:

DATE 09 - 05 - 19  SOME COUNTY SHERIFF'S DEPARTMENT

            123 Main Street

            Anytown, MN 55555

Doc #: 398277

             Affidavit Of Return

Paper #: 194094     To: STATE OF MINNESOTA

If we want to name the PDF based on the "Paper #:" field in the PDF, we
would use the Win2PDF Desktop Application to define the "Search Field 1"
to "Paper #:". After that, we would open the "Configure Auto-name"
window in the Win2PDF Desktop Application, check the "Include Search
Field" option, and set it to "Search Field 1". When the document is printed
to the Win2PDF printer, the content based naming feature automatically
names the PDF "194094.pdf" based on the contents of the document.

If you print a document that does not contain the search word when the
content based naming is enabled, the PDF file is named with "%
PDFAutoNameContentSearch%" in the file name.

See also:
Auto-name Files: Content Based File Naming: Content Field

2.20.2.6.2  Content Field

To enable the second method, the content field used for the name is
defined in the Win2PDF Desktop App. 

You simply start by opening a sample file in Win2PDF Desktop that is
illustrative of the format of the documents that will be used in the future. In
the following example, there is a "Doc #" which is unique to each printed
file. To use this unique number as part of the Auto-name for future
documents, make the following settings:

1. Go to Auto-Name menu.
2. Select Define Auto-Name Content Field from the menu.
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3. Use your mouse to define the area on the page where the content field
resides. (Note: Each future document must have this same screen
location)

4. After this has been defined, it will show you the value on the screen.
Next, choose Configure Auto-Name... from the Auto-Name menu.

5. Check the box for Auto-Name and check the "Include Content Field"
option along with any other Auto-Name settings you would like and
click OK.

The following screen cast shows how this can be defined.

How to set the Content Name Field
using Win2PDF's Auto-Name feature

See also:
Auto-name Files: Content Based File Naming: Search Word

2.20.2.7 Always Append

When the "Always Append" option is enabled, Win2PDF will automatically
append to any existing document that matches the Auto-name format. This
option is not available for Win2Image, or when security is enabled in
Win2PDF Pro.
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Auto Name Settings - Always Append

Depending on the other options selected, the "Always Append" option will
append until the date and/or time changes, or until the file is manually
renamed. A new file will be created if an existing file with the same format
does not exist.

For example, if the "Include Date" option is selected with a "Month-Day-
Year" format, the "Always Append" option will append to the same file when
it was created on the same day. The following day, a new file will be
created. If the date format is set to "Year Only", a new file will every year.
If no date or time options are enabled, Win2PDF will always append to the
same file until the file is manually renamed. The description following
"Always Append" is updated to indicate how often a new file is created.

This option can be combined with any of the other auto-name options.
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2.21 Advanced Settings

2.21.1 Optimize Image File Size using JPEG2000

The Advanced tab contains a setting for enabling or disabling JPEG2000
image compression.

Optimize Image File Size using JPEG2000

When the "Optimize Image File Size using JPEG2000" option is enabled,
color images in the PDF are compressed using the JPEG 2000 format. This
can result in significant reductions in file size, but can also reduce the
quality of some types of color images and can slow the conversion process.
The option is disabled by default.

You can also compress PDF files using the Win2PDF Desktop App, or using
the COMPRESS command line.



Part
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3 Using the Win2PDF Desktop App

3.1 Win2PDF Desktop App PDF Viewer

The Win2PDF Desktop App is one of three main components installed with
Win2PDF.  It allows you to 

· View a PDF or View an XPS,

· Edit PDFs at the page level (extract pages, delete pages, split pages,
rotate pages, etc.),

· Configure Auto-name settings for Win2PDF,

· Rename PDF files

· Configure Mail settings for Win2PDF, and

· Convert/export PDF Files to other formats.

· Convert from common formats to PDF

· Batch Convert

· Watch Folder and Convert

There are multiple ways of starting the Win2PDF Desktop App.

1. You can double-click the Win2PDF Desktop icon from your Windows
desktop,

2. You can drop a PDF file onto the Win2PDF Desktop icon, 

3. You can right-click on a PDF or XPS document in Windows Explorer or
the desktop and can choose Open With –> Win2PDF Desktop

4. You can right-click on a PDF or XPS document in Windows Explorer or
the desktop and choose "View with Win2PDF".
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5. You can choose Win2PDF Desktop from the Windows Start menu

Once the Win2PDF Desktop App has been started, the PDF file will be
displayed in Win2PDF Viewer mode and you will have the following options
from the File menu:
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Win2PDF Desktop - File Menu

Opens a PDF file for viewing or editing.

Saves the currently open PDF file if changes have been made.

Saves the currently open PDF to a new name.

Export
Converts the open PDF file to a different file format (text, PDF with options,
or image formats).

Mail
Allows you to configure Mail settings and Mail the PDF file.
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Allows you to print the open file to any printer.

Batch Convert...
Converts a folder of files to a new format.

Watch Folder and Convert...
Converts a folder of files to a new format.

Web Page To PDF
Converts an online web page to PDF.

Settings
Converts an online web page to PDF.

Closes the Win2PDF Viewer window and exits the Win2PDF Desktop
program.

Help for Win2PDF Desktop can be accessed through the Help menu:

Win2PDF Desktop - Help Menu

Opens Win2PDF online support guide in a web-browser

Opens Win2PDF Helpdesk for access to technical support, knowledgebase
articles, and product downloads
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Opens Win2PDF purchase page for ordering licenses

Displays Win2PDF License code and version number

Displays version information about Win2PDF Desktop App

Additionally, you can use the Win2PDF Desktop App to do the following:

· If you to drag and drop a document (or a group of documents) onto the
Win2PDF Desktop icon, Win2PDF will automatically convert the document
to PDF using the default application for the document type. You can drag
and drop multiple files onto the Win2PDF Desktop icon to convert them to
PDF, and you can use the Win2PDF Auto-name feature to automatically
name the PDF files.

· If the Windows clipboard contains an image, you can convert the
clipboard to a PDF.

· Use Win2PDF Desktop with command line options from a command
prompt to automate Win2PDF Desktop features or integrate with other
applications or process flows.

3.1.1 PDF Viewer

To view a PDF, open a PDF file using "File -> Open" or drag-and-dropping
a PDF file onto the Win2PDF Desktop icon. The Win2PDF Desktop viewer
will show a preview of the PDF.

You can also right-click on a PDF document in Windows Explorer or the
desktop and can choose "Open With –> Win2PDF Desktop", or "View
with Win2PDF".  On Windows 11, choose "Show more options ->
View With Win2PDF".
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Win2PDF Desktop - View with Win2PDF

The PDF is opened in a viewer with toolbar icons for navigation and
common actions.
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Win2PDF Desktop - PDF Viewer Controls

3.1.2 XPS Viewer

To view an XPS, open a XPS file using "File -> Open" or drag-and-
dropping a XPS file onto the Win2PDF Desktop icon. The Win2PDF Desktop
viewer will show a preview of the XPS.

You can also right-click on a XPS document in Windows Explorer or the
desktop and can choose "Open With –> Win2PDF Desktop", or "View
with Win2PDF".  On Windows 11, choose "Show more options ->
View With Win2PDF".
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Win2PDF Desktop - View with Win2PDF

The XPS is opened in a viewer with toolbar icons for navigation and
common actions.
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Win2PDF Desktop - XPS Viewer Controls
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3.1.3 Export Options

Win2PDF Desktop - Export Options

Converts PDF file to either an "Unformatted" or "Formatted" Text file.

Converts PDF file to a Searchable PDF file. [This option only appears when
the Win2PDF OCR Add-on is installed].

Converts PDF file to a compressed PDF file.

Converts PDF file to Monochrome, Grayscale, or Color Image-Only PDF file.
 An Image Only PDF file will not have searchable text.

https://www.win2pdf.com/download/download-win2pdf-ocr.html
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Converts PDF file to Monochrome, Grayscale, or Color Image-Only JPEG
image file.

Converts PDF file to Monochrome, Grayscale, or Color Image-Only TIFF
image file.

Converts PDF file to Monochrome, Grayscale, or Color Image-Only PNG
image file.

Converts PDF file to a Microsoft Word DOCX document.

Converts PDF file to an RTF document.

Converts PDF file to an OpenDocument Text file.

3.1.4 PDF Security

Win2PDF Desktop PDF Security  

To password protect or set permissions on an existing PDF, open a PDF file
using "File -> Open" or drag-and-dropping a PDF file onto the Win2PDF
Desktop icon and then select "File-> PDF Security...":
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Win2PDF Desktop - PDF Security Menu

Changes PDF Security options including passwords and permissions.

3.1.5 PDF Watermark

Win2PDF Desktop PDF Watermark  

To password protect or set permissions on an existing PDF, open a PDF file
using "File -> Open" or drag-and-dropping a PDF file onto the Win2PDF
Desktop icon and then select "File-> PDF Watermark...":
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Win2PDF Desktop - PDF Security Menu

Adds a PDF Watermark or Background to an existing PDF

3.1.6 Batch Convert

Win2PDF Desktop Batch Convert  

To batch convert a folder of documents to a specified format, open the
Win2PDF Desktop application and then select "File-> Batch Convert...":
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Win2PDF Desktop - Batch Convert Menu

Convert a folder of documents to a different format

3.1.7 Watch Folder and Convert

Win2PDF Desktop Watch Folder and Convert 

To watch a folder and convert any documents placed in the folder to a
specified format, open the Win2PDF Desktop application and then select
"File-> Watch Folder and Convert...":
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Win2PDF Desktop - Watch Folder and
Convert Menu

Watch a folder and convert to a different format

3.1.8 Web Page to PDF

To convert a web page specified by a URL to a PDF, open the Win2PDF
Desktop application and then select "File-> Web Page To PDF...":
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Win2PDF Desktop - Web Page To PDF
Menu

Convert a URL to PDF

3.1.9 Editing Pages

There are several editing features that can be accessed through the Pages
menu.
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Win2PDF Desktop - Append to an Existing PDF

How to append to an existing PDF

How to prepend to an existing PDF

How to extract pages

How to delete pages

How to split pages

Hot to rotate pages

3.1.10 Configuring Auto-Name

The Win2PDF Auto-Name feature can be configured through the Auto-
Name menu.
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 Win2PDF Desktop - Configuring Auto-Name

                
How to configure auto-name 

How to define auto-name content field

How to define auto-name search field

3.1.11 Auto-Rename PDFs

The Win2PDF Auto-Rename feature can be configured through the Auto-
Name menu.

 Win2PDF Desktop - Auto-Rename PDFs

                
How to configure auto-name 
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How to define auto-name content field

How to Auto-Rename PDFs

3.1.12 Email Options

The Win2PDF Auto-Name feature can be configured through the Auto-
Name menu.

 Win2PDF Desktop - Email Options

                
Sends the PDF file through email using the current Mail settings.

                
Configures the Mail options to use when sending a PDF file through email.

3.1.13 Export/Import Settings

All Win2PDF Settings can be backed up and restored using the Settings 
Export.. and  command
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Win2PDF Desktop - Export/Import Settings

                
 How To Export Settings

 How To Import Settings

3.2 Win2PDF Desktop App Converter

The Win2PDF Desktop App is one of three main components installed with
Win2PDF.  If you open it with a PDF file, it will allow you to view a PDF, edit
PDFs at the page level (extract pages, delete pages, split pages, rotate
pages, etc.), configure Auto-name settings for Win2PDF, configure mail
settings for Win2PDF, and convert/export PDF files to other formats
including batch convert and watch convert features.
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The Win2PDF Desktop App can also directly open and convert many image
formats to PDF.  The following formats are supported:

· JPG to PDF
· PNG to PDF
· TIFF to PDF
· BMP to PDF
· GIF to PDF
· Web Page to PDF
· XPS to PDF
· Any to PDF

You can also export a PDF to other formats including:
· PDF to PDF Image Only
· PDF to JPEG
· PDF to TIFF
· PDF to PNG
· PDF to Searchable PDF (OCR)
· PDF to DOCX (Win2PDF Pro)
· PDF to RTF (Win2PDF Pro)
· PDF to ODT (Win2PDF Pro)
· XPS to PDF
· XPS to PDF Image Only
· XPS to JPEG
· XPS to TIFF
· XPS to PNG
· XPS to Searchable PDF (OCR)
· XPS to DOCX (Win2PDF Pro)
· XPS to RTF (Win2PDF Pro)
· XPS to ODT (Win2PDF Pro)

There are multiple ways of starting the Win2PDF Desktop App.

1. You can double-click the Win2PDF Desktop icon from your Windows
desktop,

2. You can drop a PDF file onto the Win2PDF Desktop icon, 

3. You can right-click on a document in the Windows Explorer or the
desktop, you can choose Open With –> Win2PDF Desktop
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4. You can choose Win2PDF Desktop from the Windows Start menu

5. You can right click on the file in Windows Explorer and choose "Convert
with Win2PDF".

3.2.1 JPG To PDF

To convert a JPG to PDF using Win2PDF Desktop, open a JPG file using
"File -> Open" or drag-and-dropping a JPG file on the Win2PDF Desktop
icon. The Win2PDF Desktop converter will show a preview of the JPG file. 
To save as a PDF, choose "File -> Export -> PDF". 

Win2PDF Desktop - Export JPG to PDF

Win2PDF will open a "Save File" window that lets you choose the name and
location for the converted PDF file.  
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If you want to convert to PDF in the same folder as the JPG file, you can
also right click on a JPG file in Windows Explorer and choose "Convert
with Win2PDF".

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

You can also convert from JPG to PDF using the batch convert JPG to PDF
feature or the JPG2PDF command line.

3.2.2 PNG to PDF

To convert a PNG to PDF using Win2PDF Desktop, open a PNG file using
"File -> Open" or drag-and-dropping a PNG file on the Win2PDF Desktop
icon. The Win2PDF Desktop converter will show a preview of the PNG file. 
To save as a PDF, choose "File -> Export -> PDF". 

Win2PDF Desktop - Export PNG to PDF

Win2PDF will open a "Save File" window that lets you choose the name and
location for the converted PDF file.  

https://www.win2pdf.com/trial.html
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If you want to convert to PDF in the same folder as the PNG file, you can
also right click on a PNG file in Windows Explorer and choose "Convert
with Win2PDF".

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

You can also convert from PNG to PDF using the batch convert PNG to PDF
feature or the PNG2PDF command line.

3.2.3 TIFF to PDF

To convert a TIFF to PDF using Win2PDF Desktop, open a TIFF file using
"File -> Open" or drag-and-dropping a TIFF file on the Win2PDF Desktop
icon. The Win2PDF Desktop converter will show a preview of the TIFF file. 
To save as a PDF, choose "File -> Export -> PDF". 

Win2PDF Desktop - Export TIFF to PDF

If you want to convert to PDF in the same folder as the TIFF file, you can
also right click on a TIFF file in Windows Explorer and choose "Convert
with Win2PDF". 
  

https://www.win2pdf.com/trial.html
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This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

You can also convert from TIFF to PDF using the batch convert TIFF to PDF
feature or the TIFF2PDF command line.

3.2.4 BMP to PDF

To convert a BMP to PDF using Win2PDF Desktop, open a BMP file using
"File -> Open" or drag-and-dropping a BMP file on the Win2PDF Desktop
icon. The Win2PDF Desktop converter will show a preview of the BMP file. 
To save as a PDF, choose "File -> Export -> PDF". 

Win2PDF Desktop - Export BMP to PDF

If you want to convert to PDF in the same folder as the BMP file, you can
also right click on a BMP file in Windows Explorer and choose "Convert
with Win2PDF".

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

https://www.win2pdf.com/trial.html
https://www.win2pdf.com/trial.html
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You can also convert from BMP to PDF using the batch convert BMP to PDF
feature or the BMP2PDF command line.

3.2.5 GIF to PDF

To convert a GIF to PDF using Win2PDF Desktop, open a GIF file using
"File -> Open" or drag-and-dropping a GIF file on the Win2PDF Desktop
icon. The Win2PDF Desktop converter will show a preview of the GIF file. 
To save as a PDF, choose "File -> Export -> PDF". 

Win2PDF Desktop - Export GIF to PDF

If you want to convert to PDF in the same folder as the GIF file, you can
also right click on a GIF file in Windows Explorer and choose "Convert
with Win2PDF".

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

You can also convert from GIF to PDF using the batch convert GIF to PDF
feature or the GIF2PDF command line.

https://www.win2pdf.com/trial.html
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3.2.6 Web Page to PDF

There are multiple ways of starting the Win2PDF Desktop App to convert an
HTML file to PDF.

1. You can open the Win2PDF Desktop application and choose Web Page
To PDF... from the Windows Start menu.

Win2PDF Desktop - Web Page to PDF
Menu
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Type the web address of the page that you would like converted to PDF.

Win2PDF Desktop - Web Page to PDF

2. You can open the Win2PDF Desktop application and then choose an
HTML file on your computer in the "Open File" window.

3. You can drop an HTML file onto the Win2PDF Desktop icon.

4. You can right click on the file in Windows Explorer and choose "Convert
with Win2PDF".

The Win2PDF Desktop converter will open a "Save File" window that lets
you choose the name and location of the converted PDF file.  The default
PDF file name is the path and name of the HTML file. If the Win2PDF Auto-
name feature is enabled, the converted PDF file will be named based on the
configuration of the Auto-name settings.  

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

You can also convert from HTML to PDF using the HTML2PDF command
line.

3.2.7 XPS to PDF

To convert a XPS to PDF using Win2PDF Desktop, open a XPS file using
"File -> Open" or drag-and-dropping a XPS file on the Win2PDF Desktop
icon. The Win2PDF Desktop converter will show a preview of the XPS file. 
To save as a PDF, choose "File -> Export -> PDF". 

https://www.win2pdf.com/trial.html
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Win2PDF Desktop - Export XPS to PDF

If you want to convert to PDF in the same folder as the XPS file, you can
also right click on a XPS file in Windows Explorer and choose "Convert
with Win2PDF".

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

You can also convert from XPS to PDF using the batch convert XPS to PDF
feature or the XPS2PDF command line.

3.2.8 DOCX to PDF

Win2PDF Desktop Convert DOCX to PDF  

To convert a DOCX to PDF using Win2PDF Desktop, open a DOCX file using
"File -> Open" or drag-and-dropping a XPS file on the Win2PDF Desktop
icon. The Win2PDF Desktop converter will show a preview of the DOCX file.
 To save as a PDF, choose "File -> Export -> PDF". 

https://www.win2pdf.com/trial.html
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Win2PDF Desktop - Export DOCX to PDF

If you want to convert to PDF in the same folder as the XPS file, you can
also right click on a XPS file in Windows Explorer and choose "Convert
with Win2PDF".

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

You can also convert from DOCX to PDF using the batch convert DOCX to
PDF feature or the DOCX2PDF command line.

3.2.9 Any to PDF

The Win2PDF Desktop converter can directly convert image formats in JPG,
PNG, TIFF, BMP, and GIF to PDF, but it can also convert any other
document to PDF using Windows file associations.  As long as you have a
program installed in Windows that can open and print the document,
Win2PDF can convert it by opening the program and using the program to
print to the Win2PDF printer.

There are multiple ways of starting the Win2PDF Desktop App to convert
any document to PDF.

https://www.win2pdf.com/trial.html
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1. You can double-click the Win2PDF Desktop icon from your Windows
desktop, and then choose the document in the "Open File" window.

2. You can drop a document onto the Win2PDF Desktop icon.

3. You can choose Win2PDF Desktop from the Windows Start menu, and
then choose the document the "Open File" window.

If the Win2PDF Auto-name feature is enabled, the converted PDF file will be
named based on the configuration of the Auto-name settings.  Otherwise,
Win2PDF will open a "Save File" window that lets you choose the name and
location of the converted PDF file.  

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

You can also convert to PDF using the CONVERT command line.

https://www.win2pdf.com/trial.html
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4 How To Articles

4.1 How to install Win2PDF

4.1.1 How to Download a PDF converter

You can download the latest versions of the Win2PDF and Win2PDF
Terminal Server Edition PDF converters from our web page here:

https://www.win2pdf.com/download/download.htm

The trial versions of this PDF converter are available for free, and are not
time limited. The trial version will add an extra page to each printed PDF file
until the software is purchased, and then the extra page will be removed
from any new PDF files. To evaluate Win2PDF or Win2PDF Pro without the
trailer page, contact us for a 30 day demo license.

4.1.2 How to Install a PDF writer

First you'll need to download the Win2PDF PDF writer software. You can
download the latest versions of the Win2PDF and Win2PDF Terminal Server
Edition PDF converters from our web page here:

https://www.win2pdf.com/download/download.htm

https://www.win2pdf.com/download/download.htm
https://www.win2pdf.com/trial.html
https://www.win2pdf.com/download/download.htm
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After you have downloaded the setup file for the Win2PDF PDF writer to
your hard disk, double-click on the file to start the installation wizard.

Click on the 'Next >' button and follow the prompts to install the software. After it has
been installed, you will see a printer named 'Win2PDF' in the printers folders.
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To use Win2PDF , just select Print from any application and then choose
the printer named Win2PDF. You will then be able so save the document as
a PDF file.

4.2 How to use Win2PDF

4.2.1 How to View a PDF file after creating it

To view a PDF file after creating it, just select the 'View file' option on the
Win2PDF file save window.
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When you save the PDF file, the file will automatically be opened with your
default PDF viewer application, which is typically the free Adobe Reader
software.

4.2.2 How to Print a PDF file after creating it

To print a copy of the PDF file to a paper printer after creating it, just select
the 'Print file' option on the Win2PDF file save window.
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When you check the "Print file" option, the you will be prompted to select a
paper printer. 

Select the paper printer where you want the hard copy sent.
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When you save the PDF file, the file will automatically be sent to your
selected printer.
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How to print a hard copy to a paper printer when saving a PDF file using the
Win2PDF printer 

4.2.3 How to Email a PDF file after creating it

To email the PDF file after creating it, just select the 'Send file' option on
the Win2PDF file save window.
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When you save the PDF file, the file will automatically be attached as a new
PDF file to your default MAPI e-mail client (e.g. Microsoft Outlook). You can
then address the e-mail and send it as a file attachment.

You can also configure Win2PDF to send a PDF using Microsoft Outlook,
Mozilla Thunderbird, Gmail, Outlook.com, Yahoo! Mail, or custom SMTP
servers.

If the 'Delete after sending' option is checked, the PDF file will be deleted
from your hard disk after the e-mail has been sent.

4.2.4 How to Create a PDF/A file

The Win2PDF setup program creates a printer in the "Devices and Printers"
folder named Win2PDF. 

How to Create a PDF/A file using
Win2PDF

To create a PDF/A document:

· Open a document from a Windows application (Word, Excel, Edge, etc.)
· Print the document and select the Win2PDF printer
· The Win2PDF file save window pops up, allowing you to choose a name

and location for the PDF/A as shown below:
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Win2PDF File Save Window

The default file name is supplied by the printing application. You can choose
the "PDF for Archiving (PDF/A)" format from the "Save as type:"
options. Win2PDF also supports the following formats:
· PDF - Portable Document Format
· XPS - XML Paper Specification
· TIFF (monochrome) - Tagged Image File Format
· SVG - Scalable Vector Graphics
· PDF Image Only - monochrome
· PDF Image Only - color
· Text - Formatted
· Text - Unformatted
· PDF - Searchable (OCR)

You can choose a number of optional actions to take after the document is
created by selecting the check boxes. The options include:



How To Articles 151

© 2023 Dane Prairie Systems, LLC

· View File - Opens the file in the default viewer after the file is created.
· Print File - Prints the file to the selected paper printer after the file is

created to a Windows printer. 
· Send File - Opens a new email message using the default MAPI-

compliant email client and attaches the file to the message. The email
program is specified in the Internet Options icon in the Windows control
panel. Win2PDF can also be configured to send a PDF using Microsoft
Outlook, Mozilla Thunderbird, Gmail, Outlook.com, Yahoo! Mail, or
custom SMTP servers.

· Delete after Sending - Deletes the document after it has been sent
using the "Send File" option.

You can use the file save window to browse to a new location before saving
the document. Win2PDF remembers this location, and will use the same
location the next time you create a document.

If you want to skip the save Window, see the Win2PDF Auto-name feature.

4.2.5 How to Create an XPS file

The Win2PDF setup program creates a printer in the "Devices and Printers"
folder named Win2PDF. 

How to Create a XML Paper
Specification (XPS) file using Win2PDF

To create an XML Paper Specification (XPS) document:

· Open a document from a Windows application (Word, Excel, Edge, etc.)
· Print the document and select the Win2PDF printer
· The Win2PDF file save window pops up, allowing you to choose a name

and location for the XPS as shown below:
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Win2PDF File Save Window

The default file name is supplied by the printing application. You can choose
the "XML Paper Specification (XPS)" format from the "Save as type:"
options. Win2PDF also supports the following formats:
· PDF - Portable Document Format
· PDF/A - Portable Document Format for Archiving (PDF/A-1b, ISO 19005-

1:2005)
· TIFF (monochrome) - Tagged Image File Format
· SVG - Scalable Vector Graphics
· PDF Image Only - monochrome
· PDF Image Only - color
· Text - Formatted
· Text - Unformatted
· PDF - Searchable (OCR)
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You can choose a number of optional actions to take after the document is
created by selecting the check boxes. The options include:

· View File - Opens the file in the default viewer after the file is created.
· Print File - Prints the file to the selected paper printer after the file is

created to a Windows printer. 
· Send File - Opens a new email message using the default MAPI-

compliant email client and attaches the file to the message. The email
program is specified in the Internet Options icon in the Windows control
panel. Win2PDF can also be configured to send an XPS using Microsoft
Outlook, Mozilla Thunderbird, Gmail, Outlook.com, Yahoo! Mail, or
custom SMTP servers.

· Delete after Sending - Deletes the document after it has been sent
using the "Send File" option.

You can use the file save window to browse to a new location before saving
the document. Win2PDF remembers this location, and will use the same
location the next time you create a document.

If you want to skip the save Window, see the Win2PDF Auto-name feature.

4.2.6 How to Create a TIFF file

The Win2PDF setup program creates a printer in the "Devices and Printers"
folder named Win2PDF. 

How to Create a TIFF file using

To create a TIFF document:

· Open a document from a Windows application (Word, Excel, Edge, etc.)
· Print the document and select the Win2PDF printer
· The Win2PDF file save window pops up, allowing you to choose a name

and location for the TIFF as shown below:
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Win2PDF File Save Window

The default file name is supplied by the printing application. You can choose
the "TIFF (monochrome)" format from the "Save as type:" options.
Win2PDF also supports the following formats:
· PDF - Portable Document Format
· PDF/A - Portable Document Format for Archiving (PDF/A-1b, ISO 19005-

1:2005)
· XPS - XML Paper Specification
· SVG - Scalable Vector Graphics
· PDF Image Only - monochrome
· PDF Image Only - color
· Text - Formatted
· Text - Unformatted
· PDF - Searchable (OCR)
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You can choose a number of optional actions to take after the document is
created by selecting the check boxes. The options include:

· View File - Opens the file in the default viewer after the file is created.
· Print File - Prints the file to the selected paper printer after the file is

created to a Windows printer. 
· Send File - Opens a new email message using the default MAPI-

compliant email client and attaches the file to the message. The email
program is specified in the Internet Options icon in the Windows control
panel. Win2PDF can also be configured to send a TIFF using Microsoft
Outlook, Mozilla Thunderbird, Gmail, Outlook.com, Yahoo! Mail, or
custom SMTP servers.

· Delete after Sending - Deletes the document after it has been sent
using the "Send File" option.

You can use the file save window to browse to a new location before saving
the document. Win2PDF remembers this location, and will use the same
location the next time you create a document.

If you want to skip the save Window, see the Win2PDF Auto-name feature.

4.2.7 How to Create an SVG file

The Win2PDF setup program creates a printer in the "Devices and Printers"
folder named Win2PDF. 

How to Create a SVG file using Win2PDF

To create an SVG document:

· Open a document from a Windows application (Word, Excel, Edge, etc.)
· Print the document and select the Win2PDF printer
· The Win2PDF file save window pops up, allowing you to choose a name

and location for the SVG as shown below:
 



Win2PDF156

© 2023 Dane Prairie Systems, LLC

Win2PDF File Save Window

The default file name is supplied by the printing application. You can choose
the "Scalable Vector Graphics (SVG)" format from the "Save as type:"
options. Win2PDF also supports the following formats:
· PDF - Portable Document Format
· PDF/A - Portable Document Format for Archiving (PDF/A-1b, ISO 19005-

1:2005)
· XPS - XML Paper Specification
· TIFF (monochrome) - Tagged Image File Format
· PDF Image Only - monochrome
· PDF Image Only - color
· Text - Formatted
· Text - Unformatted
· PDF - Searchable (OCR)
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You can choose a number of optional actions to take after the document is
created by selecting the check boxes. The options include:

· View File - Opens the file in the default viewer after the file is created.
· Print File - Prints the file to the selected paper printer after the file is

created to a Windows printer. 
· Send File - Opens a new email message using the default MAPI-

compliant email client and attaches the file to the message. The email
program is specified in the Internet Options icon in the Windows control
panel. Win2PDF can also be configured to send an XPS using Microsoft
Outlook, Mozilla Thunderbird, Gmail, Outlook.com, Yahoo! Mail, or
custom SMTP servers.

· Delete after Sending - Deletes the document after it has been sent
using the "Send File" option.

You can use the file save window to browse to a new location before saving
the document. Win2PDF remembers this location, and will use the same
location the next time you create a document.

If you want to skip the save Window, see the Win2PDF Auto-name feature.

4.2.8 How to Create a non-searchable (image only) PDF file?

The Win2PDF setup program creates a printer in the "Devices and Printers"
folder named Win2PDF. 

How to Create a PDF Image Only file
using Win2PDF

To create a PDF Image Only document:

· Open a document from a Windows application (Word, Excel, Edge, etc.)
· Print the document and select the Win2PDF printer
· The Win2PDF file save window pops up, allowing you to choose a name

and location for the PDF as shown below:
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Win2PDF File Save Window

The default file name is supplied by the printing application. You can choose
the "PDF for Image Only - monochrome (PDF)" or "PDF for Image
Only - color (PDF)" format from the "Save as type:" options. Win2PDF
also supports the following formats:
· PDF - Portable Document Format
· PDF/A - Portable Document Format for Archiving (PDF/A-1b, ISO 19005-

1:2005)
· XPS - XML Paper Specification
· TIFF (monochrome) - Tagged Image File Format
· SVG - Scalable Vector Graphics
· PDF Image Only - monochrome
· PDF Image Only - color
· Text - Formatted
· Text - Unformatted
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· PDF - Searchable (OCR)

You can choose a number of optional actions to take after the document is
created by selecting the check boxes. The options include:

· View File - Opens the file in the default viewer after the file is created.
· Print File - Prints the file to the selected paper printer after the file is

created to a Windows printer. 
· Send File - Opens a new email message using the default MAPI-

compliant email client and attaches the file to the message. The email
program is specified in the Internet Options icon in the Windows control
panel. Win2PDF can also be configured to send a PDF using Microsoft
Outlook, Mozilla Thunderbird, Gmail, Outlook.com, Yahoo! Mail, or
custom SMTP servers.

· Delete after Sending - Deletes the document after it has been sent
using the "Send File" option.

You can use the file save window to browse to a new location before saving
the document. Win2PDF remembers this location, and will use the same
location the next time you create a document.

If you want to skip the save Window, see the Win2PDF Auto-name feature.

4.2.9 How to Automatically Name PDF files

Win2PDF and Win2Image can be configured to automatically name files and
skip the file save window. There are 3 ways to configure this:

1. You can run the "Configure Win2PDF Auto-Name" shortcut from the
Windows Start menu at "Start -> Win2PDF -> Configure Win2PDF Auto-
Name".
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Start Menu Configure Win2PDF Auto-Name

2. You can open "Configure Win2PDF Auto-Name" from the "Auto-
Name" menu of the Win2PDF Desktop App.



How To Articles 161

© 2023 Dane Prairie Systems, LLC

Win2PDF Desktop Open Configure Win2PDF Auto-Name

3. You can print to the Win2PDF printer, and open the "Document" tab of
PDF Options when you print to the Win2PDF printer.

Auto-name Files and Configure File Save Naming
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Options 1 and 2 are best if you need to change an existing auto-name
configuration, add a new printer with auto-name enabled, use content
based naming, or configure auto-name for all users.  Option 3 is best if you
need to enable Win2PDF Pro document security or watermark settings as
part of the auto-name settings.

If you previously configured Auto-Name through the "Document" tab of
PDF Options, the settings will be reflected in the Configure Win2PDF Auto-
Name window.

Checking the "Auto-name Files" option enables the auto-name feature for
the printer selected under "Printer Name". To turn off the auto-name
feature and configure Win2PDF to display a file save window, un-check the
"Auto-name Files" option. 

The auto-name configuration is also stopped if you hold down the shift key
while printing to the Win2PDF printer. If you are printing to Win2PDF in the
background while typing in another program, you may accidentally stop the
auto-name if you press the shift key. If you want to prevent this from
happening, you can use the Win2PDF Admin Utility "Troubleshooting"
option to "Disable Auto-Name Shift Key check".

The auto-name settings in this window only apply to the currently logged in
user.  Administrators can enable Auto-Name for all users by right clicking
on the "Configure Auto-Name" shortcut and select "Run As Administrator".  

Configure Win2PDF Auto-name
for all users

The "Configure Win2PDF Auto-Name" window title should display "All
Users":



How To Articles 163

© 2023 Dane Prairie Systems, LLC

The available naming options are:
Auto-name: Printer Name
Auto-name: Folder Name
Auto-name: File Type
Auto-name: File Name Start
Auto-name: Include Document Title
Auto-name: Include Content Field
Auto-name: Include Search Field
Auto-name: Include Date
Auto-name: Include Time
Auto-name: User Defined
Auto-name: Always Append
Auto-name Actions: Send File
Auto-name Actions: Print File

4.2.10 How to Email a PDF to Kindle

The Amazon Kindle ebook reader supports PDF files through Amazon's
Kindle Personal Documents Service. Win2PDF offers a convenient way to
add documents to your Kindle by emailing PDF files directly to your Kindle.

In order to use this service, you must first tell Amazon to accept email from
your email address. Use the following steps to enable email to your Kindle:

1. Log in to amazon.com and go to Manage Your Content and Devices
and click on the Preferences tab.

2. Scroll down and click on Personal Document Settings.

https://www.amazon.com/hz/mycd/myx#/home/settings/payment
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3. Under Approved Personal Document E-mail List, click on Add a
new approved e-mail address and add your email address.

4. Under Send-to-Kindle E-Mail Settings, find and record your Kindle's
email address. This address should end in "@kindle.com". This is the
address that you will use to email PDF files to your kindle.

Once the Amazon Personal Document Settings have been configured, you
can send PDF files directly to your Kindle by following the instructions under
"How to email a PDF file after creating it?" and specifying the Kindle address
recorded in step 4 as the email recipient.

Amazon charges fees for sending files to your Kindle for some devices. 
· For Kindle devices with WiFi only (no 3G), there is no charge to receive

PDF files. The Kindle must be connected to a WiFi network to receive PDF
files.

· For Kindle devices with 3G, Amazon charges a small fee to deliver the PDF
files over 3G if the Kindle is not currently connected to a WiFi network. To
avoid fees on 3G Kindles, you can use "@free.kindle.com" as the email
address to prevent PDF files from being delivered over 3G.

4.2.11 How to Transfer a PDF to an Apple iPhone

The Apple iOS devices (iPhone and iPad) support viewing PDF files through
their iBooks application, and through a variety of other 3rd party apps
(such as the Adobe Reader for iOS app). Win2PDF offers a convenient way
to add documents to your iPhone by emailing PDF files directly to yourself.
If you follow these steps, you will be able to create and transfer PDF files to
your iPhone.

1. Create a PDF file using Win2PDF, and check the Send file option to send
an email to yourself (using any email account you can access through the
native iPhone Mail app).

mailto:@free.kindle.com
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2. After you have sent the email with the PDF file to yourself, then open the
Mail app on the iPhone. Touch the PDF file attachment to open the PDF file.
It will look something like this:
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3. The PDF file can be opened and viewed with the iBooks app, or you can
use any number of other PDF capable viewers (provided you have
previously downloaded these apps to your device through the iTunes app
store).
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4. If you want to use Adobe Reader, for example, just click on the "Open
In..." button and then you will be able to select Adobe Reader from the list
of available apps. 
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4.2.12 How to Transfer a PDF to an Apple iPad

The Apple iOS devices (iPhone and iPad) support viewing PDF files through
their iBooks application, and through a variety of other 3rd party apps
(such as the Adobe Reader for iOS app). Win2PDF offers a convenient way
to add documents to your iPad by emailing PDF files directly to yourself. If
you follow these steps, you will be able to create and transfer PDF files to
your iPad.

1. Create a PDF file using Win2PDF, and check the Send file option to send
an email to yourself (using any email account you can access through the
native iPad Mail app).
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2. After you have sent the email with the PDF file to yourself, then open the
Mail app on the iPad. Touch the PDF file attachment to open the PDF file. It
will look something like this:

3. The PDF file can be opened and viewed with the iBooks app, or you can
use any number of other PDF capable viewers (provided you have
previously downloaded these apps to your device through the iTunes app
store).
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4. If you want to use Adobe Reader, for example, just click on the "Open
In..." button and then you will be able to select Adobe Reader from the list
of available apps. 
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4.2.13 How to Email using web-based email

Win2PDF has a feature to "Send file" that can be enabled on the file save
window (see below).
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When this option is checked, Win2PDF will create the PDF file and
automatically attach it to a new email message using the computer's default
MAPI email client (which is typically Microsoft Outlook or Windows Live
Mail).

If you do not use a full MAPI email client like Outlook and rely on web-
based email, Win2PDF can also be configured to send a PDF using Microsoft
Outlook, Mozilla Thunderbird, Gmail, Outlook.com, Yahoo! Mail, or custom
SMTP servers.

You can also use a third party program called Affixa for users that want to
use the "Send file" feature with a web-based email program. Affixa resides
in the background and acts as a connector to these web-based email
services. When you use the "Send file" feature in Win2PDF it automatically
creates a web email message with the PDF attached.

More information on Affixa and its products can be found at
www.affixa.com

4.2.14 How to Extract pages from a PDF file

See also: How to extract pages from an existing PDF using the Win2PDF
Desktop app.

http://www.affixa.com/
http://www.affixa.com/
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Because Win2PDF installs as printer, it does not have a native editing
program. However, you can use the printing capability with a PDF Reader
application to extract a page or series of pages in a PDF file. Here is the
general procedure to use:

1). Open the original PDF file in Adobe Reader, or in another PDF Reader
application

2). Select 'Print' and choose a range of pages and Win2PDF as the printer

3). Save the results of this subset of pages as a new PDF file (e.g.,
"newfile.pdf")

Using this technique, you can effectively extract the pages of an existing
PDF file and save the results to a new PDF file. The following video shows
how this is done.
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4.2.15 How to Delete pages from a PDF file

See also: How to delete pages from an existing PDF using the Win2PDF
Desktop app.

You can use the printing capability with a PDF Reader application to delete a
page or series of pages in a PDF file. Here is the general procedure to use:

1). Open the original PDF file in Adobe Reader, or in another PDF Reader
application

2). Select 'Print' and choose a range of pages EXCLUDING the pages you
want to delete, and select Win2PDF as the printer.
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In this screen shot example, the application will print pages 1 through 19,
and then pages 21 through 115 -- effectively "deleting" page 20 from the
new PDF document.

3). Save the results of this subset of pages as a new PDF file (e.g.,
"newfile.pdf")

Using this technique, you can effectively delete pages of an existing PDF file
and save the results to a new PDF file. The following video shows how this
is done.
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4.2.16 How to Reorder or Rearrange pages in a PDF file

Because Win2PDF installs as printer, it does not have a native editing
program. However, you can use the printing capability with a PDF Reader
application to reorder or rearrange pages in a PDF file. Here is the general
procedure to use:

1). Open the original PDF file in Adobe Reader, or in another PDF Reader
application

2). Select 'Print' and choose a range of pages and Win2PDF as the
printer. 



How To Articles 177

© 2023 Dane Prairie Systems, LLC

In the above screen shot, pages 2 through 4 of the original document will
be saved as a new PDF file. This is effectively "extracting" these pages and
saving them to a new PDF file.

A more complicated operation might include rearranging the pages as well.
For instance, consider the following screen shot:
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In this example, the new PDF file will have the pages rearranged so that
page 1 will appear first, followed by pages 10 through 115, and then pages
2 through 9 will be added to the end.

3). Save the results of this subset of pages as a new PDF file (e.g.,
"newfile.pdf")

4). (Optional) If you want to rearrange pages from multiple documents,
repeat step 2) using the 2nd PDF document

5). Save the results of the new subset of page(s) and select the same file
name (e.g., "newfile.pdf")

6). When prompted, you can either append (add to the end) or prepend
(add to the beginning) to merge your new pages with the first set of pages
you printed.
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Using this technique, you can effectively reorder or rearrange the pages of
an existing PDF file (or multiple files) and save the results to a new PDF file.
The following video shows how this is done.

4.2.17 How to Combine existing PDF files using Adobe Reader

See also: How to append to an existing PDF and How to prepend to an
existing PDF
 using the Win2PDF Desktop App.

You can use the printing capability with a PDF Reader application to merge
or combine two or more PDF files. Here is the general procedure to use if
you wanted to combine "sample1.pdf" and "sample2.pdf" into a new
document called "newsample.pdf":

1). Open the "sample2.pdf" file in Adobe Reader

2). Select 'Print' and choose a range of pages (if desired) and Win2PDF as
the printer
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3). Save the results of this print and select the first file name --
"sample1.pdf"

4). When prompted, you can either append (add to the end) or prepend
(add to the beginning) to merge your new pages with the first set of pages
you printed. Select Append and choose the file name "newsample.pdf"

Using this technique, you can effectively combine both files --
"sample1.pdf" and "sample2.pdf" -- into a new PDF file called
"newsample.pdf". The following video shows how this is done.
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4.2.18 How To Flatten a PDF

It is sometimes desirable to flatten PDF form fields and combine the form
field layers into a single layer. This prevents active form fields from being
modified, and can fix display problems when viewing filled forms on some
PDF viewers. 

The easiest way to flatten a PDF using Win2PDF is to open the PDF in a PDF
viewer such as "Adobe Acrobat Reader DC" and print the PDF to the
Win2PDF printer. You can choose either standard PDF, or PDF Image Only
as the "Save As Type". The resulting PDF will be a flattened PDF that can be
viewed in any PDF viewer.

After you print from a PDF viewer to Win2PDF, the resulting flattened PDF
will no longer be searchable. If you want the flattened PDF to be
searchable, you can download and install the “Win2PDF OCR Add-on” add-
on and select “Portable Document Format - Searchable” as the Win2PDF
“Save As Type”. 

You can also open the PDF file in the Win2PDF Desktop app, and choose
"Export -> PDF Image Only -> Monochrome", "Export -> PDF Image Only -
> Grayscale", or "Export -> PDF Image Only -> Color" you will be
prompted to save as a flattened Image Only PDF file.

https://helpdesk.win2pdf.com/index.php?/Knowledgebase/Article/View/197/15/win2pdf-desktop-with-ocr-download
https://www.win2pdf.com/doc/print-to-searchable-pdf.html
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Win2PDF Desktop - Export PDF Image Only Menu

If you want to apply other PDF operations to the PDF such as appending an
existing PDF or applying a watermark, you can use the “Flatten PDF Layers
and Save as Image Only PDF” plug-in to flatten the PDF as the last step in
the process.

4.3 How to use the Win2PDF Desktop App

4.3.1 How to install the Win2PDF Desktop App on Windows XP, Vista, & Windows
7

The Win2PDF Desktop is installed with the Win2PDF setup program on
Windows 10 and Windows 11. To install the Win2PDF Desktop App on
Windows 7, you can download the setup file here:

https://helpdesk.win2pdf.com/index.php?/default_import/Knowledgebase/
Article/View/197/0/win2pdf-desktop-download

Double-click on the win2pdf-desktop-setup.exe file to install. If you do
not have Win2PDF installed, it will automatically be downloaded with this
setup. Win2PDF is required for this Desktop App add-on.

https://github.com/win2pdf/Win2PDF.Samples/tree/master/plug-in/PDFImageOnlyFlatten
https://github.com/win2pdf/Win2PDF.Samples/tree/master/plug-in/PDFImageOnlyFlatten
https://helpdesk.win2pdf.com/index.php?/default_import/Knowledgebase/Article/View/197/0/win2pdf-desktop-download
https://helpdesk.win2pdf.com/index.php?/default_import/Knowledgebase/Article/View/197/0/win2pdf-desktop-download
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The Win2PDF Desktop app and features are not supported on Windows XP
and Windows Vista.

4.3.2 How to use the Win2PDF Desktop App

The Win2PDF Desktop App is one of three main components installed with
Win2PDF.  It allows you to 

· View a PDF or View an XPS,

· Edit PDFs at the page level (extract pages, delete pages, split pages,
rotate pages, etc.),

· Configure Auto-name settings for Win2PDF,

· Rename PDF files

· Configure Mail settings for Win2PDF, and

· Convert/export PDF Files to other formats.

· Convert from common formats to PDF

· Batch Convert  

· Watch Convert 

There are multiple ways of starting the Win2PDF Desktop App.

1. You can double-click the Win2PDF Desktop icon from your Windows
desktop,

2. You can drop a PDF file onto the Win2PDF Desktop icon, 

3. You can right-click on a PDF or XPS document in Windows Explorer or
the desktop and can choose Open With –> Win2PDF Desktop

4. You can right-click on a PDF or XPS documetn in Windows Explorer or
the desktop and choose "View with Win2PDF".
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5. You can choose Win2PDF Desktop from the Windows Start menu

4.3.3 How to append to an existing PDF

Win2PDF Desktop Append to PDF

If you drag a PDF to the Win2PDF Desktop icon, or select a PDF from the
open window when launching the Win2PDF Desktop application, the
following options will be displayed under the "Pages" menu:

Win2PDF Desktop - Append to an Existing PDF

To append (add to the end of the existing PDF), choose "Append to Existing
PDF" and click "Continue". A file open Window will be displayed allowing
you to select the existing PDF to append to.

This is also available using the APPEND command line.
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This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

4.3.4 How to prepend to an existing PDF

Win2PDF Desktop Prepend to PDF

If you drag a PDF to the Win2PDF Desktop icon, or select a PDF from the
open window when launching the Win2PDF Desktop application, the
following options will be displayed under the "Pages" menu:

Win2PDF Desktop - Prepend to an Existing PDF

To prepend (add to the beginning of the existing PDF), choose "Prepend to
Existing PDF" and click "Continue". A file open Window will be displayed
allowing you to select the existing PDF to prepend to.

This is also available using the APPEND command line.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

4.3.5 How to extract pages from an existing PDF

Win2PDF Desktop Extract Pages

https://www.win2pdf.com/trial.html
https://www.win2pdf.com/trial.html
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If you drag a PDF to the Win2PDF Desktop icon, or select a PDF from the
open window when launching the Win2PDF Desktop application, the
following options will be displayed under the "Pages" menu:

Win2PDF Desktop - Extract Pages Menu

Selecting "Extract Pages..." will open the following window:

Win2PDF Desktop - Extract Pages from an
Existing PDF

Enter a page range to extract pages from the document. The total number
of pages in the document are listed. To extract a single page, enter the
same page number in both boxes. If the document only contains one page,
the extract pages item is not available.

This is also available using the EXTRACTPAGES command line.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

https://www.win2pdf.com/trial.html
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4.3.6 How to delete pages from an existing PDF

Win2PDF Desktop Delete Pages

If you drag a PDF to the Win2PDF Desktop icon, or select a PDF from the
open window when launching the Win2PDF Desktop application, the
following options will be displayed under the "Pages" menu:

Win2PDF Desktop - Delete Pages Menu

Selecting "Extract Pages..." will open the following window:

Win2PDF Desktop - Delete Pages

Enter a page range to delete pages from the document. The total number of
pages in the document are listed. To delete a single page, enter the same
page number in both boxes. If the document only contains one page, the
delete pages item is not available. 

This is also available using the DELETEPAGES command line.
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This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

4.3.7 How to split pages from an existing PDF

Win2PDF Desktop Split Pages

If you drag a PDF to the Win2PDF Desktop icon, or select a PDF from the
open window when launching the Win2PDF Desktop application, the
following options will be displayed under the "Pages" menu:

Win2PDF Desktop - Split Pages Menu

Selecting "Split Pages..." will open the following window:

https://www.win2pdf.com/trial.html
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Win2PDF Desktop - Split Pages

The split files are placed in the folder specified by the "Output Folder".

The "Split At" options are:

· Every Page - each page is saved to a separate file with the format
filename.1.pdf, filename.2.pdf, filename.3.pdf, etc.

· Every Even Pages - each 2 pages is saved to a separate file with the
format  filename.1.pdf, filename.3.pdf, filename.5.pdf, etc.

· Every Odd Pages - each 2 pages is saved to a separate file with the
format filename.1.pdf, filename.2.pdf, filename.4.pdf, etc. Useful for
documents with a separate cover page.

· Every N Pages - each N pages is saved to a separate file with the format
filename.1.pdf, filename.N+1.pdf, etc.

· Before Search - split pages before the text specified in the search box is
encountered. 

· After Search - split pages after the text specified in the search box is
encountered. 

The "Before Search" and "After Search" options are useful if you want to
split a PDF into variable length PDFs based on the content of the PDF.
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This is also available using the SPLITPAGES command line,
SPLITPAGESBEFORESEARCH command line, and
SPLITPAGESAFTERSEARCH command line.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

4.3.8 How to rotate pages from an existing PDF

Win2PDF Desktop Rotate Pages

If you drag a PDF to the Win2PDF Desktop icon, or select a PDF from the
open window when launching the Win2PDF Desktop application, the
following options will be displayed under the "Pages" menu:

Win2PDF Desktop - Rotate Pages Menu

Selecting "Rotate Pages..." will open the following window:

https://www.win2pdf.com/trial.html
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Win2PDF Desktop - Rotate Pages

Select the desired rotation amount and page range, and click OK. You will
be prompted to save a new PDF with the rotation applied.

The rotation is absolute, not relative. If a page is already rotated by 90
degrees, rotating the page again by 90 degrees will have no affect.

This is also available using the ROTATEPAGES command line.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

4.3.9 How to create a PDF from the clipboard

Win2PDF Desktop Create PDF from Clipboard

If the Windows clipboard contains an image when the Win2PDF Desktop
app is launched, the following screen will be displayed:

Win2PDF Desktop - Create PDF
from clipboard

https://www.win2pdf.com/trial.html
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If you choose "Yes", the Window PDF file save window will open and allow
you to choose a name of the converted PDF.

4.3.10 How to Extract Text from an existing PDF

Win2PDF Desktop Extract Text

If you drag a PDF to the Win2PDF Desktop icon, or select a PDF from the
open window when launching the Win2PDF Desktop application, the
following options will be displayed under the "File" menu:

Extract Text

After selecting "Export -> Text -> Unformatted" or "Export -> Text ->
Formatted", you will be prompted to save the extracted text to a file.

This is also available using the EXTRACTTEXT command line.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

https://www.win2pdf.com/trial.html
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4.3.11 How To Compress an existing PDF

Win2PDF Desktop Compress PDF

If you drag a PDF to the Win2PDF Desktop icon, or select a PDF from the
open window when launching the Win2PDF Desktop application, the
following options will be displayed under the "File" menu:

Win2PDF Desktop - Compress PDF Menu

After selecting "Export -> PDF - Compressed", you will be prompted to
save compressed PDF file. After saving the file, you will be given a
summary of the compression results:

Win2PDF Desktop - Compress PDF Results
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The compression savings will vary depending on the document, but files
with color images will benefit the most from compression.

This is also available using the COMPRESS command line.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

4.3.12 How To Export as PDF Image Only

Win2PDF Desktop Export PDF Image Only

If you drag a PDF to the Win2PDF Desktop icon, or select a PDF from the
open window when launching the Win2PDF Desktop application, the
following options will be displayed under the "File" menu:

Win2PDF Desktop - Export PDF Image Only Menu

After selecting "Export -> PDF Image Only -> Monochrome", "Export ->
PDF Image Only -> Grayscale", or "Export -> PDF Image Only -> Color"
you will be prompted to save as an Image Only PDF file.

This is also available using the IMAGEPDF command line.

https://www.win2pdf.com/trial.html
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This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

4.3.13 How To Export a PDF to JPEG

Win2PDF Desktop Export PDF to JPEG

If you drag a PDF to the Win2PDF Desktop icon, or select a PDF from the
open window when launching the Win2PDF Desktop application, the
following options will be displayed under the "File" menu:

Win2PDF Desktop - Export PDF to JPEG

After selecting "Export -> JPEG -> Color" or "Export -> JPEG ->
Grayscale", you will be prompted to save the JPEG file.

If the source document is more than one page, only the first page is saved
as a JPEG.

This is also available using the PDF2JPG command line.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

https://www.win2pdf.com/trial.html
https://www.win2pdf.com/trial.html
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4.3.14 How To Export a PDF to TIFF

Win2PDF Desktop Export PDF to TIFF

If you drag a PDF to the Win2PDF Desktop icon, or select a PDF from the
open window when launching the Win2PDF Desktop application, the
following options will be displayed under the "File" menu:

Win2PDF Desktop - Export PDF to TIFF menu

After selecting "Export -> TIFF -> Monochrome", "Export -> TIFF ->
Grayscale", "Export -> TIFF -> Color", or "Export -> TIFF -> Color with
Transparent Background", you will be prompted to save the multi-page
TIFF file.

This is also available using the PDF2TIFF command line.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

4.3.15 How To Export a PDF to PNG

Win2PDF Desktop Export PDF to PNG

https://www.win2pdf.com/trial.html
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If you drag a PDF to the Win2PDF Desktop icon, or select a PDF from the
open window when launching the Win2PDF Desktop application, the
following options will be displayed under the "File" menu:

Win2PDF Desktop - Export PDF to PNG

After selecting "Export -> PNG - Color" or "Export -> PNG - Grayscale",
"Export -> PNG - Color with Transparent Background" or "Export -> PNG -
Grayscale with Transparent Background", you will be prompted to save the
PNG file.

This is also available using the PDF2PNG command line.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

4.3.16 How to make a PDF Searchable (OCR)

Win2PDF Desktop Export PDF to Searchable PDF

If you drag a PDF to the Win2PDF Desktop icon, or select a PDF from the
open window when launching the Win2PDF Desktop application, the
following options will be displayed under the "File" menu:

https://www.win2pdf.com/trial.html
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Win2PDF Desktop - Make PDF Searchable

After selecting "Export -> PDF - Searchable (OCR)", you will be prompted
to save the searchable PDF file. If the option is grayed out, you need to
download and install the "Win2PDF OCR Add-on" from:
https://www.win2pdf.com/download/download-win2pdf-ocr.html

Win2PDF will recognize text from images and graphics using Optical
Character Recognition (OCR), and will save the text information in an
invisible text layer to make the PDF searchable.

This is also available using the MAKESEARCHABLE command line.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.
 

4.3.17 How To Export a PDF to DOCX

Win2PDF Desktop Export PDF to DOCX  

https://www.win2pdf.com/download/download-win2pdf-ocr.html
https://www.win2pdf.com/trial.html
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If you drag a PDF to the Win2PDF Desktop icon, or select a PDF from the
open window when launching the Win2PDF Desktop application, the
following options will be displayed under the "File" menu:

Win2PDF Desktop - Export PDF to DOCX

After selecting "Export -> DOCX", you will be prompted to save the DOCX
file.

This is also available using the PDF2DOCX command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.18 How To Export a PDF to RTF

Win2PDF Desktop Export PDF to RTF  

https://www.win2pdf.com/trial.html
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If you drag a PDF to the Win2PDF Desktop icon, or select a PDF from the
open window when launching the Win2PDF Desktop application, the
following options will be displayed under the "File" menu:

Win2PDF Desktop - Export PDF to RTF

After selecting "Export -> RTF", you will be prompted to save the RTF file.

This is also available using the PDF2RTF command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.19 How To Export a PDF to ODT

Win2PDF Desktop Export PDF to ODT  

https://www.win2pdf.com/trial.html
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If you drag a PDF to the Win2PDF Desktop icon, or select a PDF from the
open window when launching the Win2PDF Desktop application, the
following options will be displayed under the "File" menu:

Win2PDF Desktop - Export PDF to ODT

After selecting "Export -> ODT", you will be prompted to save the ODT file.

This is also available using the PDF2ODT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.20 How To Export an XPS to PDF

Win2PDF Desktop Export XPS to PDF

https://www.win2pdf.com/trial.html
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If you drag a XPS to the Win2PDF Desktop icon, or select an XPS from the
open window when launching the Win2PDF Desktop application, the
following options will be displayed under the "File" menu:

Win2PDF Desktop - Export XPS to PDF

After selecting "Export -> PDF" you will be prompted to save as an Image
Only PDF file.

This is also available using the XPS2PDF command line.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

4.3.21 How To Export an XPS to PDF Image Only

Win2PDF Desktop Export XPS to PDF Image Only

If you drag an XPS to the Win2PDF Desktop icon, or select an XPS from the
open window when launching the Win2PDF Desktop application, the
following options will be displayed under the "File" menu:

https://www.win2pdf.com/trial.html
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Win2PDF Desktop - Export XPS to PDF Image Only Menu

After selecting "Export -> PDF Image Only -> Monochrome", "Export ->
PDF Image Only -> Grayscale", or "Export -> PDF Image Only -> Color"
you will be prompted to save as an Image Only PDF file.

This is also available using the CONVERTTO command line.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

4.3.22 How To Export an XPS to JPEG

Win2PDF Desktop Export XPS to JPEG

If you drag a XPS to the Win2PDF Desktop icon, or select an XPS from the
open window when launching the Win2PDF Desktop application, the
following options will be displayed under the "File" menu:

https://www.win2pdf.com/trial.html
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Win2PDF Desktop - Export XPS to JPEG

After selecting "Export -> JPEG -> Color" or "Export -> JPEG ->
Grayscale", you will be prompted to save the JPEG file.

This is also available using the CONVERTTO command line.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

4.3.23 How To Export an XPS to TIFF

Win2PDF Desktop Export XPS to TIFF

If you drag an XPS to the Win2PDF Desktop icon, or select an XPS from the
open window when launching the Win2PDF Desktop application, the
following options will be displayed under the "File" menu:

https://www.win2pdf.com/trial.html
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Win2PDF Desktop - Export XPS to TIFF menu

After selecting "Export -> TIFF -> Monochrome", "Export -> TIFF ->
Grayscale" or "Export -> TIFF -> Color", you will be prompted to save the
multi-page TIFF file.

This is also available using the CONVERTTO command line.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

4.3.24 How To Export an XPS to PNG

Win2PDF Desktop Export XPS to PNG

If you drag an XPS to the Win2PDF Desktop icon, or select an XPS from the
open window when launching the Win2PDF Desktop application, the
following options will be displayed under the "File" menu:

https://www.win2pdf.com/trial.html
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Win2PDF Desktop - Export PDF to PNG

After selecting "Export -> PNG - Color" or "Export -> PNG - Grayscale",
you will be prompted to save the PNG file.

This is also available using the CONVERTTO command line.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

4.3.25 How to Export an XPS to Searchable PDF (OCR)

Win2PDF Desktop Export XPS to Searchable PDF

If you drag an XPS to the Win2PDF Desktop icon, or select an XPS from the
open window when launching the Win2PDF Desktop application, the
following options will be displayed under the "File" menu:

https://www.win2pdf.com/trial.html
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Win2PDF Desktop - Make PDF Searchable

After selecting "Export -> PDF - Searchable (OCR)", you will be prompted
to save the searchable PDF file. If the option is grayed out, you need to
download the "Win2PDF OCR Add-on" setup program from:
https://www.win2pdf.com/download/download-win2pdf-ocr.html

Win2PDF will recognize text from images and graphics using Optical
Character Recognition (OCR), and will save the text information in an
invisible text layer to make the PDF searchable.

This is also available using the CONVERTTO command line.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.
 

4.3.26 How To Export a XPS to DOCX

Win2PDF Desktop Export XPS to DOCX  

https://www.win2pdf.com/download/download-win2pdf-ocr.html
https://www.win2pdf.com/trial.html
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If you drag a XPS to the Win2PDF Desktop icon, or select a PDF from the
open window when launching the Win2PDF Desktop application, the
following options will be displayed under the "File" menu:

Win2PDF Desktop - Export XPS to DOCX

After selecting "Export -> DOCX", you will be prompted to save the DOCX
file.

This is also available using the XPS2DOCX command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.27 How To Export a XPS to RTF

Win2PDF Desktop Export XPS to RTF  

https://www.win2pdf.com/trial.html
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If you drag an XPS to the Win2PDF Desktop icon, or select a PDF from the
open window when launching the Win2PDF Desktop application, the
following options will be displayed under the "File" menu:

Win2PDF Desktop - Export XPS to RTF

After selecting "Export -> RTF", you will be prompted to save the RTF file.

This is also available using the XPS2RTF command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.28 How To Export a XPS to ODT

Win2PDF Desktop Export XPS to ODT  

https://www.win2pdf.com/trial.html
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If you drag an XPS to the Win2PDF Desktop icon, or select a PDF from the
open window when launching the Win2PDF Desktop application, the
following options will be displayed under the "File" menu:

Win2PDF Desktop - Export XPS to ODT

After selecting "Export -> ODT", you will be prompted to save the ODT file.

This is also available using the XPS2ODT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.29 How to Extract Text from an existing XPS

Win2PDF Desktop Extract Text from XPS

https://www.win2pdf.com/trial.html
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If you drag a XPS to the Win2PDF Desktop icon, or select a XPS from the
open window when launching the Win2PDF Desktop application, the
following options will be displayed under the "File" menu:

Extract Text

After selecting "Export -> Text -> Unformatted" or "Export -> Text ->
Formatted", you will be prompted to save the extracted text to a file.

This is also available using the EXTRACTTEXT command line.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

4.3.30 How to Change PDF Security

Win2PDF Desktop Modify PDF Security  

If you drag a PDF to the Win2PDF Desktop icon, or select a PDF from the
open window when launching the Win2PDF Desktop application, the
following options will be displayed under the "File" menu:

https://www.win2pdf.com/trial.html
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Win2PDF Desktop PDF Security

Select "PDF Security..." to change the PDF security. If the PDF is already
encrypted, you will be prompted to enter the master password. 
 

Win2PDF Desktop Enter Master Password
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The Security window reflects the current security settings for the PDF.  For
an unencrypted PDF, the following window is displayed.

Win2PDF Desktop PDF Security

To set permissions or a user password on an unencrypted PDF, first change
the "Encryption Level" to either "128 bit encryption" or "256 bit
encryption".
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Win2PDF Desktop PDF Security Settings

The "Encryption Level" setting controls the type of encryption used in the
PDF file. The 128 bit AES encryption is compatible with Acrobat Reader 5.0
and above and the 256 bit AES encryption is compatible with Adobe Reader
9.0 and above. For best security, the 256 bit encryption option is
recommended.

The "Permissions" setting controls restrictions that can be placed on the
PDF file. To prevent printing of a PDF file, uncheck the "Allow the
document to be printed" option. To prevent the text and graphics from
being copied from the PDF file, uncheck the "Allow text and graphics to
be copied" option. To prevent the document from being modified in a PDF
editor, uncheck the "Allow the document to be modified" option. 

A "user" password is optional, and if set will require a password to open or
view the PDF.  

You must always enter a master password when security options
are enabled or if a user password is specified. It is recommended that
passwords be at least 8 characters long and contain at least 1 number.

To remove security from an encrypted PDF, set the "Encryption Level" to
"No Encryption".  
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Clicking "OK" will apply the current security settings.

You can also change security of an existing PDF using the Command Line
Encrypt PDF.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.31 How to Add a PDF Watermark

Win2PDF Desktop Add a PDF Watermark  

If you drag a PDF to the Win2PDF Desktop icon, or select a PDF from the
open window when launching the Win2PDF Desktop application, the
following options will be displayed under the "File" menu:

Win2PDF Desktop Watermark Menu

Select "PDF Watermark..." to open the watermark settings page.

https://www.win2pdf.com/trial.html


Win2PDF216

© 2023 Dane Prairie Systems, LLC

Win2PDF Desktop Watermark Settings

Win2PDF Desktop can overlay a PDF file on top of an existing PDF (Add a
Watermark) or place a PDF file behind text and graphics on an existing PDF
(Add a Background). The existing watermark or background PDF file can
contain any text or graphics, but it most often used to apply a "confidential"
or "draft" stamp on each page of a document.

When the watermark or background options are enabled, a text box
containing the name of the current watermark or background PDF file is
shown below the options. If you would like to change the file, click the
"Change..." button and select a new watermark or background PDF file.
Win2PDF will always display the last used watermark or background PDF
file.

If the watermark or background PDF file contains more than one page, only
the first page will be applied to each page of the new document. It's best to
use a watermark or background PDF file that has the same page size as the
newly created PDF file. If the watermark or background file has a different
page size, it will be scaled and centered on the page of the newly created
PDF file.

You can create the watermark or background PDF file using Win2PDF and
any Windows application such as Microsoft Word. If you are using Win2PDF



How To Articles 217

© 2023 Dane Prairie Systems, LLC

Pro, the watermark or background PDF file must not be encrypted. Some
sample watermark and background PDF files and the corresponding Word
documents are available on the download section of the support web site
at:
https://helpdesk.win2pdf.com/index.php?/Knowledgebase/Article/View/18
6/17/watermark-samples

If the watermark file has click-able links, you can check the "Allow Links in
Watermark" option to keep these links active in the final watermarked PDF
file.

Win2PDF Desktop Allow Links

If you only want to apply the watermark or background to the first or last
page, you can select the "First Page Only" or "Last Page Only" options in
the "Apply To:" setting.

https://helpdesk.win2pdf.com/index.php?/Knowledgebase/Article/View/186/17/watermark-samples
https://helpdesk.win2pdf.com/index.php?/Knowledgebase/Article/View/186/17/watermark-samples


Win2PDF218

© 2023 Dane Prairie Systems, LLC

Win2PDF Desktop Apply To

Clicking "OK" will add the watermark to the existing PDF.

You can also add a watermark to an existing PDF using the Command Line
PDF Watermark/Background.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.32 How to Export/Import Win2PDF Settings

Win2PDF Desktop Export Settings

All Win2PDF Settings can be backed up and restored using the Settings 
Export.. and  command

https://www.win2pdf.com/trial.html
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Win2PDF Desktop - Export/Import Settings

The "Export..." command exports all Win2PDF settings including auto-
name configurations for all printers.  The "Import..." command restores
all setting for all printers, but will not recreate missing printer instances. 
Printer instances need to be recreated manually using the Add Win2PDF
Printer menu item.

The Win2PDF Settings Export and Import commands can be used to
deploy complex settings to other computers.

You can also change export or import Win2PDF settings using the
Command Line Export Win2PDF Settings and Command Line Import
Win2PDF Settings commands.
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4.3.33 How to Mail a PDF

If you drag a PDF to the Win2PDF Desktop icon, or select a PDF from the
open window when launching the Win2PDF Desktop application, the
following options will be displayed under the "File" menu:

Win2PDF Desktop Send Mail

After selecting "Send Mail", the currently opened PDF will be attached to an
email message. The "Send Mail" option can send using Microsoft Outlook,
Mozilla Thunderbird, Gmail, Outlook.com, Yahoo! Mail, or custom SMTP
servers. The Mail Provider can be configured by selecting "Configure Mail".

Win2PDF Desktop Configure Mail



How To Articles 221

© 2023 Dane Prairie Systems, LLC

Configure Win2PDF Mail for Microsoft Outlook
Configure Win2PDF Mail for Mozilla Thunderbird
Configure Win2PDF Mail for Gmail
Configure Win2PDF Mail for Outlook.com
Configure Win2PDF Mail for Yahoo! Mail
Configure Win2PDF Mail for a Custom SMTP Server

4.3.33.1 Configure Win2PDF Mail for Microsoft Outlook

To configure Win2PDF to send using Outlook, first open the "Configure
Mail" from the Win2PDF Desktop file menu.

Win2PDF Configure Mail

You can also open "Configure Win2PDF Mail" from the Windows start
menu under the "Win2PDF" program group. The following Window is
displayed:
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Win2PDF Mail Configure Outlook

Select "Use Microsoft Outlook" and click OK. The Win2PDF Desktop "Send
Mail" and the Win2PDF "Send File" features will now use Microsoft Outlook
to attach a PDF to a new email message.

4.3.33.2 Configure Win2PDF Mail for Mozilla Thunderbird

Mozilla Thunderbird is a free and open source email client developed by the
Mozilla Foundation that can be downloaded at:
https://www.thunderbird.net/

To configure Win2PDF to send using Mozilla Thunderbird, first open the
"Configure Mail" from the Win2PDF Desktop file menu.

https://www.thunderbird.net/
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Win2PDF Configure Mail

You can also open "Configure Win2PDF Mail" from the Windows start
menu under the "Win2PDF" program group. The following Window is
displayed:
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Win2PDF Mail Configure Thunderbird

Select "Use Thunderbird" and click OK. The Win2PDF Desktop "Send Mail"
and the Win2PDF "Send File" features will now use Mozilla Thunderbird to
attach a PDF to a new email message.

4.3.33.3 Configure Win2PDF Mail for Gmail

To configure Win2PDF to send using Google Gmail, first open the
"Configure Mail" from the Win2PDF Desktop file menu.
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Win2PDF Configure Mail

You can also open "Configure Win2PDF Mail" from the Windows start
menu under the "Win2PDF" program group. The following Window is
displayed:
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Configure GMail Mail Provider

Select "Use Mail Provider" and select "Gmail". Fill in the "Email Address
(From:)" and "User Name" fields with your Gmail address. If you have 2
factor verification enabled on your Gmail account (recommended), follow
these steps to create an App Password.

Go to your Google Account.
1. Select Security.
2. Under "Signing in to Google," select App Passwords. You may need

to sign in. If you don’t have this option, it might be because:
o 2-Step Verification is not set up for your account.

o 2-Step Verification is only set up for security keys.

o Your account is through work, school, or other organization.

o You turned on Advanced Protection.

3. At the bottom, choose "Select app" and choose "Other (Custom
Name)". Type "Win2PDF Mail" and then click "Generate".

https://myaccount.google.com/
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4. Follow the instructions to enter the App Password. The App Password is
the 16-character code in the yellow bar on your device.

5. Copy the 16-character code or write it down.
6. Paste or enter the 16 character code into the Win2PDF Mail Settings

"Password" field.
7. Click OK.
Note: You’ll only have to enter an App Password once, so don’t worry
about memorizing it. You can generate a new App Password if you need
to reconfigure Win2PDF Mail.

If you don't have 2 factor verification enabled, just enter your Gmail
password in the "Password" field. If you get a password error, you may
need to turn on "Allow less secure app access".

The Win2PDF Desktop "Send Mail" and the Win2PDF "Send File" features
will display the following window when you send a PDF:

Win2PDF Compose Mail

When you click "Send", the email will be sent using the Gmail server.

4.3.33.4 Configure Win2PDF Mail for Outlook.com

To configure Win2PDF to send using Outlook.com, first open the "Configure
Mail" from the Win2PDF Desktop file menu.

https://myaccount.google.com/lesssecureapps
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Win2PDF Configure Mail

You can also open "Configure Win2PDF Mail" from the Windows start
menu under the "Win2PDF" program group. The following Window is
displayed:
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Configure Outlook.com Mail Provider

Select "Use Mail Provider" and select "Outlook.com". Fill in the "Email
Address (From:)" and "User Name" fields with your Outlook.com or
Hotmail.com address. If you have 2 step verification enabled on your
Outlook.com account (recommended), follow these steps to create an 

Go to the Security basics page and sign in to your Microsoft account.
1. Select "Advanced security options". 
2. Under App passwords, select Create a new app password. A new app

password is generated and appears on your screen.
3. Copy this password to the clipboard, or write it down.
4. Enter this app password in the Win2PDF Mail Settings "Password"

field.
Note: You’ll only have to enter an App Password once, so don’t worry
about memorizing it. You can generate a new App Password if you need
to reconfigure Win2PDF Mail.

https://account.microsoft.com/security
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If you don't have 2 step verification enabled, just enter your Outlook.com
password in the "Password" field.

The Win2PDF Desktop "Send Mail" and the Win2PDF "Send File" features
will display the following window when you send a PDF:

Win2PDF Compose Mail

When you click "Send", the email will be sent using the Outlook.com
server.

4.3.33.5 Configure Win2PDF Mail for Yahoo! Mail

To configure Win2PDF to send using Yahoo! Mail, first open the "Configure
Mail" from the Win2PDF Desktop file menu.
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Win2PDF Configure Mail

You can also open "Configure Win2PDF Mail" from the Windows start
menu under the "Win2PDF" program group. The following Window is
displayed:
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Configure Yahoo! Mail Provider

Select "Use Mail Provider" and select "Yahoo! Mail". Fill in the "Email
Address (From:)" and "User Name" fields with your Yahoo! Mail address. If
you have Yahoo! Account Key enabled on your Yahoo! Mail account
(recommended), follow these steps to create an App Password for Win2PDF
Mail.

1. Sign in to Yahoo! and go to your Account security page.
2. Click Generate app password or Manage app passwords.

https://login.yahoo.com/account/security?.scrumb=za8qMKmDmdv
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3. Select"Other App" from the drop down menu,

Configure Yahoo! Mail App Password

type in "Win2PDF Mail" in the "Enter custom name" box,
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Generate Yahoo! Mail App Password

and click Generate.
4. Copy the password to the clipboard, or write it down.
5. Click Done.
6. Paste or enter the password into the Win2PDF Mail Settings "Password"

field.

Note: You’ll only have to enter an App Password once, so don’t worry
about memorizing it. You can generate a new App Password if you need
to reconfigure Win2PDF Mail.

If you don't have Yahoo! Account Key enabled, just enter your Yahoo! Mail
password in the "Password" field.

The Win2PDF Desktop "Send Mail" and the Win2PDF "Send File" features
will display the following window when you send a PDF:
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Win2PDF Compose Mail

When you click "Send", the email will be sent using the Yahoo! Mail server.

4.3.33.6 Configure Win2PDF Mail for a Custom SMTP Server

Most email providers support sending email through a Simple Mail
Transport Protocol (SMTP) server. To configure Win2PDF Mail to use a
SMTP server, first open the "Configure Mail" from the Win2PDF Desktop file
menu.

Win2PDF Configure Mail
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You can also open "Configure Win2PDF Mail" from the Windows start
menu under the "Win2PDF" program group. The following Window is
displayed:

Configure Custom Mail Provider

Select "Use Mail Provider" and select "Custom". Fill in the "Email Address
(From:)" and "User Name" fields with your email address, and enter your
Password in the "Password" field.

Enter the SMTP Server Name provided by your email administrator in the
"SMTP Server Name" field. Enter the SMTP port number in the "SMTP Port"
field. The most common ports are 587 and 465.

Note: Win2PDF Mail only supports SMTP servers that require authentication
and that use SSL.
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The Win2PDF Desktop "Send Mail" and the Win2PDF "Send File" features
will display the following window when you send a PDF:

Win2PDF Compose Mail

When you click "Send", the email will be sent using the Yahoo! Mail server.

4.3.34 How To Configure Auto-Name Settings

Win2PDF and Win2Image can be configured to automatically name files and
skip the file save window. There are 3 ways to configure this:

1. You can run the "Configure Win2PDF Auto-Name" shortcut from the
Windows Start menu.
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Start Menu Configure Win2PDF Auto-Name

2. You can open "Configure Win2PDF Auto-Name" from the "Auto-Name"
menu of the Win2PDF Desktop App.
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Win2PDF Desktop Open Configure Win2PDF Auto-Name

3. You can print to the Win2PDF printer, and open the "Document" tab of
PDF Options when you print to the Win2PDF printer.

Options 1 and 2 will display the following window:
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Win2PDF Desktop Configure Auto-Name

Checking the "Auto-name Files" option enables the auto-name feature for
the printer selected under "Printer Name". To turn off the auto-name
feature and configure Win2PDF to display a file save window, un-check the
"Auto-name Files" option. 

You can configure the naming options by checking options.  The "File Save
Name" preview will automatically update as you enable and disable options
to show an example file name.  

The available naming options are:
Auto-name: Printer Name
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Auto-name: Folder Name
Auto-name: File Type
Auto-name: File Name Start
Auto-name: Include Document Title
Auto-name: Include Content Field
Auto-name: Include Search Field
Auto-name: Include Date
Auto-name: Include Time
Auto-name: User Defined
Auto-name: Always Append
Auto-name Actions: Send File
Auto-name Actions: Print File

If you previously configured Auto-Name through the "Document" tab of
PDF Options, the settings will be reflected in the Configure Win2PDF Auto-
Name window.

The auto-name configuration is stopped if you hold down the shift key while
printing to the Win2PDF printer. If you are printing to Win2PDF in the
background while typing in another program, you may accidentally stop the
auto-name if you press the shift key. If you want to prevent this from
happening, you can use the Win2PDF Admin Utility "Troubleshooting"
option to "Disable Auto-Name Shift Key check".

The auto-name settings in this window only apply to the currently logged in
user.  Administrators can enable Auto-Name for all users by right clicking
on the "Configure Auto-Name" shortcut and select "Run As Administrator".  

Configure Win2PDF Auto-name
for all users

The "Configure Win2PDF Auto-Name" window title should display "all
users".
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4.3.34.1 Auto-Name: Printer Name

The "Printer Name" setting allows you to change the Auto-name settings for
each individual printer. Each printer can have a different configuration with
auto-name enabled or disabled, different folder names, and different
options for the file name. 

For example, you may have different actions for different types of
documents. You may want to always save invoices to a specific folder and
print a copy to a paper printer. You may want to save sales quotes to a
different folder and automatically email them. At other times, you may
create PDFs interactively and choose the file location in the Win2PDF "File
Save" pop-up window. You can handle these cases by creating separate
Win2PDF printers to handle each work flow. You could create a new printer
named "Win2PDF Invoice" that is configured to automatically name PDF
files and print, a second printer named "Win2PDF Sales Quote" that is
configured automatically name to a different folder and email, and you can
leave the "Auto-Name" feature off for the "Win2PDF" printer so you can still
print interactively.

The "Printer Name" setting displays all available Win2PDF and Win2Image
printers are displayed.
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Configure Win2PDF Auto-Name: Select Printer

The "Printer Name" setting also allows you to add a printer by selecting
"Add Win2PDF Printer..." at the bottom of the printers list.
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Configure Win2PDF Auto-name: Add Printer

Auto-name settings are stored separately for each printer, and it's often
helpful to create a new Win2PDF printer when defining a new Auto-Name
configuration.

4.3.34.2 Auto-Name: Folder Name

The "Folder Name" setting displays the current Auto-name folder for the
currently selected printer. Clicking the "Change Folder" button allows you to
change the folder. The folder can be either on the local computer or on a
shared network location, but you must have write permissions to the
folder.
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Win2PDF Desktop Configure Auto-Name Folder

The "Sample File Name" listed at the bottom of the window is updated to
show what the resulting file name will be. This option can be combined with
any of the other auto-name options.

4.3.34.3 Auto-Name: File Type

The "File Type" setting allows you to configure the type of file created by
Win2PDF when the auto-name feature is enabled.
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Win2PDF Desktop Configure Auto-Name File Type

The file type can be one of:

· PDF/A - Portable Document Format for Archiving (PDF/A-1b, ISO 19005-
1:2005)

· PDF Image Only - monochrome
· PDF Image Only - color
· OCR PDF - Portable Document Format - Searchable *
· XPS - XML Paper Specification
· SVG - Scalable Vector Graphics
· Text - Formatted
· Text - Unformatted
· TIFF (monochrome, color, or color with transparent background)
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· JPEG
· GIF 
· PNG (grayscale, color, grayscale with transparent background, color with

transparent background)
· BMP

*The "OCR PDF" file type is only available if you download and install the
optional "Win2PDF OCR Add-on" from:

https://www.win2pdf.com/download/download-win2pdf-ocr.html

4.3.34.4 Auto-Name: File Name Start

When the "Auto-name Files" option is enabled, you can specify fixed text
that will be added to the beginning of the PDF file name. 

https://www.win2pdf.com/download/download-win2pdf-ocr.html
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Auto-name Settings - File Name Start

The "Sample File Name" listed at the bottom of the window is updated to
show what the resulting file name will be. This option can be combined with
any of the other auto-name options.

4.3.34.5 Auto-Name: Include Document Title

When the "Auto-name Files" option is enabled, you can add the document
title to the file name by checking the "Include Document Title" option. 
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Win2PDF Desktop Auto-Name Settings - Include Document Title

The document title is set by the calling application, and may change for
each document being printed depending on the application. 

The "Sample File Name" listed at the bottom of the window is updated to
show the resulting file name based on the options selected using "Title" as
a placeholder for the application document title. This option can be
combined with any of the other auto-name options.
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4.3.34.6 Auto-Name: Include Content Field

When the "Auto-name Files" option is enabled, you can add a previously
defined content field to the file name by checking the "Include Content
Field" option. 

Win2PDF Desktop Configure Auto-Name: Include Content Field

To define a content field, first open a representative PDF in the Win2PDF
Desktop app. The content field is defined by selecting "Define Auto-Name
Content Field" from the "Auto-Name" menu, and dragging a rectangle
around the content in the open PDF document. If text is found in the
rectangle defined by the content field, it will be displayed as sample text
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after the "Include Content Field" item. If the content field hasn't been
defined, the sample text will say "Not defined". 

The "Sample File Name" listed at the bottom of the window is updated to
show the resulting file name based on the options selected using the
sample text from content field. This option can be combined with any of the
other auto-name options.

The following screen cast shows how this can be defined.

How to set the Content Name Field
using Win2PDF's Auto-Name feature

If the text in the PDF file is not searchable, you can download and install
the optional "Win2PDF OCR Add-on" from:
https://www.win2pdf.com/download/download-win2pdf-ocr.html
You should make the PDF searchable before defining the content field, and
you should select "OCR PDF" as the file type in the auto-name settings.

4.3.34.7 Auto-Name: Include Search Field

When the "Auto-name Files" option is enabled, you can add a previously
defined content field to the file name by checking the "Include Search Field"
option. 

https://www.win2pdf.com/download/download-win2pdf-ocr.html


Win2PDF252

© 2023 Dane Prairie Systems, LLC

Win2PDF Desktop Configure Auto-Name: Include Search Field

To define a search field, first open a representative PDF in the Win2PDF
Desktop app. The search field is defined by selecting "Define Auto-Name
Search Field" from the "Auto-Name" menu, and specifying the search word
that precedes the desired text field. If text is found after the search word, it
will be displayed as sample text after the "Include Content Field" item. If
the search field hasn't been defined, the sample text will say "Not defined".
You can define up to three search fields, and select the desired search filed
using the drop down menu.

If the text in the PDF file is not searchable, you can download and install
the optional "Win2PDF OCR Add-on" from:
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https://www.win2pdf.com/download/download-win2pdf-ocr.html
You should make the PDF searchable before defining the content field, and
you should select "OCR PDF" as the file type in the auto-name settings.

The "Sample File Name" listed at the bottom of the window is updated to
show the resulting file name based on the options selected using the
sample text from search field. This option can be combined with any of the
other auto-name options.

4.3.34.8 Auto-Name: Include Date

When the "Auto-name Files" option is enabled, you can add a date to the
file name by checking on the "Include Date" option. 

Win2PDF Desktop Auto-Name Settings - Include Date

https://www.win2pdf.com/download/download-win2pdf-ocr.html
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The date format can be selected to the right of the option, and available
formats include:

· Year-Month-Day
· Year-Month
· Month-Day-Year (Default)
· Day-Month-Year
· Month-Day
· Month-Day - abbr. names
· Year Only
· Month Only - numeral
· Month Only - abbr. name
· Day Only
· Day in Week - abbr. name

The "Sample File Name" listed at the bottom of the window is updated to
show the resulting file name based on the options selected. This option can
be combined with any of the other auto-name options.

4.3.34.9 Auto-Name: Include Time

When the "Auto-name Files" option is enabled, you can add a time to the
file name by checking on the "Include Time" option. 
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Win2PDF Desktop Auto-Name Settings - Include Time

The time format can be selected to the right of the option, and available
formats include:

· 12 Hour-Minute-Second-AM/PM
· 12 Hour-Minute-Second-Millisecond-AM/PM (default)
· 12 Hour-Minute-AM/PM
· 12 Hour Only-AM/PM
· 24 Hour-Minute-Second
· 24 Hour Minute-Second-Millisecond
· 24 Hour-Minute
· 24 Hour Only
· Minute-Second
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· Minute Only
· Second Only

The "Sample File Name" listed at the bottom of the window is updated to
show the resulting file name based on the options selected. This option can
be combined with any of the other auto-name options.

4.3.34.10Auto-Name: User Defined

When the "Auto-name Files" option is enabled, advanced users can control
the format of the file name using the "User Defined" option.

Win2PDF Desktop Auto-Name Settings - User Defined
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When the "User Defined" option is enabled, the field is filled with the currently
selected options in a tag format that is delimited by % characters (e.g. %PDFHour
%). Advanced users can re-order the Win2PDF tags to match their requirements, or
mix and match tags to create their own file name format. The supported tags are:

%PDFTitle% Document title set by the application including the file extension
%
PDFTitleNoExten
sion%

Document title set by the application, excluding the 3 or 4
character file extension (if any)

%PDFDate% Eight digit date separated by dashes in the format month-day-
year (12-25-2015)

%PDFTime% Six digit 12 hour time separated by dashes in the format hour-
minute-second-AM/PM (12-59-59 PM)

%PDFYear% Four digit number for the current year (2015)
%PDFMonth% Two digit number for the current month (12)
%
PDFMonthName
%

Three character abbreviated name for the current month (Dec)

%PDFDay% Two digit number for the current day of the month (25)
%PDFDayName
%

Three character abbreviated name for the day of the week (Wed)

%
PDFDayInWeek
%

One digit number for the current day of the week

%PDFHour% Two digit number for the current hour in a 12 hour format (12)
%PDFHour24% Two digit number for the current hour in a 24 hour format (24)
%PDFMinute% Two digit number for the current minute within the hour (59)
%PDFMinute5% Number for the current 5 minute interval within the hour (0, 5,

10,..55)
%
PDFMinute10%

Number for the current 10 minute interval within the hour (0, 10,
20, ..50)

%
PDFMinute15%

Number for the current 15 minute interval within the hour (0, 15,
30, 45)

%
PDFMinute30%

Number for the current 30 minute interval within the hour (0, 30)

%PDFSecond% Two digit number for the current second within the minute (59)
%
PDFMillisecond
%

Three digit number for the current millisecond (999)

%
PDFTimeMarker
%

Two character abbreviation for AM or PM

%
PDFPrinterName
%

The name of the Win2PDF printer instance

%PDFIncrement
%

The %PDFIncrement% variable starts at 1, and increments by
one until the expanded file name does not exist.
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%
PDFAutoNameC
ontentSearch% 

Used for content based file naming. Win2PDF searches the text
of the current PDF for the word specified in the Win2PDF
Desktop "Define Search Field" command or by the
PDFAutoNameContentSearchWord registry setting. If the word is
found, the auto-name variable %PDFAutoNameContentSearch%
is filled with the word after the search word. 

%
PDFAutoNameC
ontentSearch2%

Used for content based file naming. Win2PDF searches the text
of the current PDF for the word specified in the Win2PDF
Desktop "Define Search Field" command or by the
PDFAutoNameContentSearchWord2 registry setting. If the word
is found, the auto-name variable %
PDFAutoNameContentSearch2% is filled with the word after the
search word. 

%
PDFAutoNameC
ontentSearch3%

Used for content based file naming. Win2PDF searches the text
of the current PDF for the word specified in the Win2PDF
Desktop "Define Search Field" command or by the
PDFAutoNameContentSearchWord3 registry setting. If the word
is found, the auto-name variable %
PDFAutoNameContentSearch3% is filled with the word after the
search word. 

%
PDFAutoNameC
ontentField%

Used for content based file naming. Win2PDF searches the
content field rectangle defined in the Win2PDF Desktop "Define
Content Field" command. If text is found in the defined rectangle,
the auto-name variable %PDFAutoNameContentField% is filled
with found text.

The "Sample File Name" listed at the bottom of the window is updated to
show the resulting file name based on the options selected.

You can specify an Auto-Name folder using any of the tags. For example, to
place all PDF file in a folder based on the current month and a sub folder
based on the current day in the month, you could set the "User Defined"
field to:
%PDFMonth%\%PDFDay%\%PDFTitle%.pdf

If the folder doesn't exist, it will be created by Win2PDF.

4.3.34.11Auto-Name: Always Append

When the "Always Append" option is enabled, Win2PDF will automatically
append to any existing document that matches the Auto-Name format. This
option is not available for Win2Image, or when security is enabled in
Win2PDF Pro.
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Win2PDF Desktop Configure Auto Name Settings: Always Append

Depending on the other options selected, the "Always Append" option will
append until the date and/or time changes. A new file will be created if an
existing file with the same format does not exist.

For example, if the "Include Date" option is selected with a "Month-Day-
Year" format, the "Always Append" option will append to the same file when
it was created on the same day. The following day, a new file will be
created. If the date format is set to "Year Only", a new file will every year.
If no date or time options are enabled, Win2PDF will always append to the
same file. The description following "Always Append" is updated to indicate
how often a new file is created.
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This option can be combined with any of the other auto-name options.

4.3.34.12Auto-Name Actions: Send File

When the "Auto-name Files" option is enabled, you can configure Win2PDF
to automatically send the file by checking the "Send File" button.

Win2PDF uses the email client configured in the "Configure Mail" menu. The
recipient can be configured in the drop down menu. The following options
are available:
· Default - uses the email client default recipient
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· Content Field - uses the content field defined by the "Define Auto-Name
Content Field"

· Search Field 1 - uses the search field defined by the "Define Auto-Name
Search Field" for "Search Field 1"

· Search Field 2 - uses the search field defined by the "Define Auto-Name
Search Field" for "Search Field 2"

· Search Field 3 - uses the search field defined by the "Define Auto-Name
Search Field" for "Search Field 3"

If a content field is defined, the sample text is displayed next to the
"Recipient" field.

4.3.34.13Auto-Name Actions: Print File

When the "Auto-name Files" option is enabled, you can configure Win2PDF
to automatically print the file by checking the "Print File" button.
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Win2PDF Desktop Configure Auto-Name Print File

When you select the "Print File" option, a printer selection window opens
and allows you to choose a paper printer. The selected printer is displayed
next to the "Print File" option.

4.3.35 How To Batch Convert

Win2PDF Desktop Batch  

Win2PDF Pro can batch convert folders of files in one of the following input
formats:

· PDF
· DOCX
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· DOC
· RTF
· ODT
· TXT
· HTML
· XPS
· TIFF
· JPG
· PNG
· BMP
· GIF

It can convert them to one of the following output formats:

· PDF
· PDF Image Only - monochrome
· PDF Image Only - grayscale
· PDF Image Only - color
· PDF - compressed
· PDF - searchable (OCR)
· DOCX - Microsoft Word
· RTF - Rich Text Format
· ODT - OpenDocument Text
· Text - formatted
· Text - unformatted
· Text - formatted after making searchable (OCR)
· Text - unformatted after making searchable (OCR)
· JPEG - grayscale
· JPEG - color
· TIFF - monochrome
· TIFF - grayscale
· TIFF - color
· TIFF - color with transparent background 
· PNG - Grayscale
· PNG - Grayscale with transparent background
· PNG - Color
· PNG - Color with transparent background
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Win2PDF Desktop - Batch Convert Formats

You can batch convert folders of files from one format to another by
opening the "Batch Convert..." window from the Win2PDF Desktop "File"
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menu:

Win2PDF Desktop - Batch Convert Menu
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Win2PDF Desktop - Batch Convert

The "Convert Files From" setting allows you to configure the location of the
files to convert. Any files in this folder that are supported will be converted
to the "Convert To Format". You can type in the location, or click "Change
Folder" to browse to the location.

The "Save To" folder setting allows you to configure the location of the
converted files. It must be a different location from the "Convert Files
From" folder. You can type in the location, or click "Change Folder" to
browse to the location.

The "Convert" button will start the conversion process.  Depending on the
number of files in the "Convert Files From" folder and the "Convert To
Format" selected, it can take a long time to convert all files.  The "Cancel"
button remains active during the conversion process, and allows you to
cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.1 Batch Convert PDF to JPG

Batch Convert PDF to JPG  

To batch convert from PDF to JPG, open the Win2PDF Desktop "Batch
Convert" window and set the "Convert To Format" to either "JPEG -
Grayscale" or "JPEG - Color".

https://www.win2pdf.com/trial.html
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Win2PDF Desktop - Batch Convert PDF to JPG

Set the "Convert Files From" location to the folder containing the PDF files
to convert, and set the "Save To" folder to the location for the converted
JPG files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.2 Batch Convert PDF to PNG

Batch Convert PDF to PNG  

To batch convert from PDF to PNG, open the Win2PDF Desktop "Batch
Convert" window and set the "Convert To Format" to either "PNG -
Grayscale" or "PNG - Color".

https://www.win2pdf.com/trial.html
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Win2PDF Desktop - Batch Convert PDF to PNG

Set the "Convert Files From" location to the folder containing the PDF files
to convert, and set the "Save To" folder to the location for the converted
PNG files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.3 Batch Convert PDF to TIFF

Batch Convert PDF to TIFF  

To batch convert from PDF to TIFF, open the Win2PDF Desktop "Batch
Convert" window and set the "Convert To Format" to either "TIFF -

https://www.win2pdf.com/trial.html
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Monochrome", "TIFF - Grayscale", "TIFF - Color", "TIFF - Color with
transparent background".

Win2PDF Desktop - Batch Convert PDF to TIFF

Set the "Convert Files From" location to the folder containing the PDF files
to convert, and set the "Save To" folder to the location for the converted
TIFF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.4 Batch Convert PDF to Text

Batch Convert PDF to TXT  

To batch convert from PDF to Text, open the Win2PDF Desktop "Batch
Convert" window and set the "Convert To Format" to either "Text -
Formatted", "Text - Unformatted", "Text with OCR - Formatted", or "Text

https://www.win2pdf.com/trial.html
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with OCR - Unformatted".  The "OCR" formats attempt to make non-
searchable sections of the PDF searchable using optical character
recognition (OCR) before converting to text, and requires the "Win2PDF
OCR Add-on" from:
https://www.win2pdf.com/download/download-win2pdf-ocr.html

The "OCR" formats are much slower, and should only be used for PDF files
that contain unsearchable text.

Win2PDF Desktop - Batch Convert PDF to Text

Set the "Convert Files From" location to the folder containing the PDF files
to convert, and set the "Save To" folder to the location for the converted
text files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.

https://www.win2pdf.com/download/download-win2pdf-ocr.html


How To Articles 275

© 2023 Dane Prairie Systems, LLC

Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.5 Batch Convert PDF to Searchable PDF

Batch Convert PDF to Searchable PDF  

To batch convert from PDF to searchable PDF, open the Win2PDF Desktop
"Batch Convert" window and set the "Convert To Format" to either "PDF -
Searchable (OCR)".  This attempts to make non-searchable sections of the

https://www.win2pdf.com/trial.html
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PDF searchable using optical character recognition (OCR), and requires the
"Win2PDF OCR Add-on" from:
https://www.win2pdf.com/download/download-win2pdf-ocr.html

Win2PDF Desktop - Batch Convert PDF to Searchable PDF

Set the "Convert Files From" location to the folder containing the PDF files
to convert, and set the "Save To" folder to the location for the converted
searchable PDF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.

https://www.win2pdf.com/download/download-win2pdf-ocr.html
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.6 Batch Convert PDF to Compressed PDF

Batch Convert PDF to Compressed PDF  

To batch convert from PDF to compressed PDF, open the Win2PDF Desktop
"Batch Convert" window and set the "Convert To Format" to either "PDF -
Compressed".

https://www.win2pdf.com/trial.html
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Win2PDF Desktop - Batch Convert PDF to Compressed PDF

Set the "Convert Files From" location to the folder containing the PDF files
to convert, and set the "Save To" folder to the location for the converted
compressed PDF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.7 Batch Convert PDF to Image Only PDF

Batch Convert PDF to Image Only PDF  

To batch convert from PDF to an image only PDF, open the Win2PDF
Desktop "Batch Convert" window and set the "Convert To Format" to either

https://www.win2pdf.com/trial.html
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"PDF - Image Only (monochrome)", "PDF - Image Only (grayscale)", or
"PDF - Image Only (color)".

Win2PDF Desktop - Batch Convert PDF to Image Only PDF

Set the "Convert Files From" location to the folder containing the PDF files
to convert, and set the "Save To" folder to the location for the converted
image only PDF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.8 Batch Convert PDF to DOCX

Batch Convert PDF to DOCX  

To batch convert from PDF to a Microsoft Word DOCX file, open the
Win2PDF Desktop "Batch Convert" window and set the "Convert To
Format" to "DOCX - Microsoft Word Document".

https://www.win2pdf.com/trial.html
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Win2PDF Desktop - Batch Convert PDF to DOCX

Set the "Convert Files From" location to the folder containing the PDF files
to convert, and set the "Save To" folder to the location for the converted
DOCX files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.9 Batch Convert PDF to RTF

Batch Convert PDF to RTF  

To batch convert from PDF to a Rich Text Format RTF file, open the
Win2PDF Desktop "Batch Convert" window and set the "Convert To
Format" to "RTF - Microsoft Rich Text Format Document".

https://www.win2pdf.com/trial.html
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Win2PDF Desktop - Batch Convert PDF to RTF

Set the "Convert Files From" location to the folder containing the PDF files
to convert, and set the "Save To" folder to the location for the converted
RTF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.10Batch Convert PDF to ODT

Batch Convert PDF to ODT  

To batch convert from PDF to an OpenDocument Text ODT file, open the
Win2PDF Desktop "Batch Convert" window and set the "Convert To
Format" to "ODT - OpenDocument Text".

https://www.win2pdf.com/trial.html
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Win2PDF Desktop - Batch Convert PDF to ODT

Set the "Convert Files From" location to the folder containing the PDF files
to convert, and set the "Save To" folder to the location for the converted
ODT files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.11Batch Convert PDF to XPS

Batch Convert PDF to XPS  

To batch convert from PDF to an XML Paper Specification XPS file, open the
Win2PDF Desktop "Batch Convert" window and set the "Convert To
Format" to "XPS - XML Paper Specification".

https://www.win2pdf.com/trial.html
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Win2PDF Desktop - Batch Convert PDF to XPS

Set the "Convert Files From" location to the folder containing the PDF files
to convert, and set the "Save To" folder to the location for the converted
XPS files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.12Batch Convert JPG to PDF

Batch Convert JPG to PDF  

To batch convert from JPG to PDF, open the Win2PDF Desktop "Batch
Convert" window and set the "Convert To Format" to "PDF".

https://www.win2pdf.com/trial.html
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Win2PDF Desktop - Batch Convert JPG to PDF

Set the "Convert Files From" location to the folder containing the JPG files
to convert, and set the "Save To" folder to the location for the converted
PDF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.13Batch Convert JPG to PNG

Batch Convert JPG to PNG  

To batch convert from JPG to PNG, open the Win2PDF Desktop "Batch
Convert" window and set the "Convert To Format" to either "PNG -
Grayscale" or "PNG - Color".

https://www.win2pdf.com/trial.html
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Win2PDF Desktop - Batch Convert JPG to PNG

Set the "Convert Files From" location to the folder containing the JPG files
to convert, and set the "Save To" folder to the location for the converted
PNG files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.14Batch Convert JPG to TIFF

Batch Convert JPG to TIFF  

To batch convert from JPG to TIFF, open the Win2PDF Desktop "Batch
Convert" window and set the "Convert To Format" to either "TIFF -

https://www.win2pdf.com/trial.html
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Monochrome", "TIFF - Grayscale", "TIFF - Color", or "TIFF - Color with
transparent background".

Win2PDF Desktop - Batch Convert JPG to TIFF

Set the "Convert Files From" location to the folder containing the JPG files
to convert, and set the "Save To" folder to the location for the converted
TIFF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.15Batch Convert JPG to Text

Batch Convert JPG to TXT  

To batch convert from JPG to Text, open the Win2PDF Desktop "Batch
Convert" window and set the "Convert To Format" to "Text with OCR -

https://www.win2pdf.com/trial.html
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Formatted", or "Text with OCR - Unformatted".  This requires the "Win2PDF
OCR Add-on" from:
https://www.win2pdf.com/download/download-win2pdf-ocr.html

Win2PDF Desktop - Batch Convert JPG to Text

Set the "Convert Files From" location to the folder containing the JPG files
to convert, and set the "Save To" folder to the location for the converted
text files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.

https://www.win2pdf.com/download/download-win2pdf-ocr.html
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.16Batch Convert JPG to Searchable PDF

Batch Convert JPG to Searchable PDF  

To batch convert from JPG to searchable PDF, open the Win2PDF Desktop
"Batch Convert" window and set the "Convert To Format" to either "PDF -
Searchable (OCR)".  This requires the "Win2PDF OCR Add-on" from:

https://www.win2pdf.com/trial.html
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https://www.win2pdf.com/download/download-win2pdf-ocr.html

Win2PDF Desktop - Batch Convert JPG to Searchable PDF

Set the "Convert Files From" location to the folder containing the JPG files
to convert, and set the "Save To" folder to the location for the converted
searchable PDF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.

https://www.win2pdf.com/download/download-win2pdf-ocr.html
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.17Batch Convert JPG to Compressed PDF

Batch Convert JPG to Compressed PDF  

To batch convert from JPG to compressed PDF, open the Win2PDF Desktop
"Batch Convert" window and set the "Convert To Format" to either "PDF -
Compressed".

https://www.win2pdf.com/trial.html
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Win2PDF Desktop - Batch Convert JPG to Compressed PDF

Set the "Convert Files From" location to the folder containing the JPG files
to convert, and set the "Save To" folder to the location for the converted
compressed PDF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.18Batch Convert JPG to Image Only PDF

Batch Convert JPG to Image Only PDF  

To batch convert from JPG to an image only PDF, open the Win2PDF
Desktop "Batch Convert" window and set the "Convert To Format" to either
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"PDF - Image Only (monochrome)", "PDF - Image Only (grayscale)", or
"PDF - Image Only (color)".

Win2PDF Desktop - Batch Convert JPG to Image Only PDF

Set the "Convert Files From" location to the folder containing the JPG files
to convert, and set the "Save To" folder to the location for the converted
image only PDF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.19Batch Convert JPG to DOCX

Batch Convert JPG to DOCX  
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To batch convert from JPG to a Microsoft Word DOCX file, open the
Win2PDF Desktop "Batch Convert" window and set the "Convert To
Format" to "DOCX - Microsoft Word Document".

Win2PDF Desktop - Batch Convert JPG to DOCX

Set the "Convert Files From" location to the folder containing the JPG files
to convert, and set the "Save To" folder to the location for the converted
DOCX files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.20Batch Convert JPG to RTF

Batch Convert JPG to RTF  

To batch convert from JPG to a Rich Text Format RTF file, open the
Win2PDF Desktop "Batch Convert" window and set the "Convert To
Format" to "RTF - Microsoft Rich Text Format Document".
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Win2PDF Desktop - Batch Convert JPG to RTF

Set the "Convert Files From" location to the folder containing the JPG files
to convert, and set the "Save To" folder to the location for the converted
RTF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.21Batch Convert JPG to ODT

Batch Convert JPG to ODT  

To batch convert from JPG to an OpenDocument Text ODT file, open the
Win2PDF Desktop "Batch Convert" window and set the "Convert To
Format" to "ODT - OpenDocument Text".
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Win2PDF Desktop - Batch Convert JPG to ODT

Set the "Convert Files From" location to the folder containing the JPG files
to convert, and set the "Save To" folder to the location for the converted
ODT files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.22Batch Convert JPG to XPS

Batch Convert JPG to XPS  

To batch convert from JPG to an XML Paper Specification XPS file, open the
Win2PDF Desktop "Batch Convert" window and set the "Convert To
Format" to "XPS - XML Paper Specification".
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Win2PDF Desktop - Batch Convert JPG to XPS

Set the "Convert Files From" location to the folder containing the JPG files
to convert, and set the "Save To" folder to the location for the converted
XPS files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.23Batch Convert PNG to PDF

Batch Convert PNG to PDF  

To batch convert from PNG to PDF, open the Win2PDF Desktop "Batch
Convert" window and set the "Convert To Format" to "PDF".
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Win2PDF Desktop - Batch Convert PNG to PDF

Set the "Convert Files From" location to the folder containing the PNG files
to convert, and set the "Save To" folder to the location for the converted
PDF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.24Batch Convert PNG to JPG

Batch Convert PNG to JPEG  

To batch convert from PNG to JPG, open the Win2PDF Desktop "Batch
Convert" window and set the "Convert To Format" to either "JPG -
Grayscale" or "JPG - Color".

https://www.win2pdf.com/trial.html


Win2PDF314

© 2023 Dane Prairie Systems, LLC

Win2PDF Desktop - Batch Convert PNG to JPG

Set the "Convert Files From" location to the folder containing the PNG files
to convert, and set the "Save To" folder to the location for the converted
JPG files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.25Batch Convert PNG to TIFF

Batch Convert PNG to TIFF  

To batch convert from PNG to TIFF, open the Win2PDF Desktop "Batch
Convert" window and set the "Convert To Format" to either "TIFF -
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Monochrome", "TIFF - Grayscale", "TIFF - Color", or "TIFF - Color with
transparent background".

Win2PDF Desktop - Batch Convert PNG to TIFF

Set the "Convert Files From" location to the folder containing the PNG files
to convert, and set the "Save To" folder to the location for the converted
TIFF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.26Batch Convert PNG to Text

Batch Convert PNG to TXT  

To batch convert from PNG to Text, open the Win2PDF Desktop "Batch
Convert" window and set the "Convert To Format" to "Text with OCR -
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Formatted", or "Text with OCR - Unformatted".  This requires the "Win2PDF
OCR Add-on" from:
https://www.win2pdf.com/download/download-win2pdf-ocr.html

Win2PDF Desktop - Batch Convert PNG to Text

Set the "Convert Files From" location to the folder containing the PNG files
to convert, and set the "Save To" folder to the location for the converted
text files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.27Batch Convert PNG to Searchable PDF

Batch Convert PNG to PDF Searchable (OCR) 
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To batch convert from PNG to searchable PDF, open the Win2PDF Desktop
"Batch Convert" window and set the "Convert To Format" to either "PDF -
Searchable (OCR)".  This requires the "Win2PDF OCR Add-on" from:
https://www.win2pdf.com/download/download-win2pdf-ocr.html

Win2PDF Desktop - Batch Convert PNG to Searchable PDF

Set the "Convert Files From" location to the folder containing the PNG files
to convert, and set the "Save To" folder to the location for the converted
searchable PDF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.28Batch Convert PNG to Compressed PDF

Batch Convert PNG to Compressed PDF  

To batch convert from PNG to compressed PDF, open the Win2PDF
Desktop "Batch Convert" window and set the "Convert To Format" to either
"PDF - Compressed".
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Win2PDF Desktop - Batch Convert PNG to Compressed PDF

Set the "Convert Files From" location to the folder containing the PNG files
to convert, and set the "Save To" folder to the location for the converted
compressed PDF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.29Batch Convert PNG to Image Only PDF

Batch Convert PNG to Image Only PDF  

To batch convert from PNG to an image only PDF, open the Win2PDF
Desktop "Batch Convert" window and set the "Convert To Format" to either
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"PDF - Image Only (monochrome)", "PDF - Image Only (grayscale)", or
"PDF - Image Only (color)".

Win2PDF Desktop - Batch Convert PNG to Image Only PDF

Set the "Convert Files From" location to the folder containing the PNG files
to convert, and set the "Save To" folder to the location for the converted
image only PDF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.30Batch Convert PNG to DOCX

Batch Convert PNG to DOCX  

To batch convert from a PNG to a Microsoft Word DOCX file, open the
Win2PDF Desktop "Batch Convert" window and set the "Convert To
Format" to "DOCX - Microsoft Word Document".
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Win2PDF Desktop - Batch Convert PNG to DOCX

Set the "Convert Files From" location to the folder containing the PNG files
to convert, and set the "Save To" folder to the location for the converted
DOCX files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.31Batch Convert PNG to RTF

Batch Convert PNG to RTF  

To batch convert from a PNG to a Rich Text Format RTF file, open the
Win2PDF Desktop "Batch Convert" window and set the "Convert To
Format" to "RTF - Microsoft Rich Text Format Document".
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Win2PDF Desktop - Batch Convert PNG to RTF

Set the "Convert Files From" location to the folder containing the PNG files
to convert, and set the "Save To" folder to the location for the converted
RTF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.32Batch Convert PNG to ODT

Batch Convert PNG to ODT  

To batch convert from a PNG to an OpenDocument Text ODT file, open the
Win2PDF Desktop "Batch Convert" window and set the "Convert To
Format" to "ODT - OpenDocument Text".
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Win2PDF Desktop - Batch Convert PNG to ODT

Set the "Convert Files From" location to the folder containing the PNG files
to convert, and set the "Save To" folder to the location for the converted
ODT files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.33Batch Convert PNG to XPS

Batch Convert PNG to XPS  

To batch convert from a PNG to an XML Paper Specification XPS file, open
the Win2PDF Desktop "Batch Convert" window and set the "Convert To
Format" to "XPS - XML Paper Specification".
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Win2PDF Desktop - Batch Convert PNG to XPS

Set the "Convert Files From" location to the folder containing the PNG files
to convert, and set the "Save To" folder to the location for the converted
XPS files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.34Batch Convert TIFF to PDF

Batch Convert TIFF to PDF  

To batch convert from TIFF to PDF, open the Win2PDF Desktop "Batch
Convert" window and set the "Convert To Format" to "PDF".
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Win2PDF Desktop - Batch Convert TIFF to PDF

Set the "Convert Files From" location to the folder containing the TIFF files
to convert, and set the "Save To" folder to the location for the converted
PDF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.35Batch Convert TIFF to JPG

Batch Convert TIFF to JPEG  

To batch convert from TIFF to JPG, open the Win2PDF Desktop "Batch
Convert" window and set the "Convert To Format" to either "JPG -
Grayscale" or "JPG - Color".
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Win2PDF Desktop - Batch Convert TIFF to JPG

Set the "Convert Files From" location to the folder containing the TIFF files
to convert, and set the "Save To" folder to the location for the converted
JPG files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.36Batch Convert TIFF to PNG

Batch Convert TIFF to PNG  

To batch convert from TIFF to PNG, open the Win2PDF Desktop "Batch
Convert" window and set the "Convert To Format" to either "PNG -
Grayscale" or "PNG - Color".
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Win2PDF Desktop - Batch Convert TIFF to PNG

Set the "Convert Files From" location to the folder containing the TIFF files
to convert, and set the "Save To" folder to the location for the converted
PNG files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.37Batch Convert TIFF to Text

Batch Convert TIFF to TXT  

To batch convert from TIFF to Text, open the Win2PDF Desktop "Batch
Convert" window and set the "Convert To Format" to "Text with OCR -
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Formatted", or "Text with OCR - Unformatted".  This requires the "Win2PDF
OCR Add-on" from:
https://www.win2pdf.com/download/download-win2pdf-ocr.html

Win2PDF Desktop - Batch Convert TIFF to Text

Set the "Convert Files From" location to the folder containing the TIFF files
to convert, and set the "Save To" folder to the location for the converted
text files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.

https://www.win2pdf.com/download/download-win2pdf-ocr.html


How To Articles 341

© 2023 Dane Prairie Systems, LLC

Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.38Batch Convert TIFF to Searchable PDF

Batch Convert TIFF to Searchable PDF  

To batch convert from TIFF to searchable PDF, open the Win2PDF Desktop
"Batch Convert" window and set the "Convert To Format" to either "PDF -
Searchable (OCR)".  This requires the "Win2PDF OCR Add-on" from:
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https://www.win2pdf.com/download/download-win2pdf-ocr.html

Win2PDF Desktop - Batch Convert TIFF to Searchable PDF

Set the "Convert Files From" location to the folder containing the TIFF files
to convert, and set the "Save To" folder to the location for the converted
searchable PDF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.

https://www.win2pdf.com/download/download-win2pdf-ocr.html
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.39Batch Convert TIFF to Compressed PDF

Batch Convert TIFF to Compressed PDF  

To batch convert from TIFF to compressed PDF, open the Win2PDF
Desktop "Batch Convert" window and set the "Convert To Format" to either
"PDF - Compressed".
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Win2PDF Desktop - Batch Convert PNG to Compressed PDF

Set the "Convert Files From" location to the folder containing the TIFF files
to convert, and set the "Save To" folder to the location for the converted
compressed PDF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.40Batch Convert TIFF to Image Only PDF

Batch Convert TIFF to Image Only PDF  

To batch convert from TIFF to an image only PDF, open the Win2PDF
Desktop "Batch Convert" window and set the "Convert To Format" to either
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"PDF - Image Only (monochrome)", "PDF - Image Only (grayscale)", or
"PDF - Image Only (color)".

Win2PDF Desktop - Batch Convert TIFF to Image Only PDF

Set the "Convert Files From" location to the folder containing the TIFF files
to convert, and set the "Save To" folder to the location for the converted
image only PDF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.41Batch Convert XPS to PDF

Batch Convert XPS to PDF  

To batch convert from XPS to PDF, open the Win2PDF Desktop "Batch
Convert" window and set the "Convert To Format" to "PDF".
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Win2PDF Desktop - Batch Convert XPS to PDF

Set the "Convert Files From" location to the folder containing the XPS files
to convert, and set the "Save To" folder to the location for the converted
PDF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.



How To Articles 349

© 2023 Dane Prairie Systems, LLC

Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.42Batch Convert XPS to JPG

Batch Convert XPS to JPEG  

To batch convert from XPS to JPG, open the Win2PDF Desktop "Batch
Convert" window and set the "Convert To Format" to either "JPG -
Grayscale" or "JPG - Color".
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Win2PDF Desktop - Batch Convert XPS to JPG

Set the "Convert Files From" location to the folder containing the XPS files
to convert, and set the "Save To" folder to the location for the converted
JPG files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.43Batch Convert XPS to PNG

Batch Convert XPS to PNG  

To batch convert from XPS to PNG, open the Win2PDF Desktop "Batch
Convert" window and set the "Convert To Format" to either "PNG -
Grayscale" or "PNG - Color".
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Win2PDF Desktop - Batch Convert XPS to PNG

Set the "Convert Files From" location to the folder containing the XPS files
to convert, and set the "Save To" folder to the location for the converted
PNG files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.44Batch Convert XPS to TIFF

Batch Convert XPS to TIFF  

To batch convert from XPS to TIFF, open the Win2PDF Desktop "Batch
Convert" window and set the "Convert To Format" to either "TIFF -
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Monochrome", "TIFF - Grayscale", "TIFF - Color", or "TIFF - Color with
transparent background".

Win2PDF Desktop - Batch Convert XPS to TIFF

Set the "Convert Files From" location to the folder containing the XPS files
to convert, and set the "Save To" folder to the location for the converted
TIFF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.45Batch Convert XPS to Text

Batch Convert XPS to TXT  

To batch convert from XPS to Text, open the Win2PDF Desktop "Batch
Convert" window and set the "Convert To Format" to "Text with OCR -

https://www.win2pdf.com/trial.html


Win2PDF356

© 2023 Dane Prairie Systems, LLC

Formatted", or "Text with OCR - Unformatted".  This requires the "Win2PDF
OCR Add-on" from:
https://www.win2pdf.com/download/download-win2pdf-ocr.html

Win2PDF Desktop - Batch Convert XPS to Text

Set the "Convert Files From" location to the folder containing the XPS files
to convert, and set the "Save To" folder to the location for the converted
text files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.46Batch Convert XPS to Searchable PDF

Batch Convert XPS to Searchable PDF  

To batch convert from XPS to searchable PDF, open the Win2PDF Desktop
"Batch Convert" window and set the "Convert To Format" to either "PDF -
Searchable (OCR)".  This requires the "Win2PDF OCR Add-on" from:
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https://www.win2pdf.com/download/download-win2pdf-ocr.html

Win2PDF Desktop - Batch Convert XPS to Searchable PDF

Set the "Convert Files From" location to the folder containing the XPS files
to convert, and set the "Save To" folder to the location for the converted
searchable PDF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.47Batch Convert XPS to Compressed PDF

Batch Convert XPS to Compressed PDF  

To batch convert from XPS to compressed PDF, open the Win2PDF Desktop
"Batch Convert" window and set the "Convert To Format" to either "PDF -
Compressed".
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Win2PDF Desktop - Batch Convert XPS to Compressed PDF

Set the "Convert Files From" location to the folder containing the XPS files
to convert, and set the "Save To" folder to the location for the converted
compressed PDF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.48Batch Convert XPS to Image Only PDF

Batch Convert XPS to Image Only PDF  

To batch convert from XPS to an image only PDF, open the Win2PDF
Desktop "Batch Convert" window and set the "Convert To Format" to either
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"PDF - Image Only (monochrome)", "PDF - Image Only (grayscale)", or
"PDF - Image Only (color)".

Win2PDF Desktop - Batch Convert XPS to Image Only PDF

Set the "Convert Files From" location to the folder containing the XPS files
to convert, and set the "Save To" folder to the location for the converted
image only PDF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.49Batch Convert BMP to PDF

Batch Convert BMP to PDF  

To batch convert from BMP to PDF, open the Win2PDF Desktop "Batch
Convert" window and set the "Convert To Format" to "PDF".
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Win2PDF Desktop - Batch Convert BMP to PDF

Set the "Convert Files From" location to the folder containing the BMP files
to convert, and set the "Save To" folder to the location for the converted
PDF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.50Batch Convert BMP to JPG

Batch Convert BMP to JPEG  

To batch convert from BMP to JPG, open the Win2PDF Desktop "Batch
Convert" window and set the "Convert To Format" to either "JPG -
Grayscale" or "JPG - Color".
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Win2PDF Desktop - Batch Convert BMP to JPG

Set the "Convert Files From" location to the folder containing the BMP files
to convert, and set the "Save To" folder to the location for the converted
JPG files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.51Batch Convert BMP to PNG

Batch Convert BMP to PNG  

To batch convert from BMP to PNG, open the Win2PDF Desktop "Batch
Convert" window and set the "Convert To Format" to either "PNG -
Grayscale" or "PNG - Color".
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Win2PDF Desktop - Batch Convert BMP to PNG

Set the "Convert Files From" location to the folder containing the BMP files
to convert, and set the "Save To" folder to the location for the converted
PNG files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.52Batch Convert BMP to TIFF

Batch Convert BMP to TIFF  

To batch convert from BMP to TIFF, open the Win2PDF Desktop "Batch
Convert" window and set the "Convert To Format" to either "TIFF -
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Monochrome", "TIFF - Grayscale", "TIFF - Color", or "TIFF - Color with
transparent background".

Win2PDF Desktop - Batch Convert BMP to TIFF

Set the "Convert Files From" location to the folder containing the BMP files
to convert, and set the "Save To" folder to the location for the converted
TIFF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.53Batch Convert BMP to Text

Batch Convert BMP to TXT  

To batch convert from BMP to Text, open the Win2PDF Desktop "Batch
Convert" window and set the "Convert To Format" to "Text with OCR -
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Formatted", or "Text with OCR - Unformatted".  This requires the "Win2PDF
OCR Add-on" from:
https://www.win2pdf.com/download/download-win2pdf-ocr.html

Win2PDF Desktop - Batch Convert BMP to Text

Set the "Convert Files From" location to the folder containing the BMP files
to convert, and set the "Save To" folder to the location for the converted
text files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.54Batch Convert BMP to Searchable PDF

Batch Convert BMP to Searchable PDF  

To batch convert from BMP to searchable PDF, open the Win2PDF Desktop
"Batch Convert" window and set the "Convert To Format" to either "PDF -
Searchable (OCR)".  This requires the "Win2PDF OCR Add-on" from:
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Win2PDF Desktop - Batch Convert BMP to Searchable PDF

Set the "Convert Files From" location to the folder containing the BMP files
to convert, and set the "Save To" folder to the location for the converted
searchable PDF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.55Batch Convert BMP to Compressed PDF

Batch Convert BMP to Compressed PDF  

To batch convert from BMP to compressed PDF, open the Win2PDF Desktop
"Batch Convert" window and set the "Convert To Format" to either "PDF -
Compressed".
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Win2PDF Desktop - Batch Convert BMP to Compressed PDF

Set the "Convert Files From" location to the folder containing the BMP files
to convert, and set the "Save To" folder to the location for the converted
compressed PDF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.56Batch Convert BMP to Image Only PDF

Batch Convert BMP to Image Only PDF  

To batch convert from BMP to an image only PDF, open the Win2PDF
Desktop "Batch Convert" window and set the "Convert To Format" to either
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"PDF - Image Only (monochrome)", "PDF - Image Only (grayscale)", or
"PDF - Image Only (color)".

Win2PDF Desktop - Batch Convert BMP to Image Only PDF

Set the "Convert Files From" location to the folder containing the BMP files
to convert, and set the "Save To" folder to the location for the converted
image only PDF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.57Batch Convert GIF to PDF

Batch Convert GIF to PDF  

To batch convert from GIF to PDF, open the Win2PDF Desktop "Batch
Convert" window and set the "Convert To Format" to "PDF".

https://www.win2pdf.com/trial.html


Win2PDF380

© 2023 Dane Prairie Systems, LLC

Win2PDF Desktop - Batch Convert GIF to PDF

Set the "Convert Files From" location to the folder containing the GIF files
to convert, and set the "Save To" folder to the location for the converted
PDF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.58Batch Convert GIF to JPG

Batch Convert GIF to JPEG  

To batch convert from GIF to JPG, open the Win2PDF Desktop "Batch
Convert" window and set the "Convert To Format" to either "JPG -
Grayscale" or "JPG - Color".
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Win2PDF Desktop - Batch Convert GIF to JPG

Set the "Convert Files From" location to the folder containing the GIF files
to convert, and set the "Save To" folder to the location for the converted
JPG files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.59Batch Convert GIF to PNG

Batch Convert GIF to PNG  

To batch convert from GIF to PNG, open the Win2PDF Desktop "Batch
Convert" window and set the "Convert To Format" to either "PNG -
Grayscale" or "PNG - Color".
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Win2PDF Desktop - Batch Convert GIF to PNG

Set the "Convert Files From" location to the folder containing the GIF files
to convert, and set the "Save To" folder to the location for the converted
PNG files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.60Batch Convert GIF to TIFF

Batch Convert GIF to TIFF  

To batch convert from GIF to TIFF, open the Win2PDF Desktop "Batch
Convert" window and set the "Convert To Format" to either "TIFF -
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Monochrome", "TIFF - Grayscale", "TIFF - Color", or "TIFF - Color with
transparent background".

Win2PDF Desktop - Batch Convert GIF to TIFF

Set the "Convert Files From" location to the folder containing the GIF files
to convert, and set the "Save To" folder to the location for the converted
TIFF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.61Batch Convert GIF to Text

Batch Convert GIF to TXT  

To batch convert from GIF to Text, open the Win2PDF Desktop "Batch
Convert" window and set the "Convert To Format" to "Text with OCR -
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Formatted", or "Text with OCR - Unformatted".  This requires the "Win2PDF
OCR Add-on" from:
https://www.win2pdf.com/download/download-win2pdf-ocr.html

Win2PDF Desktop - Batch Convert GIF to Text

Set the "Convert Files From" location to the folder containing the GIF files
to convert, and set the "Save To" folder to the location for the converted
text files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.62Batch Convert GIF to Searchable PDF

Batch Convert GIF to Searchable PDF  

To batch convert from GIF to searchable PDF, open the Win2PDF Desktop
"Batch Convert" window and set the "Convert To Format" to either "PDF -
Searchable (OCR)".  This requires the "Win2PDF OCR Add-on" from:
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Win2PDF Desktop - Batch Convert GIF to Searchable PDF

Set the "Convert Files From" location to the folder containing the GIF files
to convert, and set the "Save To" folder to the location for the converted
searchable PDF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.

https://www.win2pdf.com/download/download-win2pdf-ocr.html
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.63Batch Convert GIF to Compressed PDF

Batch Convert GIF to Compressed PDF  

To batch convert from GIF to compressed PDF, open the Win2PDF Desktop
"Batch Convert" window and set the "Convert To Format" to either "PDF -
Compressed".
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Win2PDF Desktop - Batch Convert GIF to Compressed PDF

Set the "Convert Files From" location to the folder containing the GIF files
to convert, and set the "Save To" folder to the location for the converted
compressed PDF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.64Batch Convert GIF to Image Only PDF

Batch Convert GIF to Image Only PDF  

To batch convert from GIF to an image only PDF, open the Win2PDF
Desktop "Batch Convert" window and set the "Convert To Format" to either
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"PDF - Image Only (monochrome)", "PDF - Image Only (grayscale)", or
"PDF - Image Only (color)".

Win2PDF Desktop - Batch Convert GIF to Image Only PDF

Set the "Convert Files From" location to the folder containing the GIF files
to convert, and set the "Save To" folder to the location for the converted
image only PDF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.65Batch Convert DOCX to PDF

Batch Convert DOCX to PDF  

To batch convert from a Microsoft Word DOCX to PDF, open the Win2PDF
Desktop "Batch Convert" window and set the "Convert To Format" to
"PDF".
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Win2PDF Desktop - Batch Convert DOCX to PDF

Set the "Convert Files From" location to the folder containing the DOCX files
to convert, and set the "Save To" folder to the location for the converted
PDF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.66Batch Convert DOCX to JPG

Batch Convert DOCX to JPEG  

To batch convert from a Microsoft Word DOCX to JPG, open the Win2PDF
Desktop "Batch Convert" window and set the "Convert To Format" to either
"JPG - Grayscale" or "JPG - Color".
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Win2PDF Desktop - Batch Convert DOCX to JPG

Set the "Convert Files From" location to the folder containing the DOCX files
to convert, and set the "Save To" folder to the location for the converted
JPG files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.67Batch Convert DOCX to PNG

Batch Convert DOCX to PNG  

To batch convert from a Microsoft Word DOCX to PNG, open the Win2PDF
Desktop "Batch Convert" window and set the "Convert To Format" to either
"PNG - Grayscale" or "PNG - Color".
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Win2PDF Desktop - Batch Convert DOCX to PNG

Set the "Convert Files From" location to the folder containing the DOCX files
to convert, and set the "Save To" folder to the location for the converted
PNG files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.68Batch Convert DOCX to TIFF

Batch Convert DOCX to TIFF  

To batch convert from a Microsoft Word DOCX to TIFF, open the Win2PDF
Desktop "Batch Convert" window and set the "Convert To Format" to either
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"TIFF - Monochrome", "TIFF - Grayscale", "TIFF - Color", or "TIFF - Color
with transparent background".

Win2PDF Desktop - Batch Convert DOCX to TIFF

Set the "Convert Files From" location to the folder containing the DOCX files
to convert, and set the "Save To" folder to the location for the converted
TIFF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.69Batch Convert DOCX to Text

Batch Convert DOCX to TXT  

To batch convert from a Microsoft Word DOCX to Text, open the Win2PDF
Desktop "Batch Convert" window and set the "Convert To Format" to "Text
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with OCR - Formatted", or "Text with OCR - Unformatted".  This requires
the "Win2PDF OCR Add-on" from:
https://www.win2pdf.com/download/download-win2pdf-ocr.html

Win2PDF Desktop - Batch Convert DOCX to Text

Set the "Convert Files From" location to the folder containing the DOCX files
to convert, and set the "Save To" folder to the location for the converted
text files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.70Batch Convert DOCX to Searchable PDF

Batch Convert DOCX to Searchable PDF  

To batch convert from a Microsoft Word DOCX to searchable PDF, open the
Win2PDF Desktop "Batch Convert" window and set the "Convert To
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Format" to either "PDF - Searchable (OCR)".  This requires the "Win2PDF
OCR Add-on" from:
https://www.win2pdf.com/download/download-win2pdf-ocr.html

Win2PDF Desktop - Batch Convert DOCX to Searchable PDF

Set the "Convert Files From" location to the folder containing the DOCX files
to convert, and set the "Save To" folder to the location for the converted
searchable PDF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.71Batch Convert DOCX to Compressed PDF

Batch Convert DOCX to Compressed PDF  

To batch convert from a Microsoft Word DOCX to compressed PDF, open
the Win2PDF Desktop "Batch Convert" window and set the "Convert To
Format" to either "PDF - Compressed".
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Win2PDF Desktop - Batch Convert DOCX to Compressed PDF

Set the "Convert Files From" location to the folder containing the DOCX files
to convert, and set the "Save To" folder to the location for the converted
compressed PDF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.72Batch Convert DOCX to Image Only PDF

Batch Convert DOCX to Image Only PDF  

To batch convert from a Microsoft Word DOCX to an image only PDF, open
the Win2PDF Desktop "Batch Convert" window and set the "Convert To
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Format" to either "PDF - Image Only (monochrome)", "PDF - Image Only
(grayscale)", or "PDF - Image Only (color)".

Win2PDF Desktop - Batch Convert DOCX to Image Only PDF

Set the "Convert Files From" location to the folder containing the DOCX files
to convert, and set the "Save To" folder to the location for the converted
image only PDF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.73Batch Convert DOCX to RTF

Batch Convert DOCX to RTF  

To batch convert from Microsoft Word DOCX to a Rich Text Format RTF file,
open the Win2PDF Desktop "Batch Convert" window and set the "Convert
To Format" to "RTF - Microsoft Rich Text Format Document".
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Win2PDF Desktop - Batch Convert DOCX to RTF

Set the "Convert Files From" location to the folder containing the DOCX files
to convert, and set the "Save To" folder to the location for the converted
RTF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.74Batch Convert DOCX to ODT

Batch Convert DOCX to ODT  

To batch convert from Microsoft Word DOCX to an OpenDocument Text
ODT file, open the Win2PDF Desktop "Batch Convert" window and set the
"Convert To Format" to "ODT - OpenDocument Text".
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Win2PDF Desktop - Batch Convert DOCX to ODT

Set the "Convert Files From" location to the folder containing the DOCX files
to convert, and set the "Save To" folder to the location for the converted
ODT files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.75Batch Convert DOCX to XPS

Batch Convert DOCX to XPS  

To batch convert from Microsoft Word DOCX to an XML Paper Specification
XPS file, open the Win2PDF Desktop "Batch Convert" window and set the
"Convert To Format" to "XPS - XML Paper Specification".
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Win2PDF Desktop - Batch Convert DOCX to XPS

Set the "Convert Files From" location to the folder containing the DOCX files
to convert, and set the "Save To" folder to the location for the converted
XPS files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.76Batch Convert DOC to PDF

Batch Convert DOC to PDF  

To batch convert from a Microsoft Word DOC to PDF, open the Win2PDF
Desktop "Batch Convert" window and set the "Convert To Format" to
"PDF".

https://www.win2pdf.com/trial.html


Win2PDF418

© 2023 Dane Prairie Systems, LLC

Win2PDF Desktop - Batch Convert DOC to PDF

Set the "Convert Files From" location to the folder containing the DOC files
to convert, and set the "Save To" folder to the location for the converted
PDF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.77Batch Convert DOC to JPG

Batch Convert DOC to JPEG  

To batch convert from a Microsoft Word DOC to JPG, open the Win2PDF
Desktop "Batch Convert" window and set the "Convert To Format" to either
"JPG - Grayscale" or "JPG - Color".
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Win2PDF Desktop - Batch Convert DOC to JPG

Set the "Convert Files From" location to the folder containing the DOC files
to convert, and set the "Save To" folder to the location for the converted
JPG files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.78Batch Convert DOC to PNG

Batch Convert DOC to PNG  

To batch convert from a Microsoft Word DOC to PNG, open the Win2PDF
Desktop "Batch Convert" window and set the "Convert To Format" to either
"PNG - Grayscale" or "PNG - Color".
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Win2PDF Desktop - Batch Convert DOC to PNG

Set the "Convert Files From" location to the folder containing the DOC files
to convert, and set the "Save To" folder to the location for the converted
PNG files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.



How To Articles 423

© 2023 Dane Prairie Systems, LLC

Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.79Batch Convert DOC to TIFF

Batch Convert DOC to TIFF  

To batch convert from a Microsoft Word DOC to TIFF, open the Win2PDF
Desktop "Batch Convert" window and set the "Convert To Format" to either
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"TIFF - Monochrome", "TIFF - Grayscale", "TIFF - Color", or "TIFF - Color
with transparent background".

Win2PDF Desktop - Batch Convert DOC to TIFF

Set the "Convert Files From" location to the folder containing the DOC files
to convert, and set the "Save To" folder to the location for the converted
TIFF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.80Batch Convert DOC to Text

Batch Convert DOC to TXT  

To batch convert from a Microsoft Word DOC to Text, open the Win2PDF
Desktop "Batch Convert" window and set the "Convert To Format" to "Text
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with OCR - Formatted", or "Text with OCR - Unformatted".  This requires
the "Win2PDF OCR Add-on" from:
https://www.win2pdf.com/download/download-win2pdf-ocr.html

Win2PDF Desktop - Batch Convert DOC to Text

Set the "Convert Files From" location to the folder containing the DOC files
to convert, and set the "Save To" folder to the location for the converted
text files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.81Batch Convert DOC to Searchable PDF

Batch Convert DOC to Searchable PDF  

To batch convert from a Microsoft Word DOC to searchable PDF, open the
Win2PDF Desktop "Batch Convert" window and set the "Convert To
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Format" to either "PDF - Searchable (OCR)".  This requires the "Win2PDF
OCR Add-on" from:
https://www.win2pdf.com/download/download-win2pdf-ocr.html

Win2PDF Desktop - Batch Convert DOC to Searchable PDF

Set the "Convert Files From" location to the folder containing the DOC files
to convert, and set the "Save To" folder to the location for the converted
searchable PDF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.

https://www.win2pdf.com/download/download-win2pdf-ocr.html


How To Articles 429

© 2023 Dane Prairie Systems, LLC

Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.82Batch Convert DOC to Compressed PDF

Batch Convert DOC to Compressed PDF  

To batch convert from a Microsoft Word DOC to compressed PDF, open the
Win2PDF Desktop "Batch Convert" window and set the "Convert To
Format" to either "PDF - Compressed".
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Win2PDF Desktop - Batch Convert DOC to Compressed PDF

Set the "Convert Files From" location to the folder containing the DOC files
to convert, and set the "Save To" folder to the location for the converted
compressed PDF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.83Batch Convert DOC to Image Only PDF

Batch Convert DOC to Image Only PDF  

To batch convert from a Microsoft Word DOC to an image only PDF, open
the Win2PDF Desktop "Batch Convert" window and set the "Convert To
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Format" to either "PDF - Image Only (monochrome)", "PDF - Image Only
(grayscale)", or "PDF - Image Only (color)".

Win2PDF Desktop - Batch Convert DOC to Image Only PDF

Set the "Convert Files From" location to the folder containing the DOC files
to convert, and set the "Save To" folder to the location for the converted
image only PDF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.84Batch Convert DOC to DOCX

Batch Convert DOC to DOCX  

To batch convert from a Microsoft Word DOC to a DOCX file, open the
Win2PDF Desktop "Batch Convert" window and set the "Convert To
Format" to "DOCX - Microsoft Word Document".
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Win2PDF Desktop - Batch Convert DOC to DOCX

Set the "Convert Files From" location to the folder containing the DOC files
to convert, and set the "Save To" folder to the location for the converted
DOCX files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.85Batch Convert DOC to RTF

Batch Convert DOC to RTF  

To batch convert from Microsoft Word DOC to a Rich Text Format RTF file,
open the Win2PDF Desktop "Batch Convert" window and set the "Convert
To Format" to "RTF - Microsoft Rich Text Format Document".
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Win2PDF Desktop - Batch Convert DOC to RTF

Set the "Convert Files From" location to the folder containing the DOC files
to convert, and set the "Save To" folder to the location for the converted
RTF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.86Batch Convert DOC to ODT

Batch Convert DOC to ODT  

To batch convert from Microsoft Word DOC to an OpenDocument Text ODT
file, open the Win2PDF Desktop "Batch Convert" window and set the
"Convert To Format" to "ODT - OpenDocument Text".

https://www.win2pdf.com/trial.html


Win2PDF438

© 2023 Dane Prairie Systems, LLC

Win2PDF Desktop - Batch Convert DOC to ODT

Set the "Convert Files From" location to the folder containing the DOC files
to convert, and set the "Save To" folder to the location for the converted
ODT files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.87Batch Convert DOC to XPS

Batch Convert DOC to XPS  

To batch convert from Microsoft Word DOC to an XML Paper Specification
XPS file, open the Win2PDF Desktop "Batch Convert" window and set the
"Convert To Format" to "XPS - XML Paper Specification".
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Win2PDF Desktop - Batch Convert DOC to XPS

Set the "Convert Files From" location to the folder containing the DOC files
to convert, and set the "Save To" folder to the location for the converted
XPS files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.88Batch Convert RTF to PDF

Batch Convert RTF to PDF  

To batch convert from a Rich Text Format RTF to PDF, open the Win2PDF
Desktop "Batch Convert" window and set the "Convert To Format" to
"PDF".
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Win2PDF Desktop - Batch Convert RTF to PDF

Set the "Convert Files From" location to the folder containing the RTF files
to convert, and set the "Save To" folder to the location for the converted
PDF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.89Batch Convert RTF to JPG

Batch Convert RTF to JPEG  

To batch convert from a Rich Text Format RTF to JPG, open the Win2PDF
Desktop "Batch Convert" window and set the "Convert To Format" to either
"JPG - Grayscale" or "JPG - Color".
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Win2PDF Desktop - Batch Convert RTF to JPG

Set the "Convert Files From" location to the folder containing the RTF files
to convert, and set the "Save To" folder to the location for the converted
JPG files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.90Batch Convert RTF to PNG

Batch Convert RTF to PNG  

To batch convert from a Rich Text Format RTF to PNG, open the Win2PDF
Desktop "Batch Convert" window and set the "Convert To Format" to either
"PNG - Grayscale" or "PNG - Color".
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Win2PDF Desktop - Batch Convert RTF to PNG

Set the "Convert Files From" location to the folder containing the RTF files
to convert, and set the "Save To" folder to the location for the converted
PNG files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.91Batch Convert RTF to TIFF

Batch Convert RTF to TIFF  

To batch convert from a Rich Text Format RTF to TIFF, open the Win2PDF
Desktop "Batch Convert" window and set the "Convert To Format" to either

https://www.win2pdf.com/trial.html


Win2PDF448

© 2023 Dane Prairie Systems, LLC

"TIFF - Monochrome", "TIFF - Grayscale", "TIFF - Color", or "TIFF - Color
with transparent background".

Win2PDF Desktop - Batch Convert RTF to TIFF

Set the "Convert Files From" location to the folder containing the RTF files
to convert, and set the "Save To" folder to the location for the converted
TIFF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.



How To Articles 449

© 2023 Dane Prairie Systems, LLC

Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.92Batch Convert RTF to Text

Batch Convert RTF to TXT  

To batch convert from a Rich Text Format RTF to Text, open the Win2PDF
Desktop "Batch Convert" window and set the "Convert To Format" to "Text
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with OCR - Formatted", or "Text with OCR - Unformatted".  This requires
the "Win2PDF OCR Add-on" from:
https://www.win2pdf.com/download/download-win2pdf-ocr.html

Win2PDF Desktop - Batch Convert RTF to Text

Set the "Convert Files From" location to the folder containing the RTF files
to convert, and set the "Save To" folder to the location for the converted
text files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.93Batch Convert RTF to Searchable PDF

Batch Convert RTF to Searchable PDF  

To batch convert from a Rich Text Format RTF to searchable PDF, open the
Win2PDF Desktop "Batch Convert" window and set the "Convert To
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Format" to either "PDF - Searchable (OCR)".  This requires the "Win2PDF
OCR Add-on" from:
https://www.win2pdf.com/download/download-win2pdf-ocr.html

Win2PDF Desktop - Batch Convert RTF to Searchable PDF

Set the "Convert Files From" location to the folder containing the RTF files
to convert, and set the "Save To" folder to the location for the converted
searchable PDF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.94Batch Convert RTF to Compressed PDF

Batch Convert RTF to Compressed PDF  

To batch convert from a Rich Text Format RTF to compressed PDF, open
the Win2PDF Desktop "Batch Convert" window and set the "Convert To
Format" to either "PDF - Compressed".
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Win2PDF Desktop - Batch Convert RTR to Compressed PDF

Set the "Convert Files From" location to the folder containing the RTF files
to convert, and set the "Save To" folder to the location for the converted
compressed PDF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.95Batch Convert RTF to Image Only PDF

Batch Convert RTF to Image Only PDF  

To batch convert from a Rich Text Format RTF to an image only PDF, open
the Win2PDF Desktop "Batch Convert" window and set the "Convert To
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Format" to either "PDF - Image Only (monochrome)", "PDF - Image Only
(grayscale)", or "PDF - Image Only (color)".

Win2PDF Desktop - Batch Convert RTF to Image Only PDF

Set the "Convert Files From" location to the folder containing the RTF files
to convert, and set the "Save To" folder to the location for the converted
image only PDF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.96Batch Convert RTF to DOCX

Batch Convert RTF to DOCX  

To batch convert from a Rich Text Format RTF to a DOCX file, open the
Win2PDF Desktop "Batch Convert" window and set the "Convert To
Format" to "DOCX - Microsoft Word Document".
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Win2PDF Desktop - Batch Convert RTF to DOCX

Set the "Convert Files From" location to the folder containing the RTF files
to convert, and set the "Save To" folder to the location for the converted
DOCX files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.97Batch Convert RTF to ODT

Batch Convert RTF to ODT  

To batch convert from Rich Text Format RTF to an OpenDocument Text
ODT file, open the Win2PDF Desktop "Batch Convert" window and set the
"Convert To Format" to "ODT - OpenDocument Text".
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Win2PDF Desktop - Batch Convert RTF to ODT

Set the "Convert Files From" location to the folder containing the RTF files
to convert, and set the "Save To" folder to the location for the converted
ODT files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.98Batch Convert RTF to XPS

Batch Convert RTF to XPS  

To batch convert from Rich Text Format RTF to an XML Paper Specification
XPS file, open the Win2PDF Desktop "Batch Convert" window and set the
"Convert To Format" to "XPS - XML Paper Specification".
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Win2PDF Desktop - Batch Convert RTF to XPS

Set the "Convert Files From" location to the folder containing the RTF files
to convert, and set the "Save To" folder to the location for the converted
XPS files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.99Batch Convert ODT to PDF

Batch Convert ODT to PDF  

To batch convert from an OpenDocument Text ODT to PDF, open the
Win2PDF Desktop "Batch Convert" window and set the "Convert To
Format" to "PDF".
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Win2PDF Desktop - Batch Convert ODT to PDF

Set the "Convert Files From" location to the folder containing the ODT files
to convert, and set the "Save To" folder to the location for the converted
PDF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.100Batch Convert ODT to JPG

Batch Convert ODT to JPEG  

To batch convert from an OpenDocument Text ODT to JPG, open the
Win2PDF Desktop "Batch Convert" window and set the "Convert To
Format" to either "JPG - Grayscale" or "JPG - Color".
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Win2PDF Desktop - Batch Convert ODT to JPG

Set the "Convert Files From" location to the folder containing the ODT files
to convert, and set the "Save To" folder to the location for the converted
JPG files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.



How To Articles 467

© 2023 Dane Prairie Systems, LLC

Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.101Batch Convert ODT to PNG

Batch Convert ODT to PNG  

To batch convert from an OpenDocument Text ODT to PNG, open the
Win2PDF Desktop "Batch Convert" window and set the "Convert To
Format" to either "PNG - Grayscale" or "PNG - Color".
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Win2PDF Desktop - Batch Convert ODT to PNG

Set the "Convert Files From" location to the folder containing the ODT files
to convert, and set the "Save To" folder to the location for the converted
PNG files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.102Batch Convert ODT to TIFF

Batch Convert ODT to TIFF  

To batch convert from an OpenDocument Text ODT to TIFF, open the
Win2PDF Desktop "Batch Convert" window and set the "Convert To
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Format" to either "TIFF - Monochrome", "TIFF - Grayscale", "TIFF - Color",
or "TIFF - Color with transparent background".

Win2PDF Desktop - Batch Convert ODT to TIFF

Set the "Convert Files From" location to the folder containing the ODT files
to convert, and set the "Save To" folder to the location for the converted
TIFF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.103Batch Convert ODT to Text

Batch Convert ODT to TXT  

To batch convert from an OpenDocument Text ODT to Text, open the
Win2PDF Desktop "Batch Convert" window and set the "Convert To
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Format" to "Text with OCR - Formatted", or "Text with OCR - Unformatted".
 This requires the "Win2PDF OCR Add-on" from:
https://www.win2pdf.com/download/download-win2pdf-ocr.html

Win2PDF Desktop - Batch Convert ODT to Text

Set the "Convert Files From" location to the folder containing the ODT files
to convert, and set the "Save To" folder to the location for the converted
text files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.104Batch Convert ODT to Searchable PDF

Batch Convert ODT to Searchable PDF  

To batch convert from an OpenDocument Text ODT to searchable PDF,
open the Win2PDF Desktop "Batch Convert" window and set the "Convert
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To Format" to either "PDF - Searchable (OCR)".  This requires the
"Win2PDF OCR Add-on" from:
https://www.win2pdf.com/download/download-win2pdf-ocr.html

Win2PDF Desktop - Batch Convert ODT to Searchable PDF

Set the "Convert Files From" location to the folder containing the ODT files
to convert, and set the "Save To" folder to the location for the converted
searchable PDF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.105Batch Convert ODT to Compressed PDF

Batch Convert ODT to Compressed PDF  

To batch convert from an OpenDocument Text ODT to compressed PDF,
open the Win2PDF Desktop "Batch Convert" window and set the "Convert
To Format" to either "PDF - Compressed".
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Win2PDF Desktop - Batch Convert ODT to Compressed PDF

Set the "Convert Files From" location to the folder containing the ODT files
to convert, and set the "Save To" folder to the location for the converted
compressed PDF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.106Batch Convert ODT to Image Only PDF

Batch Convert ODT to Image Only PDF  

To batch convert from an OpenDocument Text ODT to an image only PDF,
open the Win2PDF Desktop "Batch Convert" window and set the "Convert
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To Format" to either "PDF - Image Only (monochrome)", "PDF - Image
Only (grayscale)", or "PDF - Image Only (color)".

Win2PDF Desktop - Batch Convert ODT to Image Only PDF

Set the "Convert Files From" location to the folder containing the ODT files
to convert, and set the "Save To" folder to the location for the converted
image only PDF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.107Batch Convert ODT to DOCX

Batch Convert ODT to DOCX  

To batch convert from an OpenDocument Text ODT to a DOCX file, open
the Win2PDF Desktop "Batch Convert" window and set the "Convert To
Format" to "DOCX - Microsoft Word Document".

https://www.win2pdf.com/trial.html
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Win2PDF Desktop - Batch Convert ODT to DOCX

Set the "Convert Files From" location to the folder containing the ODT files
to convert, and set the "Save To" folder to the location for the converted
DOCX files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.



How To Articles 481

© 2023 Dane Prairie Systems, LLC

Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.108Batch Convert ODT to RTF

Batch Convert ODT to RTF  

To batch convert from an OpenDocument Text ODT to a Rich Text Format
RTF file, open the Win2PDF Desktop "Batch Convert" window and set the
"Convert To Format" to "RTF - Microsoft Rich Text Format Document".

https://www.win2pdf.com/trial.html
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Win2PDF Desktop - Batch Convert ODT to RTF

Set the "Convert Files From" location to the folder containing the ODT files
to convert, and set the "Save To" folder to the location for the converted
RTF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.109Batch Convert ODT to XPS

Batch Convert ODT to XPS  

To batch convert from an OpenDocument Text ODT to an XML Paper
Specification XPS file, open the Win2PDF Desktop "Batch Convert" window
and set the "Convert To Format" to "XPS - XML Paper Specification".

https://www.win2pdf.com/trial.html
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Win2PDF Desktop - Batch Convert ODT to XPS

Set the "Convert Files From" location to the folder containing the ODT files
to convert, and set the "Save To" folder to the location for the converted
XPS files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.110Batch Convert Text to PDF

Batch Convert TXT to PDF  

To batch convert from Text to PDF, open the Win2PDF Desktop "Batch
Convert" window and set the "Convert To Format" to "PDF".

https://www.win2pdf.com/trial.html
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Win2PDF Desktop - Batch Convert TXT to PDF

Set the "Convert Files From" location to the folder containing the TXT files
to convert, and set the "Save To" folder to the location for the converted
PDF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.111Batch Convert Text to JPG

Batch Convert TXT to JPEG  

To batch convert from Text to JPG, open the Win2PDF Desktop "Batch
Convert" window and set the "Convert To Format" to either "JPG -
Grayscale" or "JPG - Color".

https://www.win2pdf.com/trial.html
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Win2PDF Desktop - Batch Convert TXT to JPG

Set the "Convert Files From" location to the folder containing the TXT files
to convert, and set the "Save To" folder to the location for the converted
JPG files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.112Batch Convert Text to PNG

Batch Convert TXT to PNG  

To batch convert from Text to PNG, open the Win2PDF Desktop "Batch
Convert" window and set the "Convert To Format" to either "PNG -
Grayscale" or "PNG - Color".

https://www.win2pdf.com/trial.html
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Win2PDF Desktop - Batch Convert TXT to PNG

Set the "Convert Files From" location to the folder containing the TXT files
to convert, and set the "Save To" folder to the location for the converted
PNG files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.113Batch Convert Text to TIFF

Batch Convert TXT to TIFF  

To batch convert from Text to TIFF, open the Win2PDF Desktop "Batch
Convert" window and set the "Convert To Format" to either "TIFF -

https://www.win2pdf.com/trial.html
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Monochrome", "TIFF - Grayscale", "TIFF - Color", or "TIFF - Color with
transparent background".

Win2PDF Desktop - Batch Convert TXT to TIFF

Set the "Convert Files From" location to the folder containing the TXT files
to convert, and set the "Save To" folder to the location for the converted
TIFF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.114Batch Convert Text to Searchable PDF

Batch Convert TXT to Searchable PDF  

To batch convert from Text to searchable PDF, open the Win2PDF Desktop
"Batch Convert" window and set the "Convert To Format" to either "PDF -
Searchable (OCR)".  This requires the "Win2PDF OCR Add-on" from:

https://www.win2pdf.com/trial.html
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https://www.win2pdf.com/download/download-win2pdf-ocr.html

Win2PDF Desktop - Batch Convert TXT to Searchable PDF

Set the "Convert Files From" location to the folder containing the TXT files
to convert, and set the "Save To" folder to the location for the converted
searchable PDF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.

https://www.win2pdf.com/download/download-win2pdf-ocr.html
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.115Batch Convert Text to Compressed PDF

Batch Convert TXT to Compressed PDF  

To batch convert from a Text to compressed PDF, open the Win2PDF
Desktop "Batch Convert" window and set the "Convert To Format" to either
"PDF - Compressed".

https://www.win2pdf.com/trial.html
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Win2PDF Desktop - Batch Convert TXT to Compressed PDF

Set the "Convert Files From" location to the folder containing the TXT files
to convert, and set the "Save To" folder to the location for the converted
compressed PDF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.116Batch Convert Text to Image Only PDF

Batch Convert TXT to Image Only PDF  

To batch convert from Text to an image only PDF, open the Win2PDF
Desktop "Batch Convert" window and set the "Convert To Format" to either

https://www.win2pdf.com/trial.html
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"PDF - Image Only (monochrome)", "PDF - Image Only (grayscale)", or
"PDF - Image Only (color)".

Win2PDF Desktop - Batch Convert TXT to Image Only PDF

Set the "Convert Files From" location to the folder containing the TXT files
to convert, and set the "Save To" folder to the location for the converted
image only PDF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.117Batch Convert Text to DOCX

Batch Convert TXT to DOCX  

To batch convert from Text to a DOCX file, open the Win2PDF Desktop
"Batch Convert" window and set the "Convert To Format" to "DOCX -
Microsoft Word Document".

https://www.win2pdf.com/trial.html
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Win2PDF Desktop - Batch Convert TXT to DOCX

Set the "Convert Files From" location to the folder containing the TXT files
to convert, and set the "Save To" folder to the location for the converted
DOCX files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.118Batch Convert Text to RTF

Batch Convert TXT to RTF  

To batch convert from Text to a Rich Text Format RTF file, open the
Win2PDF Desktop "Batch Convert" window and set the "Convert To
Format" to "RTF - Microsoft Rich Text Format Document".

https://www.win2pdf.com/trial.html
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Win2PDF Desktop - Batch Convert TXT to RTF

Set the "Convert Files From" location to the folder containing the TXT files
to convert, and set the "Save To" folder to the location for the converted
RTF files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.119Batch Convert Text to ODT

Batch Convert TXT to ODT  

To batch convert from Text to an OpenDocument Text ODT file, open the
Win2PDF Desktop "Batch Convert" window and set the "Convert To
Format" to "ODT - OpenDocument Text".

https://www.win2pdf.com/trial.html
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Win2PDF Desktop - Batch Convert TXT to ODT

Set the "Convert Files From" location to the folder containing the TXT files
to convert, and set the "Save To" folder to the location for the converted
ODT files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.35.120Batch Convert Text to XPS

Batch Convert TXT to XPS  

To batch convert from Text to an XML Paper Specification XPS file, open the
Win2PDF Desktop "Batch Convert" window and set the "Convert To
Format" to "XPS - XML Paper Specification".

https://www.win2pdf.com/trial.html
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Win2PDF Desktop - Batch Convert TXT to XPS

Set the "Convert Files From" location to the folder containing the TXT files
to convert, and set the "Save To" folder to the location for the converted
XPS files.  These locations must be different.

Click the "Convert" button to start the conversion process.  Depending on
the number of files in the "Convert Files From" folder, it can take a long
time to convert all files.  The "Cancel" button remains active during the
conversion process, and allows you to cancel the batch convert.
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Win2PDF Desktop - Batch Converting

After the conversion is complete, a summary of the conversion is displayed.

Win2PDF Desktop - Batch
Convert Complete

You can also batch convert folders of files from one format to another using
the BATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.36 How To Watch Folder and Convert

Win2PDF Pro Terminal Server Edition can continuously watch a local or
shared folder and automatically convert all files in one of the following input
formats:

· PDF

https://www.win2pdf.com/trial.html
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· DOCX
· DOC
· RTF
· ODT
· TXT
· HTML
· XPS
· TIFF
· JPG
· PNG
· BMP
· GIF

It can convert them to one of the following output formats:

· PDF
· PDF Image Only - monochrome
· PDF Image Only - grayscale
· PDF Image Only - color
· PDF - compressed
· PDF - searchable (OCR)
· DOCX - Microsoft Word
· RTF - Rich Text Format
· ODT - OpenDocument Text
· Text - formatted
· Text - unformatted
· Text - formatted after making searchable (OCR)
· Text - unformatted after making searchable (OCR)
· JPEG - grayscale
· JPEG - color
· TIFF - monochrome
· TIFF - grayscale
· TIFF - color
· TIFF - color with transparent background 
· PNG - Grayscale
· PNG - Grayscale with transparent background
· PNG - Color
· PNG - Color with transparent background
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Win2PDF Desktop - Watch Folder Formats

You can watch a folder and convert files from one format to another by
opening the "Watch Folder and Convert..." window from the Win2PDF
Desktop "File" menu:

Win2PDF Desktop - Watch
Folder Menu
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Win2PDF Desktop - Watch Folder and Convert

The "Convert Files From" setting allows you to configure the location of the
files to convert. Any files in this folder that are supported will be converted
to the "Convert To Format". You can type in the location, or click "Change
Folder" to browse to the location.

The "Move After Conversion" is enabled, the following folder setting allows
you to configure the location of the files after conversion. It must be a
different location from the "Convert Files From" folder. You can type in the
location, or click "Change Folder" to browse to the location.  If you don't
want to save the files after they are converted, set this to "Delete After
Conversion".
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Win2PDF Desktop - Watch Folder Delete After Conversion

The "Save To" folder setting allows you to configure the location of the
converted files. It must be a different location from the "Convert Files
From" folder. You can type in the location, or click "Change Folder" to
browse to the location.

The "Convert" button will start monitoring the watch folder and converting
any supported files to the selected "Convert To Format". Any files that
cannot be converted are automatically skipped.  The "Stop" button remains
active while watching the folder, and allows you to cancel the watch folder
process.  If an error occurs when converting to the selected format, the file
is renamed with a ".err" extension and an error message is displayed
before the "Watching..." status line.
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Win2PDF Desktop - Watching Folder

You can also watch and convert a folder of files from one format to another
using the WATCHCONVERT command line.

This feature requires a licensed version of Win2PDF Pro Terminal Server
Edition. Contact us for a time limited evaluation license.

4.3.37 How to Rename PDF Files

Win2PDF Pro can rename folders of existing PDF files using the contents of
the PDF file such as account numbers, invoice numbers, or client names. 
You can rename based on combinations of document information, text, or
user defined fields based on the content of the document. To rename a
folder of PDF files, open one of the PDFs in the folder using the Win2PDF
Desktop App and select "Auto-Rename" from the "Auto-Name" menu:

https://www.win2pdf.com/trial.html
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Win2PDF Desktop Auto-Rename

A configuration window shows the currently selected folder for PDFs to
rename, rename options, and a preview of the renamed files in the folder.
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Win2PDF Desktop Auto-rename Configuration

All PDFs in the selected folder will be renamed. If you want to exclude a file
from the rename operation, uncheck the box next to the file name.

You can select up to 5 different options which can be combined to build the
renamed file name.  The rename options can include:
Auto-Rename: Original File Name
Auto-Rename: Content Field
Auto-Rename: Search Field
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Auto-Rename: Text
Auto-Rename: Document Creation Date
Auto-Rename: Document Modified Date
Auto-Rename: Document Title
Auto-Rename: Document Author
Auto-Rename: Document Subject
Auto-Rename: Document Keywords
Auto-Rename: User Name
Auto-Rename: Computer Name
Auto-Rename: Date
Auto-Rename: Time
Auto-Rename: Year
Auto-Rename: Month
Auto-Rename: Hour
Auto-Rename: Minute
Auto-Rename: Second
Auto-Rename: Millisecond
Auto-Rename: User Defined

You can add additional rename options by clicking the "Add" button. You
can configure the separator between rename options to be "none", a space
character, or a special character (-,+,_,#,*,^,!,~). 

The rename preview at the bottom of the window automatically updates
when you change any of the rename options. 

If you want to customize the formatting or order of the standard rename
options or use more than 5 options, you can use the Auto-Rename: User
Defined setting.
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When the "Renamed file name" preview looks correct, click the "Rename"
button to rename all files in the folder. A confirmation window will display
the number of files that were renamed.

Clicking the "Undo" button will reverse the rename operation.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

4.3.37.1 Auto-Rename: Original File Name

Selecting the "Original File Name" as a rename option uses the original file
name without the ".PDF" extension.

https://www.win2pdf.com/trial.html
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Win2PDF Auto-Rename Original File Name

This can be useful when combined with other rename options to build a
renamed file that includes part of the original file name.

4.3.37.2 Auto-Rename: Content Field

If you would like to rename a PDF based on text in a PDF at a specific
location, choose "Define Auto-Name Content Field" from the "Auto-Name"
menu and draw a rectangle around the desired text to be used in the
renamed file.
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The following screen cast shows how this can be defined.

How to set the Content Name Field

After the content field is defined, selecting "content field" as a rename
option will use the content at the defined location for each PDF in the
renamed file name. The preview window will be updated to show the
renamed file with the content field.
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Win2PDF Auto-Rename Content Field

4.3.37.3 Auto-Rename: Search Field

If you would like to rename a PDF based on text that always occurs after a
search word, Choose "Define Auto-Name Search Field" from the "Auto-
Name" menu. Type the search word into the window, and the field following
the search word is displayed under "Found search field".



Win2PDF520

© 2023 Dane Prairie Systems, LLC

Define Search Field

Selecting the "Search Direction" controls whether Win2PDF searches to the
right or just below the search term.  If your search field is to the right of
your search term as in:

Invoice 01357

you should select "Search Right".  

If your search field is below your search term as in:

Invoice

10357

you should select "Search Below". 

Selecting the "Search until space character" option will end the search when
a space, tab, or newline character occurs. Selecting "Search up to X
characters" will include the specified number of characters, including any
space characters.  The "Found search field" sample text is updated as you
type based on the current open PDF file.
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After the search field is defined, selecting "search field 1", "search field 2",
or "search field 3" as a rename option will use the search content for each
PDF in the renamed file name. The preview window will be updated to show
the renamed file with the search field.

Win2PDF Auto Rename Search Field

4.3.37.4 Auto-Rename: Text

The "Text" rename option allows you to include fixed user defined text in
the renamed file name.
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Win2PDF Auto-Rename Text

You are prompted to enter any text that you would like included in the
renamed files.
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The entered text can include any valid characters in Windows file names,
including spaces.  The renamed file preview is automatically updated to
include the entered text.

4.3.37.5 Auto-Rename: Document Creation Date

Selecting the "Document Creation Date" rename option uses the creation
date metadata embedded in the PDF file in the renamed file name.
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Win2PDF Auto-Rename Document Creation Date

Some documents do not have the "Document Creation Date" metadata set
in the PDF.  If the "Document Creation Date" metadata is empty, a "-"
character is substituted in the renamed file.

You can view the PDF metadata fields by opening the PDF in Adobe Acrobat
Reader DC and viewing the "Document Properties" under the "File" menu.
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4.3.37.6 Auto-Rename: Document Modified Date

Selecting the "Document Modified Date" rename option uses the modified
date metadata embedded in the PDF file in the renamed file name.

Win2PDF Auto-Rename Document Modified Date

Some documents do not have the "Document Modified Date" metadata set
in the PDF.  If the "Document Modified Date" metadata is empty, a "-"
character is substituted in the renamed file.
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You can view the PDF metadata fields by opening the PDF in Adobe Acrobat
Reader DC and viewing the "Document Properties" under the "File" menu.

4.3.37.7 Auto-Rename: Document Title

Selecting the "Document Title" rename option uses the document title
metadata embedded in the PDF file in the renamed file name.

Some documents do not have the "Document Title" metadata set in the
PDF.  If the "Document Title" metadata is empty, a "-" character is
substituted in the renamed file.

You can view the PDF metadata fields by opening the PDF in Adobe Acrobat
Reader DC and viewing the "Document Properties" under the "File" menu.

4.3.37.8 Auto-Rename: Document Author

Selecting the "Document Author" rename option uses the document author
metadata embedded in the PDF file in the renamed file name.

Some documents do not have the "Document Author" metadata set in the
PDF.  If the "Document Author" metadata is empty, a "-" character is
substituted in the renamed file.

You can view the PDF metadata fields by opening the PDF in Adobe Acrobat
Reader DC and viewing the "Document Properties" under the "File" menu.

4.3.37.9 Auto-Rename: Document Subject

Selecting the "Document Subject" rename option uses the document
subject metadata embedded in the PDF file in the renamed file name.

Some documents do not have the "Document Subject" metadata set in the
PDF.  If the "Document Subject" metadata is empty, a "-" character is
substituted in the renamed file.

You can view the PDF metadata fields by opening the PDF in Adobe Acrobat
Reader DC and viewing the "Document Properties" under the "File" menu.

4.3.37.10Auto-Rename: Document Keywords

Selecting the "Document Keywords" rename option uses the document
keywords metadata embedded in the PDF file in the renamed file name.

Some documents do not have the "Document Keywords" metadata set in
the PDF.  If the "Document Keywords" metadata is empty, a "-" character
is substituted in the renamed file.
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You can view the PDF metadata fields by opening the PDF in Adobe Acrobat
Reader DC and viewing the "Document Properties" under the "File" menu.

4.3.37.11Auto-Rename: User Name

The "User Name" rename option allows you to include the name of the
currently logged in user in the renamed file name. This is equivalent to the
"USERNAME" environment variable.

Win2PDF Auto-Rename Current User Name
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This can be combined with other rename options to make the renamed file
unique.

4.3.37.12Auto-Rename: Computer Name

The "User Name" rename option allows you to include the name of the
computer in the renamed file name.  This is equivalent to the
"COMPUTERNAME" environment variable.

Win2PDF Auto-Rename Current Computer Name
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This can be combined with other rename options to make the renamed file
unique.

4.3.37.13Auto-Rename: Date

Selecting the "Current Date" as a rename option uses the current date in
either MM-DD-YYYY format or YYYY-MM-DD format.

Win2PDF Auto-Rename Date
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4.3.37.14Auto-Rename: Time

Selecting the "Current Time" as a rename option uses the current date in
either 12 or 24 hour format.

Win2PDF Auto Rename Time

4.3.37.15Auto-Rename: Year

Selecting the "Current Year" as a rename option uses the current year
(YYYY) in the renamed file name.  This can be combined with Auto-
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Rename: Month and/or Auto-Rename: Day to create a custom date format
in the renamed file name.

4.3.37.16Auto-Rename: Month

Selecting the "Current Month" or "Current Month - abbr. name" as a
rename option uses the current month in either a numeric format (MM) or
an abbreviated name format in the renamed file name.  This can be
combined with Auto-Rename: Year and/or Auto-Rename: Day to create a
custom date format in the renamed file name.

4.3.37.17Auto-Rename: Day

Selecting the "Current Day" or "Current Day in week - abbr. name" as a
rename option uses the current day in either a numeric format (DD) or
current day in week format ("Mon", "Tue", etc.) in the renamed file name. 
This can be combined with Auto-Rename: Year and/or Auto-Rename:
Month to create a custom date format in the renamed file name.

4.3.37.18Auto-Rename: Hour

Selecting the "Current Hour" as a rename option uses the current hour in
either a 12 or 25 hour format the renamed file name.  This can be
combined with Auto-Rename: Minute, Auto-Rename: Second and/or Auto-
Rename: Millisecond to create a custom time format in the renamed file
name.

4.3.37.19Auto-Rename: Minute

Selecting the "Current Minute" as a rename option uses the current hour in
the renamed file name.  This can be combined with Auto-Rename: Hour,
Auto-Rename: Second and/or Auto-Rename: Millisecond to create a
custom time format in the renamed file name.

4.3.37.20Auto-Rename: Second

Selecting the "Current Second" as a rename option uses the current second
in the renamed file name.  This can be combined with Auto-Rename:
Minute, Auto-Rename: Hour and/or Auto-Rename: Millisecond to create a
custom time format in the renamed file name.

4.3.37.21Auto-Rename: Millisecond

Selecting the "Current Millisecond" as a rename option uses the current
millisecond (1/1000 second) in the renamed file name.  This can be
combined with Auto-Rename: Hour, Auto-Rename: Minute and/or Auto-
Rename: Second to create a custom time format in the renamed file name.
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4.3.37.22Auto-Rename: User Defined

Advanced options for controlling the format of the renamed file can be
configured using the "User Defined" rename option.

Win2PDF Auto-Rename User Defined

When the "User Defined" option is checked, the field is filled with the currently
selected options in a tag format that is delimited by % characters (e.g. %PDFHour
%). Advanced users can re-order the Win2PDF tags to match their requirements, or
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mix and match tags to create their own file name format. Clicking the "Reset" button
fills in the currently selected rename options. The supported tags are:

%PDFSourceFile% The original file name with no extension.
%PDFTitle% Document title from the PDF metadata (if set)
%PDFAuthor% Document author from the PDF metadata (if set)
%PDFSubject% Document subject from the PDF metadata (if set)
%PDFKeywords% Document keywords from the PDF metadata (if set)
%PDFCreationDate
%

Document creation date from the PDF metadata (if set).

%PDFModifiedDate
%

Document modified date from the PDF metadata (if set).

%PDFText1% User defined text defined in the first rename option
%PDFText2% User defined text defined in the second rename option
%PDFText3% User defined text defined in the third rename option
%PDFText4% User defined text defined in the fourth rename option
%PDFText5% User defined text defined in the fifth rename option
%PDFDate% Eight digit date separated by dashes in the format month-day-

year (12-25-2015)
%PDFTime% Six digit 12 hour time separated by dashes in the format hour-

minute-second-AM/PM (12-59-59 PM)
%PDFYear% Four digit number for the current year (2015)
%PDFMonth% Two digit number for the current month (12)
%PDFMonthName
%

Three character abbreviated name for the current month (Dec)

%PDFDay% Two digit number for the current day of the month (25)
%PDFDayName% Three character abbreviated name for the day of the week

(Wed)
%PDFDayInWeek%One digit number for the current day of the week
%PDFHour% Two digit number for the current hour in a 12 hour format (12)
%PDFHour24% Two digit number for the current hour in a 24 hour format (24)
%PDFMinute% Two digit number for the current minute within the hour (59)
%PDFMinute5% Number for the current 5 minute interval within the hour (0, 5,

10,..55)
%PDFMinute10% Number for the current 10 minute interval within the hour (0,

10, 20, ..50)
%PDFMinute15% Number for the current 15 minute interval within the hour (0,

15, 30, 45)
%PDFMinute30% Number for the current 30 minute interval within the hour (0,

30)
%PDFSecond% Two digit number for the current second within the minute (59)
%PDFMillisecond% Three digit number for the current millisecond (999)
%PDFTimeMarker%Two character abbreviation for AM or PM
%PDFIncrement% The %PDFIncrement% variable starts at 1, and increments by

one until the expanded file name does not exist.
%
PDFAutoNameCont

Used for content based file naming. Win2PDF searches the
text of the current PDF for the word specified in the Win2PDF
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entSearch% Desktop "Define Search Field" command or by the
PDFAutoNameContentSearchWord registry setting. If the word
is found, the auto-name variable %
PDFAutoNameContentSearch% is filled with the word after the
search word. 

%
PDFAutoNameCont
entSearch2%

Used for content based file naming. Win2PDF searches the
text of the current PDF for the word specified in the Win2PDF
Desktop "Define Search Field" command or by the
PDFAutoNameContentSearchWord2 registry setting. If the
word is found, the auto-name variable %
PDFAutoNameContentSearch2% is filled with the word after
the search word. 

%
PDFAutoNameCont
entSearch3%

Used for content based file naming. Win2PDF searches the
text of the current PDF for the word specified in the Win2PDF
Desktop "Define Search Field" command or by the
PDFAutoNameContentSearchWord3 registry setting. If the
word is found, the auto-name variable %
PDFAutoNameContentSearch3% is filled with the word after
the search word. 

%
PDFAutoNameCont
entField%

Used for content based file naming. Win2PDF searches the
content field rectangle defined in the Win2PDF Desktop
"Define Content Field" command. If text is found in the defined
rectangle, the auto-name variable %
PDFAutoNameContentField% is filled with found text.

The "Renamed File Name" column listed at the bottom of the window is
updated to show the resulting file name based on the options selected. 

4.4 How to Print to PDF from Common Applications

4.4.1 How to Convert a Microsoft Word Doc to PDF

To print from Microsoft Word, first open the document you wish to convert
in Microsoft Word.

Select 'Print' from the 'File' menu and choose the printer named Win2PDF,
and then click on the 'Print' button.
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You will then be presented with the Win2PDF file save window, and you can
save the .doc or .docx Microsoft Word document as a PDF file.

4.4.2 How to Convert a Microsoft Excel XLS to PDF

To print from Microsoft Excel, first open the .xls or .xlsx document you wish
to convert in Microsoft Excel.

Select 'Print' from the 'File' menu and choose the printer named Win2PDF,
and then click on the 'Print' button.

If you are creating a document from an Excel workbook that contains
multiple worksheets, selecting the "Entire workbook" option from the
Excel print window will create a separate document for each worksheet. If
you would like to have all worksheets in a single document, you can select
multiple worksheets before printing to the Win2PDF printer.
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You can select multiple worksheets by holding down the "shift" or "control"
key while clicking on the sheet tab. Select the "Print..." command from the
"File" menu and make sure "Active sheet(s)" is enabled in the Excel print
window. More information on selecting multiple worksheets is available at:

https://support.office.com/en-us/article/Select-one-or-multiple-worksheets-096b40c9-
0ee7-4980-bac6-cc92aec7b266

Alternatively, if you select "print to file" from the Excel print window all
worksheets will be created in a single document.

4.4.3 How to Convert a Microsoft PowerPoint PPT to PDF

To print from Microsoft Powerpoint, first open the .ppt or .pptx document
you wish to convert in Microsoft PowerPoint.

Select 'Print' from the 'File' menu and choose the printer named Win2PDF,
and then click on the 'Print' button.

https://support.office.com/en-us/article/Select-one-or-multiple-worksheets-096b40c9-0ee7-4980-bac6-cc92aec7b266
https://support.office.com/en-us/article/Select-one-or-multiple-worksheets-096b40c9-0ee7-4980-bac6-cc92aec7b266
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You will then be presented with the Win2PDF file save window, and you can
save the .ppt or .pptx Microsoft PowerPoint document as a PDF file.

4.4.4 How to Convert a Microsoft Publisher PUB to PDF

To print from Microsoft Publisher, first open the .pub document you wish to
convert in Microsoft Publisher.

Select 'Print' from the 'File' menu and choose the printer named Win2PDF,
and then click on the 'Print' button.
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You will then be presented with the Win2PDF file save window, and you can
save the .pub Microsoft Publisher document as a PDF file.

4.4.5 How to Convert a Microsoft Outlook Email to PDF

To print from Microsoft Outlook, first open the email you wish to convert.

Select 'Print' from the 'File' menu and choose the printer named Win2PDF,
and then click on the 'Print' button.
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You will then be presented with the Win2PDF file save window, and you can
save the email as a PDF file.

4.4.6 How to Convert a Windows Live email to PDF

To print from Microsoft Outlook 2010, first open the email you wish to
convert.

Select 'Print' from the 'File' menu and choose the printer named Win2PDF,
and then click on the 'Print' button.
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You will then be presented with the Win2PDF file save window, and you can
save the email as a PDF file.

4.4.7 How to Convert HTML files to PDF

In Win2PDF 10.0.113 or later, you can open the "Web Page to PDF"
shortcut in the start menu.

If the HTML file is local on your computer, you can right click on the file in
Windows Explorer and choose "Convert with Win2PDF".

To convert a public web page to PDF, you can use the free HTML to PDF
service at https://www.win2pdf.com/html-to-pdf.html.

You can automate the HTML to PDF conversion using the HTML2PDF
command line or Microsoft Power Automate Desktop HTML To PDF.

You can also convert HTML files to a PDF document by printing to Win2PDF
using any Windows browser (e.g., Edge, Firefox, Chrome, etc.).

https://www.win2pdf.com/html-to-pdf.html
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First, open the HTML file or load the web site page in your browser window.
Then select 'Print...' from the web browser's File menu.

You will then be able to convert the HTML web page to a PDF copy of the
page on your computer.

4.4.8 How to Convert an Internet Explorer page to PDF

To convert a public web page to PDF, you can use the free HTML to PDF
service at https://www.win2pdf.com/html-to-pdf.html.

You can also convert HTML files to a PDF document by printing to the
Win2PDF printer using Internet Explorer.

First, open the HTML file or load the web site page in your Internet Explorer
browser window. Then select 'Print...' from the web browser's File menu.

https://www.win2pdf.com/html-to-pdf.html
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You will then be able to convert the HTML web page to a PDF copy of the
page on your computer.

4.4.9 How to Convert an AutoCAD DWG to PDF

In AutoCAD, plot to a PDF as follows :

Command 'PLOT'.

· Select 'Plot Device' Tab.

· In the 'Plotter Configuration' frame, click the 'Properties...'
button.

 
· A new window opens.

· Select 'Device and Document Settings' tab.

· If necessary highlight 'Custom Properties' in the tree.
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· Click the 'Custom Properties' button.
 
· A new window opens.

· Select the 'Paper Orientation' (Note A).

· Click the 'Advanced...' button.
 
· A new window opens.

· Highlight 'Paper Size' in the tree.

· Select the paper size from the drop-down list. This is an important
step. (Note B)

 
· Click 'OK' 3 times to close the windows and save to a .pc3 file if

necessary.
 

· Back in the AutoCAD plot window, select the 'Plot Settings' tab. In
the 'Paper Size...' frame the paper size should have changed to the
value set earlier at (Note B). Do not change the paper size here as
this may produce inconsistent rotations, sizes and offsets. In the
'Drawing Orientation' frame select 'Portrait' or 'Landscape'. Note
that this orientation selection overrides orientations that were set at
(Note A) or (Note B). 

· Click 'OK' to plot.
 

4.5 How to use the Win2PDF Admin Utility

4.5.1 How to Install the Win2PDF Admin Utility

The Win2PDF Admin Utility is a free download used for managing Win2PDF
settings, disabling Win2PDF features, setting defaults for all users, setting
automatic email and file save features, and troubleshooting.

To download this software, visit the Win2PDF Admin Utility page in our
technical support section.

Once you have downloaded this file, double-click the setup file to install.

After it has been installed, you will be able to access the Win2PDF Admin
Utility by going to:

http://helpdesk.win2pdf.com/index.php?/Knowledgebase/Article/View/187/15/win2pdf-admin-utility-download
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"Start->Programs->Win2PDF->Win2PDF Admin Utility->Win2PDF
Admin Utility"

4.5.2 How to Manage file save window settings

The first tab of the Win2PDF Admin Utility allows you to set defaults for the
initial default path and watermark (Win2PDF Pro feature only), and to
customize the options that are available on the main Win2PDF file save
window.
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Win2PDF Admin Utility File Save Configuration

Default path on first use: this is the location that Win2PDF will use for
the initial file save location. You will need to enter the full path in this box
(e.g., "C:\Users\Bob\Documents"). You can use environment variables
such as "%USERPROFILE%\Documents\PDF Files". This value will only be
used the first time that the Win2PDF file save window appears. If the user
changes the save to folder through the interface, Win2PDF will remember
that new location on the next use. This file location is saved with respect to
each application (e.g., Word files will always save to the last saved location
for Word prints, Excel files will always be saved to the last save location for
Excel prints, etc.)

Default watermark PDF file: [Win2PDF Pro feature only] This allows you
to set the default watermark PDF file. This fill will always be set until the
user changes the file, and then the new file will be remember for successive
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uses (until change). If you click on the [...] button, you will be able to
browse and select the default watermark PDF file.

Disable [feature]: When any of these options are checked, the feature
will be disabled ("grayed out") in the Win2PDF file save window. For
example, if you checked the "Disable Send PDF" option, the user would not
be able to change this option through the main Win2PDF file save window
interface.

4.5.3 How to Manage email settings

The second tab of the Win2PDF Admin Utility allows you to set email
options that are used when the "Send PDF" option is enabled on the
Win2PDF file save window.

Win2PDF Admin Utility Email Configuration
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Default subject: the default subject line that will be filled in on the new
email message (e.g., " - The PDF file you requested is attached"). The PDF
file name is automatically added to the beginning of the subject line, so the
previous example would be expanded to something like "Invoice.pdf - The
PDF file you requested is attached".

Default To: addresses: list of To: email address to be automatically set in
the new email message. The value can be a single email address in the
form "someone@somedomain.com", or multiple recipients separated by
semicolon ';' or comma ',' characters. 

Default CC: addresses: list of CC: (carbon copy) email address to be
automatically set in the new email message. The value can be a single email
address in the form "someone@somedomain.com", or multiple recipients
separated by semicolon ';' or comma ',' characters. 

Default body text: the default body text in the new email message (e.g.,
"Please find the attached PDF file. Thanks.")

Use Address Book to verify addresses: When this option is checked,
the list of email addresses will be checked against your current address
book. This can improve the reliability of sent email in some environments,
but may cause the email client to display a warning window.

4.5.4 How to Manage file name settings

See also: How to Automatically Name PDF files

The third tab of the Win2PDF Admin Utility allows you to set default file
name options, and to set merging and watermark features to the file save.
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Win2PDF Admin Utility File Name Configuration

PDF file name (include full path): Use the [...] button to browse for an
existing PDF file, or use the %PDFTitle% variable to pick up the file name
from the original document. Any variables listed in the PDF Auto-name:
User Defined documentation can be used in this field. For example, if you
want to place the files in a folder named "PDF Files" on your "C:" drive, you
would type the following in the Admin Utility:

c:\PDF Files\%PDFTitle%.pdf

The current date and time can be added to the file name using the %
PDFDate% and %PDFTime% environment variables in a similar manner. If
an existing PDF file with the same name exists in the folder, it will be
overwritten. To prevent files from being overwritten, append a "*"
character to the name as in:
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c:\PDF Files\%PDFTitle%*.pdf

This will append a number to the PDF file if an existing PDF file is already in
the destination folder. 

If you wanted to save the file as a different file type, like .xps or .tif, you
just need to add the appropriate file extension in this box (e.g., substitute
c:\TIFF Files\%PDFTitle%.tif in the above example). To save a file as

PDF/A, add a .pdfa extension to the file. The file created will have a .pdf
extension, but it will be in the PDF/A format. Other formats can be specified
by setting the extension as listed in the setting the file name
documentation.

You will have to run the Win2PDF Admin Utility again and remove the file
name when you want to create PDF files interactively.

Content Based Naming Search Word (optional): Searches the
contents of the PDF for the word specified. If the search word is found, the
world following the search word is placed in the %PDFAutoNameContentSearch
% variable which can be referenced in the "PDF file name" field. This feature requires Win2PDF
10.0.57 or above.

Run the following program after PDF creation (optional): this setting
allows you automatically launch a program after the PDF file has been
created. For example, if you wanted to add the PDF file to a document
management program, you'd just need to specify the command line to this
program in this area. The "Wait To Finish" checkbox determines if Win2PDF
waits for the program to exit before returning control back to the printing
application.

[Append/Prepend] the following PDF file after creation (optional):
the settings allows you to automatically add an existing PDF file to the
beginning of your PDF file (Prepend), or to the end of your PDF file
(Append).

Apply [Background/Foreground] watermark PDF file after creation
(Win2PDF Pro, optional):  this setting allows you to automatically apply
a watermark PDF file. When set to [Background], the PDF file will be placed
"under" the new printed PDF file results (useful for setting a company
letterhead, for example). When set to [Foreground], the PDF file will be
placed "on top" of the new printed PDF file results (useful for applying a
watermark that says "Confidential", for example).
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The Exclude watermark from settings allows you to see pages at the
beginning or end of the new document where the new watermark will not
be applied. For example if you had a cover page (which should not have a
watermark) followed by a 20 page report (which should have the
watermark), you can set the value to be Exclude watermark from: 1 pages
from the document start.

Apply to all users - when this option is checked, the settings apply to all
users on the PC or server. If it is unchecked, the settings only apply to the
current user.

Test - Button allows you to test create a PDF file with the file name and
settings you've configured. 

4.5.5 How to Enable troubleshooting options

The fourth tab of the Win2PDF Admin Utility allows you to set various
troubleshooting options. Use these options only when directed by
Win2PDF's technical support group.
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Win2PDF Admin Utility Troubleshooting Configuration

4.5.6 How to Manage security settings

The fifth tab of the Win2PDF Admin Utility allows you to set default security
options. These options are ONLY applicable to the Win2PDF Pro and
Win2PDF Pro Terminal Server Edition (TSE) versions of the software.
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Win2PDF Admin Utility Security Configuration

Default [feature]: These boxes allow you to set default passwords or
other security features in the Win2PDF file save window.

Allow [feature] to be changed: When these check boxes are enabled
("checked"), it will allow the user to change these values in the Win2PDF
file save window. When these check boxes are disabled ("unchecked"), it
will not allow the user to change these values. The features will appear
"grayed out" in the interface.
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4.6 How to Automate Win2PDF with Microsoft Power Automate
Desktop

Microsoft Power Automate Desktop for Windows 10 and Windows 11 is a
free download from Microsoft that allows you to automate anything on your
desktop, including printing to the Win2PDF printer. Anyone can build
powerful automation steps called "flows" using pre-built drag and drop
actions.

There are two pre-built drag and drop actions that can be used to interface
with Win2PDF, the "Print Document" action to print to the Win2PDF printer,
and the "Run DOS command" action that can be used to launch the
Win2PDF Desktop command line. 

The "Print Document" action can be used in conjunction with the Win2PDF
Auto-name feature to automatically name PDF files, or you can set the PDF
file name from within a Power Automate Desktop flow.

How To Print To PDF Using Power Automate Desktop
How To Set the PDF File Name using Power Automate Desktop
How To Use the Win2PDF Command Line with Power Automate Desktop
Win2PDF Power Automate Desktop Example Flows

4.6.1 How To Print To PDF Using Power Automate Desktop

The easiest way to automate Win2PDF using Power Automate Desktop is to
use the "Print Document" action from the "System" menu.

https://flow.microsoft.com/en-us/desktop/
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When you drag the "Print Document" action onto a Power Automate "flow",
you're prompted to enter a document to print.
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You can either select a filename, or use a variable for the file name ({x}).
The "Print document" action prints to the default printer, so you should
drag the "Set Default Printer" action before the "Print Document" action in
the flow.

The simple "flow" should look like:

When you run this "flow", the Win2PDF printer will prompt for the name of
the PDF file. If you want to avoid this, you can enable the Win2PDF Auto-
name feature.

You can combine these simple Power Automate Desktop actions with the
Power Automate "Get files in a folder" action to convert all documents in a
folder to PDF using Win2PDF.
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To use this "flow", copy the following into a new Power Automate Desktop
flow:

System.SetDefaultPrinter PrinterName: $'''Win2PDF'''
Folder.GetFiles Folder: $'''C:\\Users\\Public\\Documents''' FileFilter: $'''*.docx''' IncludeSubfolders: False FailOnAccessDenied: True SortBy1: Folder.SortBy.NoSort SortDescending1: False SortBy2: Folder.SortBy.NoSort SortDescending2: False SortBy3: Folder.SortBy.NoSort SortDescending3: False Files=> Files
LOOP FOREACH CurrentItem IN Files
  System.PrintDocument DocumentPath: CurrentItem
END

4.6.2 How To Set the PDF File Name Using Power Automate Desktop

The Power Automate Desktop "Print Document" action works well to
convert documents to PDF with Win2PDF, but it doesn't allow you to set the
file name directly. You need to configure the "Win2PDF Auto-name" feature
separately before running the "flow". 

For more control, Win2PDF supports a PDFFileName registry setting for
setting the file name, and this can be used in a Power Automate Desktop
flow using the "reg.exe" DOS command. To set the file name, drag the
"Run DOS Command" action from the "System" menu to a "flow" and enter
the following command:

reg.exe add "HKCU\Software\Dane Prairie Systems\Win2PDF" /v PDFFileName /d "C:\Users\Public\Documents\test.pdf" /f

The file name path after the /d should be modified to the location and file
name of the PDF, and should be enclosed with quote characters.
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You can also use variables when setting the PDF file name using the
"reg.exe" command. The following simple flow prompts for a document
name using the Power Automate Desktop "Display select file dialog" action,
and then splits the file name into directory and file name without extension
variables using the "Get file path part" action. It then sets the file name to
the same as the document name, but with a PDF extension before printing
the document to the Win2PDF printer.
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The "Run DOS Command" action to set the file name using variables is:

reg.exe add "HKCU\Software\Dane Prairie Systems\Win2PDF" /v PDFFileName /d "%Directory%\%FileNameNoExtension%.pdf" /f
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To use this "flow", copy the following into a new Power Automate Desktop
flow:

Display.SelectFile Title: $'''Select File to Convert to PDF''' IsTopMost: False CheckIfFileExists: True SelectedFile=> SelectedFile ButtonPressed=> ButtonPressed
File.GetPathPart File: SelectedFile RootPath=> RootPath Directory=> Directory FileName=> FileName FileNameWithoutExtension=> FileNameNoExtension Extension=> FileExtension
# Set the PDF file name in the registry using the reg.exe command
System.RunDOSCommand DOSCommandOrApplication: $'''reg.exe add \"HKCU\\Software\\Dane Prairie Systems\\Win2PDF\" /v PDFFileName /d \"%Directory%\\%FileNameNoExtension%.pdf\" /f''' StandardOutput=> CommandOutput StandardError=> CommandErrorOutput ExitCode=> CommandExitCode
System.SetDefaultPrinter PrinterName: $'''Win2PDF'''
System.PrintDocument DocumentPath: SelectedFile

If you are using the "Print document" action inside of a loop, you should
wait for each document to be completed before printing the next document.
You can do this by using the "PDFPostFileName" registry setting instead of
"PDFFileName", and waiting for the registry value to be deleted. The
following flow shows how to do this:
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To use this "flow", copy the following into a new Power Automate Desktop
flow:
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# This flow converts a folder of Microsoft Word .DOCX files to PDF using the Win2PDF printer. The PDF files are placed in the same folder as the DOCX files, but with a .PDF extension.
System.SetDefaultPrinter PrinterName: $'''Win2PDF'''
Display.SelectFolder Description: $'''Select folder to convert to PDF''' IsTopMost: False SelectedFolder=> SelectedFolder ButtonPressed=> ButtonPressed
Folder.GetFiles Folder: SelectedFolder FileFilter: $'''*.docx''' IncludeSubfolders: False FailOnAccessDenied: True SortBy1: Folder.SortBy.NoSort SortDescending1: False SortBy2: Folder.SortBy.NoSort SortDescending2: False SortBy3: Folder.SortBy.NoSort SortDescending3: False Files=> Files
LOOP FOREACH CurrentItem IN Files
  # Get the path variables so we can save the file with a .PDF extension
  File.GetPathPart File: CurrentItem RootPath=> RootPath Directory=> Directory FileName=> FileName FileNameWithoutExtension=> FileNameNoExtension Extension=> FileExtension
  /# Set the PDF file name to the same name as the .DOCX, but with a .PDF extension
reg.exe add "HKCU\Software\Dane Prairie Systems\Win2PDF" /v PDFPostFileName /d "%Directory%\%FileNameNoExtension%.pdf" /f#/
  System.RunDOSCommand DOSCommandOrApplication: $'''reg.exe add \"HKCU\\Software\\Dane Prairie Systems\\Win2PDF\" /v PDFPostFileName /d \"%Directory%\\%FileNameNoExtension%.pdf\" /f''' StandardOutput=> CommandOutput StandardError=> CommandErrorOutput ExitCode=> CommandExitCode
  # Print to the Win2PDF printer to convert to PDF
  System.PrintDocument DocumentPath: CurrentItem
  SET CommandExitCode TO 0
  # Wait for the Win2PDF printer to finish before printing the next document. 
  LOOP WHILE (CommandExitCode) = (0)
    /# The "PDFPostFileName" registry setting will be deleted when the PDF is created. The following reg.exe command will return an error code if the registry setting does not exist.
reg.exe query "HKCU\Software\Dane Prairie Systems\Win2PDF" /v PDFPostFileName#/
    System.RunDOSCommand DOSCommandOrApplication: $'''reg.exe query \"HKCU\\Software\\Dane Prairie Systems\\Win2PDF\" /v PDFPostFileName''' StandardOutput=> CommandOutput StandardError=> CommandErrorOutput ExitCode=> CommandExitCode
    WAIT 0.1 
  END
END

4.6.3 How To Use Win2PDF Command Line With Power Automate Desktop

The Microsoft Power Automate "Run DOS Command" action under the
"System" menu allows you to call any Win2PDF Desktop command line
option. You should start by entering the full path to the Win2PDF
executable:

C:\Windows\System32\spool\drivers\x64\3\win2pdfd.exe on 64 bit editions or

C:\Windows\System32\spool\drivers\w32x86\3\win2pdfd.exe on 32 bit editions.
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The Win2PDF Desktop command line options vary for each command. As
an example, we'll use the "compress" command which takes a source file,
compress ratio, and destination file as parameters. It's important to enclose
all file name parameters in quote characters in case the file name paths
include space characters.

As an example, we'll use the "Display select file dialog" to choose an
existing PDF, and then split the file name using "Get file path part" so we
can save the compressed PDF in the same location but with a different
name.



How To Articles 563

© 2023 Dane Prairie Systems, LLC

The "Run DOS Command" action for the full command line for the
compress command is:

C:\Windows\System32\spool\drivers\x64\3\win2pdfd.exe compress "%SelectedFile%" 50 "%Directory%%FileNameNoExtension%-compressed.pdf"

This opens a PDF, compresses it, and then saves it in the same folder with
a "-compressed.pdf" added to the name.

To use this "flow", copy the following into a new Power Automate Desktop
flow:
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Display.SelectFile Title: $'''Compress PDF File''' FileFilter: $'''*.pdf''' IsTopMost: False CheckIfFileExists: True SelectedFile=> SelectedFile ButtonPressed=> ButtonPressed
File.GetPathPart File: SelectedFile RootPath=> RootPath Directory=> Directory FileName=> FileName FileNameWithoutExtension=> FileNameNoExtension Extension=> FileExtension
System.RunDOSCommand DOSCommandOrApplication: $'''C:\\Windows\\System32\\spool\\drivers\\x64\\3\\win2pdfd.exe compress \"%SelectedFile%\" 50 \"%Directory%\\%FileNameNoExtension%-compressed.pdf\"''' WorkingDirectory: $'''c:\\windows\\system32\\spool\\drivers\\x64\\3\\''' StandardOutput=> CommandOutput StandardError=> CommandErrorOutput ExitCode=> CommandExitCode
# Display result of compress command
Display.ShowMessage Title: $'''Win2PDF Compress''' Message: CommandOutput Icon: Display.Icon.None Buttons: Display.Buttons.OK DefaultButton: Display.DefaultButton.Button1 IsTopMost: False ButtonPressed=> ButtonPressed2

4.6.4 Win2PDF Power Automate Desktop Example Flows

The following examples show how to use Win2PDF with Microsoft Power
Automate Desktop.

Convert Word Documents To PDF
Convert Excel Documents To PDF
Convert HTML To PDF Using Microsoft Edge
Convert HTML To PDF Using Google Chrome
Convert HTML To PDF Using Mozilla FireFox
Compress PDF files
Encrypt PDF files
Rename PDFs based on File Contents

4.6.4.1 How To Convert Word Documents To PDF Using Power Automate Desktop

The following flow shows how to convert a folder of Microsoft Word .DOCX
files to PDF using the Win2PDF printer. The PDF files are saved in the same
location as the .DOCX files, but with a .PDF extension.
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To use this "flow", copy the following into a new Power Automate Desktop
flow:

# This flow converts a folder of Microsoft Word .DOCX files to PDF using the Win2PDF printer. The PDF files are placed in the same folder as the DOCX files, but with a .PDF extension.
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Workstation.SetDefaultPrinter PrinterName: $'''Win2PDF'''
Display.SelectFolder Description: $'''Select folder to convert to PDF''' IsTopMost: False SelectedFolder=> SelectedFolder ButtonPressed=> ButtonPressed
Folder.GetFiles Folder: SelectedFolder FileFilter: $'''*.docx''' IncludeSubfolders: False FailOnAccessDenied: True SortBy1: Folder.SortBy.NoSort SortDescending1: False SortBy2: Folder.SortBy.NoSort SortDescending2: False SortBy3: Folder.SortBy.NoSort SortDescending3: False Files=> Files
LOOP FOREACH CurrentItem IN Files
    # Get the path variables so we can save the file with a .PDF extension
    File.GetPathPart File: CurrentItem RootPath=> RootPath Directory=> Directory FileName=> FileName FileNameWithoutExtension=> FileNameNoExtension Extension=> FileExtension
    # Set the PDF file name to the same name as the .DOCX, but with a .PDF extension
    Scripting.RunDOSCommand.RunDOSCommand DOSCommandOrApplication: $'''reg.exe add \"HKCU\\Software\\Dane Prairie Systems\\Win2PDF\" /v PDFPostFileName /d \"%Directory%\\%FileNameNoExtension%.pdf\"''' StandardOutput=> CommandOutput StandardError=> CommandErrorOutput ExitCode=> CommandExitCode
    # Print to the Win2PDF printer to convert to PDF
    Workstation.PrintDocument DocumentPath: CurrentItem
    SET CommandExitCode TO 0
    LOOP WHILE (CommandExitCode) = (0)
        # The "PDFPostFileName" registry setting will be deleted when the PDF is created. The following reg.exe command will return an error code if the registry setting does not exist.
        Scripting.RunDOSCommand.RunDOSCommand DOSCommandOrApplication: $'''reg.exe query \"HKCU\\Software\\Dane Prairie Systems\\Win2PDF\" /v PDFPostFileName''' StandardOutput=> CommandOutput StandardError=> CommandErrorOutput ExitCode=> CommandExitCode
        WAIT 0.1
    END
END

4.6.4.2 How To Convert Excel Documents To PDF Using Power Automate Desktop

The following flow shows how to convert a folder of Microsoft Excel .XLSX
files to PDF using the Win2PDF printer. The PDF files are saved in the same
location as the .XLSX files, but with a .PDF extension.



How To Articles 567

© 2023 Dane Prairie Systems, LLC

To use this "flow", copy the following into a new Power Automate Desktop
flow:

# This flow converts a folder of Microsoft Excel .XLSX files to PDF using the Win2PDF printer. The PDF files are placed in the same folder as the .XLSX files, but with a .PDF extension.
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Workstation.SetDefaultPrinter PrinterName: $'''Win2PDF'''
Display.SelectFolder Description: $'''Select folder to convert to PDF''' IsTopMost: False SelectedFolder=> SelectedFolder ButtonPressed=> ButtonPressed
Folder.GetFiles Folder: SelectedFolder FileFilter: $'''*.xlsx''' IncludeSubfolders: False FailOnAccessDenied: True SortBy1: Folder.SortBy.NoSort SortDescending1: False SortBy2: Folder.SortBy.NoSort SortDescending2: False SortBy3: Folder.SortBy.NoSort SortDescending3: False Files=> Files
LOOP FOREACH CurrentItem IN Files
    # Get the path variables so we can save the file with a .PDF extension
    File.GetPathPart File: CurrentItem RootPath=> RootPath Directory=> Directory FileName=> FileName FileNameWithoutExtension=> FileNameNoExtension Extension=> FileExtension
    # Set the PDF file name to the same name as the .XLSX, but with a .PDF extension
    Scripting.RunDOSCommand.RunDOSCommand DOSCommandOrApplication: $'''reg.exe add \"HKCU\\Software\\Dane Prairie Systems\\Win2PDF\" /v PDFPostFileName /d \"%Directory%\\%FileNameNoExtension%.pdf\"''' StandardOutput=> CommandOutput StandardError=> CommandErrorOutput ExitCode=> CommandExitCode
    # Print to the Win2PDF printer to convert to PDF
    Workstation.PrintDocument DocumentPath: CurrentItem
    SET CommandExitCode TO 0
    LOOP WHILE (CommandExitCode) = (0)
        # The "PDFPostFileName" registry setting will be deleted when the PDF is created. The following reg.exe command will return an error code if the registry setting does not exist.
        Scripting.RunDOSCommand.RunDOSCommand DOSCommandOrApplication: $'''reg.exe query \"HKCU\\Software\\Dane Prairie Systems\\Win2PDF\" /v PDFPostFileName''' StandardOutput=> CommandOutput StandardError=> CommandErrorOutput ExitCode=> CommandExitCode
        WAIT 0.1
    END
END

4.6.4.3 How To Convert an HTML Web Page To PDF Using Power Automate Desktop and Microsoft
Edge

The following flow shows how to convert an HTML web page to PDF using
the Win2PDF printer and Microsoft Edge. 
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To use this "flow", copy the following into a new Power Automate Desktop
flow:

# This Power Automate Desktop flow converts an HTML file to PDF using Microsoft Edge and the Win2PDF printer. This sample requires the Microsoft Power Automate for Edge add-in is installed.
WebAutomation.LaunchEdge.LaunchEdge Url: $'''https://helpdesk.win2pdf.com''' WindowState: WebAutomation.BrowserWindowState.Normal ClearCache: False ClearCookies: False Timeout: 60 BrowserInstance=> Browser
File.GetTempPath TempFile=> TempFile
WebAutomation.TakeScreenshot.TakeScreenshotSaveToFile BrowserInstance: Browser File: TempFile FileFormat: WebAutomation.FileFormat.Png
/# Convert the PNG to PDF using the Win2PDF Desktop Command Line
C:\\Windows\\System32\\spool\\drivers\\x64\\3\\win2pdfd png2pdf %TempFile% %TempFile%.pdf#/



Win2PDF570

© 2023 Dane Prairie Systems, LLC

Scripting.RunDOSCommand.RunDOSCommand DOSCommandOrApplication: $'''C:\\Windows\\System32\\spool\\drivers\\x64\\3\\win2pdfd png2pdf %TempFile% %TempFile%.pdf''' StandardOutput=> CommandOutput StandardError=> CommandErrorOutput ExitCode=> CommandExitCode
/# Make the PDF searchable (optional)
Requires the Win2PDF OCR Add-on download
C:\\Windows\\System32\\spool\\drivers\\x64\\3\\win2pdfd.exe makesearchable %TempFile%.pdf %TempFile%.pdf#/
Scripting.RunDOSCommand.RunDOSCommand DOSCommandOrApplication: $'''C:\\Windows\\System32\\spool\\drivers\\x64\\3\\win2pdfd.exe makesearchable %TempFile%.pdf %TempFile%.pdf''' StandardOutput=> CommandOutput2 StandardError=> CommandErrorOutput2 ExitCode=> CommandExitCode2
# Delete the temporary PNG file
File.Delete Files: TempFile
WebAutomation.CloseWebBrowser BrowserInstance: Browser
# Open the PDF using the default viewer
System.RunApplication.RunApplication ApplicationPath: $'''%TempFile%.pdf''' WindowStyle: System.ProcessWindowStyle.Normal ProcessId=> AppProcessId

4.6.4.4 How To Convert an HTML Web Page To PDF Using Power Automate Desktop and Google
Chrome

The following flow shows how to convert an HTML web page to PDF using
the Win2PDF printer and Google Chrome. 
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To use this "flow", copy the following into a new Power Automate Desktop
flow:

# This Power Automate Desktop flow converts an HTML file to PDF using Google Chrome and the Win2PDF printer. This sample requires the Microsoft Power Automate for Chrome plug-in is installed.
WebAutomation.LaunchChrome.LaunchChrome Url: $'''https://helpdesk.win2pdf.com''' WindowState: WebAutomation.BrowserWindowState.Normal ClearCache: False ClearCookies: False Timeout: 60 BrowserInstance=> Browser
File.GetTempPath TempFile=> TempFile
WebAutomation.TakeScreenshot.TakeScreenshotSaveToFile BrowserInstance: Browser File: TempFile FileFormat: WebAutomation.FileFormat.Png
/# Convert the PNG to PDF using the Win2PDF Desktop Command Line
C:\\Windows\\System32\\spool\\drivers\\x64\\3\\win2pdfd png2pdf %TempFile% %TempFile%.pdf#/
Scripting.RunDOSCommand.RunDOSCommand DOSCommandOrApplication: $'''C:\\Windows\\System32\\spool\\drivers\\x64\\3\\win2pdfd png2pdf %TempFile% %TempFile%.pdf''' StandardOutput=> CommandOutput StandardError=> CommandErrorOutput ExitCode=> CommandExitCode
/# Make the PDF searchable (optional)
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Requires the Win2PDF OCR Add-on download
C:\\Windows\\System32\\spool\\drivers\\x64\\3\\win2pdfd.exe makesearchable %TempFile%.pdf %TempFile%.pdf#/
Scripting.RunDOSCommand.RunDOSCommand DOSCommandOrApplication: $'''C:\\Windows\\System32\\spool\\drivers\\x64\\3\\win2pdfd.exe makesearchable %TempFile%.pdf %TempFile%.pdf''' StandardOutput=> CommandOutput2 StandardError=> CommandErrorOutput2 ExitCode=> CommandExitCode2
# Delete the temporary PNG file
File.Delete Files: TempFile
WebAutomation.CloseWebBrowser BrowserInstance: Browser
# Open the PDF using the default viewer
System.RunApplication.RunApplication ApplicationPath: $'''%TempFile%.pdf''' WindowStyle: System.ProcessWindowStyle.Normal ProcessId=> AppProcessId

4.6.4.5 How To Convert an HTML Web Page To PDF Using Power Automate Desktop and FireFox

The following flow shows how to convert an HTML web page to PDF using
the Win2PDF printer and Mozilla FireFox. 
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To use this "flow", copy the following into a new Power Automate Desktop
flow:

# This Power Automate Desktop flow converts an HTML file to PDF using Mozilla Firefox and the Win2PDF printer. This sample requires the Microsoft Power Automate for Firefox plug-in is installed.
WebAutomation.LaunchFirefox.LaunchFirefox Url: $'''https://helpdesk.win2pdf.com''' WindowState: WebAutomation.BrowserWindowState.Normal ClearCache: False ClearCookies: False BrowserInstance=> Browser
File.GetTempPath TempFile=> TempFile
WebAutomation.TakeScreenshot.TakeScreenshotSaveToFile BrowserInstance: Browser File: TempFile FileFormat: WebAutomation.FileFormat.Png
/# Convert the PNG to PDF using the Win2PDF Desktop Command Line
C:\\Windows\\System32\\spool\\drivers\\x64\\3\\win2pdfd png2pdf %TempFile% %TempFile%.pdf#/
Scripting.RunDOSCommand.RunDOSCommand DOSCommandOrApplication: $'''C:\\Windows\\System32\\spool\\drivers\\x64\\3\\win2pdfd png2pdf %TempFile% %TempFile%.pdf''' StandardOutput=> CommandOutput StandardError=> CommandErrorOutput ExitCode=> CommandExitCode
/# Make the PDF searchable (optional)
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Requires the Win2PDF OCR Add-on download
C:\\Windows\\System32\\spool\\drivers\\x64\\3\\win2pdfd.exe makesearchable %TempFile%.pdf %TempFile%.pdf#/
Scripting.RunDOSCommand.RunDOSCommand DOSCommandOrApplication: $'''C:\\Windows\\System32\\spool\\drivers\\x64\\3\\win2pdfd.exe makesearchable %TempFile%.pdf %TempFile%.pdf''' StandardOutput=> CommandOutput2 StandardError=> CommandErrorOutput2 ExitCode=> CommandExitCode2
# Delete the temporary PNG file
File.Delete Files: TempFile
WebAutomation.CloseWebBrowser BrowserInstance: Browser
# Open the PDF using the default viewer
System.RunApplication.RunApplication ApplicationPath: $'''%TempFile%.pdf''' WindowStyle: System.ProcessWindowStyle.Normal ProcessId=> AppProcessId

4.6.4.6 How To Compress PDFs Using Power Automate Desktop

The following Microsoft Power Automate Desktop flow shows how to
compress a folder of PDFs in place using the Win2PDF Desktop command
line compress command.

To use this "flow", copy the following into a new Power Automate Desktop
flow:

# This sample demonstrates how to compress a folder of PDFs using the Win2PDF compress command line compress with Microsoft Power Automate Desktop.
Display.SelectFolder Description: $'''Select Folder to Compress''' IsTopMost: False SelectedFolder=> SelectedFolder ButtonPressed=> ButtonPressed3
Folder.GetFiles Folder: SelectedFolder FileFilter: $'''*.pdf''' IncludeSubfolders: False FailOnAccessDenied: True SortBy1: Folder.SortBy.NoSort SortDescending1: False SortBy2: Folder.SortBy.NoSort SortDescending2: False SortBy3: Folder.SortBy.NoSort SortDescending3: False Files=> Files
LOOP FOREACH CurrentItem IN Files
    /# Compress the PDF file in place using the Win2PDF compress command line:
C:\\Windows\\System32\\spool\\drivers\\x64\\3\\win2pdfd.exe compress "%CurrentItem%" 50 "%CurrentItem%"#/
    Scripting.RunDOSCommand.RunDOSCommand DOSCommandOrApplication: $'''C:\\Windows\\System32\\spool\\drivers\\x64\\3\\win2pdfd.exe compress \"%CurrentItem%\" 50 \"%CurrentItem%\"''' WorkingDirectory: $'''c:\\windows\\system32\\spool\\drivers\\x64\\3\\''' StandardOutput=> CommandOutput StandardError=> CommandErrorOutput ExitCode=> CommandExitCode
END

4.6.4.7 How To Encrypt PDFs Using Power Automate Desktop

The following Microsoft Power Automate Desktop flow shows how to
encrypt a folder of PDFs in place using the Win2PDF Desktop command line
encrypt command.
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To use this "flow", copy the following into a new Power Automate Desktop
flow:

# This sample demonstrates how to encrypt a folder of PDFs using the Win2PDF encrypt command line with Microsoft Power Automate Desktop.
Display.SelectFolder Description: $'''Select Folder to Encrypt''' IsTopMost: False SelectedFolder=> SelectedFolder ButtonPressed=> ButtonPressed3
Folder.GetFiles Folder: SelectedFolder FileFilter: $'''*.pdf''' IncludeSubfolders: False FailOnAccessDenied: True SortBy1: Folder.SortBy.NoSort SortDescending1: False SortBy2: Folder.SortBy.NoSort SortDescending2: False SortBy3: Folder.SortBy.NoSort SortDescending3: False Files=> Files
LOOP FOREACH CurrentItem IN Files
    /# Encrypt the PDF file in place  and disable print, copy, and modify permissions using the Win2PDF encrypt command line:
C:\\Windows\\System32\\spool\\drivers\\x64\\3\\win2pdfd.exe encrypt "%CurrentItem%" "%CurrentItem%" ffffffe0 256aes "master" ""#/
    Scripting.RunDOSCommand.RunDOSCommand DOSCommandOrApplication: $'''C:\\Windows\\System32\\spool\\drivers\\x64\\3\\win2pdfd.exe encrypt \"%CurrentItem%\" \"%CurrentItem%\" ffffffe0 256aes \"master\" \"\"''' WorkingDirectory: $'''c:\\windows\\system32\\spool\\drivers\\x64\\3\\''' StandardOutput=> CommandOutput StandardError=> CommandErrorOutput ExitCode=> CommandExitCode
END

4.6.4.8 How To Rename PDFs based on File Contents Using Power Automate Desktop

The following Microsoft Power Automate Desktop flow shows how to
rename a folder of PDFs in place using the Win2PDF Desktop command line
getcontentsearch command. The flow searches the PDF files for a field
named "INVOICE :", and then renames the PDF based on the text
immediately following the "INVOICE :" field. You can configure the search
field by changing the "SearchText" variable.

This flow requires Win2PDF 10.0.100 or above.
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To use this "flow", copy the following into a new Power Automate Desktop
flow:

# This flow searches the contents of PDF files in the selected folder for SearchText, and renames the PDF files based on the text immediately following SearchText. Change the SearchText variable to the desired search field. Note : the SearchText field is case sensitive.
SET SearchText TO $'''INVOICE :'''
Display.SelectFolder Description: $'''Select Folder to Rename''' IsTopMost: False SelectedFolder=> SelectedFolder ButtonPressed=> ButtonPressed3
Folder.GetFiles Folder: SelectedFolder FileFilter: $'''*.pdf''' IncludeSubfolders: False FailOnAccessDenied: True SortBy1: Folder.SortBy.NoSort SortDescending1: False SortBy2: Folder.SortBy.NoSort SortDescending2: False SortBy3: Folder.SortBy.NoSort SortDescending3: False Files=> Files
LOOP FOREACH CurrentItem IN Files
# Search for %SearchText% field and return following text in CommandOutput using the following Win2PDF command line:
# C:\Windows\System32\spool\drivers\x64\3\win2pdfd.exe getcontentsearch "%CurrentItem%" "" "%SearchText%"
Scripting.RunDOSCommand.RunDOSCommand DOSCommandOrApplication: $'''C:\\Windows\\System32\\spool\\drivers\\x64\\3\\win2pdfd.exe getcontentsearch \"%CurrentItem%\" \"\" \"%SearchText%\"''' StandardOutput=> CommandOutput StandardError=> CommandErrorOutput ExitCode=> CommandExitCode
IF CommandExitCode = 0 THEN
Text.Trim Text: CommandOutput TrimOption: Text.TrimOption.Both TrimmedText=> TrimmedText
File.RenameFiles.Rename Files: CurrentItem NewName: $'''%SelectedFolder%\\%TrimmedText%''' KeepExtension: True IfFileExists: File.IfExists.Overwrite RenamedFiles=> RenamedFiles
ELSE
Display.ShowMessageDialog.ShowMessageWithTimeout Title: $'''Win2PDF Renamer''' Message: $'''Could not find \"INVOICE :\" field for file %CurrentItem%''' Icon: Display.Icon.None Buttons: Display.Buttons.OK DefaultButton: Display.DefaultButton.Button1 IsTopMost: False Timeout: 10 ButtonPressed=> ButtonPressed4
END
END
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4.7 How to use the Win2PDF Mail Helper Utility

4.7.1 How to install the Win2PDF Mail Helper Utility

Note: In the latest version of Win2PDF, the Win2PDF Mail Helper
functionality has been incorporated in to the Win2PDF Desktop
application and is no longer required in most circumstances (See How to
Mail a PDF).

The Win2PDF Mail Helper application is an optional SMTP mail client that
integrates with Win2PDF and supports sending email with or without user
interaction. This application can be downloaded from the Win2PDF support
download site at: 

https://helpdesk.win2pdf.com/index.php?/Knowledgebase/Article/View/18
9/15/win2pdf-mail-helper-download

After you have downloaded this file, double-click on it and it will install to
your PC.

4.7.2 How to configure the Win2PDF Mail Helper Utility

Note: In the latest version of Win2PDF, the Win2PDF Mail Helper
functionality has been incorporated in to the Win2PDF Desktop
application and is no longer required in most circumstances (See
Configure Win2PDF Mail for Microsoft Outlook, Configure Win2PDF Mail for
Gmail, Configure Win2PDF Mail for Yahoo! Mail, Configure Win2PDF Mail for
Mozilla Thunderbird, Configure Win2PDF Mail for Outlook.com, Configure
Win2PDF Mail for a Custom SMTP Server).

You can open the Win2PDF Mail Helper Utility by going to:

  Start -> Programs -> Win2PDF -> Win2PDF Mail Helper

(for Windows XP, Vista, and Windows 7, Windows 10, and Windows 11
users), or

by accessing the "Configure Win2PDF Mail Helper" start tile in Windows 8.

Once opened, the user interface will look like this:

https://helpdesk.win2pdf.com/index.php?/Knowledgebase/Article/View/189/15/win2pdf-mail-helper-download
https://helpdesk.win2pdf.com/index.php?/Knowledgebase/Article/View/189/15/win2pdf-mail-helper-download
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If "Use the default MAPI client" is selected, Win2PDF will send the email
using the default email program (typically Microsoft Outlook, Windows Live
Mail, Thunderbird, or other native Windows Mail application) installed on the
computer. This is the default option.

If "Use the Win2PDF Mail Helper" is selected, Win2PDF will use the
Win2PDF Mail Helper to send the email. This will bypass the default
Windows email program on your PC like Outlook, Windows Live Mail, or
Thunderbird.

To use the Win2PDF Mail Helper with Gmail, set the following:

o "SMTP Mail Server Name" set to "smtp.gmail.com"

o "Use SMTP authentication" is checked, and user name and password

set using your Gmail email address including @gmail.com and
password.

o "SMTP Port" set to "587", and

o "This server requires a secure connection (SSL/TLS)" should be

checked.

To use the Win2PDF Mail Helper with Yahoo Mail, set the following:

o "SMTP Mail Server Name" set to "smtp.mail.yahoo.com".

o "Use SMTP authentication" is checked, and user name and password

set using your Yahoo email address including @yahoo.com and
password.
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o "SMTP Port" set to "465", and

o "This server requires a secure connection (SSL/TLS)" should be

checked.

To use the Win2PDF Mail Helper with Windows Live Hotmail or
Outlook.com, set the following:

o "SMTP Mail Server Name" set to "smtp.live.com"

o "Use SMTP authentication" is checked, and user name and password

set using your Windows Live Hotmail email address including @live.com,
@hotmail.com, or @outlook.com and password.

o "SMTP Port" set to "587", and

o "This server requires a secure connection (SSL/TLS)" should be

checked.

4.8 How to print to PDF using Win2PDF in Microsoft Windows 8

4.8.1 How to install Win2PDF with Windows 8

Win2PDF 10 is available for download from our Win2PDF download page.
This version of Win2PDF will support Windows 8 and Windows 8.1 on all
Intel-based computers. 

Currently, Win2PDF will not work with the Windows 8 RT version for ARM-
based devices.

To install Win2PDF, download and run the Win2PDF setup program. After
you run the setup program, you will have a new printer in the "Devices and
Printers" folder named "Win2PDF".

http://www.win2pdf.com/download/download.htm
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If you are evaluating Win2PDF, you can start creating PDF documents
immediately. The evaluation version is fully functional, but every document
will have an extra trailer page with Win2PDF product information. Also, a
license reminder window will occasionally display. To evaluate Win2PDF or
Win2PDF Pro without the trailer page, contact support@win2pdf.com for a
30 day demo license.

The Win2PDF Pro install program can only be downloaded after you
purchase the product, and the download link will be included in your
purchase receipt. If you already have Win2PDF evaluation version installed,
you do not need to uninstall Win2PDF before running the Win2PDF Pro
install program. 

If you have purchased Win2PDF, you can enter your license code by
following the instructions in "Entering the Win2PDF license code".

mailto:support@win2pdf.com
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4.8.2 How to license Win2PDF with Windows 8

To enter the license code on a Windows 8 PC or tablet you'll first need to
find the "Enter Win2PDF License" app from the Windows 8 Start screen.
You can either locate it visually as a tile on your Start screen, or you can
use the Search charm to find this application. Here is a short video showing
how the "Enter Win2PDF License" app is used to license your copy of
Win2PDF.

How to license your copy of Win2PDF in Windows 8

Once you start the "Enter Win2PDF License" app, the following window
will appear.
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Click on the "Enter license code" button, and enter your name, company,
and license code exactly as they are listed in your email receipt.
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If you entered the information correctly, you should see a success message
as follows.

New documents created by Win2PDF will no longer include the trailer page
on each document.

4.8.3 How to print to a PDF file with a Windows 8 desktop app

Creating a PDF, XPS, TIFF, or SVG File from a Windows 8 or Windows 8.1
desktop application works the same as it did with Windows 7, Vista, or XP
applications.

Here’s a short video that shows Win2PDF creating a PDF file from a
Windows 8 desktop app:

How to print to Win2PDF from Windows 8 desktop apps
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4.8.4 How to print to a PDF file from a Windows 8 style app

The key differences with printing to Windows 8 style apps are:

1. Printers are accessed as Devices, which can be found in the Charm
bar. You can access the Charm bar by moving the cursor to the
right side of the screen and swiping up in a Windows 8 style app.

2. From Devices, you choose the printer named ‘Win2PDF’ and then
print. Immediately after printing, you will receive a notification in the
upper right corner of the screen. “The printer requires your attention.
Go to the desktop to take care of it.”

3. Click on this notification. This will bring you to the desktop where you
will see the normal Win2PDF file save window.

4. Then you can set the file name and save the PDF as you normally
would. If you click ‘View file’ and your default PDF viewer is a
Windows 8 style app such as Microsoft Reader, then it will open up
back in the Windows 8 full screen interface.

Here’s a short video that shows Win2PDF creating a PDF file from a
Windows 8 style app:

How to print to Win2PDF from Windows 8 style apps
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4.9 How to print to PDF using Win2PDF in Microsoft Windows 10

4.9.1 How to install Win2PDF with Windows 10

Win2PDF 10 is available for download from our Win2PDF download page.
This version of Win2PDF will support Windows 10 on all Intel-based
computers and tablets. 

Currently, Win2PDF will not work with the Windows 10 Mobile or
Windows 10 Mobile Enterprise editions of Windows 10 that use ARM or
Qualcomm Snapdragon processors.

To install Win2PDF, download and run the Win2PDF setup program. After
you run the setup program, you will have a new printer in the "Devices and
Printers" folder named "Win2PDF".

If you are evaluating Win2PDF, you can start creating PDF documents
immediately. The evaluation version is fully functional, but every document
will have an extra trailer page with Win2PDF product information. Also, a
license reminder window will occasionally display. To evaluate Win2PDF or

http://www.win2pdf.com/download/download.htm
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Win2PDF Pro without the trailer page, contact support@win2pdf.com for a
30 day demo license.

The Win2PDF Pro install program can only be downloaded after you
purchase the product, and the download link will be included in your
purchase receipt. If you already have Win2PDF evaluation version installed,
you do not need to uninstall Win2PDF before running the Win2PDF Pro
install program. 

If you have purchased Win2PDF, you can enter your license code by
following the instructions in "Entering the Win2PDF license code".

mailto:support@win2pdf.com
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4.9.2 How to license Win2PDF with Windows 10

To enter the license code on a Windows 10 PC or tablet you'll first need to
find the "Enter Win2PDF License" app from the Windows 10 Start
screen. You can either locate it visually as a tile on your Start screen, or
you can use the Search charm to find this application. Here is a short video
showing how the "Enter Win2PDF License" app is used to license your copy
of Win2PDF.

How to license your copy of Win2PDF in Windows 8

Once you start the "Enter Win2PDF License" app, the following window
will appear.
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Click on the "Enter license code" button, and enter your name, company,
and license code exactly as they are listed in your email receipt.
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If you entered the information correctly, you should see a success message
as follows.

New documents created by Win2PDF will no longer include the trailer page
on each document.

4.9.3 How to create a PDF using Win2PDF Print to PDF in Windows 10

The Win2PDF setup program creates a printer in the Windows 10 "Devices
and Printers" folder named Win2PDF. 

How to Create a PDF file using Win2PDF

To create a PDF document:

· Open a document from a Windows application (Word, Excel, Edge, etc.)
· Print the document and select the Win2PDF printer
· The Win2PDF print to PDF file save window pops up, allowing you to

choose a name and location for the PDF as shown below:
 



Win2PDF590

© 2023 Dane Prairie Systems, LLC

Win2PDF File Save Window

The default file name is supplied by the printing application. You can choose
the "Portable Document Format (PDF)" format from the "Save as
type:" options. Win2PDF print to PDF also supports the following formats:
· PDF/A - Portable Document Format for Archiving (PDF/A-1b, ISO 19005-

1:2005)
· XPS - XML Paper Specification
· TIFF (monochrome) - Tagged Image File Format
· SVG - Scalable Vector Graphics
· PDF Image Only - monochrome
· PDF Image Only - color
· Text - Formatted
· Text - Unformatted
· PDF - Searchable (OCR)
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You can choose a number of optional actions to take after the document is
created by selecting the check boxes. The options include:

· View File - Opens the file in the default viewer after the file is created.
· Print File - Prints the file to the selected paper printer after the file is

created to a Windows printer. 
· Send File - Opens a new email message using the default MAPI-

compliant email client and attaches the file to the message. The email
program is specified in the Internet Options icon in the Windows control
panel. Win2PDF can also be configured to send a PDF using Microsoft
Outlook, Mozilla Thunderbird, Gmail, Outlook.com, Yahoo! Mail, or
custom SMTP servers.

· Delete after Sending - Deletes the document after it has been sent
using the "Send File" option.

You can use the file save window to browse to a new location before saving
the document. Win2PDF remembers this location, and will use the same
location the next time you create a document.

If you want to skip the save Window, see the Win2PDF Auto-name feature.

4.9.4 How to view a file after using Win2PDF print to PDF in Windows 10

To view a PDF file after using the Win2PDF Print to PDF instead of the
Microsoft Print to PDF feature, just select the 'View file' option on the
Win2PDF file save window.
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When you save the PDF file, the file will automatically be opened with your
default PDF viewer application, which is typically the new Microsoft Edge
browser for Windows 10. Alternately, it may be the Adobe Reader software
if that has been installed and configured as the default PDF viewer.

4.9.5 How to print a file after using Win2PDF print to PDF in Windows 10

To print a copy of the PDF file to a paper printer after creating it, just select
the 'Print file' option on the Win2PDF file save window.
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When you check the "Print file" option, the you will be prompted to select a
paper printer. 

Select the paper printer where you want the hard copy sent.
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When you save the PDF file, the file will automatically be sent to your
selected printer.
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How to print a hard copy to a paper printer when saving a PDF file using the
Win2PDF printer 

4.9.6 How to email a file after using Win2PDF print to PDF in Windows 10

To email the PDF file after creating it with the Win2PDF Print to PDF printer,
select the 'Send file' option on the Win2PDF file save window.
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When the file is saved, it will automatically be attached as a new PDF file to
your default MAPI e-mail client (e.g. Microsoft Outlook). You can then
address the e-mail and send it as a file attachment.

You can also configure Win2PDF to send a PDF using Microsoft Outlook,
Mozilla Thunderbird, Gmail, Outlook.com, Yahoo! Mail, or custom SMTP
servers.

If the 'Delete after sending' option is checked, the PDF file will be deleted
from your hard disk after the e-mail has been sent.

4.9.7 How to create a PDF/A file using Win2PDF print to PDF in Windows 10

The Win2PDF setup program creates a printer in the "Devices and Printers"
folder named Win2PDF. 

How to Create a PDF/A file using
Win2PDF

To create a PDF/A document:

· Open a document from a Windows application (Word, Excel, Edge, etc.)
· Print the document and select the Win2PDF printer
· The Win2PDF print to PDF file save window pops up, allowing you to

choose a name and location for the PDF/A as shown below:
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Win2PDF File Save Window

The default file name is supplied by the printing application. You can choose
the "PDF for Archiving (PDF/A)" format from the "Save as type:"
options. Win2PDF also supports the following formats:
· PDF - Portable Document Format
· XPS - XML Paper Specification
· TIFF (monochrome) - Tagged Image File Format
· SVG - Scalable Vector Graphics
· PDF Image Only - monochrome
· PDF Image Only - color
· Text - Formatted
· Text - Unformatted
· PDF - Searchable (OCR)

You can choose a number of optional actions to take after the document is
created by selecting the check boxes. The options include:
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· View File - Opens the file in the default viewer after the file is created.
· Print File - Prints the file to the selected paper printer after the file is

created to a Windows printer. 
· Send File - Opens a new email message using the default MAPI-

compliant email client and attaches the file to the message. The email
program is specified in the Internet Options icon in the Windows control
panel. Win2PDF can also be configured to send a PDF using Microsoft
Outlook, Mozilla Thunderbird, Gmail, Outlook.com, Yahoo! Mail, or
custom SMTP servers.

· Delete after Sending - Deletes the document after it has been sent
using the "Send File" option.

You can use the file save window to browse to a new location before saving
the document. Win2PDF remembers this location, and will use the same
location the next time you create a document.

If you want to skip the save Window, see the Win2PDF Auto-name feature.

4.9.8 How to create an XPS file using Win2PDF in Windows 10

The Win2PDF setup program creates a printer in the "Devices and Printers"
folder named Win2PDF. 

How to Create a XML Paper
Specification (XPS) file using Win2PDF

To create an XML Paper Specification (XPS) document:

· Open a document from a Windows application (Word, Excel, Edge, etc.)
· Print the document and select the Win2PDF printer
· The Win2PDF file save window pops up, allowing you to choose a name

and location for the XPS as shown below:
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Win2PDF File Save Window

The default file name is supplied by the printing application. You can choose
the "XML Paper Specification (XPS)" format from the "Save as type:"
options. Win2PDF also supports the following formats:
· PDF - Portable Document Format
· PDF/A - Portable Document Format for Archiving (PDF/A-1b, ISO 19005-

1:2005)
· TIFF (monochrome) - Tagged Image File Format
· SVG - Scalable Vector Graphics
· PDF Image Only - monochrome
· PDF Image Only - color
· Text - Formatted
· Text - Unformatted
· PDF - Searchable (OCR)
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You can choose a number of optional actions to take after the document is
created by selecting the check boxes. The options include:

· View File - Opens the file in the default viewer after the file is created.
· Print File - Prints the file to the selected paper printer after the file is

created to a Windows printer. 
· Send File - Opens a new email message using the default MAPI-

compliant email client and attaches the file to the message. The email
program is specified in the Internet Options icon in the Windows control
panel. Win2PDF can also be configured to send an XPS using Microsoft
Outlook, Mozilla Thunderbird, Gmail, Outlook.com, Yahoo! Mail, or
custom SMTP servers.

· Delete after Sending - Deletes the document after it has been sent
using the "Send File" option.

You can use the file save window to browse to a new location before saving
the document. Win2PDF remembers this location, and will use the same
location the next time you create a document.

If you want to skip the save Window, see the Win2PDF Auto-name feature.

4.9.9 How to create a TIFF file using Win2PDF in Windows 10

The Win2PDF setup program creates a printer in the
"Devices and Printers" folder named Win2PDF. 

How to Create a TIFF file using

To create a TIFF document:

· Open a document from a Windows application (Word, Excel, Edge, etc.)
· Print the document and select the Win2PDF printer
· The Win2PDF file save window pops up, allowing you to choose a name

and location for the TIFF as shown below:
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Win2PDF File Save Window

The default file name is supplied by the printing application. You can choose
the "TIFF (monochrome)" format from the "Save as type:" options.
Win2PDF also supports the following formats:
· PDF - Portable Document Format
· PDF/A - Portable Document Format for Archiving (PDF/A-1b, ISO 19005-

1:2005)
· XPS - XML Paper Specification
· SVG - Scalable Vector Graphics
· PDF Image Only - monochrome
· PDF Image Only - color
· Text - Formatted
· Text - Unformatted
· PDF - Searchable (OCR)
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You can choose a number of optional actions to take after the document is
created by selecting the check boxes. The options include:

· View File - Opens the file in the default viewer after the file is created.
· Print File - Prints the file to the selected paper printer after the file is

created to a Windows printer. 
· Send File - Opens a new email message using the default MAPI-

compliant email client and attaches the file to the message. The email
program is specified in the Internet Options icon in the Windows control
panel. Win2PDF can also be configured to send a TIFF using Microsoft
Outlook, Mozilla Thunderbird, Gmail, Outlook.com, Yahoo! Mail, or
custom SMTP servers.

· Delete after Sending - Deletes the document after it has been sent
using the "Send File" option.

You can use the file save window to browse to a new location before saving
the document. Win2PDF remembers this location, and will use the same
location the next time you create a document.

If you want to skip the save Window, see the Win2PDF Auto-name feature.

4.9.10 How to create a SVG file using Win2PDF in Windows 10

The Win2PDF setup program creates a printer in the "Devices and Printers"
folder named Win2PDF. 

How to Create a SVG file using Win2PDF

To create an SVG document:

· Open a document from a Windows application (Word, Excel, Edge, etc.)
· Print the document and select the Win2PDF printer
· The Win2PDF file save window pops up, allowing you to choose a name

and location for the SVG as shown below:
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Win2PDF File Save Window

The default file name is supplied by the printing application. You can choose
the "Scalable Vector Graphics (SVG)" format from the "Save as type:"
options. Win2PDF also supports the following formats:
· PDF - Portable Document Format
· PDF/A - Portable Document Format for Archiving (PDF/A-1b, ISO 19005-

1:2005)
· XPS - XML Paper Specification
· TIFF (monochrome) - Tagged Image File Format
· PDF Image Only - monochrome
· PDF Image Only - color
· Text - Formatted
· Text - Unformatted
· PDF - Searchable (OCR)
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You can choose a number of optional actions to take after the document is
created by selecting the check boxes. The options include:

· View File - Opens the file in the default viewer after the file is created.
· Print File - Prints the file to the selected paper printer after the file is

created to a Windows printer. 
· Send File - Opens a new email message using the default MAPI-

compliant email client and attaches the file to the message. The email
program is specified in the Internet Options icon in the Windows control
panel. Win2PDF can also be configured to send an XPS using Microsoft
Outlook, Mozilla Thunderbird, Gmail, Outlook.com, Yahoo! Mail, or
custom SMTP servers.

· Delete after Sending - Deletes the document after it has been sent
using the "Send File" option.

You can use the file save window to browse to a new location before saving
the document. Win2PDF remembers this location, and will use the same
location the next time you create a document.

If you want to skip the save Window, see the Win2PDF Auto-name feature.

4.9.11 How to create a non-searchable (image only) PDF file using Win2PDF print to
PDF in Windows 10

The Win2PDF setup program creates a printer in the "Devices and Printers"
folder named Win2PDF. 

How to Create a PDF Image Only file
using Win2PDF

To create a PDF Image Only document:

· Open a document from a Windows application (Word, Excel, Edge, etc.)
· Print the document and select the Win2PDF printer
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· The Win2PDF file save window pops up, allowing you to choose a name
and location for the PDF as shown below:

 

Win2PDF File Save Window

The default file name is supplied by the printing application. You can choose
the "PDF for Image Only - monochrome (PDF)" or "PDF for Image
Only - color (PDF)" format from the "Save as type:" options. Win2PDF
also supports the following formats:
· PDF - Portable Document Format
· PDF/A - Portable Document Format for Archiving (PDF/A-1b, ISO 19005-

1:2005)
· XPS - XML Paper Specification
· TIFF (monochrome) - Tagged Image File Format
· SVG - Scalable Vector Graphics
· PDF Image Only - monochrome
· PDF Image Only - color
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· Text - Formatted
· Text - Unformatted
· PDF - Searchable (OCR)

You can choose a number of optional actions to take after the document is
created by selecting the check boxes. The options include:

· View File - Opens the file in the default viewer after the file is created.
· Print File - Prints the file to the selected paper printer after the file is

created to a Windows printer. 
· Send File - Opens a new email message using the default MAPI-

compliant email client and attaches the file to the message. The email
program is specified in the Internet Options icon in the Windows control
panel. Win2PDF can also be configured to send a PDF using Microsoft
Outlook, Mozilla Thunderbird, Gmail, Outlook.com, Yahoo! Mail, or
custom SMTP servers.

· Delete after Sending - Deletes the document after it has been sent
using the "Send File" option.

You can use the file save window to browse to a new location before saving
the document. Win2PDF remembers this location, and will use the same
location the next time you create a document.

If you want to skip the save Window, see the Win2PDF Auto-name feature.

4.9.12 How to automatically name PDF files using Win2PDF print to PDF in
Windows 10

Win2PDF and Win2Image can be configured to automatically name files and
skip the file save window. There are 3 ways to configure this:

1. You can run the "Configure Win2PDF Auto-Name" shortcut from the
Windows Start menu at "Start -> Win2PDF -> Configure Win2PDF Auto-
Name".
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Start Menu Configure Win2PDF Auto-Name

2. You can open "Configure Win2PDF Auto-Name" from the "Auto-Name"
menu of the Win2PDF Desktop App.
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Win2PDF Desktop Open Configure Win2PDF Auto-Name

3. You can print to the Win2PDF print to pdf printer, and open the
"Document" tab of PDF Options when you print to the Win2PDF printer.

Auto-name Files and Configure File Save Naming
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Options 1 and 2 are best if you need to change an existing auto-name
configuration, or add a new printer with auto-name enabled, use content
based naming, or configure auto-name for all users.  Option 3 is best if you
need to enable Win2PDF Pro document security or watermark settings as
part of the auto-name settings.

For more advanced methods for controlling the PDF file name, please visit
the How to Manage file name settings section of the How to use the
Win2PDF Admin Utility section of our online help.

4.10 How to print to PDF using Win2PDF in Microsoft Windows 11

4.10.1 How to install Win2PDF with Windows 11

Win2PDF 10 is available for download from our Win2PDF download page.
This version of Win2PDF will support Windows 11 on all Intel-based
computers and tablets. 

Currently, Win2PDF will not work with editions of Windows 11 that use ARM
or Qualcomm Snapdragon processors.

To install Win2PDF, download and run the Win2PDF setup program. After
you run the setup program, you will have a new printer in the "Devices and
Printers" folder named "Win2PDF".

http://www.win2pdf.com/doc/manage-pdf-file.htm
http://www.win2pdf.com/download/download.htm
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If you are evaluating Win2PDF, you can start creating PDF documents
immediately. The evaluation version is fully functional, but every document
will have an extra trailer page with Win2PDF product information. Also, a
license reminder window will occasionally display. To evaluate Win2PDF or
Win2PDF Pro without the trailer page, contact support@win2pdf.com for a
30 day demo license.

The Win2PDF Pro install program can only be downloaded after you
purchase the product, and the download link will be included in your
purchase receipt. If you already have Win2PDF evaluation version installed,
you do not need to uninstall Win2PDF before running the Win2PDF Pro
install program. 

If you have purchased Win2PDF, you can enter your license code by
following the instructions in "Entering the Win2PDF license code".

mailto:support@win2pdf.com
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4.10.2 How to license Win2PDF with Windows 11

To enter the license code on a Windows 11 PC or tablet you'll first need to
find the "Enter Win2PDF License" app from the Windows 11 Start
screen. You can either locate it visually as a tile on your Start screen, or
you can use the Search menu to find this application. Here is a short video
showing how the "Enter Win2PDF License" app is used to license your copy
of Win2PDF.

How to license your copy of Win2PDF in Windows 8

Once you start the "Enter Win2PDF License" app, the following window
will appear.
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Click on the "Enter license code" button, and enter your name, company,
and license code exactly as they are listed in your email receipt.
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If you entered the information correctly, you should see a success message
as follows.

New documents created by Win2PDF will no longer include the trailer page
on each document.

4.10.3 How to create a PDF using Win2PDF Print to PDF in Windows 11

The Win2PDF setup program creates a printer in the Windows 11 "Devices
and Printers" folder named Win2PDF. 

How to Create a PDF file using Win2PDF

To create a PDF document:

· Open a document from a Windows application (Word, Excel, Edge, etc.)
· Print the document and select the Win2PDF printer
· The Win2PDF print to PDF file save window pops up, allowing you to

choose a name and location for the PDF as shown below:
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Win2PDF File Save Window

The default file name is supplied by the printing application. You can choose
the "Portable Document Format (PDF)" format from the "Save as
type:" options. Win2PDF print to PDF also supports the following formats:
· PDF/A - Portable Document Format for Archiving (PDF/A-1b, ISO 19005-

1:2005)
· XPS - XML Paper Specification
· TIFF (monochrome) - Tagged Image File Format
· SVG - Scalable Vector Graphics
· PDF Image Only - monochrome
· PDF Image Only - color
· Text - Formatted
· Text - Unformatted
· PDF - Searchable (OCR)



How To Articles 615

© 2023 Dane Prairie Systems, LLC

You can choose a number of optional actions to take after the document is
created by selecting the check boxes. The options include:

· View File - Opens the file in the default viewer after the file is created.
· Print File - Prints the file to the selected paper printer after the file is

created to a Windows printer. 
· Send File - Opens a new email message using the default MAPI-

compliant email client and attaches the file to the message. The email
program is specified in the Internet Options icon in the Windows control
panel. Win2PDF can also be configured to send a PDF using Microsoft
Outlook, Mozilla Thunderbird, Gmail, Outlook.com, Yahoo! Mail, or
custom SMTP servers.

· Delete after Sending - Deletes the document after it has been sent
using the "Send File" option.

You can use the file save window to browse to a new location before saving
the document. Win2PDF remembers this location, and will use the same
location the next time you create a document.

If you want to skip the save Window, see the Win2PDF Auto-name feature.

4.10.4 How to view a file after using Win2PDF print to PDF in Windows 11

To view a PDF file after using the Win2PDF Print to PDF instead of the
Microsoft Print to PDF feature, just select the 'View file' option on the
Win2PDF file save window.
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When you save the PDF file, the file will automatically be opened with your
default PDF viewer application, which is typically the new Microsoft Edge
browser for Windows 11. Alternately, it may be the Adobe Reader software
if that has been installed and configured as the default PDF viewer.

4.10.5 How to print a file after using Win2PDF print to PDF in Windows 11

To print a copy of the PDF file to a paper printer after creating it, just select
the 'Print file' option on the Win2PDF file save window.
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When you check the "Print file" option, the you will be prompted to select a
paper printer. 

Select the paper printer where you want the hard copy sent.
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When you save the PDF file, the file will automatically be sent to your
selected printer.
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How to print a hard copy to a paper printer when saving a PDF file using the
Win2PDF printer 

4.10.6 How to email a file after using Win2PDF print to PDF in Windows 11

To email the PDF file after creating it with the Win2PDF Print to PDF printer,
select the 'Send file' option on the Win2PDF file save window.
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When the file is saved, it will automatically be attached as a new PDF file to
your default MAPI e-mail client (e.g. Microsoft Outlook). You can then
address the e-mail and send it as a file attachment.

You can also configure Win2PDF to send a PDF using Microsoft Outlook,
Mozilla Thunderbird, Gmail, Outlook.com, Yahoo! Mail, or custom SMTP
servers.

If the 'Delete after sending' option is checked, the PDF file will be deleted
from your hard disk after the e-mail has been sent.

4.10.7 How to create a PDF/A file using Win2PDF print to PDF in Windows 11

The Win2PDF setup program creates a printer in the "Devices and Printers"
folder named Win2PDF. 

How to Create a PDF/A file using
Win2PDF

To create a PDF/A document:

· Open a document from a Windows application (Word, Excel, Edge, etc.)
· Print the document and select the Win2PDF printer
· The Win2PDF print to PDF file save window pops up, allowing you to

choose a name and location for the PDF/A as shown below:
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Win2PDF File Save Window

The default file name is supplied by the printing application. You can choose
the "PDF for Archiving (PDF/A)" format from the "Save as type:"
options. Win2PDF also supports the following formats:
· PDF - Portable Document Format
· XPS - XML Paper Specification
· TIFF (monochrome) - Tagged Image File Format
· SVG - Scalable Vector Graphics
· PDF Image Only - monochrome
· PDF Image Only - color
· Text - Formatted
· Text - Unformatted
· PDF - Searchable (OCR)

You can choose a number of optional actions to take after the document is
created by selecting the check boxes. The options include:
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· View File - Opens the file in the default viewer after the file is created.
· Print File - Prints the file to the selected paper printer after the file is

created to a Windows printer. 
· Send File - Opens a new email message using the default MAPI-

compliant email client and attaches the file to the message. The email
program is specified in the Internet Options icon in the Windows control
panel. Win2PDF can also be configured to send a PDF using Microsoft
Outlook, Mozilla Thunderbird, Gmail, Outlook.com, Yahoo! Mail, or
custom SMTP servers.

· Delete after Sending - Deletes the document after it has been sent
using the "Send File" option.

You can use the file save window to browse to a new location before saving
the document. Win2PDF remembers this location, and will use the same
location the next time you create a document.

If you want to skip the save Window, see the Win2PDF Auto-name feature.

4.10.8 How to create an XPS file using Win2PDF in Windows 11

The Win2PDF setup program creates a printer in the "Devices and Printers"
folder named Win2PDF. 

How to Create a XML Paper
Specification (XPS) file using Win2PDF

To create an XML Paper Specification (XPS) document:

· Open a document from a Windows application (Word, Excel, Edge, etc.)
· Print the document and select the Win2PDF printer
· The Win2PDF file save window pops up, allowing you to choose a name

and location for the XPS as shown below:
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Win2PDF File Save Window

The default file name is supplied by the printing application. You can choose
the "XML Paper Specification (XPS)" format from the "Save as type:"
options. Win2PDF also supports the following formats:
· PDF - Portable Document Format
· PDF/A - Portable Document Format for Archiving (PDF/A-1b, ISO 19005-

1:2005)
· TIFF (monochrome) - Tagged Image File Format
· SVG - Scalable Vector Graphics
· PDF Image Only - monochrome
· PDF Image Only - color
· Text - Formatted
· Text - Unformatted
· PDF - Searchable (OCR)
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You can choose a number of optional actions to take after the document is
created by selecting the check boxes. The options include:

· View File - Opens the file in the default viewer after the file is created.
· Print File - Prints the file to the selected paper printer after the file is

created to a Windows printer. 
· Send File - Opens a new email message using the default MAPI-

compliant email client and attaches the file to the message. The email
program is specified in the Internet Options icon in the Windows control
panel. Win2PDF can also be configured to send an XPS using Microsoft
Outlook, Mozilla Thunderbird, Gmail, Outlook.com, Yahoo! Mail, or
custom SMTP servers.

· Delete after Sending - Deletes the document after it has been sent
using the "Send File" option.

You can use the file save window to browse to a new location before saving
the document. Win2PDF remembers this location, and will use the same
location the next time you create a document.

If you want to skip the save Window, see the Win2PDF Auto-name feature.

4.10.9 How to create a TIFF file using Win2PDF in Windows 11

The Win2PDF setup program creates a printer in the "Devices and Printers"
folder named Win2PDF. 

How to Create a TIFF file using

To create a TIFF document:

· Open a document from a Windows application (Word, Excel, Edge, etc.)
· Print the document and select the Win2PDF printer
· The Win2PDF file save window pops up, allowing you to choose a name

and location for the TIFF as shown below:
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Win2PDF File Save Window

The default file name is supplied by the printing application. You can choose
the "TIFF (monochrome)" format from the "Save as type:" options.
Win2PDF also supports the following formats:
· PDF - Portable Document Format
· PDF/A - Portable Document Format for Archiving (PDF/A-1b, ISO 19005-

1:2005)
· XPS - XML Paper Specification
· SVG - Scalable Vector Graphics
· PDF Image Only - monochrome
· PDF Image Only - color
· Text - Formatted
· Text - Unformatted
· PDF - Searchable (OCR)
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You can choose a number of optional actions to take after the document is
created by selecting the check boxes. The options include:

· View File - Opens the file in the default viewer after the file is created.
· Print File - Prints the file to the selected paper printer after the file is

created to a Windows printer. 
· Send File - Opens a new email message using the default MAPI-

compliant email client and attaches the file to the message. The email
program is specified in the Internet Options icon in the Windows control
panel. Win2PDF can also be configured to send a TIFF using Microsoft
Outlook, Mozilla Thunderbird, Gmail, Outlook.com, Yahoo! Mail, or
custom SMTP servers.

· Delete after Sending - Deletes the document after it has been sent
using the "Send File" option.

You can use the file save window to browse to a new location before saving
the document. Win2PDF remembers this location, and will use the same
location the next time you create a document.

If you want to skip the save Window, see the Win2PDF Auto-name feature.

4.10.10 How to create a SVG file using Win2PDF in Windows 11

The Win2PDF setup program creates a printer in the "Devices and Printers"
folder named Win2PDF. 

How to Create a SVG file using Win2PDF

To create an SVG document:

· Open a document from a Windows application (Word, Excel, Edge, etc.)
· Print the document and select the Win2PDF printer
· The Win2PDF file save window pops up, allowing you to choose a name

and location for the SVG as shown below:
 



How To Articles 627

© 2023 Dane Prairie Systems, LLC

Win2PDF File Save Window

The default file name is supplied by the printing application. You can choose
the "Scalable Vector Graphics (SVG)" format from the "Save as type:"
options. Win2PDF also supports the following formats:
· PDF - Portable Document Format
· PDF/A - Portable Document Format for Archiving (PDF/A-1b, ISO 19005-

1:2005)
· XPS - XML Paper Specification
· TIFF (monochrome) - Tagged Image File Format
· PDF Image Only - monochrome
· PDF Image Only - color
· Text - Formatted
· Text - Unformatted
· PDF - Searchable (OCR)
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You can choose a number of optional actions to take after the document is
created by selecting the check boxes. The options include:

· View File - Opens the file in the default viewer after the file is created.
· Print File - Prints the file to the selected paper printer after the file is

created to a Windows printer. 
· Send File - Opens a new email message using the default MAPI-

compliant email client and attaches the file to the message. The email
program is specified in the Internet Options icon in the Windows control
panel. Win2PDF can also be configured to send an XPS using Microsoft
Outlook, Mozilla Thunderbird, Gmail, Outlook.com, Yahoo! Mail, or
custom SMTP servers.

· Delete after Sending - Deletes the document after it has been sent
using the "Send File" option.

You can use the file save window to browse to a new location before saving
the document. Win2PDF remembers this location, and will use the same
location the next time you create a document.

If you want to skip the save Window, see the Win2PDF Auto-name feature.

4.10.11 How to create a non-searchable (image only) PDF file using Win2PDF print to
PDF in Windows 11

The Win2PDF setup program creates a printer in the "Devices and Printers"
folder named Win2PDF. 

How to Create a PDF Image Only file
using Win2PDF

To create a PDF Image Only document:

· Open a document from a Windows application (Word, Excel, Edge, etc.)
· Print the document and select the Win2PDF printer
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· The Win2PDF file save window pops up, allowing you to choose a name
and location for the PDF as shown below:

 

Win2PDF File Save Window

The default file name is supplied by the printing application. You can choose
the "PDF for Image Only - monochrome (PDF)" or "PDF for Image
Only - color (PDF)" format from the "Save as type:" options. Win2PDF
also supports the following formats:
· PDF - Portable Document Format
· PDF/A - Portable Document Format for Archiving (PDF/A-1b, ISO 19005-

1:2005)
· XPS - XML Paper Specification
· TIFF (monochrome) - Tagged Image File Format
· SVG - Scalable Vector Graphics
· PDF Image Only - monochrome
· PDF Image Only - color
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· Text - Formatted
· Text - Unformatted
· PDF - Searchable (OCR)

You can choose a number of optional actions to take after the document is
created by selecting the check boxes. The options include:

· View File - Opens the file in the default viewer after the file is created.
· Print File - Prints the file to the selected paper printer after the file is

created to a Windows printer. 
· Send File - Opens a new email message using the default MAPI-

compliant email client and attaches the file to the message. The email
program is specified in the Internet Options icon in the Windows control
panel. Win2PDF can also be configured to send a PDF using Microsoft
Outlook, Mozilla Thunderbird, Gmail, Outlook.com, Yahoo! Mail, or
custom SMTP servers.

· Delete after Sending - Deletes the document after it has been sent
using the "Send File" option.

You can use the file save window to browse to a new location before saving
the document. Win2PDF remembers this location, and will use the same
location the next time you create a document.

If you want to skip the save Window, see the Win2PDF Auto-name feature.

4.10.12 How to automatically name PDF files using Win2PDF print to PDF in
Windows 11

Win2PDF and Win2Image can be configured to automatically name files and
skip the file save window. There are 3 ways to configure this:

1. You can run the "Configure Win2PDF Auto-Name" shortcut from the
Windows Start menu at "Start -> Win2PDF -> Configure Win2PDF Auto-
Name".



How To Articles 631

© 2023 Dane Prairie Systems, LLC

Start Menu Configure Win2PDF Auto-Name

2. You can open "Configure Win2PDF Auto-Name" from the "Auto-Name"
menu of the Win2PDF Desktop App.
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Win2PDF Desktop Open Configure Win2PDF Auto-Name

3. You can print to the Win2PDF print to pdf printer, and open the
"Document" tab of PDF Options when you print to the Win2PDF printer.

Auto-name Files and Configure File Save Naming
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Options 1 and 2 are best if you need to change an existing auto-name
configuration, or add a new printer with auto-name enabled, use content
based naming, or configure auto-name for all users.  Option 3 is best if you
need to enable Win2PDF Pro document security or watermark settings as
part of the auto-name settings.

For more advanced methods for controlling the PDF file name, please visit
the How to Manage file name settings section of the How to use the
Win2PDF Admin Utility section of our online help.

4.11 How to Use Microsoft Print To PDF in Windows 10

4.11.1 How to make PDF files created with Microsoft Print To PDF in Windows 10
smaller

The PDF files created using the Microsoft Print to PDF printer can be
very large as they are not optimally compressed and do not provide any
mechanism for changing the resolution of the graphics. If you want to
reduce the file size of a Microsoft Print to PDF file, you can use the
Win2PDF Print to PDF software to reduce file sizes.

The Win2PDF Print to PDF printer has better default file compression and
supports a user-controllable resolution setting for the printer.

The default resolution for bitmaps is 300 DPI. You can change the default
resolution by opening the "Printers" folder, right clicking on the Win2PDF
icon, and opening "Printing Preferences". The resolution (Print Quality)
setting us under the "Advanced..." section of this window.

http://www.win2pdf.com/doc/manage-pdf-file.htm
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Increasing the resolution will improve the quality of bitmap images, but it
will also increase the document size.

Enabling JPEG2000 image compression in the Advanced tab of the PDF
Options window can also reduce the PDF file size.
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You can also use the Win2PDF Desktop App to compress an existing PDF.

4.11.2 How to prevent printing PDF files created with Microsoft Print To PDF in
Windows 10

The PDF files created using the Microsoft Print to PDF printer are not
encrypted, and users cannot restrict the ability to print a PDF file once it
has been created. If you want to prevent the ability to print a PDF file
created with Microsoft Print to PDF, you can use the Win2PDF Pro Print
to PDF to set the encryption and permissions of the PDF file.

Win2PDF Pro supports the standard security options and permissions
available in the PDF file format.
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The "Encryption Level" setting controls the type of encryption used in the
PDF file. The 128 bit encryption is compatible with Acrobat Reader 7.0 and
above and the 256 bit encryption is compatible with Acrobat Reader 9.0
and above. For best security, the 256 bit encryption option is
recommended.

The "Permissions" setting controls restrictions that can be placed on the
PDF file. To prevent printing of a PDF file, uncheck the "Allow the
document to be printed" option. 

You must always enter a master password when security options are
enabled or when a user password is set. It is recommended that passwords
be at least 8 characters long and contain at least 1 number.

The password and permissions options are only available when the
"Encryption Level" is set to 128 or 256 bit encryption. Here is a YouTube
video that shows how to set the security options:
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Enabling security options in PDF with Win2PDF Pro

Information on controlling the encryption options from a custom application
is available in "controlling encryption options" in the developer information
section.

An administrator can disable or change the default value for any of the
security settings using the "Win2PDF Admin Utility" available for
download at:
https://helpdesk.win2pdf.com/index.php?/Knowledgebase/Article/View/18
7/15/win2pdf-admin-utility-download

4.11.3 How to prevent copying text or images from PDF files created with Microsoft
Print To PDF in Windows 10

The PDF files created using the Microsoft Print to PDF printer are not
encrypted, and users cannot restrict the ability to copy text or images from
a PDF file once it has been created. If you want to prevent the ability to
copy text or images from a PDF file created with Microsoft Print to PDF,
you can use the Win2PDF Pro Print to PDF to set the encryption and
permissions of the PDF file.

Win2PDF Pro supports the standard security options and permissions
available in the PDF file format.

https://helpdesk.win2pdf.com/index.php?/Knowledgebase/Article/View/187/15/win2pdf-admin-utility-download
https://helpdesk.win2pdf.com/index.php?/Knowledgebase/Article/View/187/15/win2pdf-admin-utility-download
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The "Encryption Level" setting controls the type of encryption used in the
PDF file. The 128 bit encryption is compatible with Acrobat Reader 7.0 and
above and the 256 bit encryption is compatible with Acrobat Reader 9.0
and above. For best security, the 256 bit encryption option is
recommended.

The "Permissions" setting controls restrictions that can be placed on the
PDF file. To prevent the text and graphics from being copied from the PDF
file, uncheck the "Allow text and graphics to be copied" option. 

You must always enter a master password when security options are
enabled. It is recommended that passwords be at least 8 characters long
and contain at least 1 number.

The password and permissions options are only available when the
"Encryption Level" is set to 128 or 256 bit encryption. Here is a YouTube
video that shows how to set the security options:
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Enabling security options in PDF with Win2PDF Pro

Information on controlling the encryption options from a custom application
is available in "controlling encryption options" in the developer information
section.

An administrator can disable or change the default value for any of the
security settings using the "Win2PDF Admin Utility" available for
download at:
https://helpdesk.win2pdf.com/index.php?/Knowledgebase/Article/View/18
7/15/win2pdf-admin-utility-download

4.11.4 How to prevent modification of PDF files created with Microsoft Print To PDF
in Windows 10

The PDF files created using the Microsoft Print to PDF printer are not
encrypted, and users cannot restrict the ability to modifying or editing a
PDF file once it has been created with another application like Adobe
Acrobat. If you want to prevent the ability to edit or modify a PDF file
created with Microsoft Print to PDF, you can use the Win2PDF Pro Print
to PDF to set the encryption and permissions of the PDF file.

Win2PDF Pro supports the standard security options and permissions
available in the PDF file format.

https://helpdesk.win2pdf.com/index.php?/Knowledgebase/Article/View/187/15/win2pdf-admin-utility-download
https://helpdesk.win2pdf.com/index.php?/Knowledgebase/Article/View/187/15/win2pdf-admin-utility-download
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The "Encryption Level" setting controls the type of encryption used in the
PDF file. The 128 bit encryption is compatible with Acrobat Reader 7.0 and
above and the 256 bit encryption is compatible with Acrobat Reader 9.0
and above. For best security, the 256 bit encryption option is
recommended.

The "Permissions" setting controls restrictions that can be placed on the
PDF file. To prevent the text and graphics from being copied from the PDF
file, uncheck the "Allow text and graphics to be copied" option. 

You must always enter a master password when security options are
enabled. It is recommended that passwords be at least 8 characters long
and contain at least 1 number.

The password and permissions options are only available when the
"Encryption Level" is set to 128 or 256 bit encryption. Here is a YouTube
video that shows how to set the security options:
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Enabling security options in PDF with Win2PDF Pro

Information on controlling the encryption options from a custom application
is available in "controlling encryption options" in the developer information
section.

An administrator can disable or change the default value for any of the
security settings using the "Win2PDF Admin Utility" available for
download at:
https://helpdesk.win2pdf.com/index.php?/Knowledgebase/Article/View/18
7/15/win2pdf-admin-utility-download

4.11.5 How to password protect PDF files created with Microsoft Print To PDF in
Windows 10

The PDF files created using the Microsoft Print to PDF printer are not
encrypted, and users cannot set a password that a user would need to
open or view the PDF file. If you want to set a password (needed to open
or view) a PDF file created with Microsoft Print to PDF, you can use the
Win2PDF Pro Print to PDF to set the encryption and password for the PDF
file.

Win2PDF Pro supports the standard security options and permissions
available in the PDF file format.

https://helpdesk.win2pdf.com/index.php?/Knowledgebase/Article/View/187/15/win2pdf-admin-utility-download
https://helpdesk.win2pdf.com/index.php?/Knowledgebase/Article/View/187/15/win2pdf-admin-utility-download
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The "Encryption Level" setting controls the type of encryption used in the
PDF file. The 128 bit encryption is compatible with Acrobat Reader 7.0 and
above and the 256 bit encryption is compatible with Acrobat Reader 9.0
and above. For best security, the 256 bit encryption option is
recommended.

The PDF file format allows two types of passwords, a user password and a
master password. The user password is used to open the document, and
the master password used to encrypt the security options. When a user
password is set, Acrobat Reader displays the following prompt when you
open the PDF file.
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You must always enter a master password when security options are
enabled. It is recommended that passwords be at least 8 characters long
and contain at least 1 number.

The password and permissions options are only available when the
"Encryption Level" is set to 128 or 256 bit encryption. Here is a YouTube
video that shows how to set the security options:

Enabling security options in PDF with Win2PDF Pro

Information on controlling the encryption options from a custom application
is available in "controlling encryption options" in the developer information
section.

An administrator can disable or change the default value for any of the
security settings using the "Win2PDF Admin Utility" available for
download at:
https://helpdesk.win2pdf.com/index.php?/Knowledgebase/Article/View/18
7/15/win2pdf-admin-utility-download

https://helpdesk.win2pdf.com/index.php?/Knowledgebase/Article/View/187/15/win2pdf-admin-utility-download
https://helpdesk.win2pdf.com/index.php?/Knowledgebase/Article/View/187/15/win2pdf-admin-utility-download


Win2PDF644

© 2023 Dane Prairie Systems, LLC

4.11.6 How to add a background image to PDF files created with Microsoft Print To
PDF in Windows 10

Background images (watermarks applied underneath the text/images of a
PDF file) cannot be added to PDF files created using the Microsoft Print to
PDF printer. If you want to add a background to a PDF file created with
Microsoft Print to PDF, you can use the Win2PDF Pro Print to PDF to
set the background image.

Win2PDF Pro can place an existing PDF file behind text and graphics on
newly created PDF files (Add a Background). The existing background PDF
file can contain any text or graphics, but it most often used to apply a
"confidential" or "draft" stamp on each page of a document. To enable the
background feature, select the "Add a Background" option in the Win2PDF
"PDF Options" window.

When the background option is enabled, a text box containing the name of
the current watermark or background PDF file is shown below the options.
If you would like to change the file, click the "Change..." button and select
a new background PDF file. Win2PDF will always display the last used
background PDF file when the feature is enabled.  Here is a YouTube video
that shows how to set the security options:
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Adding a watermark to a PDF file using Win2PDF Pro

If the background PDF file contains more than one page, only the first page
will be applied to each page of the new document. It's best to use a
background PDF file that has the same page size as the newly created PDF
file. If the background file has a different page size, it will be scaled and
centered on the page of the newly created PDF file.

You can create the background PDF file using Win2PDF and any Windows
application such as Microsoft Word. If you are using Win2PDF Pro, the
background PDF file must not be encrypted. Some sample background PDF
files and the corresponding Word documents are available on the download
section of the support web site at:
https://helpdesk.win2pdf.com/index.php?/Knowledgebase/Article/View/18
6/17/watermark-samples

Information on controlling the watermark options from a custom application
is available in "watermark options" in the developer information section.

An administrator can disable or set a default watermark PDF file for all users
with the "Win2PDF Admin Utility" available for download at:
https://helpdesk.win2pdf.com/index.php?/Knowledgebase/Article/View/18
7/15/win2pdf-admin-utility-download

https://helpdesk.win2pdf.com/index.php?/Knowledgebase/Article/View/186/17/watermark-samples
https://helpdesk.win2pdf.com/index.php?/Knowledgebase/Article/View/186/17/watermark-samples
https://helpdesk.win2pdf.com/index.php?/Knowledgebase/Article/View/187/15/win2pdf-admin-utility-download
https://helpdesk.win2pdf.com/index.php?/Knowledgebase/Article/View/187/15/win2pdf-admin-utility-download
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4.11.7 How to add a watermark image to PDF files created with Microsoft Print To
PDF in Windows 10

Background images (watermarks applied underneath the text/images of a
PDF file) cannot be added to PDF files created using the Microsoft Print to
PDF printer. If you want to add a background to a PDF file created with
Microsoft Print to PDF, you can use the Win2PDF Pro Print to PDF to
set the background image.

Win2PDF Pro can overlay an existing PDF file on newly created PDF files
(Add a Watermark). The existing watermark PDF file can contain any text or
graphics, but it most often used to apply a "confidential" or "draft" stamp
on each page of a document. To enable the watermark feature, select the
"Add a Watermark" option in the Win2PDF "PDF Options" window.

When the watermark option is enabled, a text box containing the name of
the current watermark PDF file is shown below the options. If you would
like to change the file, click the "Change..." button and select a new
watermark PDF file. Win2PDF will always display the last used watermark
PDF file when the feature is enabled.  Here is a YouTube video that shows
how to set the security options:
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Adding a watermark to a PDF file using Win2PDF Pro

If the watermark PDF file contains more than one page, only the first page
will be applied to each page of the new document. It's best to use a
watermark PDF file that has the same page size as the newly created PDF
file. If the watermark file has a different page size, it will be scaled and
centered on the page of the newly created PDF file.

You can create the watermark PDF file using Win2PDF and any Windows
application such as Microsoft Word. If you are using Win2PDF Pro, the
watermark PDF file must not be encrypted. Some sample watermark PDF
files and the corresponding Word documents are available on the download
section of the support web site at:
https://helpdesk.win2pdf.com/index.php?/Knowledgebase/Article/View/18
6/17/watermark-samples

Information on controlling the watermark options from a custom application
is available in "watermark options" in the developer information section.

An administrator can disable or set a default watermark PDF file for all users
with the "Win2PDF Admin Utility" available for download at:
https://helpdesk.win2pdf.com/index.php?/Knowledgebase/Article/View/18
7/15/win2pdf-admin-utility-download

https://helpdesk.win2pdf.com/index.php?/Knowledgebase/Article/View/186/17/watermark-samples
https://helpdesk.win2pdf.com/index.php?/Knowledgebase/Article/View/186/17/watermark-samples
https://helpdesk.win2pdf.com/index.php?/Knowledgebase/Article/View/187/15/win2pdf-admin-utility-download
https://helpdesk.win2pdf.com/index.php?/Knowledgebase/Article/View/187/15/win2pdf-admin-utility-download
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4.11.8 How to prepend to a PDF file created with Microsoft Print To PDF in
Windows 10

The Microsoft Print to PDF printer does not have an ability to prepend
the PDF file to an existing PDF file. If you want to prepend (insert before) a
PDF file created with Microsoft Print to PDF to an existing PDF file, you
can use the Win2PDF Print to PDF merge options.

When using the Win2PDF software, if you select a PDF file in the file save
window that already exists, Win2PDF will display the following window:

The "Prepend" button will create a new document containing the existing
PDF file and will insert the new document information at the beginning of
the file. The "Replace" button will overwrite the existing PDF file, and the
"Cancel" button will cancel the PDF creation without affecting the existing
PDF file. Here is a YouTube video that shows how to append to an existing
PDF file.
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How to append to an existing PDF file using Win2PDF

If the "Overwrite original file" check box is checked, the "Prepend"
button will overwrite the original document with the new merged document.
This option should be used with caution since it cannot be undone. If the
"Overwrite original file" check box is not checked, the "Prepend"
button will display an additional window to choose a new file name as
shown below. In this case, the original PDF file will not be modified.
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If you selected options to "View File", "Print File", or "Send File" in the
first file save window, they will be performed after the file has been
merged.

If you enabled encryption in Win2PDF Pro, the merged file will be
encrypted. Win2PDF cannot append or prepend to an existing PDF file that
is already encrypted.

You can also append two existing PDF files using the Win2PDF Desktop
App.
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4.11.9 How to append to a PDF file created with Microsoft Print To PDF in Windows
10

The Microsoft Print to PDF printer does not have an ability to append the
PDF file to an existing PDF file. If you want to append (insert after) a PDF
file created with Microsoft Print to PDF to an existing PDF file, you can
use the Win2PDF Print to PDF merge options.

When using the Win2PDF software, if you select a PDF file in the file save
window that already exists, Win2PDF will display the following window:

The "Append" button will create a new document containing the existing
PDF file and will add the new document information to the end of the file.
The "Replace" button will overwrite the existing PDF file, and the "Cancel"
button will cancel the PDF creation without affecting the existing PDF file.
Here is a YouTube video that shows how to append to an existing PDF file.
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How to append to an existing PDF file using Win2PDF

If the "Overwrite original file" check box is checked, the "Append"
button will overwrite the original document with the new merged document.
This option should be used with caution since it cannot be undone. If the
"Overwrite original file" check box is not checked, the "Append" button
will display an additional window to choose a new file name as shown
below. In this case, the original PDF file will not be modified.
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If you selected options to "View File", "Print File", or "Send File" in the
first file save window, they will be performed after the file has been
merged.

If you enabled encryption in Win2PDF Pro, the merged file will be
encrypted. Win2PDF cannot append or prepend to an existing PDF file that
is already encrypted.

You can also append two existing PDF files using the Win2PDF Desktop
App.
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4.11.10 How to automatically name PDF files created with Microsoft Print To PDF in
Windows 10

The Microsoft Print to PDF printer does not have an ability to
automatically name PDF files. The user must manually enter in a name for
each document they print.

The Win2PDF Print to PDF printer can be configured to set the default file
name that is shown in the file save window. It can also be configured to
automatically name files and skip the file save window. 

Win2PDF and Win2Image can be configured to automatically name files and
skip the file save window. There are 3 ways to configure this:

1. You can run the "Configure Win2PDF Auto-Name" shortcut from the
Windows Start menu at "Start -> Win2PDF -> Configure Win2PDF Auto-
Name".
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Start Menu Configure Win2PDF Auto-Name

2. You can open "Configure Win2PDF Auto-Name" from the "Auto-Name"
menu of the Win2PDF Desktop App.
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Win2PDF Desktop Open Configure Win2PDF Auto-Name

3. You can print to the Win2PDF print to pdf printer, and open the
"Document" tab of PDF Options when you print to the Win2PDF printer.

Auto-name Files and Configure File Save Naming
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Options 1 and 2 are best if you need to change an existing auto-name
configuration, or add a new printer with auto-name enabled, use content
based naming, or configure auto-name for all users.  Option 3 is best if you
need to enable Win2PDF Pro document security or watermark settings as
part of the auto-name settings.

For more advanced methods for controlling the PDF file name, please visit
the How to Manage file name settings section of the How to use the
Win2PDF Admin Utility section of our online help.

http://www.win2pdf.com/doc/manage-pdf-file.htm
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5 Frequently Asked Questions

5.1 Win2PDF Support on the Internet

There are also many common problems and solutions listed in the
knowledge base section of the Win2PDF support page.  If your question is
not answered here, you may submit a question from this site.

5.2 What is the difference between Win2PDF and the Adobe PDF
Writer

The original version of Adobe Acrobat included two ways to create PDF
files: Adobe PDF Writer and Adobe Distiller. The Adobe PDF Writer was a
Windows printer driver that directly converted Windows graphics
commands into PDF. Adobe Distiller was a Postscript to PDF converter. If
you printed to the Adobe Distiller printer, it first converted the graphics to a
Postscript file, and then Adobe Distiller converted the Postscript to PDF. The
two step conversion processes used by Adobe Distiller was slower, but
usually produced smaller and better quality PDF files.

The original version of Win2PDF released for Windows NT in March of 2000
was very similar in architecture to the original Adobe PDF Writer. Win2PDF
also directly converted Windows graphics commands into PDF, and was
very fast when compared to Adobe Distiller.

Starting in Adobe Acrobat 6, Adobe discontinued support for Adobe PDF
Writer and Adobe Distiller became the default "Adobe PDF Printer".

Starting in Win2PDF 7, the architecture of Win2PDF changed to make use of
the Microsoft XML Paper Specification feature that is built in to Windows
Vista, Windows 7, and Windows Server 2008. Win2PDF 10 now creates an
XPS file, and then converts the XPS file to PDF. This allows Win2PDF 10 to
handle fonts and graphics better than older versions of Win2PDF.

5.3 Can I use Win2PDF as a shared printer on a print server?

Yes, with certain caveats, although we don't officially support it. Win2PDF
works differently than a paper printer.

First, the pricing and licensing requirements are the same as the standard
edition of Win2PDF. Each PC that installs Win2PDF as a local printer, or
accesses the Win2PDF printer from a shared print server, requires a license
of Win2PDF Standard Edition. It is not based on concurrent users; each PC
that has access to Win2PDF will need a license. 

https://helpdesk.win2pdf.com/index.php?/Knowledgebase/List
https://helpdesk.win2pdf.com/
https://helpdesk.win2pdf.com/index.php?/Tickets/Submit


Win2PDF660

© 2023 Dane Prairie Systems, LLC

Second, Win2PDF differs from most printer drivers in that all operations are
done locally on the PC or server where Win2PDF is installed. This is
true both when Win2PDF has been installed using the Win2PDF setup
program, and when Win2PDF has been installed using printer sharing. If
Win2PDF has been installed using printer sharing, no processing or
communication is done on the print server. There is no performance
advantage to installing Win2PDF using printer sharing.

It is recommended that the Win2PDF printer be installed local to
each PC instead of accessing it as a shared printer. There are several
limitations with the shared printer implementation, which are:

üWin2PDF relies on some Windows components that are not available on
all versions of Windows servers or clients. The Win2PDF setup program
checks for these components, and installs them if necessary. If Win2PDF
is installed using printer sharing, there is no opportunity to check for
these components and Win2PDF may not function correctly if the
components are missing. As such, users of Windows XP or Windows
Server 2003 will need to manually download and install the Microsoft XPS
Essentials Pack setup before connecting to the shared printer. Windows
11, Windows 10, Windows 7, Windows Server 2019, Windows Server
2012 or Windows Server 2008 do not need to install this separately as it
is included with the core operating system.

üThe Win2PDF Help files will not be installed for shared users. They will
only have access to the Win2PDF print driver, and not any of the help
topics.

üPrinter sharing relies on Windows installation and update mechanisms.
Most printer drivers use standard Microsoft port monitors, but Win2PDF
uses a custom port. There have been several reported bugs in the
Windows printer sharing relating to printer drivers with custom port
monitors, and there are a large number of combinations of Windows
versions and service pack levels for the print server and clients (including
variations for 32 bit and 64 bit clients and servers). Only some
combinations are tested with Win2PDF, and based on past experience
there may be problems with other combinations. Since the installation and
update process is handled entirely by Windows, these issues can be
difficult to isolate and troubleshoot.

In contrast, when Win2PDF is installed directly on each PC, the installer
detects the operating system and CPU architecture and installs the correct
version of the print driver along with any other necessary files. It is not
necessary to install the Microsoft XPS Essentials Pack separately. Also the
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help files will be installed locally, and there aren't any issues with updates
due to the custom port.

For these reasons, we strongly encourage deployment as a local printer
install instead of printer sharing. To ease deployment concerns, for orders
of 50 licenses or more we provide a pre-registered volume license installer.
This -- together with the silent install options -- is the preferred way of
deploying Win2PDF to a large number of PCs. 

5.4 Does Win2PDF support Windows 95/98/ME?

No, Win2PDF does not support Windows 95/98/ME. 

Win2PDF 10 installs as a print driver, and this print driver only works with
Windows XP, Windows Vista, Server 2003, Server 2008, and Windows 7.

Win2PDF 10 uses some features of Windows that are not available in
Windows NT and Windows 2000. Win2PDF 3.5 is still supported and does
work with Windows NT and Windows 2000.

5.5 Does Win2PDF support Windows 8?

Yes, Win2PDF fully supports Windows 8, Windows 8 Pro, and Windows 8.1.
Win2PDF does not support Windows RT.

5.6 Does Win2PDF support Windows 10?

Yes, the Win2PDF printer supports these editions of Windows 10 using the
familiar ‘Print to PDF’ interface as in past editions.

· Windows 10 Home
· Windows 10 Pro
· Windows 10 Enterprise
· Windows 10 Education

Win2PDF does NOT support these mobile editions of Windows 10, however.

· Windows 10 Mobile
· Windows 10 Mobile Enterprise
· Windows 10 S

You can switch from Windows 10 S to Windows 10 Pro easily at any time
through the Microsoft Store. 

https://docs.microsoft.com/en-us/education/windows/switch-to-pro-education
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The mobile editions are designed primarily for phones and tablet devices
that run on non-Intel processors. These editions only support printers that
are built in to Windows, so they don't support Win2PDF.

5.7 Does Win2PDF support Windows 11?

Yes, Win2PDF supports all versions of Windows 11 for Intel or AMD
processors using the familiar ‘Print to PDF’ interface as in past editions.

Win2PDF does NOT currently support mobile versions of Windows 11 for
ARM or Qualcomm Snapdragon processors.

5.8 How does Win2PDF compare to the Microsoft Print to PDF printer
in Windows 10?

The Microsoft Print to PDF printer is including in the Microsoft Windows
10 operating system, but it contains several major limitations when
compared to the Win2PDF Print to PDF printer. Here is the default view of
the Microsoft Print to PDF file save window.

Windows 10 Microsoft Print to PDF file save window
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Here is a summary of features that are available in Win2PDF that are NOT
available in the Microsoft Print to PDF printer.

· Use default file name to document being printed
· Save files in other formats like XPS, TIFF, JPG, PNG, BMP, and SVG
· Save files as PDF/A (archival PDF)
· Save files as non-searchable (image-only) PDFs
· View PDF file after it has been created
· Email PDF file after it has been created
· Change resolution of PDF files to reduce file size
· Automatically name PDF files without user interaction
· Password protect PDF files (Win2PDF Pro only)
· Disable the ability to print PDF files (Win2PDF Pro only)
· Disable the ability to copy text or images from PDF files (Win2PDF Pro

only)
· Disable the ability to modify PDF files (Win2PDF Pro only)
· Set a watermark image on the PDF file (Win2PDF Pro only)
· Set a background image on a PDF file (Win2PDF Pro only)
· Print a copy of the PDF file to the default paper printer
· Supports a developer API for developer integrations
· Supports an administrator configuration tool for changing default behavior
· Supports a stand-alone SMTP email program for automated sending of

PDFs
· Supports naming PDFs based on the contents of the document.

5.9 How does Win2PDF compare to the Microsoft Print to PDF printer
in Windows 11?

The Microsoft Print to PDF printer is including in the Microsoft Windows
11 operating system, but it contains several major limitations when
compared to the Win2PDF Print to PDF printer. Here is the default view of
the Microsoft Print to PDF file save window.
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Windows 10 Microsoft Print to PDF file save window

Here is a summary of features that are available in Win2PDF that are NOT
available in the Microsoft Print to PDF printer.

· Use default file name to document being printed
· Save files in other formats like XPS, TIFF, JPG, PNG, BMP, and SVG
· Save files as PDF/A (archival PDF)
· Save files as non-searchable (image-only) PDFs
· View PDF file after it has been created
· Email PDF file after it has been created
· Change resolution of PDF files to reduce file size
· Automatically name PDF files without user interaction
· Password protect PDF files (Win2PDF Pro only)
· Disable the ability to print PDF files (Win2PDF Pro only)
· Disable the ability to copy text or images from PDF files (Win2PDF Pro

only)
· Disable the ability to modify PDF files (Win2PDF Pro only)
· Set a watermark image on the PDF file (Win2PDF Pro only)
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· Set a background image on a PDF file (Win2PDF Pro only)
· Print a copy of the PDF file to the default paper printer
· Supports a developer API for developer integrations
· Supports an administrator configuration tool for changing default behavior
· Supports naming PDFs based on the contents of the document.

5.10 Does Win2PDF 64 bit editions of Windows?

Yes, Win2PDF fully supports all versions of Windows 64 bit editions. The
Win2PDF setup program includes both 32 bit and 64 bit versions of
Win2PDF, and the setup program automatically detects the current version
of Win2PDF and installs the 64 bit edition if necessary. There isn't a
separate Win2PDF setup program for 64 bit platforms.

Win2PDF has been tested with and fully supports the following 64 bit
Windows platforms:
· Windows XP x64 edition
· Windows Server 2003 x64 editions
· Windows Vista x64 editions
· Windows Server 2008 x64 editions
· Windows Server 2008 R2 editions
· Windows 7 x64 editions
· Windows 8 x64 editions
· Windows 10 x64 editions
· Windows 11
· Windows Server 2012 editions
· Windows Server 2012 R2 editions
· Windows Server 2016 editions
· Windows Server 2019 editions
· Windows Server 2022 editions

5.11 What type of fonts does Win2PDF support

When creating a standard PDF, Win2PDF 10 automatically embeds all fonts
except for the 14 fonts that are built into Adobe Reader®. These include: 
 
· Courier

· Courier-Bold

· Courier-Oblique

· Courier-BoldOblique

· Helvetica
· Helvetica-Bold
· Helvetica-Oblique
· Helvetica-BoldOblique
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· Times-Roman
· Times-Bold
· Times-Italic
· Times-BoldItalic
· Symbol
· ZapfDingbats

When the PDF/A format is selected, all fonts including the font Adobe
Reader built-in fonts are automatically embedded in the PDF file.

5.12 What PDF Viewers can I use to open PDF files created by
Win2PDF?

Win2PDF creates PDF files that conform to the published PDF file
specification. Any PDF viewer or PDF reader will be able to open, view, or
print PDF files created by Win2PDF.

The most common PDF viewer application is the free Adobe Reader
software. This software can be downloaded from Adobe's web site here:

Adobe Reader

Microsoft Edge is the default PDF viewer for Windows 10 and Windows 11,
and works will with files produced Win2PDF. Google Chrome's built-in PDF
viewer also works well with Win2PDF.

There are numerous other 3rd party PDF viewer applications, many of
which have smaller downloads and load PDF files quicker than the Adobe
Reader software. One recommended free PDF viewer is Sumatra PDF
available at:

Sumatra PDF Reader

5.13 Is Win2PDF free?  Or do I have to pay for it?

Win2PDF is free to use for personal or noncommercial use, but you must
purchase the software to remove the extra page from each document.
Once you purchase the Win2PDF software, you will be emailed a license
code. After the license code is entered, the extra page will not appear on

http://get.adobe.com/reader/
https://www.sumatrapdfreader.org/download-free-pdf-viewer.html
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any new PDF files. To evaluate Win2PDF or Win2PDF Pro without the extra
page, contact support@win2pdf.com for a 30 day demo license.

The Win2PDF license is sold as a permanent, perpetual license. It will never
expire, and it does not require any subscription to use it.

5.14 Is there an annual fee to use Win2PDF?

No. When you purchase Win2PDF, you will have a permanent, non-
expiring, perpetual license to use Win2PDF for the creation of PDF files.
There are no limits with regard to file size or the number of PDF files that
may be created, and there are no annual subscription fees.

Win2PDF does offer an optional "Priority Support" package which includes:
· No charge for software updates (includes volume license installation

packages for orders of 50 licenses or greater)
· Priority e-mail support for all support issues; this will immediately notify

support staff and put the support ticket to the top of the response queue.
· Access to a direct phone line to discuss support issues "in person" during

US business hours (9am-5pm, US Central Time Zone).
· 72-hour max response time for all reported issues.
· Priority bug fixing.
· Custom hot-fix builds if necessary.
· Remote diagnostic assistance (if allowed by customer) to connect via the

internet to the customer's PC or server for troubleshooting.

For pricing information on Win2PDF Priority Support, contact
sales@win2pdf.com.

5.15 I can't activate my copy of Win2PDF

If you get an error "Cannot activate Win2PDF online. Please contact
support@win2pdf.com", you can try the following:
· Right click on the "Enter Win2PDF License" and choose "Run As

Administrator".
· Temporarily disable anti-virus software that may be blocking the network

connection to the Win2PDF activation server.

If these steps don't fix your problem or if your PC does not have an internet
connection, contact support@win2pdf.com for activation instructions.

mailto:support@win2pdf.com
mailto:sales@win2pdf.com
mailto:support@win2pdf.com
mailto:support@win2pdf.com


Win2PDF668

© 2023 Dane Prairie Systems, LLC

5.16 How can I control the PDF file name without prompting?

There are several options:

· You can use the Win2PDF Auto-name feature to set the file name as
documented under "How to Automatically Name PDF files"

· You can use the Win2PDF Admin Utility to set the file name as
documented under "How to Automatically Name PDF files"

· You can use the registry as documented in the "Developer Information"
section under "Specifying an output file name".

· You can use the Win32 API as documented in the "Developer Information
section under "Windows Printer Interface".

· You can use the .NET Framework API as documented in the NET
Framework example.

5.17 Does Win2PDF create PDF files that are optimized for web
downloading?

PDF files created with Win2PDF can be used on web pages, but they are not
linearized PDF files. 

5.18 How can I improve the quality of bitmap images?

You can increase the default resolution to improve the quality of bitmap
images. To do this, open the printers folder, right click on the Win2PDF
icon, and select "Printing Preferences". You can increase the default
resolution under the "Advanced" tab to improve the bitmap quality but this
will also increase the document size.

For more information, see "Resolution".

5.19 Can Win2PDF be used on a web server?

Usage on a server requires a Win2PDF Terminal Server Edition (TSE)
license of Win2PDF. Information on using a printer from a web server from
the Microsoft knowledge base is at:

https://support.microsoft.com/en-us/help/184291/com-objects-fail-to-
print-when-called-from-asp

https://support.microsoft.com/en-us/help/184291/com-objects-fail-to-print-when-called-from-asp
https://support.microsoft.com/en-us/help/184291/com-objects-fail-to-print-when-called-from-asp
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5.20 Is it possible to print multiple worksheets in a single Excel
workbook to a single .pdf file?

Some applications -- including Microsoft Excel -- can send multiple "print
jobs" if it has multiple sheets with different print areas. Even though only
one file is being printed, the application (i.e., Excel) breaks up the file into
different print jobs and sends them separately to the printer. This typically
results in multiple prompts for a file name, and multiple PDF files being
created.

In Win2PDF 7.5 and later version, there is an Auto-merge feature to
handle this situation. With Auto-merge enabled, all of the sheets in the
workbook are merged automatically into a single PDF file if the file being
printed has the same base file name and is printed in rapid succession.

In Win2PDF 7 and earlier versions, you will need to save the files separately
or manually merge the files together. You can do this by selecting the
worksheets that you want to print by holding down the "shift" or "control"
key while clicking on the sheet tab. Select the "Print..." command from the
"File" menu and make sure "Active sheet(s)" is enabled in the Excel print
window. More information on selecting multiple worksheets is available at:

https://support.office.com/en-us/article/Select-one-or-multiple-
worksheets-096b40c9-0ee7-4980-bac6-cc92aec7b266

Alternatively, if you select "print to file" from the Excel print window all
worksheets will be created in a single document.

5.21 Does Win2PDF support Asian character sets?

Yes, Win2PDF fully supports Asian character sets.

5.22 Is it legal to create PDF files with Win2PDF?

Yes. Adobe Systems Inc. created the PDF file format and owns the
copyrights on the data structures, operators, and written specification for
PDF. Adobe wishes to make PDF an open standard, so they have given
permission to anyone to write software that creates PDF files. The have
also given royalty free licenses to the patents if used to create PDF files.
Information on this policy is in section 1.7 of the PDF specification
published by Adobe.

5.23 Can Win2PDF append to an existing PDF file?

Yes, Win2PDF can append or prepend to an exiting PDF file. Please see
"Merging to an existing PDF file".

http://office.microsoft.com/en-us/assistance/HP052024921033.aspx
http://office.microsoft.com/en-us/assistance/HP052024921033.aspx
https://wwwimages2.adobe.com/content/dam/acom/en/devnet/flashplayer/pdfs/adobe_supplement_iso32000_1.pdf
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5.24 When installing Win2PDF, I'm get the error message "AddPrinter
error 126."

This "AddPrinter error 126" can occur if either of the following conditions is
true:

· The %SYSTEMROOT%\System32\Wbem\framedyn.dll file is missing or
damaged.

-or- 
· The Windows Path environment variable does not point to the %

SYSTEMROOT%\System32\Wbem folder. 

To correct the problem, use one of the following methods:

Run the Windows system file checker

The Windows system file checker will scan all protected Windows files
and verify their versions. If it detects any files that have been replaced or
damaged, it will repair the files. To run the system file checker:

1.Click Start, and then click Run.
2.In the Open box, type sfc /scannow and then click OK.

More information on the Windows system file checker is available at the
following location:

http://support.microsoft.com/?kbid=310747

Replace the Framedyn.dll File

1. Click Start, and then click Run.
2. In the Open box, type %systemroot%\system32\dllcache, and

then click OK.
3. Right-click framedyn.dll, and then click Copy on the shortcut menu

that appears.
4. Click Start, and then click Run.
5. In the Open box, type %systemroot%\system32\wbem, and

then click OK.
6. On the Edit menu, click Paste. If you are prompted to replace the

existing file, click Yes.

Verify System Variables

1. Click Start, right-click My Computer, and then click Properties on
the shortcut menu that appears. If you receive the following error

http://support.microsoft.com/?kbid=310747
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message, click OK: rundll32.exe - Unable To Locate Component
This application has failed to start because framedyn.dll was not
found. Re-installing the application may fix this problem. 

2. In the System Properties window box, click the Advanced tab.
3. Click Environment Variables.
4. Under System variables, click Path, and then click Edit. NOTE: If

no Path variable is listed, click New. In the Variable name box,
type Path.

5. In the Variable value box, type the following: %SystemRoot%
\system32;%SystemRoot%;%SystemRoot%
\System32\wbem

6. Click OK three times (each time that you have the option).

More information on this problem is at the following location:
http://support.microsoft.com/default.aspx?scid=kb;en-us;319114

5.25 Can Win2PDF set the file save path to point to original
document?

No. Unfortunately, this isn't possible. Win2PDF is a print driver, and the
application sends document information to the Win2PDF printer driver just
like it's a paper printer. The printing application usually (but not always)
sends the document name to Win2PDF, but it does not send the document
path to Win2PDF. Win2PDF does not have access to the source document
location, so it can't use it save the converted PDF.

http://support.microsoft.com/default.aspx?scid=kb;en-us;319114
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6 Developer Information

6.1 Windows Printer Interface

Win2PDF interfaces with an application using standard Windows printer
APIs. Whenever possible, Win2PDF uses standard Windows APIs instead of
defining new interfaces. You can print to the Win2PDF printer just like a
paper printer, and control page size, resolution, and orientation using
standard APIs.

You can set the PDF file name from VB.NET or C# using the .NET
framework Printersettings.PrintFileName property. You should also set the
PrinterSettings.PrintToFile property to true:

PrintDocument.PrinterSettings.PrintFileName = "C:\Users\test\AppData\Local\Temp\aFile.pdf"
PrintDocument.PrinterSettings.PrintToFile = true;

If you are a Win32 software developer and are developing an application
that uses Win2PDF, you can also control the output filename using the
standard Win32 API. To specify the file name you need to use the Microsoft
defined DOCINFO structure and the StartDoc function. Set the
lpszOutput field of the DOCINFO structure to the fully qualified path name
of the file, and then pass the DOCINFO structure to the Win32 StartDoc
function. Using this method, each file can be created using a unique name.

You can control the orientation, resolution, and other settings using the
Win32 API and the DEVMODE structure as defined in the Microsoft Platform
SDK. The Microsoft article at:
https://support.microsoft.com/en-us/help/167345/how-to-modify-printer-
settings-with-the-documentproperties-function
describes how to change printer settings using the Win32 API.

6.2 Using the Windows registry

6.2.1 Registry Overview

Win2PDF uses standard Windows APIs for settings when possible. This
includes settings for paper size, paper orientation, and resolution. 

You can set the PDF file name from VB.NET or C# using the .NET
framework Printersettings.PrintFileName property. You should also set the
PrinterSettings.PrintToFile property to true:

https://docs.microsoft.com/en-us/dotnet/api/system.drawing.printing.printersettings.printfilename
https://docs.microsoft.com/en-us/dotnet/api/system.drawing.printing.printersettings.printtofile
https://support.microsoft.com/en-us/help/167345/how-to-modify-printer-settings-with-the-documentproperties-function
https://support.microsoft.com/en-us/help/167345/how-to-modify-printer-settings-with-the-documentproperties-function
https://docs.microsoft.com/en-us/dotnet/api/system.drawing.printing.printersettings.printfilename
https://docs.microsoft.com/en-us/dotnet/api/system.drawing.printing.printersettings.printtofile
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PrintDocument.PrinterSettings.PrintFileName = "C:\Users\test\AppData\Local\Temp\aFile.pdf"
PrintDocument.PrinterSettings.PrintToFile = true;

For settings that aren't available through the Windows API, Win2PDF can
use the Windows registry. This makes it easy to control Win2PDF from
almost any development environment.

Win2PDF looks for registry values at the following locations and in the
following order: 

"HKEY_CURRENT_USER\Software\VB and VBA Program Settings\Dane Prairie Systems\Win2PDF" 

"HKEY_CURRENT_USER\Software\Dane Prairie Systems\Win2PDF" and 
"HKEY_LOCAL_MACHINE\Software\Dane Prairie Systems\Win2PDF" 

The first registry location is used for the Visual Basic and VB.NET
"SaveSetting" function. From Visual Basic or VB.NET, you can call
SaveSetting with the following parameters to control Win2PDF:

SaveSetting "Dane Prairie Systems", "Win2PDF", ValueName, Value

From C#, you can use the same fully qualified SaveSetting function
name:

Microsoft.VisualBasic.Interaction.SaveSetting("Dane Prairie Systems", "Win2PDF", ValueName, Value)

Where "ValueName" and "Value" will depend on the Win2PDF setting to
control. The SaveSetting command only works with Win2PDF registry
settings that use a string type.

The HKEY_CURRENT_USER registry location is useful if you want the
setting to apply only to the current user. This is especially important when
using Win2PDF in a multi-user environment such as Windows Terminal
Services.

The HKEY_LOCAL_MACHINE location is useful if you want the setting to
apply to all users, the application is running as part of a Windows service,
or if your application is only going to be used with a single user.

After the document is created, the registry value will be deleted by
Win2PDF. If you would like the setting to apply to all documents without
having to add the registry value for each document, you can create a non-
zero registry value named "persistent" to one of the locations listed
above. This will prevent Win2PDF from deleting the value after each
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document. Most settings also have a "Default" setting that is not deleted
after each document.

The following Win2PDF settings can be controlled from the registry. All
settings with the "String" type support Environment Variable Expansion if
saved as REG_EXPAND_SZ.
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Value Name Typ
e

Description

PDFFileName Stri
ng

Controls the output file name Is automatically
deleted after each document.

PDFDefaultFileNa
me

Stri
ng

Controls the output file name. Is not automatically
deleted after each document.

PDFPostFileName Stri
ng

Same as PDFFileName, but is deleted after the
document has been created

persistent Dwo
rd

Prevents registry values from being deleted when it
is set to a non-zero value

PDFTitle Stri
ng

Sets the document title, or file name displayed in
the Win2PDF file save window. Is automatically
deleted after each document.

PDFDefaultTitle Stri
ng

Sets the default document title, or file name
displayed in the Win2PDF file save window. Is not
automatically deleted after each document.

PDFAuthor Stri
ng

Sets the document author

PDFSubject Stri
ng

Sets the document subject

PDFKeywords Stri
ng

Sets the document keywords

file options Dwo
rd

Enables encryption, e-mail, view, and print PDF
options

disabled options Dwo
rd

Disables options from the file save window

Post Action Stri
ng

Automatically executes the application specified
after PDF creation and waits for the application to
close. Deleted after each document.

Post Action Nowait Stri
ng

Automatically executes the application specified
after PDF creation and immediately returns control
to the printing application. Deleted after each
document.

Default Post ActionStri
ng

Automatically executes the application specified
after PDF creation and waits for the application to
close. Not deleted after each document.

Default Post Action
Nowait

Stri
ng

Automatically executes the application specified
after PDF creation and immediately returns control
to the printing application. Not deleted after each
document.

user password Stri
ng

Sets the user password (Win2PDF Pro)

master password Stri
ng

Sets the master password (Win2PDF Pro)

PDFMailRecipients Stri
ng

Sets the email "To:"recipient addresses when the
"Send PDF" option is enabled. Deleted after each
document.

PDFMailDefaultRec
ipients

Stri
ng

Sets the email "To:"recipient addresses when the
"Send PDF" option is enabled. Not deleted after
each document.

PDFMailCCRecipie
nts

Stri
ng

Sets the email "CC:" recipient addresses when the
"Send PDF" option is enabled. Deleted after each
document.

PDFMailDefaultCC
Recipients

Stri
ng

Sets the email "CC:" recipient addresses when the
"Send PDF" option is enabled. Not deleted after
each document.

PDFMailBCCRecipi
ents

Stri
ng

Sets the email "BCC:" recipient addresses when
the "Send PDF" option is enabled. Deleted after
each document.

PDFMailDefaultBC
CRecipients

Stri
ng

Sets the email "BCC:" recipient addresses when
the "Send PDF" option is enabled. Not deleted after
each document.

PDFMailSubject Stri
ng

Sets the email subject when the "Send PDF" option
is enabled. Deleted after each document.

PDFMailDefaultSub
ject

Stri
ng

Sets the email subject when the "Send PDF" option
is enabled. Not deleted after each document.

PDFMailNote Stri
ng

Sets the email body text when the "Send PDF"
option is enabled. Deleted after each document.

PDFMailDefaultNot
e

Stri
ng

Sets the email body text when the "Send PDF"
option is enabled. Not deleted after each
document.

PDFMailHTML Stri
ng

Sets the email body HTML text when the "Send
PDF" option is enabled. Deleted after each
document.

PDFMailDefaultHT
ML

Stri
ng

Sets the email body HTML text when the "Send
PDF" option is enabled. Not deleted after each
document.

PDFMailResolveNa
mes

Stri
ng

Verifies email addresses using the default address
book

PDFWatermarkFile Stri
ng

Sets the watermark PDF file

PDFDefaultWaterm
arkFile

Stri
ng

Sets the default watermark PDF file

PDFExcludeWater
markPre

Dwo
rd

Excludes the watermark from being applied to the
first number of pages of a document.

PDFExcludeWater
markPost

Dwo
rd

Excludes the watermark from being applied to the
last number of pages of a document.

PDFIncludeWater
markPre

Dwo
rd

Include the watermark to the specified number of
pages from the beginning of the document.

PDFIncludeWater
markPost

Dwo
rd

Include the watermark to the specified number of
pages from the end of the document.

PDFDefaultExclude
WatermarkPre

Dwo
rd

Always excludes the watermark from being applied
to the first number of pages of a document.

PDFDefaultExclude
WatermarkPost

Dwo
rd

Always excludes the watermark from being applied
to the last number of pages of a document.

PDFDefaultInclude
WatermarkPre

Dwo
rd

Always include the watermark to the specified
number of pages from the beginning of the
document.

PDFDefaultInclude
WatermarkPost

Dwo
rd

Always include the watermark to the specified
number of pages from the end of the document.

PDFPrintToName Stri
ng

Sets a specific printer instead of the Windows
default printer with "print file" file_options are set.

PDFDefaultPrintTo
Name

Stri
ng

Sets a default specific printer instead of the
Windows default printer with "print file" file_options
are set.

PDFDocumentScali
ng

Dwo
rd

Sets a document scaling percent (1-999). 100
indicates no scaling.

auto merge
interval

Dwo
rd

Time in milliseconds between documents for auto-
merge feature. Set to 0 to disable auto-merge.

disable autoname
keyboard check

Dwo
rd

Disables the shift key checking when the auto-
name feature is enabled.

formats Dwo
rd

Controls which save formats are displayed in the
Win2PDF file save window.

JPEG2000 Ratio Dwo
rd

Sets a compression ratio for JPEG 2000
compression (1-99). Requires "Enable JPEG2000"
file option.

post action
checkbox label

Stri
ng

Adds an option to the Win2PDF file save window to
selectively execute "Post Action" or "Default Post
Action".

PDFAppendFile Stri
ng

Append the PDF file specified to the newly created
PDF once.

PDFPrependFile Stri
ng

Prepend the PDF file specified to the newly created
PDF once.

PDFDefaultAppend
File

Stri
ng

Always append the PDF file specified to the newly
created PDF.

PDFDefaultPrepen
dFile

Stri
ng

Always prepend the PDF file specified to the newly
created PDF.

PDFAppendToExist
ingFile

Dwo
rd

When set to 1, automatically appends to the file
specified by PDFFileName, PDFPostFileName, or
PDFDefaultFileName

PDFPrependToExis
tingFile

Dwo
rd

When set to 1, automatically prepends to the file
specified by PDFFileName, PDFPostFileName, or
PDFDefaultFileName

shell print Dwo
rd

When set to 1, use the Windows default PDF
viewer to print PDF files when the "Print File" option
is enabled.

PDFPreview Dwo
rd

When set to 1, use the Win2PDF Desktop PDF
viewer instead of the default Windows PDF viewer.

PDFAutoNameCon
tentSearchWord
PDFAutoNameCon
tentSearchWord2
PDFAutoNameCon
tentSearchWord3

Stri
ng

Win2PDF searches the text of the current PDF for
the word specified. If the word is found, the auto-
name variable %PDFAutoNameContentSearch% is
filled with the word after the search word. 

PDFAutoNameCon
tentLength

Dwo
rd

Specified the length of the text field to use for the
auto-name variable %
PDFAutoNameContentPosition%
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If you create the any of the string registry values as a REG_EXPAND_SZ
instead of a REG_SZ type, the value will be expanded from environment
variables. The environment variables are specified with "%" characters at
the beginning and end of the variables as in "%HOMEPATH%". A list of
Win2PDF environment variables that can be used in registry settings is at
PDF Auto-name: User Defined. The REG_EXPAND_SZ option is not available
from the Visual Basic SaveSetting command. The %DATE% and %TIME%
environment variables are not expanded by this option.

The registry methods are not safe when used with programs that have
multiple threads or multiple processes that access Win2PDF unless you use
a REG_EXPAND_SZ setting for "PDFDefaultFileName" with a %
PDFMillisecond% or %PDFIncrement% variable to prevent files from being
overwritten. For these types of programs, you need to ensure that only one
thread or process has access to Win2PDF at a time by using a Windows
critical section or mutex. The Windows printer interfaces do not have these
limitations.

When multiple instances of Win2PDF are installed, Win2PDF first looks in
the registry locations based on the instance name of Win2PDF. This allows
separate settings for different instance of Win2PDF. For example, if the
current instance of Win2PDF is named "Win2PDF (Copy 1)" the following
registry locations would be checked before the standard registry locations:

"HKEY_CURRENT_USER\Software\VB and VBA Program Settings\Dane Prairie Systems\Win2PDF (Copy 1)" 

"HKEY_CURRENT_USER\Software\Dane Prairie Systems\Win2PDF (Copy 1)" and 
"HKEY_LOCAL_MACHINE\Software\Dane Prairie Systems\Win2PDF (Copy 1)" 

If a setting doesn't exist under the instance name section of the registry,
then Win2PDF checks the standard locations.

6.2.2 Specifying an output file name

In addition to being able to control the output file using the Win32 API, you
can control the output file name by creating a string value in the registry at
any of the standard registry locations. The "PDFFileName" value should
be set to the full path name of the document.  If the "PDFFileName" entry
does not exist in the registry, the user will be prompted to enter a file
name.

From Visual Basic or VB.NET, you can set the output file name using the
following code sample: 

SaveSetting "Dane Prairie Systems", "Win2PDF", "PDFFileName", filename 
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From C#, you can set the output file name using:

Microsoft.VisualBasic.Interaction.SaveSetting("Dane Prairie Systems", "Win2PDF", "PDFFileName", filename)

Where the filename parameter is the full path name for the file. By default,
the "PDFFileName" entry is removed from the registry after each
document is created and you must add the "PDFFileName" each time you
print. 

If you don't want the setting to be reset after each document, you can use
"PDFDefaultFileName" in place of "PDFFileName". You can also prevent
the "PDFFileName" from being removed by creating a DWord value
named "persistent" at one of the standard registry locations.

The format type is determined by the filename extension. The following
extensions are supported:
· .PDF - Portable Document Format
· .PDFA -PDF for Archiving (PDF/A). File is renamed with a .PDF extension

after creation.
· .PDFI -PDF Image Only (monochrome). File is renamed with a .PDF

extension after creation.
· .PDFC -PDF Image Only (color). File is renamed with a .PDF extension

after creation.
· .PDFO -PDF OCR (Searchable). File is renamed with a .PDF extension

after creation. Requires the Win2PDF OCR Add-on.
· .PDFS -Portable Document Format. Used to force PDF standard instead of

PDF/A or PDF Image Only. File is renamed with a .PDF extension after
creation.

· .XPS - XML Paper Specification
· .TIFF or .TIF - Tagged Image File Format
· .TIFM - Tagged Image File Format (monochrome). File is renamed with a

.TIF extension after creation.
· .TIFC - Tagged Image File Format (color). File is renamed with a .TIF

extension after creation.
· .SVG - Scalable Vector Graphics

The following extensions are supported by both the Win2PDF or Win2Image
Printer:
· .JPGG - JPEG (grayscale). File is renamed with a .JPG extension after

creation.
· .JPGC - JPEG (color). File is renamed with a .JPG extension after creation.

https://www.win2pdf.com/download/download-win2pdf-ocr.html
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· .TIFM - Tagged Image File Format (monochrome). File is renamed with a
.TIF extension after creation.

· .TIFC - Tagged Image File Format (color). File is renamed with a .TIF
extension after creation.

· .GIFG - GIF (grayscale). File is renamed with a .GIF extension after
creation.

· .GIFC - GIF (color). File is renamed with a .GIF extension after creation.
· .PNGG - PNG (grayscale). File is renamed with a .PNG extension after

creation.
· .PNGC - PNG (color). File is renamed with a .PNG extension after creation.
· .BMPG - BMP (grayscale). File is renamed with a .BMP extension after

creation.
· .BMPC - BMP (color). File is renamed with a .BMP extension after creation.

If a file already exists at the location specified by "PDFFileName", it will be
overwritten. If you want to prevent files from being overwritten, you can
add a single asterisk character "*" to the file name to specify a wildcard. If
a wildcard character exists, it will be replaced by a sequential number so
that documents are never overwritten.

If you want to create a unique document name, you can use a single "%"
character in the file name. The "%" character will be expanded to include a
sequence of numbers based on the current date and time.

If you create the "PDFFileName" registry value as a REG_EXPAND_SZ
instead of a REG_SZ type, the file name will be expanded from environment
variables. The environment variables are specified with "%" characters at
the beginning and end of the variables as in "%HOMEPATH%". If the
environment variable does not exist, the first "%" character will be
expanded by a sequences of numbers based on the date and time as
described previously. The REG_EXPAND_SZ option is not available from the
Visual Basic SaveSetting command. The %DATE% and %TIME%
environment variables are not expanded by this option. 

Win2PDF sets the current PDF document title in an environment variable
named "PDFTitle". You can use this in combination with a
REG_EXPAND_SZ environment variable to set the file name to the
document title. For example, if a "PDFFileName" entry with a
REG_EXPAND_SZ type is set to "c:\test\%PDFTitle%*.pdf", Win2PDF will
create a document using the document specified title without displaying a
file save window and it will never overwrite an existing file.
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Win2PDF also supports a number of variables that can be used to
dynamically create a date and time stamp. These are listed in the auto-
name: user defined documentation.

If the application needs to determine when Win2PDF has finished creating
the document, it can use "PDFPostFileName" instead of "PDFFileName".
The behavior of "PDFPostFileName" is identical to "PDFFileName"
except the registry value is not deleted by Win2PDF until the document has
been created. The application can monitor the existence of this registry
value to determine if Win2PDF is still processing the document.
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6.2.3 Environment Variable Expansion

The following environment variables are set by Win2PDF and can be used
with registry expansion in the "PDFFileName", "PDFDefaultFileName", and
all other Win2PDF String registry values. The registry values must be set as
REG_EXPAND_SZ instead of REG_SZ for the expansion to work.

%PDFTitle
%

Document title set by the application

%
PDFTitleNo
Extension%

Document title set by the application with document extension
removed

%
PDFIncrem
ent%

If a file exists with the expanded name, %PDFIncrement% is
incremented until a file does not exist. Starts at 1. Ensures files are
never overwritten.

%PDFDate
%

Eight digit date separated by dashes in the format month-day-year
(12-25-2015)

%PDFTime
%

Six digit 12 hour time separated by dashes in the format hour-minute-
second-AM/PM (12-59-59 PM)

%PDFYear
%

Four digit number for the current year (2015)

%
PDFMonth
%

Two digit number for the current month (12)

%
PDFMonth
Name%

Three character abbreviated name for the current month (Dec)

%PDFDay
%

Two digit number for the current day of the month (25)

%
PDFDayNa
me%

Three character abbreviated name for the day of the week (Wed)

%
PDFDayIn
Week%

One digit number for the current day of the week

%PDFHour
%

Two digit number for the current hour in a 12 hour format (12)

%
PDFHour24
%

Two digit number for the current hour in a 24 hour format (24)

%
PDFMinute
%

Two digit number for the current minute within the hour (59)
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%
PDFMinute
5%

Two digit number for the current minute in 5 minute increments
(0,5,10,..55)

%
PDFMinute
10%

Two digit number for the current minute in 10 minute increments
(0,10,..50)

%
PDFMinute
15%

Two digit number for the current minute in 15 minute increments
(0,15,30,45)

%
PDFMinute
30%

Two digit number for the current minute in 30 minute increments
(0,30)

%
PDFSecond
%

Two digit number for the current second within the minute (59)

%
PDFMillisec
ond%

Three digit number for the current millisecond (999)

%
PDFTimeM
arker%

Two character abbreviation for AM or PM

%
PDFAutoNa
meContent
Search%

Expanded to the word in the PDF following the registry value specified
by PDFAutoNameContentSearchWord 

%
PDFAutoNa
meContent
Search2%

Expanded to the word in the PDF following the registry value specified
by PDFAutoNameContentSearchWord2 

%
PDFAutoNa
meContent
Search3%

Expanded to the word in the PDF following the registry value specified
by PDFAutoNameContentSearchWord3 

%
PDFAutoNa
meContent
Field%

Expanded to the word in the PDF specified by the absolute location
defined in the Win2PDF Desktop Content Field.

Environment variables defined by Windows such as %HOMEPATH%, %
USERNAME%, and %USERPROFILE% can also be used with all Win2PDF
String registry settings.
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6.2.4 Appending or Prepending to an existing PDF

You can prepend or append and existing file with the newly created file by
creating a string value in the registry at any of the standard registry
locations. 

Settin
g

Description

PDFApp
endFile

Appends the specified PDF to the newly created PDF for one
document. The setting is deleted after the append.

PDFPre
pendFil
e

Prepends the specified PDF to the newly created PDF for one
document. The setting is deleted after the prepend.

PDFDef
aultApp
endFile

Always appends the specified PDF to the newly created PDF.

PDFDef
aultPre
pendFil
e

Always prepends the specified PDF to the newly created PDF.

You can specify both a "PDFPrependFile" and a "PDFAppendFile" at the
same time, and both options are only used if the output file name was
specified by using "PDFFileName", "PDFPostFileName", or
"PDFDefaultFileName".

For example, if you have an existing PDF file named "file1.pdf" and you
would like to create a new PDF file named "file2.pdf" with the contents of
"file1.pdf" at the beginning of the new file, you would set
"PDFPrependFile" to file1.pdf and "PDFDefaultFileName" to "file2.pdf".
Alternatively, if you wanted to the contents of "file1.pdf" to be at the end of
the new file, you would set "PDFAppendFile" to "file1.pdf" and
"PDFDefaultFileName" to "file2.pdf".

By default, the "PDFPrependFile" and "PDFAppendFile" entries are
removed from the registry after each PDF file is created and you must add
the values each time you print. If you want to prevent the values from
being removed after each document, you can use
"PDFDefaultAppendFile", "PDFDefaultPrependFile", or create a
DWord value named "persistent" at one of the standard registry locations.
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6.2.5 Setting Document Information

You can set the PDF document subject, title, author, and keywords by
creating string values named PDFSubject, PDFTitle, PDFAuthor, and
PDFKeywords in the registry at any of the standard registry locations.
These are the same values as described in the Document Information. All
values are deleted after each document is created unless the "persistent"
registry value is set.

The PDFTitle can also be used to set the file name displayed in the
Win2PDF file save window. The PDFDefaultTitle variation behaves the
same as PDFTitle, but is not automatically deleted after each document.

6.2.6 Enabling encryption, email, view, and print PDF Options

You can create a DWORD value in the registry at any of the standard
registry locations to control actions to be taken after the document is
created. The value is named "file options", and its value can be a
combination of the following values:
            

Action value
(hexa
decim
al)

Send
email

0x01

View File 0x02

Send to
palm 

0x04

Set 40 bit
encryption
 

0x08 (Win2PDF Pro)

Set 128
bit
encryption
 

0x10 (Win2PDF Pro)

Enable
URL
detection

0x20

Delete
email

0x40

Print File 0x80
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Apply
foregroun
d
watermar
k 

0x200  (Win2PDF Pro)

Send
email - no
user
interaction
  

0x400 

Apply
backgroun
d
watermar
k

0x800 (Win2PDF Pro)

Enable
JPEG2000
compressi
on

0x1000 (requires Win2PDF 10.0.39 or above)

Set 256
bit
encyption

0x2000 (Win2PDF Pro, requires Win2PDF 10.0.39 or above)

The values can be added together, so if you wanted to send e-mail, enable
URL detection, and delete the file after sending you would set "file
options" to 0x61 hexadecimal. The 40, 28, and 256 bit encryption options
are only valid for Win2PDF Pro. All values are deleted after each document
is created unless the "persistent" registry value is set.

When the "View File" or "Print File" options are enabled, the file is
opened in the default file viewer specified by standard Windows file
associations. 

When "Print File" is enabled, the file is sent to the printer named by a string
registry value named "PDFPrintToName" or "PDFDefaultPrintToName"
at one of the standard registry locations. The "PDFPrintToName" is
automatically deleted after each job, and the "PDFDefaultPrintToName"
is persistent. If "PDFPrintToName" or "PDFDefaultPrintToName" are
not present, the file is printed on the default Windows printer.
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6.2.7 Setting email Options

When the "Send email" or "Send email - no user interaction" options are
enabled, you can set the email address by creating a string value in one of
the standard registry locations named "PDFMailRecipients" or
"PDFMailDefaultRecipients". The value can be a single email address in
the form "someone@somedomain.com", or multiple recipients separated
by semicolon ';' or comma ',' characters. You can also set one or more
"CC:" or "BCC:" email addresses by setting a string value named
"PDFMailCCRecipients", "PDFMailDefaultCCRecipients",
"PDFMailBCCRecipients", or "PDFMailDefaultBCCRecipients" in one of
the standard registry locations. Some email clients require a "SMTP:" string
in front of the address such as "SMTP:someone@somedomain.com". 

Win2PDF can verify the addresses using the default address book if a
DWORD value named "PDFMailResolveNames" is set to 1 in one of the
standard registry locations. This can improve the reliability of sent email,
but may cause the email client to display a warning window.

You can set the e-mail subject field by creating a string value named
"PDFMailSubject" or "PDFMailDefaultSubject", and you can fill in the
body text of the message by creating a string value named "PDFMailNote"
or "PDFMailDefaultNote". To set the HTML body text of the message, use
"PDFMailHTML" or "PDFMailDefaultHTML". For the settings that include
"Default" in the name ("PDFMailDefaultRecipients",
"PDFMailDefaultCCRecipients", "PDFMailDefaultBCCRecipients",
"PDFMailDefaultSubject", "PDFMailDefaultNote", and "PDFMailDefaultHTML",
the registry values are applied to all documents and are not deleted. All
other values are deleted after each document is created unless the
"persistent" registry value is set.

Windows MAPI email clients such as Microsoft Outlook or Outlook Express
will not let you send email without user interaction. 

6.2.8 Controlling Encryption Options

To set the security permissions, you can create a DWORD value named
"security permissions" at any of the standard registry locations. 

The DWORD value must be named "security permissions", and the value is
defined by Adobe in the PDF specification available from:
https://www.adobe.com/content/dam/acom/en/devnet/acrobat/pdfs/PDF3
2000_2008.pdf

The following table from this specification defines the privileges:

https://www.adobe.com/content/dam/acom/en/devnet/acrobat/pdfs/PDF32000_2008.pdf
https://www.adobe.com/content/dam/acom/en/devnet/acrobat/pdfs/PDF32000_2008.pdf
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Bit Position Meaning

1-2 Reserved; must be 0

3 Print document

4 Modify contents of document (other than text
annotations and interactive form fields

5 Copy text and graphics from document

6 Add or modify text annotations and interactive form
fields

7-8 Reserved; must be 1

9 Fill in existing form fields

10 Extract text and graphics for Accessibility

11 Assemble the document 

12 Allow high resolution printing 

13-32 Reserved; must be 1

The default value is 0xfffffffc. For example, to create a PDF document that
doesn't allow printing you need to set bit position 3 to a 0 so you would set
the "security permissions" to 0xfffffff8.

The following table lists common combinations of security permissions:
Disable printing            0xfffffff8
Disable copying             0xffffffec
Disable modifying            0xfffffff4
Disable printing & copying       0xffffffe8
Disable printing & modifying      0xfffffff0
Disable copying & modifying       0xffffffe4
Disable printing & copying & modifying 0xffffffe0

You can set passwords by creating String values named "user password"
or "master password" to password protect documents. The passwords
are only used if encryption is enabled in the "file options" setting. All
registry values are deleted after each document unless the persistent
value is set.

The security permissions and passwords are only valid for Win2PDF Pro.

6.2.9 Disabling File Save Options

The file save options such as "View PDF", "Print PDF", and "Send PDF" can
be disabled by adding a DWORD value to the registry named "disabled
options" at any of the standard registry locations. The options are specified
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using the same table as the "file options". The values can be added
together, so if you wanted to disable the "send PDF" and "delete after
sending" options you would set "disabled options" to 0x41 hexadecimal. 

All values are deleted after each document is created unless the
"persistent" registry value is set.

6.2.10 Win2PDF Plug-In Interface

Win2PDF supports extending features using a plug-in interface that is
enabled through a registry setting. You can write plug-ins to extend the
features of Win2PDF by interfacing with external applications such as
Outlook, by using the command line interface to perform additional PDF
operations (multiple watermarks, flattening, split pages, etc.), or by
uploading the PDF to a content management system or cloud service such
as Slack, FileStack, or Amazon S3.

https://github.com/win2pdf/Win2PDF.Samples/blob/master/plug-in/PDFSendToOutlook
https://www.win2pdf.com/doc/win2pdf-desktop-command-line.html
https://github.com/win2pdf/Win2PDF.Samples/blob/master/plug-in/PDFMultipleWatermarks
https://github.com/win2pdf/Win2PDF.Samples/blob/master/plug-in/PDFImageOnlyFlatten
https://github.com/win2pdf/Win2PDF.Samples/blob/master/plug-in/PDFSplitPages
https://helpdesk.win2pdf.com/index.php?/Knowledgebase/Article/View/235/15/win2pdf-send-to-slack-plug-in
https://github.com/win2pdf/Win2PDF.Samples/tree/master/plug-in/PDF-AWS-S3-Upload
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Plug ins are standard Windows executables that are called by Win2PDF with
a single parameter containing the PDF file name. They can be written in any
language, and can utilize the Win2PDF command line interface. Sample
plug-ins are available in the Win2PDF GitHub samples repository.

You can automatically execute a Win2PDF plug-in when the document is
created by adding one of the following string registry values in any of the
standard registry locations. 

Setting Description
Post Action Executes the plug-in for one document and waits for

the plug-in to complete, then deletes the plug-in
registry setting

Default Post Action Always Executes the plug-in and waits for the plug-in
to complete

Post Action Nowait Executes the plug-in for one document without waiting
for it to complete, then deletes the plug-in registry
setting

Default Post Action
Nowait

Always executes the plug-in without waiting for it to
complete

Post Action Secure Executes the plug-in for one document passing the
master password as an argument, waits for the plug-in
to complete, then deletes the plug-in registry setting

Default Post Action
Secure

Always Executes the plug-in passing the master
password as an argument and waits for the plug-in to
complete

Post Action Secure
Nowait

Executes the plug-in for one document passing the
master password as an argument without waiting for it
to complete, then deletes the plug-in registry setting

Default Post Action
Secure Nowait

Always executes the plug-in passing the master
password as an argument without waiting for it to
complete

The plug-in must be specified using the full path name, and the document
can be passed to the application by using a "%s" in the command line. For
example, setting "Default Post Action" to:

 "C:\Program Files\Adobe\Acrobat Reader DC\Reader\AcroRd32.exe"
"%s"

would launch Acrobat Reader after the document is created. It is important
to enclose the file name with quotation marks since the file may contain
spaces. 

https://github.com/win2pdf/Win2PDF.Samples/tree/master/plug-in
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The "Secure" variations of the "Post Action" settings pass a second
argument which is the master password used to create the encrypted PDF.
 This can be used to modify an encrypted PDF in the plug-in.  If the PDF is
not encrypted, the argument is always set to an empty string ("").

You can optionally allow users to enable or disable plug-ins by Adding a
plug-in configuration to the Win2PDF file save window.

6.2.11 Adding a plug-in configuration to the Win2PDF file save window

When a plug-in is installed using the “post action” registry setting is set, the
“post action checkbox label” setting allows an application to customize
the text displayed to the user in the Win2PDF file save Window, and allows
the user to selectively enable or disable the plug-in operation. The value is
a type “string”, and can be up to 60 characters in length.
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If the checkbox is selected, the plug-in will be launched after the PDF file
has been created. If the checkbox is not selected, the PDF is created
normally with no plug-in operation, even if the plug-in is installed. The
default value is checked, but the setting is saved and restored to the user’s
last action.

If the “post action checkbox label” setting is not present, the additional
checkbox and label are hidden. If the application specifies a file name, the
file save window is skipped and the “post action checkbox label” has no
effect. If the “post action checkbox label” is set and a plug-in is not
installed, the setting is ignored.

6.2.12 Watermark Options

When the "Apply foreground watermark" or "Apply background watermark"
options are enabled, the watermark PDF file can be specified by setting a



Win2PDF692

© 2023 Dane Prairie Systems, LLC

string value named "PDFWatermarkFile" in the registry at any of the
standard registry locations. 

A default watermark can be specified by setting a string value named
"PDFDefaultWatermarkFile". This registry setting is not deleted after each
document.

By default, the watermark is applied to all pages in the newly created
document. If you want to exclude or include the watermark from the
beginning or end of the PDF, you can use one of the following DWORD
settings.

Setting Description
PDFExclud
eWatermar
kPre

Exclude the watermark from the specified number of pages from
the beginning of the document. The setting is deleted after the
applying the watermark unless the "persistent" registry value
is set.

PDFExclud
eWatermar
kPost

Exclude the watermark from the specified number of pages from
the end of the document. The setting is deleted after the
applying the watermark unless the "persistent" registry value
is set.

PDFInclud
eWatermar
kPre

Include the watermark to the specified number of pages from
the beginning of the document. The setting is deleted after the
applying the watermark unless the "persistent" registry value
is set.

PDFInclud
eWatermar
kPost

Include the watermark to the specified number of pages from
the end of the document. The setting is deleted after the
applying the watermark unless the "persistent" registry value
is set.

PDFDefault
ExcludeWa
termarkPre

Always exclude the watermark from the specified number of
pages from the beginning of the document. 

PDFDefault
ExcludeWa
termarkPo
st

Always exclude the watermark from the specified number of
pages from the end of the document. 

PDFDefault
IncludeWa
termarkPre

Always include the watermark to the specified number of pages
from the beginning of the document. 

PDFDefault
IncludeWa
termarkPo
st

Always include the watermark to the specified number of pages
from the end of the document. 
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6.2.13 Controlling File Save Formats

The file save formats such as "PDF", "PDF/A", and "JPEG" can be controlled
by editing a DWORD value to the registry named "formats" at any of the
standard registry locations. The options are specified using table below:

Format Value (Hexadecimal)
PDF 0x1
PDF/A 0x2
XPS 0x4
TIFF (monochrome) 0x8
SVG 0x10
PDF Image Only
(monochrome)

0x20

TIFF (color) 0x40
JPEG (grayscale) 0x80
JPEG (color) 0x100
GIF (grayscale) 0x200
GIF (color) 0x400
PNG (grayscale) 0x800
PNG (color) 0x1000
BMP (grayscale) 0x2000
BMP (color) 0x4000
PDF Image Only (color) 0x8000

For example, to only display "PDF" in the file save window, you would set
"formats" to 0x1 hexadecimal. The values can be added together to specify
more than one format, so to display "PDF" and "PDF Image Only", you
would set formats to 0x21 hexadecimal. To display all formats, you can set
formats to 0xffff hexadecimal.
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6.2.14 Mail Helper Application

Note: In the latest version of Win2PDF, the Win2PDF Mail Helper
functionality has been incorporated in to the Win2PDF Desktop
application and is no longer required in most circumstances (See How to
Mail a PDF).

The Win2PDF Mail Helper application is an optional SMTP mail client that
integrates with Win2PDF and supports sending email without user
interaction. This application can be downloaded from the Win2PDF support
download site at: 
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https://helpdesk.win2pdf.com/index.php?/Knowledgebase/Article/View/18
9/15/win2pdf-mail-helper-download

To email without user interaction, you must have the Win2PDF Mail Helper
application installed and configured, you must set the email recipient
address, and you must enable the "Send email - no user interaction"
option. 

The Win2PDF Mail Helper uses SMTP to send email, and requires
configuration to use an SMTP server. You can use the "Configure Win2PDF
Mail Helper" menu option to interactively set the server settings, or you can
use the following registry settings in any of the standard registry locations:

Value
Name

Typ
e

Description

PDFMailFr
om

Stri
ng

Used to fill in the "from:" field in the email header.

PDFMailSe
rverName

Stri
ng

SMTP server name

PDFMailUs
erName

Stri
ng

If authentication is used, the user name for the SMTP server.

PDFMailPa
ssword

Stri
ng

If authentication is used, the password for the SMTP server.

PDFMailAu
thenticatio
n

Stri
ng

1 if authentication is used by the SMTP server, 0 otherwise

6.3 Command Line Interface

6.3.1 Win2PDF Desktop Command Line Summary

The Win2PDF Desktop application that is part of build 10.0.56 or above now
supports a command line interface in addition to the graphical interface. If
you supply any commands in this format, it will process it directly from the
command line. Otherwise, it displays the graphical interface.

The command line interface is supported for licensed copies of Win2PDF.
Attempting to run a command line with the evaluation version of Win2PDF
will return an error, or an trailer page will be added to the resulting PDF. To
evaluate Win2PDF or Win2PDF Pro without the trailer page, contact us for a
time limited evaluation license.

The executable is located in the printer driver directory which is usually:

c:\windows\system32\spool\drivers\x64\3\

https://helpdesk.win2pdf.com/index.php?/Knowledgebase/Article/View/189/15/win2pdf-mail-helper-download
https://helpdesk.win2pdf.com/index.php?/Knowledgebase/Article/View/189/15/win2pdf-mail-helper-download
https://www.win2pdf.com/trial.html
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On 64 bit systems, and :

c:\windows\system32\spool\drivers\w32x86\3\

On 32 bit systems.

The general format of the command line is:

win2pdfd.exe subcommand parameter1 parameter2 …

Where subcommand can be one of:
version
previewpdf
append
compress
encrypt
extractpages
deletepages
splitpages
splitpagesaftersearch
splitpagesdelete
rotatepages
pagecount
watermark
background
extracttext
makesearchable
printpdf
previewpdf
convert
convertto
batchconvert
watchconvert
pdfimage
pdf2jpg
pdf2tiff
pdf2png
tiff2pdf
jpg2pdf
png2pdf
bmp2pdf
gif2pdf
html2pdf
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xps2pdf
image2pdf
getcontentsearch
getcontentsearchbelow
sign
setpdfversion

The number of parameters varies depending on the subcommand, and all
parameters specified in the subcommand documentation are required.

If no subcommand is specified, first command line parameter is assumed to
be a file name instead of a subcommand. If the file name ends with a PDF
extension, the Win2PDF Desktop application opens with the graphical
options to append, prepend, delete pages, extract pages, split pages, or
rotate pages. Otherwise, the file name in the first parameter is opened with
the default file handler for the file type and sent to the Win2PDF printer. If
the Win2PDF auto-name feature has been enabled, the file will be converted
to PDF using the settings specified by the auto-name feature. 

6.3.2 Command Line Version

Version Command Line Format

win2pdfd.exe version

Displays the current Win2PDF version, such as "10.0.100". Available in
Win2PDF 10.0.100 or above.

6.3.3 Command Line PDF Append

Append/Prepend Command Line Format

win2pdfd.exe append "file1" "file2" "mergedfile"

Where “file2” is appended to “file1” and the combined PDF is saved to a
newly created “mergedfile”. If there is an existing file named the same as
“mergedfile”, it will be overwritten. To prepend, swap file1 and file2
parameters.

Any file names that contain spaces must be enclosed with quotation marks.
 The "file1" and "file2" parameters can be a local file paths, web addresses
(URLs) to existing PDF files, or a combination of the two.
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This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.4 Command Line PDF Image Compression

PDF Image Compression Command Line Format

win2pdfd.exe compress "sourcefile" compressratio "destfile"
win2pdfd.exe compress "sourcefile" compressratio "destfile" favorjeg2000

Re-compress  images using either JPG or JPEG2000. The “compressratio” is
a number, usually 10-100 that determines the amount of compression.
Win2PDF tries to select the best compression format based on the current
document. In the 2nd variation, specifying a "1" in the last parameter
"favorjpeg2000" will favor JPEG2000 compression even if it results in a
larger PDF.

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.5 Command Line PDF Page Extraction

Extract Pages Command Line Format

win2pdfd.exe extractpages "sourcefile" startpage endpage "destfile"

Extract pages from “sourcefile” starting at “startpage” to “endpage”, and
save extracted pages in “destfile”. 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
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Returns 0 on success, and a Windows system error code on failure.

6.3.6 Command Line PDF Page Deletion

Delete Pages Command Line Format

win2pdfd.exe deletepages "sourcefile" startpage endpage "destfile"

Delete pages from “sourcefile” starting at “startpage” to “endpage”, and
save PDF with deleted pages in “destfile”. If "sourcefile" and "destfile" are
the same file, the file is modified in place.

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.7 Command Line PDF Page Rotation

Rotate Page Command Line Format

win2pdfd.exe rotatepages "sourcefile" rotationdegrees pagenum "destfile"

Rotate a single page specified by "pagenum" from “sourcefile” by
"rotationdegrees" (0,90,180,270), and save the PDF with rotated page in
“destfile”. If "pagenum" is 0, all pages in the document are rotated. If
"sourcefile" and "destfile" are the same file, the file is modified in place. 

The rotation is absolute, not relative. If a page is already rotated by 90
degrees, calling rotatepages again with "rotationdegrees" set to 90 will
have no affect.

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
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Returns 0 on success, and a Windows system error code on failure.

6.3.8 Command Line PDF Split Pages

win2pdfd.exe splitpages "sourcefile" "destfolder" pageincrement oddpages
win2pdfd.exe splitpagesdelete "sourcefile" "destfolder" pageincrement oddpages

Split PDF from “sourcefile” into segments specified by “pageincrement”.
Page segments are placed in the “destfolder”, and are named with the
original file name with a “.#.PDF” extension. If “pageincrement” is greater
than one, the pages are named based on the beginning page of the
segment. For example, setting “pageincrement” to 2 and splitting a 7 page
document would result in 4 files named:

sourcefile.1.pdf (2 pages)

sourcefile.3.pdf (2 pages)

sourcefile.5.pdf (2 pages)

sourcefile.7.pdf (1 page)

The "oddpages" parameter is useful for splitting documents that are meant
to print as duplex but have a cover page. Setting “oddpages” to one
requires that pageincrement is set to 2. It starts with a single page
segment, and then the following segments are 2 pages long. A 7 page
document with “pageincrement” to 2 and “oddpages” to 1 would result in
the following files:

sourcefile.1.pdf (1 page)

sourcefile.2.pdf (2 pages)

sourcefile.4.pdf (2 pages)

sourcefile.6.pdf (2 pages)

The “splitpagesdelete” variation of the command behaves the same as
“splitpages” but deletes the “sourcefile” after the document has been
successfully split.

Any file names that contain spaces must be enclosed with quotation marks.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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6.3.9 Command Line PDF Split Pages With Search

win2pdfd.exe splitpagesaftersearch "sourcefile" "destfolder" "searchtext"
win2pdfd.exe splitpagesbeforesearch "sourcefile" "destfolder" "searchtext"

Split PDF from “sourcefile” into segments based on the contents of the PDF
and the  “searchtext” parameter. For the "splitpagesaftersearch" variation,
Win2PDF searches the text in the PDF and splits the PDF after it encounters
a page with the "searchtext". For the "splitpagesbeforesearch" variation,
Win2PDF splits the PDF on the page before "searchtext". Page segments
are placed in the “destfolder”, and are named with the original file name
with a “.#.PDF” extension. 

Any file names, folder paths, or searchtext parameters that contain spaces
must be enclosed with quotation marks.

Requires a licensed version of Win2PDF. Contact support@win2pdf.com for
a time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.10 Command Line PDF Page Count

win2pdfd.exe pagecount "sourcefile"

Returns number of PDF pages from “sourcefile”. If the “sourcefile” file name
contains spaces, it must be enclosed with quotation marks.  The
"sourcefile" can be a local file path, or an web address (URL) to an existing
PDF.

From the Windows CMD prompt, the page count can be referenced using
the built-in %ERRORLEVEL% environment variable. This can be referenced

from other Win2PDF command line options in a batch file.

From PowerShell, the page count can be referenced using $LASTEXITCODE.

Returns 0 if an error occurs.

6.3.11 Command Line PDF Encryption

Encrypt PDF Command Line Format  

win2pdfd.exe encrypt "sourcefile" "destfile" permissions encryptiontype masterpass userpass

Where:

mailto:support@win2pdf.com
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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“permissions” is a hexadecimal value as defined here:
https://www.win2pdf.com/doc/controllingencryptionoptions.html
It should be set without a preceding 0x. Set permissions to fffffffc to
enable all permissions.

“encryptiontype” is one of “none”, “40”, “128”, “128aes”, or
“256aes”. 256aes is recommended.

“masterpass” is the master or owner password (required).

“userpass” is the user password, and must be distinct from the
“ownerpass”. Set to “” for no user password.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

If "sourcefile" and "destfile" are the same file, the file is modified in place.

To remove encryption, set the encryptiontype to "none" and supply the
"masterpass" used when encryption was enabled.

Any file names that contain spaces must be enclosed with quotation marks.
 The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

Returns 0 on success, and a Windows system error code on failure.

6.3.12 Command Line PDF Sign With Certificate

Sign PDF With Certificate Command Line Format 

win2pdfd.exe sign "sourcepdf" "destpdf" "certfile" "certpassword"

Signs the PDF specified by "sourcepdf" and saves signed PDF to "destpdf"
using the digital certificate file and password specified by "certfile" and
"certpassword".  The "certfile" must be a PKCS#12 certificate (.pfx or .p12
file) issued by a valid Certificate Authority (CA). Adobe Acrobat Reader only
recognizes some Certificate Authorities and some Certificate Policies
without displaying a warning, but it's possible to manually mark a certificate
as "trusted" for other types of certificates.

https://www.win2pdf.com/doc/controllingencryptionoptions.html
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes


Developer Information 703

© 2023 Dane Prairie Systems, LLC

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

If "sourcefile" and "destfile" are the same file, the file is modified in place.

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcepdf" can be a local file path, or an web address (URL) to an
existing PDF.

Returns 0 on success, and a Windows system error code on failure.

6.3.13 Command Line PDF Watermark/Background

Watermark/Background PDF Command Line Format 

win2pdfd.exe watermark "sourcefile" "watermarkfile" "destfile" mode excludepre excludepost
win2pdfd.exe watermarklink "sourcefile" "watermarkfile" "destfile" mode excludepre excludepost

Where:

“mode” is either “watermark” or “background”
If mode is “watermark”, the watermarkfile PDF is overlaid on top of
all existing graphics on the page. If mode is “background, the
watermarkfile PDF is placed underneath all existing graphics on the
page.

“excludepre” is the number of pages from the beginning of the
document to skip applying the watermark. Set to 0 apply
watermarkfile to all pages including the first page. Set to a negative
value to include the watermark to the absolute value of the number
of pages from the beginning of the document.

“excludepost” is the number of pages from the end of the document
to skip applying the watermark. Set to 0 to apply the watermarkfile to
all pages including the last page. Set to a negative value to include
the watermark to the absolute value of the number of pages from the
end of the document.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

If "sourcefile" and "destfile" are the same file, the file is modified in place.

https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
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If the watermark file has click-able links, you can use the "watermarklink"
variation to keep these links active in the final watermarked PDF file.

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

Returns 0 on success, and a Windows system error code on failure.

6.3.14 Command Line PDF Text Extraction

Extract Text Command Line Format

win2pdfd.exe extracttext "sourcefile" "destfile" formatting

Extract text from “sourcefile”, and save to text file “destfile”. If “formatting”
is “1”, the destination text file is formatted similarly to the PDF. If
“formatting” is “0”, the text file is unformatted.

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.15 Command Line PDF Make Searchable (OCR)

Make Searchable Command Line Format

win2pdfd.exe makesearchable "sourcefile" "destfile"

Recognizes text from images and graphics using Optical Character
Recognition (OCR) from "sourcefile", and saves the text information in an
invisible text layer in "destfile" to make the PDF searchable. If "sourcefile"
and "destfile" are the same file, the file is modified in place.

Requires that the Win2PDF OCR Add-on is installed (separate download
from Win2PDF).

https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/download/download-win2pdf-ocr.html
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Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

Returns 0 on success, and a Windows system error code on failure.

6.3.16 Command Line PDF Image Only

PDF Image Only Command Line Format

win2pdfd.exe imagepdf "sourcefile" "destfile" colormode

Converts a pdf specified by "sourcefile" into an image only PDF specified by
"destfile". If "sourcefile" and "destfile" are the same file, the file is modified
in place. The colormode parameter can be one of:

"mono" - create a black and white image only PDF
"grayscale" - create a grayscale image only PDF
"color" - create a color image only PDF

Image only PDF files can be useful to make the PDF unsearchable, to
"flatten" text fields for security, to speed up loading time for complex PDFs,
and to reduce the PDF file size.

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

Returns 0 on success, and a Windows system error code on failure.

6.3.17 Command Line PDF Print

Print PDF Command Line Format

win2pdfd.exe printpdf "sourcefile" printername
win2pdfd.exe printpdf "sourcefile" printername startpage endpage
win2pdfd.exe printpdf "sourcefile" printername outputfile

Prints the PDF “sourcefile” to the specified printername, optionally including
a startpage, and endpage.

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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The command line option that includes an outputfile is useful for re-
rendering an existing PDF through the Win2PDF printer.

If your printer supports Direct PDF printing, the Command Line PDF Print
Direct command line may be faster.

Returns 0 on success, and a Windows system error code on failure.

6.3.18 Command Line PDF Print Direct

Print PDF Direct Command Line Format

win2pdfd.exe printpdfdirect "sourcefile" printername
win2pdfd.exe printpdfdirect "sourcefile" printername startpage endpage

Prints the PDF “sourcefile” directly to the specified “printername” that
supports Direct PDF printing, optionally including a startpage, and endpage.

Compared to the Command Line PDF Print, this can be much faster but only
works on printers with "Direct PDF" printing. Most business class printers
from HP, OKI,  Kyocera, Ricoh, Canon, and Xerox support Direct PDF
printing, but most consumer inkjet printers do not support it. If the
“pdfprintdirect” command is used on a printer that does not support Direct
PDF printing, it may result in many pages of garbled text being printed.

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

Returns 0 on success, and a Windows system error code on failure.

6.3.19 Command Line PDF View

View PDF Command Line Format

win2pdfd.exe previewpdf "sourcefile"

Shows the Win2PDF Desktop PDF viewer window for the PDF specified by
“sourcefile”.

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

Returns 0 on success, and a Windows system error code on failure.

https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.oki.com/printing/online-manuals-12/458222/id/contents/contents/pr_000037.html
http://support.ricoh.com/bb_v1oi/pub_e/oi_view/0001036/0001036377/view/printer/unv/0088.htm
https://oip.manual.canon/USRMA-0221-zz-SS-enUV/contents/08060010.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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6.3.20 Command Line PDF Convert

Convert To PDF Command Line Format

win2pdfd.exe convert "sourcefile"
win2pdfd.exe convert "sourcefile" "destpdf"

Converts the sourcefile to a PDF with the same name and location by using
the default Windows application associated with the file type. If the
"destpdf" parameter is specified, it is used for the destination PDF file
location. If no Windows application is associated with the file type, the
conversion will fail.

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing file.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.21 Command Line PDF Add Bookmark

PDF Add Bookmark Command Line Format

win2pdfd.exe addbookmark "sourcepdf" "title" pagenumber "destpdf"

Adds a PDF bookmark using "title" and "pagenumber" to the PDF specified
by "sourcepdf", and saves the modified PDF to "destpdf". If "sourcepdf"
and "destpdf" are the same file, the file is modified in place.

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcepdf" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.22 Command Line PDF Add Bookmark After Search

PDF Add Bookmark After Search Command Line Format

win2pdfd.exe addbookmarkaftersearch "sourcepdf" "title" "searchtext" "destpdf"

https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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Search the PDF file specified by "sourcepdf" for the text specified by
"searchtext". If the "searchtext" is found in the PDF file, a bookmark is
added using the specified "title" and the page number where the search
text is found and the modified PDF is saved to "destpdf". If "sourcepdf" and
"destpdf" are the same file, the file is modified in place. 

Any file names or "searchtext" that contain spaces must be enclosed with
quotation marks. The "sourcepdf" can be a local file path, or an web
address (URL) to an existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.23 Command Line PDF Delete All Bookmarks

PDF Delete Bookmarks Command Line Format

win2pdfd.exe deletebookmarks "sourcepdf" "destpdf"

Deletes all PDF bookmarks from the file specified by "sourcepdf", and saves
the modified PDF to "destpdf". If "sourcepdf" and "destpdf" are the same
file, the file is modified in place. 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcepdf" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24 Command Line Convert To Format

Convert To Format Command Line

win2pdfd.exe convertto "sourcefile" "destfile" destformat

Converts the sourcefile to the specified format, and saves the converted file
to destfile. The "sourcefile" parameter can be one of the following formats:

Extension Format
.PDF Portable Document Format

https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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.DOCX, .DOC Microsoft Word (Win2PDF Pro Only)

.RTF Rich Text Format (Win2PDF Pro Only)

.ODT OpenDocument Text (Win2PDF Pro Only)

.TXT Text (Win2PDF Pro Only)

.HTML, .HTM, .
MHTML, .JS

HyperText Markup Language

.SVG Scalable Vector Graphics

.XPS XML Paper Specification

.TIF, .TIFF Tagged Image File Format

.JPG, .JPEG, .JP
E

Joint Photographic Experts Group Image

.PNG Portable Network Graphics

.BMP, .DIB Windows Bitmap

.GIF Graphics Interchange Format

Files not matching one of these extensions cannot be converted with this
command.

The "destformat" can be one of the following:

destformat
parameter

Description

pdf Portable Document Format
pdfimagemono PDF Image Only - monochrome
pdfimagegraysc
ale

PDF Image Only - grayscale

pdfimagecolor PDF Image Only - color
pdfcompressed PDF - compressed
pdfsearchable PDF - searchable (OCR)
textformatted Text - formatted
textunformatte
d

Text - unformatted

jpggray JPG - grayscale
jpg JPG - color
tiffmono TIFF - monochrome
tiffgray TIFF - grayscale
tiff TIFF - color
tifftransparent TIFF - color with transparent background
pnggray PNG - Grayscale
png PNG - Color
pnggraytranspa
rent

PNG - Grayscale with transparent background

pngtransparent PNG - Color with transparent background
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ocrtextformatte
d

Text - formatted after making searchable, requires optional
Win2PDF OCR Add-on

ocrtextunforma
tted

Text - unformatted after making searchable, formatted after
making searchable, requires optional Win2PDF OCR Add-on
 

docx Microsoft Word (Win2PDF Pro Only)
rtf Rich Text Format (Win2PDF Pro Only)
odt OpenDocument Format (Win2PDF Pro Only)
xps XML Paper Specification (Win2PDF Pro Only)

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

For specific examples of using the convertto command to convert from one
format to another, see:
Command Line Convert HTML to Text
Command Line Convert HTML to JPG
Command Line Convert HTML to TIFF
Command Line Convert HTML to PNG
Command Line Convert XPS to Text
Command Line Convert XPS to JPG
Command Line Convert XPS to TIFF
Command Line Convert XPS to PNG
Command Line Convert TIFF to Text
Command Line Convert TIFF to JPG
Command Line Convert TIFF to TIFF
Command Line Convert TIFF to PNG
Command Line Convert JPG to Text
Command Line Convert JPG to JPG
Command Line Convert JPG to TIFF
Command Line Convert JPG to PNG
Command Line Convert PNG to Text
Command Line Convert PNG to JPG
Command Line Convert PNG to TIFF
Command Line Convert PNG to PNG
Command Line Convert BMP to Text
Command Line Convert BMP to JPG
Command Line Convert BMP to TIFF
Command Line Convert BMP to PNG
Command Line Convert GIF to Text
Command Line Convert GIF to JPG
Command Line Convert GIF to TIFF
Command Line Convert GIF to PNG

https://www.win2pdf.com/download/download-win2pdf-ocr.html
https://www.win2pdf.com/download/download-win2pdf-ocr.html
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This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.1 Command Line Convert HTML to Text

Convert HTML To Text Command Line

win2pdfd.exe convertto "sourcefile.html" "destfile.txt" textformatted
win2pdfd.exe convertto "sourcefile.html" "destfile.txt" textunformatted
win2pdfd.exe convertto "sourcefile.html" "destfile.txt" ocrtextformatted
win2pdfd.exe convertto "sourcefile.html" "destfile.txt" ocrtextunformatted

Converts the HTML "sourcefile.html" to text, and saves the converted text
to "destfile.txt". The last parameter controls the text formatting:
textformatted Text - formatted
textunformatte
d

Text - unformatted

ocrtextformatte
d

Text - formatted after making searchable, requires optional
Win2PDF OCR Add-on

ocrtextunforma
tted

Text - unformatted after making searchable, formatted after
making searchable, requires optional Win2PDF OCR Add-on

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.2 Command Line Convert HTML to JPG

Convert HTML To JPG Command Line

win2pdfd.exe convertto "sourcefile.html" "destfile.jpg" jpg
win2pdfd.exe convertto "sourcefile.html" "destfile.jpg" jpggray

Converts the HTML "sourcefile.html" to a JPEG image, and saves the
converted image to "destfile.jpg". The "jpg" variation saves the converted

https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/download/download-win2pdf-ocr.html
https://www.win2pdf.com/download/download-win2pdf-ocr.html
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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image as a color JPEG, and the "jpggray" variation saves the converted
image as a grayscale JPEG.

If the HTML file is more than one page, all pages are converted as separate
files one per page in the format:

destpng.1.jpg
destpng.2.jpg
...
destpng.n.jpg

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.3 Command Line Convert HTML to TIFF

Convert HTML To TIFF Command Line

win2pdfd.exe convertto "sourcefile.html" "destfile.tif" tiff
win2pdfd.exe convertto "sourcefile.html" "destfile.tif" tiffmono
win2pdfd.exe convertto "sourcefile.html" "destfile.tif" tiffgray
win2pdfd.exe convertto "sourcefile.html" "destfile.tif" tifftransparent

Converts the HTML "sourcefile.html" to a TIFF image, and saves the
converted image to "destfile.tif". The last parameter controls the TIFF
format:
tiffmono TIFF - monochrome
tiffgray TIFF - grayscale
tiff TIFF - color
tifftransparent TIFF - color with transparent background

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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6.3.24.4 Command Line Convert HTML to PNG

Convert HTML To PNG Command Line

win2pdfd.exe convertto "sourcefile.html" "destfile.png" png
win2pdfd.exe convertto "sourcefile.html" "destfile.png" pnggray
win2pdfd.exe convertto "sourcefile.html" "destfile.png" pngtransparent
win2pdfd.exe convertto "sourcefile.html" "destfile.png" pnggraytransparent

Converts the HTML "sourcefile.html" to a PNG image, and saves the
converted image to "destfile.png". The last parameter controls the PNG
format:
pnggray PNG - Grayscale
png PNG - Color
pnggraytransp
arent

PNG - Grayscale with transparent background

pngtransparen
t

PNG - Color with transparent background

If the HTML file is more than one page, all pages are converted as separate
files one per page in the format:

destpng.1.png
destpng.2.png
...
destpng.n.png

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.5 Command Line Convert HTML to DOCX

Convert HTML To DOCX Command Line  

win2pdfd.exe convertto "sourcefile.html" "destfile.docx" docx

Converts the HTML "sourcefile.html" to a Microsoft Word DOCX document,
and saves the document to "destfile.docx". 

https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.6 Command Line Convert HTML to RTF

Convert HTML To RTF Command Line  

win2pdfd.exe convertto "sourcefile.html" "destfile.rtf" rtf

Converts the HTML "sourcefile.html" to a Rich Text Format document, and
saves the document to "destfile.rtf". 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.7 Command Line Convert HTML to ODT

Convert HTML To ODT Command Line  

win2pdfd.exe convertto "sourcefile.html" "destfile.odt" odt

Converts the HTML "sourcefile.html" to a OpenDocument Format
document, and saves the document to "destfile.odt". 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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6.3.24.8 Command Line Convert SVG to Text

Convert SVG To Text Command Line

win2pdfd.exe convertto "sourcefile.svg" "destfile.txt" textformatted
win2pdfd.exe convertto "sourcefile.svg" "destfile.txt" textunformatted
win2pdfd.exe convertto "sourcefile.svg" "destfile.txt" ocrtextformatted
win2pdfd.exe convertto "sourcefile.svg" "destfile.txt" ocrtextunformatted

Converts the SVG "sourcefile.svg" to text, and saves the converted text to
"destfile.txt". The last parameter controls the text formatting:
textformatted Text - formatted
textunformatte
d

Text - unformatted

ocrtextformatte
d

Text - formatted after making searchable, requires optional
Win2PDF OCR Add-on

ocrtextunforma
tted

Text - unformatted after making searchable, formatted after
making searchable, requires optional Win2PDF OCR Add-on

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.9 Command Line Convert SVG to JPG

Convert SVG To JPG Command Line

win2pdfd.exe convertto "sourcefile.svg" "destfile.jpg" jpg
win2pdfd.exe convertto "sourcefile.svg" "destfile.jpg" jpggray

Converts the SVG "sourcefile.svg" to a JPEG image, and saves the
converted image to "destfile.jpg". The "jpg" variation saves the converted
image as a color JPEG, and the "jpggray" variation saves the converted
image as a grayscale JPEG.

If the SVG file is more than one page, all pages are converted as separate
files one per page in the format:

destpng.1.jpg
destpng.2.jpg
...

https://www.win2pdf.com/download/download-win2pdf-ocr.html
https://www.win2pdf.com/download/download-win2pdf-ocr.html
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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destpng.n.jpg

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.10Command Line Convert SVG to TIFF

Convert SVG To TIFF Command Line

win2pdfd.exe convertto "sourcefile.svg" "destfile.tif" tiff
win2pdfd.exe convertto "sourcefile.svg" "destfile.tif" tiffmono
win2pdfd.exe convertto "sourcefile.svg" "destfile.tif" tiffgray
win2pdfd.exe convertto "sourcefile.svg" "destfile.tif" tifftransparent

Converts the SVG "sourcefile.svg" to a TIFF image, and saves the
converted image to "destfile.tif". The last parameter controls the TIFF
format:
tiffmono TIFF - monochrome
tiffgray TIFF - grayscale
tiff TIFF - color
tifftransparent TIFF - color with transparent background

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.11Command Line Convert SVG to PNG

Convert SVG To PNG Command Line

win2pdfd.exe convertto "sourcefile.svg" "destfile.png" png
win2pdfd.exe convertto "sourcefile.svg" "destfile.png" pnggray
win2pdfd.exe convertto "sourcefile.svg" "destfile.png" pngtransparent
win2pdfd.exe convertto "sourcefile.svg" "destfile.png" pnggraytransparent

https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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Converts the SVG "sourcefile.svg" to a PNG image, and saves the
converted image to "destfile.png". The last parameter controls the PNG
format:
pnggray PNG - Grayscale
png PNG - Color
pnggraytransp
arent

PNG - Grayscale with transparent background

pngtransparen
t

PNG - Color with transparent background

If the SVG file is more than one page, all pages are converted as separate
files one per page in the format:

destpng.1.png
destpng.2.png
...
destpng.n.png

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.12Command Line Convert SVG to DOCX

Convert SVG To DOCX Command Line  

win2pdfd.exe convertto "sourcefile.svg" "destfile.docx" docx

Converts the SVG "sourcefile.svg" to a Microsoft Word DOCX document,
and saves the document to "destfile.docx". 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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6.3.24.13Command Line Convert SVG to RTF

Convert SVG To RTF Command Line  

win2pdfd.exe convertto "sourcefile.svg" "destfile.rtf" rtf

Converts the SVG "sourcefile.svg" to a Rich Text Format document, and
saves the document to "destfile.rtf". 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.14Command Line Convert SVG to ODT

Convert SVG To ODT Command Line  

win2pdfd.exe convertto "sourcefile.svg" "destfile.odt" odt

Converts the SVG "sourcefile.svg" to a OpenDocument Format document,
and saves the document to "destfile.odt". 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.15Command Line Convert XPS to Text

Convert XPS To Text Command Line

win2pdfd.exe convertto "sourcefile.xps" "destfile.txt" textformatted
win2pdfd.exe convertto "sourcefile.xps" "destfile.txt" textunformatted
win2pdfd.exe convertto "sourcefile.xps" "destfile.txt" ocrtextformatted
win2pdfd.exe convertto "sourcefile.xps" "destfile.txt" ocrtextunformatted

Converts the XPS "sourcefile.xps" to text, and saves the converted text to
"destfile.txt". The last parameter controls the text formatting:

https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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textformatted Text - formatted
textunformatte
d

Text - unformatted

ocrtextformatte
d

Text - formatted after making searchable, requires optional
Win2PDF OCR Add-on 

ocrtextunforma
tted

Text - unformatted after making searchable, formatted after
making searchable, requires optional Win2PDF OCR Add-on

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.16Command Line Convert XPS to JPG

Convert XPS To JPG Command Line

win2pdfd.exe convertto "sourcefile.xps" "destfile.jpg" jpg
win2pdfd.exe convertto "sourcefile.xps" "destfile.jpg" jpggray

Converts the XPS "sourcefile.xps" to a JPEG image, and saves the
converted image to "destfile.jpg". The "jpg" variation saves the converted
image as a color JPEG, and the "jpggray" variation saves the converted
image as a grayscale JPEG.

If the XPS file is more than one page, all pages are converted as separate
files one per page in the format:

destpng.1.jpg
destpng.2.jpg
...
destpng.n.jpg

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

https://www.win2pdf.com/download/download-win2pdf-ocr.html
https://www.win2pdf.com/download/download-win2pdf-ocr.html
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes


Win2PDF720

© 2023 Dane Prairie Systems, LLC

6.3.24.17Command Line Convert XPS to TIFF

Convert XPS To TIFF Command Line

win2pdfd.exe convertto "sourcefile.xps" "destfile.tif" tiff
win2pdfd.exe convertto "sourcefile.xps" "destfile.tif" tiffmono
win2pdfd.exe convertto "sourcefile.xps" "destfile.tif" tiffgray
win2pdfd.exe convertto "sourcefile.xps" "destfile.tif" tifftransparent

Converts the XPS "sourcefile.xps" to a TIFF image, and saves the converted
image to "destfile.tif". The last parameter controls the TIFF format:
tiffmono TIFF - monochrome
tiffgray TIFF - grayscale
tiff TIFF - color
tifftransparent TIFF - color with transparent background

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.18Command Line Convert XPS to PNG

Convert XPS To PNG Command Line

win2pdfd.exe convertto "sourcefile.xps" "destfile.png" png
win2pdfd.exe convertto "sourcefile.xps" "destfile.png" pnggray
win2pdfd.exe convertto "sourcefile.xps" "destfile.png" pngtransparent
win2pdfd.exe convertto "sourcefile.xps" "destfile.png" pnggraytransparent

Converts the XPS "sourcefile.xps" to a PNG image, and saves the converted
image to "destfile.png". The last parameter controls the PNG format:
pnggray PNG - Grayscale
png PNG - Color
pnggraytransp
arent

PNG - Grayscale with transparent background

pngtransparen
t

PNG - Color with transparent background

If the XPS file is more than one page, all pages are converted as separate
files one per page in the format:

https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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destpng.1.png
destpng.2.png
...
destpng.n.png

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.19Command Line Convert XPS to DOCX

Convert XPS To DOCX Command Line  

win2pdfd.exe convertto "sourcefile.xps" "destfile.docx" docx

Converts the XPS "sourcefile.xps" to a Microsoft Word DOCX document,
and saves the document to "destfile.docx". 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.20Command Line Convert XPS to RTF

Convert XPS To RTF Command Line  

win2pdfd.exe convertto "sourcefile.svg" "destfile.rtf" rtf

Converts the XPS "sourcefile.xps" to a Rich Text Format document, and
saves the document to "destfile.rtf". 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF Pro. Contact us for a

https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
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time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.21Command Line Convert XPS to ODT

Convert XPS To ODT Command Line  

win2pdfd.exe convertto "sourcefile.svg" "destfile.odt" odt

Converts the XPS "sourcefile.xps" to a OpenDocument Format document,
and saves the document to "destfile.odt". 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.22Command Line Convert TIFF to Text

Convert TIFF To Text Command Line

win2pdfd.exe convertto "sourcefile.tif" "destfile.txt" ocrtextformatted
win2pdfd.exe convertto "sourcefile.tif" "destfile.txt" ocrtextunformatted

Converts the TIFF "sourcefile.tif" to text, and saves the converted text to
"destfile.txt". The last parameter controls the text formatting:
ocrtextformatte
d

Text - formatted after making searchable, requires optional
Win2PDF OCR Add-on 

ocrtextunforma
tted

Text - unformatted after making searchable, formatted after
making searchable, requires optional Win2PDF OCR Add-on

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/download/download-win2pdf-ocr.html
https://www.win2pdf.com/download/download-win2pdf-ocr.html
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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6.3.24.23Command Line Convert TIFF to JPG

Convert TIFF To JPG Command Line

win2pdfd.exe convertto "sourcefile.tif" "destfile.jpg" jpg
win2pdfd.exe convertto "sourcefile.tif" "destfile.jpg" jpggray

Converts the TIFF "sourcefile.tiff" to a JPEG image, and saves the
converted image to "destfile.jpg". The "jpg" variation saves the converted
image as a color JPEG, and the "jpggray" variation saves the converted
image as a grayscale JPEG.

If the TIFF file is more than one page, all pages are converted as separate
files one per page in the format:

destpng.1.jpg
destpng.2.jpg
...
destpng.n.jpg

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.24Command Line Convert TIFF to TIFF

Convert TIFF To TIFF Command Line

win2pdfd.exe convertto "sourcefile.tif" "destfile.tif" tiff
win2pdfd.exe convertto "sourcefile.tif" "destfile.tif" tiffmono
win2pdfd.exe convertto "sourcefile.tif" "destfile.tif" tiffgray
win2pdfd.exe convertto "sourcefile.tif" "destfile.tif" tifftransparent

Reformats the TIFF "sourcefile.tiff" to a new TIFF image, and saves the
converted image to "destfile.tif". The last parameter controls the TIFF
format:
tiffmono TIFF - monochrome
tiffgray TIFF - grayscale
tiff TIFF - color
tifftransparent TIFF - color with transparent background

https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.25Command Line Convert TIFF to PNG

Convert TIFF To PNG Command Line

win2pdfd.exe convertto "sourcefile.tif" "destfile.png" png
win2pdfd.exe convertto "sourcefile.tif" "destfile.png" pnggray
win2pdfd.exe convertto "sourcefile.tif" "destfile.png" pngtransparent
win2pdfd.exe convertto "sourcefile.tif" "destfile.png" pnggraytransparent

Converts the TIFF "sourcefile.tif" to a PNG image, and saves the converted
image to "destfile.png". The last parameter controls the PNG format:
pnggray PNG - Grayscale
png PNG - Color
pnggraytransp
arent

PNG - Grayscale with transparent background

pngtransparen
t

PNG - Color with transparent background

If the XPS file is more than one page, all pages are converted as separate
files one per page in the format:

destpng.1.png
destpng.2.png
...
destpng.n.png

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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6.3.24.26Command Line Convert TIFF to DOCX

Convert TIFF To DOCX Command Line  

win2pdfd.exe convertto "sourcefile.tif" "destfile.docx" docx

Converts the TIFF "sourcefile.tif" to a Microsoft Word DOCX document, and
saves the document to "destfile.docx". 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.27Command Line Convert TIFF to RTF

Convert TIFF To RTF Command Line  

win2pdfd.exe convertto "sourcefile.tif" "destfile.rtf" rtf

Converts the TIFF "sourcefile.tif" to a Rich Text Format document, and
saves the document to "destfile.rtf". 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.28Command Line Convert TIFF to ODT

Convert TIFF To ODT Command Line  

win2pdfd.exe convertto "sourcefile.tif" "destfile.odt" odt

Converts the TIFF "sourcefile.tif" to a OpenDocument Format document,
and saves the document to "destfile.odt". 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an

https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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existing PDF.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.29Command Line Convert JPG to Text

Convert JPEG To Text Command Line

win2pdfd.exe convertto "sourcefile.jpg" "destfile.txt" ocrtextformatted
win2pdfd.exe convertto "sourcefile.jpg" "destfile.txt" ocrtextunformatted

Converts the JPEG "sourcefile.jpg" to text, and saves the converted text to
"destfile.txt". The last parameter controls the text formatting:
ocrtextformatte
d

Text - formatted after making searchable, requires optional
Win2PDF OCR Add-on 

ocrtextunforma
tted

Text - unformatted after making searchable, formatted after
making searchable, requires optional Win2PDF OCR Add-on 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.30Command Line Convert JPG to JPG

Convert JPG To JPG Command Line

win2pdfd.exe convertto "sourcefile.jpg" "destfile.jpg" jpg
win2pdfd.exe convertto "sourcefile.jpg" "destfile.jpg" jpggray

Reformats the JPEG "sourcefile.jpg" to a new JPEG image, and saves the
converted image to "destfile.jpg". The "jpg" variation saves the converted
image as a color JPEG, and the "jpggray" variation saves the converted
image as a grayscale JPEG.

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/download/download-win2pdf-ocr.html
https://www.win2pdf.com/download/download-win2pdf-ocr.html
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.31Command Line Convert JPG to TIFF

Convert JPG To TIFF Command Line

win2pdfd.exe convertto "sourcefile.jpg" "destfile.tif" tiff
win2pdfd.exe convertto "sourcefile.jpg" "destfile.tif" tiffmono
win2pdfd.exe convertto "sourcefile.jpg" "destfile.tif" tiffgray
win2pdfd.exe convertto "sourcefile.jpg" "destfile.tif" tifftransparent

Converts the JPEG "sourcefile.jpg" to a TIFF image, and saves the
converted image to "destfile.tif". The last parameter controls the TIFF
format:
tiffmono TIFF - monochrome
tiffgray TIFF - grayscale
tiff TIFF - color
tifftransparent TIFF - color with transparent background

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.32Command Line Convert JPG to PNG

Convert JPG To PNG Command Line

win2pdfd.exe convertto "sourcefile.jpg" "destfile.png" png
win2pdfd.exe convertto "sourcefile.jpg" "destfile.png" pnggray
win2pdfd.exe convertto "sourcefile.jpg" "destfile.png" pngtransparent
win2pdfd.exe convertto "sourcefile.jpg" "destfile.png" pnggraytransparent

Converts the JPEG "sourcefile.jpg" to a PNG image, and saves the
converted image to "destfile.png". The last parameter controls the PNG
format:
pnggray PNG - Grayscale
png PNG - Color

https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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pnggraytransp
arent

PNG - Grayscale with transparent background

pngtransparen
t

PNG - Color with transparent background

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.33Command Line Convert JPG to DOCX

Convert JPG To DOCX Command Line  

win2pdfd.exe convertto "sourcefile.jpg" "destfile.docx" docx

Converts the JPEG "sourcefile.jpg" to a Microsoft Word DOCX document,
and saves the document to "destfile.docx". 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.34Command Line Convert JPG to RTF

Convert JPG To RTF Command Line  

win2pdfd.exe convertto "sourcefile.jpg" "destfile.rtf" rtf

Converts the JPEG "sourcefile.jpg" to a Rich Text Format document, and
saves the document to "destfile.rtf". 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF Pro. Contact us for a

https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
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time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.35Command Line Convert JPG to ODT

Convert JPG To ODT Command Line  

win2pdfd.exe convertto "sourcefile.jpg" "destfile.odt" odt

Converts the JPG "sourcefile.jpg" to a OpenDocument Format document,
and saves the document to "destfile.odt". 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.36Command Line Convert PNG to Text

Convert PNG To Text Command Line

win2pdfd.exe convertto "sourcefile.png" "destfile.txt" ocrtextformatted
win2pdfd.exe convertto "sourcefile.png" "destfile.txt" ocrtextunformatted

Converts the PNG "sourcefile.png" to text, and saves the converted text to
"destfile.txt". The last parameter controls the text formatting:
ocrtextformatte
d

Text - formatted after making searchable, requires optional
Win2PDF OCR Add-on 

ocrtextunforma
tted

Text - unformatted after making searchable, formatted after
making searchable, requires optional Win2PDF OCR Add-on 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/download/download-win2pdf-ocr.html
https://www.win2pdf.com/download/download-win2pdf-ocr.html
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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6.3.24.37Command Line Convert PNG to JPG

Convert PNG To JPG Command Line

win2pdfd.exe convertto "sourcefile.png" "destfile.jpg" jpg
win2pdfd.exe convertto "sourcefile.png" "destfile.jpg" jpggray

Converts the PNG "sourcefile.png" to a JPEG image, and saves the
converted image to "destfile.jpg". The "jpg" variation saves the converted
image as a color JPEG, and the "jpggray" variation saves the converted
image as a grayscale JPEG.

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.38Command Line Convert PNG to TIFF

Convert PNG To TIFF Command Line

win2pdfd.exe convertto "sourcefile.png" "destfile.tif" tiff
win2pdfd.exe convertto "sourcefile.png" "destfile.tif" tiffmono
win2pdfd.exe convertto "sourcefile.png" "destfile.tif" tiffgray
win2pdfd.exe convertto "sourcefile.png" "destfile.tif" tifftransparent

Converts the PNG "sourcefile.png" to a TIFF image, and saves the
converted image to "destfile.tif". The last parameter controls the TIFF
format:
tiffmono TIFF - monochrome
tiffgray TIFF - grayscale
tiff TIFF - color
tifftransparent TIFF - color with transparent background

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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6.3.24.39Command Line Convert PNG to PNG

Convert PNG To PNG Command Line

win2pdfd.exe convertto "sourcefile.png" "destfile.png" png
win2pdfd.exe convertto "sourcefile.png" "destfile.png" pnggray
win2pdfd.exe convertto "sourcefile.png" "destfile.png" pngtransparent
win2pdfd.exe convertto "sourcefile.png" "destfile.png" pnggraytransparent

Reformats the PNG "sourcefile.png" to a new PNG image, and saves the
converted image to "destfile.png". The last parameter controls the PNG
format:
pnggray PNG - Grayscale
png PNG - Color
pnggraytransp
arent

PNG - Grayscale with transparent background

pngtransparen
t

PNG - Color with transparent background

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.40Command Line Convert PNG to DOCX

Convert PNG To DOCX Command Line  

win2pdfd.exe convertto "sourcefile.png" "destfile.docx" docx

Converts the PNG "sourcefile.png" to a Microsoft Word DOCX document,
and saves the document to "destfile.docx". 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes


Win2PDF732

© 2023 Dane Prairie Systems, LLC

6.3.24.41Command Line Convert PNG to RTF

Convert PNG To RTF Command Line  

win2pdfd.exe convertto "sourcefile.png" "destfile.rtf" rtf

Converts the PNG "sourcefile.png" to a Rich Text Format document, and
saves the document to "destfile.rtf". 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.42Command Line Convert PNG to ODT

Convert PNG To ODT Command Line  

win2pdfd.exe convertto "sourcefile.png" "destfile.odt" odt

Converts the PNG "sourcefile.png" to a OpenDocument Format document,
and saves the document to "destfile.odt". 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.43Command Line Convert BMP to Text

Convert BMP To Text Command Line

win2pdfd.exe convertto "sourcefile.bmp" "destfile.txt" ocrtextformatted
win2pdfd.exe convertto "sourcefile.bmp" "destfile.txt" ocrtextunformatted

Converts the BMP "sourcefile.bmp" to text, and saves the converted text to
"destfile.txt". The last parameter controls the text formatting:
ocrtextformatte
d

Text - formatted after making searchable, requires optional
Win2PDF OCR Add-on 

https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/download/download-win2pdf-ocr.html
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ocrtextunforma
tted

Text - unformatted after making searchable, formatted after
making searchable, requires optional Win2PDF OCR Add-on 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.44Command Line Convert BMP to JPG

Convert BMP To JPG Command Line

win2pdfd.exe convertto "sourcefile.bmp" "destfile.jpg" jpg
win2pdfd.exe convertto "sourcefile.bmp" "destfile.jpg" jpggray

Converts the BMP "sourcefile.bmp" to a JPEG image, and saves the
converted image to "destfile.jpg". The "jpg" variation saves the converted
image as a color JPEG, and the "jpggray" variation saves the converted
image as a grayscale JPEG.

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.45Command Line Convert BMP to TIFF

Convert BMP To TIFF Command Line

win2pdfd.exe convertto "sourcefile.bmp" "destfile.tif" tiff
win2pdfd.exe convertto "sourcefile.bmp" "destfile.tif" tiffmono
win2pdfd.exe convertto "sourcefile.bmp" "destfile.tif" tiffgray
win2pdfd.exe convertto "sourcefile.bmp" "destfile.tif" tifftransparent

Converts the BMP "sourcefile.bmp" to a TIFF image, and saves the
converted image to "destfile.tif". The last parameter controls the TIFF
format:
tiffmono TIFF - monochrome

https://www.win2pdf.com/download/download-win2pdf-ocr.html
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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tiffgray TIFF - grayscale
tiff TIFF - color
tifftransparent TIFF - color with transparent background

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.46Command Line Convert BMP to PNG

Convert BMP To PNG Command Line

win2pdfd.exe convertto "sourcefile.bmp" "destfile.png" png
win2pdfd.exe convertto "sourcefile.bmp" "destfile.png" pnggray
win2pdfd.exe convertto "sourcefile.bmp" "destfile.png" pngtransparent
win2pdfd.exe convertto "sourcefile.bmp" "destfile.png" pnggraytransparent

Converts the BMP "sourcefile.bmp" to a PNG image, and saves the
converted image to "destfile.png". The last parameter controls the PNG
format:
pnggray PNG - Grayscale
png PNG - Color
pnggraytransp
arent

PNG - Grayscale with transparent background

pngtransparen
t

PNG - Color with transparent background

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.47Command Line Convert BMP to DOCX

Convert BMP To DOCX Command Line  

win2pdfd.exe convertto "sourcefile.bmp" "destfile.docx" docx

https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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Converts the BMP "sourcefile.bmp" to a Microsoft Word DOCX document,
and saves the document to "destfile.docx". 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.48Command Line Convert BMP to RTF

Convert BMP To RTF Command Line  

win2pdfd.exe convertto "sourcefile.bmp" "destfile.rtf" rtf

Converts the BMP "sourcefile.bmp" to a Rich Text Format document, and
saves the document to "destfile.rtf". 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.49Command Line Convert BMP to ODT

Convert BMP To ODT Command Line  

win2pdfd.exe convertto "sourcefile.bmp" "destfile.odt" odt

Converts the BMP "sourcefile.bmp" to a OpenDocument Format document,
and saves the document to "destfile.odt". 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
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Returns 0 on success, and a Windows system error code on failure.

6.3.24.50Command Line Convert GIF to Text

Convert GIF To Text Command Line

win2pdfd.exe convertto "sourcefile.gif" "destfile.txt" ocrtextformatted
win2pdfd.exe convertto "sourcefile.gif" "destfile.txt" ocrtextunformatted

Converts the GIF "sourcefile.gif" to text, and saves the converted text to
"destfile.txt". The last parameter controls the text formatting:
ocrtextformatte
d

Text - formatted after making searchable, requires optional
Win2PDF OCR Add-on 

ocrtextunforma
tted

Text - unformatted after making searchable, formatted after
making searchable, requires optional Win2PDF OCR Add-on 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.51Command Line Convert GIF to JPG

Convert GIF To JPG Command Line

win2pdfd.exe convertto "sourcefile.png" "destfile.jpg" jpg
win2pdfd.exe convertto "sourcefile.png" "destfile.jpg" jpggray

Converts the GIF "sourcefile.gif" to a JPEG image, and saves the converted
image to "destfile.jpg". The "jpg" variation saves the converted image as a
color JPEG, and the "jpggray" variation saves the converted image as a
grayscale JPEG.

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/download/download-win2pdf-ocr.html
https://www.win2pdf.com/download/download-win2pdf-ocr.html
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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6.3.24.52Command Line Convert GIF to TIFF

Convert GIF To TIFF Command Line

win2pdfd.exe convertto "sourcefile.gif" "destfile.tif" tiff
win2pdfd.exe convertto "sourcefile.gif" "destfile.tif" tiffmono
win2pdfd.exe convertto "sourcefile.gif" "destfile.tif" tiffgray
win2pdfd.exe convertto "sourcefile.gif" "destfile.tif" tifftransparent

Converts the GIF "sourcefile.gif" to a TIFF image, and saves the converted
image to "destfile.tif". The last parameter controls the TIFF format:
tiffmono TIFF - monochrome
tiffgray TIFF - grayscale
tiff TIFF - color
tifftransparent TIFF - color with transparent background

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.53Command Line Convert GIF to PNG

Convert GIF To PNG Command Line

win2pdfd.exe convertto "sourcefile.gif" "destfile.png" png
win2pdfd.exe convertto "sourcefile.gif" "destfile.png" pnggray
win2pdfd.exe convertto "sourcefile.gif" "destfile.png" pngtransparent
win2pdfd.exe convertto "sourcefile.gif" "destfile.png" pnggraytransparent

Reformats the GIF "sourcefile.gif" to a new PNG image, and saves the
converted image to "destfile.png". The last parameter controls the PNG
format:
pnggray PNG - Grayscale
png PNG - Color
pnggraytransp
arent

PNG - Grayscale with transparent background

pngtransparen
t

PNG - Color with transparent background

https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.54Command Line Convert GIF to DOCX

Convert GIF To DOCX Command Line  

win2pdfd.exe convertto "sourcefile.gif" "destfile.docx" docx

Converts the GIF "sourcefile.gif" to a Microsoft Word DOCX document, and
saves the document to "destfile.docx". 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.55Command Line Convert GIF to RTF

Convert GIF To RTF Command Line  

win2pdfd.exe convertto "sourcefile.gif" "destfile.rtf" rtf

Converts the GIF "sourcefile.gif" to a Rich Text Format document, and
saves the document to "destfile.rtf". 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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6.3.24.56Command Line Convert GIF to ODT

Convert GIF To ODT Command Line  

win2pdfd.exe convertto "sourcefile.gif" "destfile.odt" odt

Converts the GIF "sourcefile.gif" to a OpenDocument Format document,
and saves the document to "destfile.odt". 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.57Command Line Convert Text to JPG

Convert Text To JPG Command Line  

win2pdfd.exe convertto "sourcefile.txt" "destfile.jpg" jpg
win2pdfd.exe convertto "sourcefile.txt" "destfile.jpg" jpggray

Converts the Text file "sourcefile.txt" to a JPEG image, and saves the
converted image to "destfile.jpg". The "jpg" variation saves the converted
image as a color JPEG, and the "jpggray" variation saves the converted
image as a grayscale JPEG.

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.58Command Line Convert Text to TIFF

Convert Text To TIFF Command Line  

win2pdfd.exe convertto "sourcefile.txt" "destfile.tif" tiff
win2pdfd.exe convertto "sourcefile.txt" "destfile.tif" tiffmono
win2pdfd.exe convertto "sourcefile.txt" "destfile.tif" tiffgray
win2pdfd.exe convertto "sourcefile.txt" "destfile.tif" tifftransparent

https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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Converts the Text file "sourcefile.txt" to a TIFF image, and saves the
converted image to "destfile.tif". The last parameter controls the TIFF
format:
tiffmono TIFF - monochrome
tiffgray TIFF - grayscale
tiff TIFF - color
tifftransparent TIFF - color with transparent background

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.59Command Line Convert Text to PNG

Convert Text To PNG Command Line  

win2pdfd.exe convertto "sourcefile.txt" "destfile.png" png
win2pdfd.exe convertto "sourcefile.txt" "destfile.png" pnggray
win2pdfd.exe convertto "sourcefile.txt" "destfile.png" pngtransparent
win2pdfd.exe convertto "sourcefile.txt" "destfile.png" pnggraytransparent

Converts the Text file "sourcefile.txt" to a PNG image, and saves the
converted image to "destfile.png". The last parameter controls the PNG
format:
pnggray PNG - Grayscale
png PNG - Color
pnggraytransp
arent

PNG - Grayscale with transparent background

pngtransparen
t

PNG - Color with transparent background

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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6.3.24.60Command Line Convert Text to DOCX

Convert Text To DOCX Command Line  

win2pdfd.exe convertto "sourcefile.txt" "destfile.docx" docx

Converts the Text file "sourcefile.txt" to a Microsoft Word DOCX document,
and saves the document to "destfile.docx". 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.61Command Line Convert Text to RTF

Convert Text To RTF Command Line  

win2pdfd.exe convertto "sourcefile.txt" "destfile.rtf" rtf

Converts the Text file "sourcefile.txt" to a Rich Text Format document, and
saves the document to "destfile.rtf". 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.62Command Line Convert Text to ODT

Convert Text To ODT Command Line  

win2pdfd.exe convertto "sourcefile.txt" "destfile.odt" odt

Converts the Text file "sourcefile.txt" to a OpenDocument Format
document, and saves the document to "destfile.odt". 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an

https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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existing PDF.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.63Command Line Convert DOC to JPG

Convert DOC To JPG Command Line  

win2pdfd.exe convertto "sourcefile.doc" "destfile.jpg" jpg
win2pdfd.exe convertto "sourcefile.doc" "destfile.jpg" jpggray

Converts the Microsoft Word DOC file "sourcefile.doc" to a JPEG image, and
saves the converted image to "destfile.jpg". The "jpg" variation saves the
converted image as a color JPEG, and the "jpggray" variation saves the
converted image as a grayscale JPEG.

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.64Command Line Convert DOC to TIFF

Convert DOC To TIFF Command Line  

win2pdfd.exe convertto "sourcefile.doc" "destfile.tif" tiff
win2pdfd.exe convertto "sourcefile.doc" "destfile.tif" tiffmono
win2pdfd.exe convertto "sourcefile.doc" "destfile.tif" tiffgray
win2pdfd.exe convertto "sourcefile.doc" "destfile.tif" tifftransparent

Converts the Microsoft Word DOC file "sourcefile.doc" to a TIFF image, and
saves the converted image to "destfile.tif". The last parameter controls the
TIFF format:
tiffmono TIFF - monochrome
tiffgray TIFF - grayscale
tiff TIFF - color
tifftransparent TIFF - color with transparent background

Any file names that contain spaces must be enclosed with quotation marks.

https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.65Command Line Convert DOC to PNG

Convert DOC To PNG Command Line  

win2pdfd.exe convertto "sourcefile.doc" "destfile.png" png
win2pdfd.exe convertto "sourcefile.doc" "destfile.png" pnggray
win2pdfd.exe convertto "sourcefile.doc" "destfile.png" pngtransparent
win2pdfd.exe convertto "sourcefile.doc" "destfile.png" pnggraytransparent

Converts the Microsoft Word DOC file "sourcefile.doc" to a PNG image, and
saves the converted image to "destfile.png". The last parameter controls
the PNG format:
pnggray PNG - Grayscale
png PNG - Color
pnggraytransp
arent

PNG - Grayscale with transparent background

pngtransparen
t

PNG - Color with transparent background

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.66Command Line Convert DOC to DOCX

Convert DOC To DOCX Command Line  

win2pdfd.exe convertto "sourcefile.doc" "destfile.docx" docx

Converts the Microsoft Word DOC file "sourcefile.doc" to a Microsoft Word
DOCX document, and saves the document to "destfile.docx". 

Any file names that contain spaces must be enclosed with quotation marks.

https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.67Command Line Convert DOC to RTF

Convert DOC To RTF Command Line  

win2pdfd.exe convertto "sourcefile.doc" "destfile.rtf" rtf

Converts the Microsoft Word DOC file "sourcefile.doc" to a Rich Text
Format document, and saves the document to "destfile.rtf". 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.68Command Line Convert DOC to ODT

Convert DOC To ODT Command Line  

win2pdfd.exe convertto "sourcefile.doc" "destfile.odt" odt

Converts the Microsoft Word DOC file "sourcefile.doc" to a OpenDocument
Format document, and saves the document to "destfile.odt". 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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6.3.24.69Command Line Convert DOC to Text

Convert DOC To Text Command Line  

win2pdfd.exe convertto "sourcefile.doc" "destfile.txt" txt

Converts the Microsoft Word DOC file "sourcefile.doc" to a text file, and
saves the document to "destfile.txt". 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.70Command Line Convert DOCX to JPG

Convert DOCX To JPG Command Line  

win2pdfd.exe convertto "sourcefile.docx" "destfile.jpg" jpg
win2pdfd.exe convertto "sourcefile.docx" "destfile.jpg" jpggray

Converts the Microsoft Word DOCX file "sourcefile.docx" to a JPEG image,
and saves the converted image to "destfile.jpg". The "jpg" variation saves
the converted image as a color JPEG, and the "jpggray" variation saves the
converted image as a grayscale JPEG.

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.71Command Line Convert DOCX to TIFF

Convert DOCX To TIFF Command Line  

win2pdfd.exe convertto "sourcefile.docx" "destfile.tif" tiff
win2pdfd.exe convertto "sourcefile.docx" "destfile.tif" tiffmono
win2pdfd.exe convertto "sourcefile.docx" "destfile.tif" tiffgray
win2pdfd.exe convertto "sourcefile.docx" "destfile.tif" tifftransparent

https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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Converts the Microsoft Word DOCX file "sourcefile.docx" to a TIFF image,
and saves the converted image to "destfile.tif". The last parameter controls
the TIFF format:
tiffmono TIFF - monochrome
tiffgray TIFF - grayscale
tiff TIFF - color
tifftransparent TIFF - color with transparent background

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.72Command Line Convert DOCX to PNG

Convert DOCX To PNG Command Line  

win2pdfd.exe convertto "sourcefile.docx" "destfile.png" png
win2pdfd.exe convertto "sourcefile.docx" "destfile.png" pnggray
win2pdfd.exe convertto "sourcefile.docx" "destfile.png" pngtransparent
win2pdfd.exe convertto "sourcefile.docx" "destfile.png" pnggraytransparent

Converts the Microsoft Word DOCX file "sourcefile.docx" to a PNG image,
and saves the converted image to "destfile.png". The last parameter
controls the PNG format:
pnggray PNG - Grayscale
png PNG - Color
pnggraytransp
arent

PNG - Grayscale with transparent background

pngtransparen
t

PNG - Color with transparent background

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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6.3.24.73Command Line Convert DOCX to RTF

Convert DOCX To RTF Command Line  

win2pdfd.exe convertto "sourcefile.docx" "destfile.rtf" rtf

Converts the Microsoft Word DOCX file "sourcefile.docx" to a Rich Text
Format document, and saves the document to "destfile.rtf". 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.74Command Line Convert DOCX to ODT

Convert DOC To ODT Command Line  

win2pdfd.exe convertto "sourcefile.doc" "destfile.odt" odt

Converts the Microsoft Word DOCX file "sourcefile.docx" to a
OpenDocument Format document, and saves the document to
"destfile.odt". 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.75Command Line Convert DOCX to Text

Convert DOCX To Text Command Line  

win2pdfd.exe convertto "sourcefile.docx" "destfile.txt" txt

Converts the Microsoft Word DOCX file "sourcefile.docx" to a text file, and
saves the document to "destfile.txt". 

Any file names that contain spaces must be enclosed with quotation marks.

https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.76Command Line Convert RTF to JPG

Convert RTF To JPG Command Line  

win2pdfd.exe convertto "sourcefile.rtf" "destfile.jpg" jpg
win2pdfd.exe convertto "sourcefile.rtf" "destfile.jpg" jpggray

Converts the Rich Text Format RTF file "sourcefile.rtf" to a JPEG image, and
saves the converted image to "destfile.jpg". The "jpg" variation saves the
converted image as a color JPEG, and the "jpggray" variation saves the
converted image as a grayscale JPEG.

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.77Command Line Convert RTF to TIFF

Convert RTF To TIFF Command Line  

win2pdfd.exe convertto "sourcefile.rtf" "destfile.tif" tiff
win2pdfd.exe convertto "sourcefile.rtf" "destfile.tif" tiffmono
win2pdfd.exe convertto "sourcefile.rtf" "destfile.tif" tiffgray
win2pdfd.exe convertto "sourcefile.rtf" "destfile.tif" tifftransparent

Converts the Rich Text Format RTF file "sourcefile.rtf" to a TIFF image, and
saves the converted image to "destfile.tif". The last parameter controls the
TIFF format:
tiffmono TIFF - monochrome
tiffgray TIFF - grayscale
tiff TIFF - color
tifftransparent TIFF - color with transparent background

https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.78Command Line Convert RTF to PNG

Convert DOC To PNG Command Line  

win2pdfd.exe convertto "sourcefile.rtf" "destfile.png" png
win2pdfd.exe convertto "sourcefile.rtf" "destfile.png" pnggray
win2pdfd.exe convertto "sourcefile.rtf" "destfile.png" pngtransparent
win2pdfd.exe convertto "sourcefile.rtf" "destfile.png" pnggraytransparent

Converts the Rich Text Format RTF file "sourcefile.rtf" to a PNG image, and
saves the converted image to "destfile.png". The last parameter controls
the PNG format:
pnggray PNG - Grayscale
png PNG - Color
pnggraytransp
arent

PNG - Grayscale with transparent background

pngtransparen
t

PNG - Color with transparent background

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.79Command Line Convert RTF to DOCX

Convert RTF To DOCX Command Line  

win2pdfd.exe convertto "sourcefile.rtf" "destfile.docx" docx

Converts the Rich Text Format RTF file "sourcefile.rtf" to a Microsoft Word
DOCX document, and saves the document to "destfile.docx". 

https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.80Command Line Convert RTF to ODT

Convert RTF To ODT Command Line  

win2pdfd.exe convertto "sourcefile.rtf" "destfile.odt" odt

Converts the Rich Text Format RTF file "sourcefile.rtf" to a OpenDocument
Format document, and saves the document to "destfile.odt". 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.81Command Line Convert RTF to Text

Convert RTF To Text Command Line  

win2pdfd.exe convertto "sourcefile.rtf" "destfile.txt" txt

Converts the Rich Text Format RTF file "sourcefile.rtf" to a text file, and
saves the document to "destfile.txt". 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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6.3.24.82Command Line Convert ODT to JPG

Convert ODT To JPG Command Line  

win2pdfd.exe convertto "sourcefile.odt" "destfile.jpg" jpg
win2pdfd.exe convertto "sourcefile.odt" "destfile.jpg" jpggray

Converts the OpenDocument Format ODT file "sourcefile.odt" to a JPEG
image, and saves the converted image to "destfile.jpg". The "jpg" variation
saves the converted image as a color JPEG, and the "jpggray" variation
saves the converted image as a grayscale JPEG.

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.83Command Line Convert ODT to TIFF

Convert ODT To TIFF Command Line  

win2pdfd.exe convertto "sourcefile.odt" "destfile.tif" tiff
win2pdfd.exe convertto "sourcefile.odt" "destfile.tif" tiffmono
win2pdfd.exe convertto "sourcefile.odt" "destfile.tif" tiffgray
win2pdfd.exe convertto "sourcefile.odt" "destfile.tif" tifftransparent

Converts the OpenDocument Format ODT file "sourcefile.odt" to a TIFF
image, and saves the converted image to "destfile.tif". The last parameter
controls the TIFF format:
tiffmono TIFF - monochrome
tiffgray TIFF - grayscale
tiff TIFF - color
tifftransparent TIFF - color with transparent background

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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6.3.24.84Command Line Convert ODT to PNG

Convert ODT To PNG Command Line  

win2pdfd.exe convertto "sourcefile.odt" "destfile.png" png
win2pdfd.exe convertto "sourcefile.odt" "destfile.png" pnggray
win2pdfd.exe convertto "sourcefile.odt" "destfile.png" pngtransparent
win2pdfd.exe convertto "sourcefile.odt" "destfile.png" pnggraytransparent

Converts the OpenDocument Format ODT file "sourcefile.odt" to a PNG
image, and saves the converted image to "destfile.png". The last parameter
controls the PNG format:
pnggray PNG - Grayscale
png PNG - Color
pnggraytransp
arent

PNG - Grayscale with transparent background

pngtransparen
t

PNG - Color with transparent background

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.85Command Line Convert ODT to DOCX

Convert ODT To DOCX Command Line  

win2pdfd.exe convertto "sourcefile.odt" "destfile.docx" docx

Converts the OpenDocument Format ODT file "sourcefile.odt" to a Microsoft
Word DOCX document, and saves the document to "destfile.docx". 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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6.3.24.86Command Line Convert ODT to RTF

Convert ODT To RTF Command Line  

win2pdfd.exe convertto "sourcefile.odt" "destfile.rtf" rtf

Converts the OpenDocument Format ODT file "sourcefile.odt" to a Rich Text
Format document, and saves the document to "destfile.rtf". 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.24.87Command Line Convert ODT to Text

Convert ODT To Text Command Line  

win2pdfd.exe convertto "sourcefile.odt" "destfile.txt" txt

Converts the OpenDocument Format ODT file "sourcefile.odt" to a text file,
and saves the document to "destfile.txt". 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.25 Command Line Batch Convert

Batch Convert Command Line Format  

win2pdfd.exe batchconvert "sourcefolder" "destfolder" destformat

Converts all compatible files in the sourcefolder to the specified format, and
saves the converted files using the same base filename to the destination
folder. The compatible file formats in the "sourcefolder" can be one of:

Extension Format

https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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.PDF Portable Document Format

.DOCX, .DOC Microsoft Word

.RTF Rich Text Format

.ODT OpenDocument Text

.TXT Text

.HTML, .HTM, .MHT
ML, .JS

HyperText Markup Language

.SVG Scalable Vector Graphics

.XPS XML Paper Specification

.TIF, .TIFF Tagged Image File Format

.JPG, .JPEG, .JPE Joint Photographic Experts Group Image

.PNG Portable Network Graphics

.BMP, .DIB Windows Bitmap

.GIF Graphics Interchange Format

Files not matching one of these extensions will be skipped.

The "destformat" can be one of the following:

destformat
parameter

Description

pdf Portable Document Format
pdfimagemono PDF Image Only - monochrome
pdfimagegraysc
ale

PDF Image Only - grayscale

pdfimagecolor PDF Image Only - color
pdfcompressed PDF - compressed
pdfsearchable PDF - searchable (OCR)
docx DOCX - Microsoft Word
rtf RTF - Rich Text Format
odt ODT - OpenDocument Text
textformatted Text - formatted
textunformatte
d

Text - unformatted

jpggray JPG - grayscale
jpg JPG - color
tiffmono TIFF - monochrome
tiffgray TIFF - grayscale
tiff TIFF - color
tifftransparent TIFF - color with transparent background
pnggray PNG - Grayscale
png PNG - Color
pnggraytranspa
rent

PNG - Grayscale with transparent background
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pngtransparent PNG - Color with transparent background
ocrtextformatte
d

Text - formatted after making searchable, requires optional
Win2PDF OCR Add-on 

ocrtextunforma
tted

Text - unformatted after making searchable, formatted after
making searchable, requires optional Win2PDF OCR Add-on
 

Any folder names that contain spaces must be enclosed with quotation
marks. 

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.26 Command Line Watch Folder and Convert

Watch Folder and Convert Command Line Format 

win2pdfd.exe watchconvert "watchfolder" "completedfolder" "convertedfolder" destformat

Watches the folder specified by "watchfolder" and automatically converts all
compatible files to the specified format, and saves the converted files using
the same base filename to "convertedfolder". Upon successful conversion,
the source file is moved from the "watchfolder" to the folder specified by
"completedfolder".  If the "completedfolder" is empty (""), the source file is
deleted after conversion. 

The compatible file formats in the "watchfolder" can be one of:

Extension Format
.PDF Portable Document Format
.DOCX, .DOC Microsoft Word
.RTF Rich Text Format
.ODT OpenDocument Text
.TXT Text
.HTML, .HTM, .MHT
ML, .JS

HyperText Markup Language

.SVG Scalable Vector Graphics

.XPS XML Paper Specification

.TIF, .TIFF Tagged Image File Format

.JPG, .JPEG, .JPE Joint Photographic Experts Group Image

.PNG Portable Network Graphics

.BMP, .DIB Windows Bitmap

https://www.win2pdf.com/download/download-win2pdf-ocr.html
https://www.win2pdf.com/download/download-win2pdf-ocr.html
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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.GIF Graphics Interchange Format

Files not matching one of these extensions will be skipped.

The "destformat" can be one of the following:

destformat
parameter

Description

pdf Portable Document Format
pdfimagemono PDF Image Only - monochrome
pdfimagegraysc
ale

PDF Image Only - grayscale

pdfimagecolor PDF Image Only - color
pdfcompressed PDF - compressed
pdfsearchable PDF - searchable (OCR)
docx DOCX - Microsoft Word
rtf RTF - Rich Text Format
odt ODT - OpenDocument Text
textformatted Text - formatted
textunformatte
d

Text - unformatted

jpggray JPG - grayscale
jpg JPG - color
tiffmono TIFF - monochrome
tiffgray TIFF - grayscale
tiff TIFF - color
tifftransparent TIFF - color with transparent background
pnggray PNG - Grayscale
png PNG - Color
pnggraytranspa
rent

PNG - Grayscale with transparent background

pngtransparent PNG - Color with transparent background
ocrtextformatte
d

Text - formatted after making searchable, requires optional
Win2PDF OCR Add-on 

ocrtextunforma
tted

Text - unformatted after making searchable, formatted after
making searchable, requires optional Win2PDF OCR Add-on
 

Any folder names that contain spaces must be enclosed with quotation
marks. If a file of the same name already exists in the "completedfolder",
the file is renamed (files are never overwritten).

The command will watch the folder for incoming files indefinitely until it is
manually stopped with "CTRL-C" or using the task manager.

https://www.win2pdf.com/download/download-win2pdf-ocr.html
https://www.win2pdf.com/download/download-win2pdf-ocr.html
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This feature requires a licensed version of Win2PDF Pro TSE. Contact us for
a time limited evaluation license.

6.3.27 Command Line PDF To JPG

PDF To JPG Command Line Format

win2pdfd.exe pdf2jpg "sourcepdf" "destjpg" pagenumber
win2pdfd.exe pdf2jpg "sourcepdf" "destjpg" startpage endpage
win2pdfd.exe pdf2jpggray "sourcepdf" "destjpg" pagenumber
win2pdfd.exe pdf2jpggray "sourcepdf" "destjpg" startpage endpage
win2pdfd.exe pdf2jpg "sourcepdf" "destjpg" pagenumber xresolution yresolution
win2pdfd.exe pdf2jpg "sourcepdf" "destjpg" startpage endpage xresolution yresolution
win2pdfd.exe pdf2jpggray "sourcepdf" "destjpg" pagenumber xresolution yresolution
win2pdfd.exe pdf2jpggray "sourcepdf" "destjpg" startpage endpage xresolution yresolution

Convert the PDF specified by "sourcepdf" to a color JPEG image file
"destjpg". If "pagenumber" is 0, all pages are converted as separate files
one per page in the format:

destjpg.1.jpg
destjpg.2.jpg
...
destjpg.n.jpg

If the "pagenumber" is greater than zero, the specified page number is
saved to the filename specified by "destjpg".

To convert a page range, specify the startpage and endpage instead of a
pagenumber.

To set the output resolution of the JPG file, set the xresolution and
yresolution.  If no resolution is specified, it will save at 300 DPI.

The "pdf2jpggray" variation is identical to "pdf2jpg", but the resulting JPEG
file is saved as a gray scale 8 bit/pixel image file.

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcepdf" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

https://www.win2pdf.com/trial.html
https://www.win2pdf.com/trial.html
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Returns 0 on success, and a Windows system error code on failure.

6.3.28 Command Line PDF To PNG

PDF To PNG Command Line Format

win2pdfd.exe pdf2png "sourcepdf" "destpng" pagenumber
win2pdfd.exe pdf2png "sourcepdf" "destpng" startpage endpage
win2pdfd.exe pdf2png "sourcepdf" "destpng" pagenumber xresolution yresolution
win2pdfd.exe pdf2png "sourcepdf" "destpng" startpage endpage xresolution yresolution

Convert the PDF specified by "sourcepdf" to a color PNG image file
"destpng". The "pdf2png" command can be one of:
pdf2png PDF to color PNG
pdf2pnggray PDF to grayscale PNG
pdf2pngtranspa
rent

PDF to color PNG with transparent background

pdf2pnggraytra
nsparent

PDF to grayscale PNG with transparent background

If "pagenumber" is 0, all pages are converted as separate files one per
page in the format:

destpng.1.png
destpng.2.png
...
destpng.n.png

If the "pagenumber" is greater than zero, the specified page number is
saved to the filename specified by "destpng".

To convert a page range, specify the startpage and endpage instead of a
pagenumber.

To set the output resolution of the PNG file, set the xresolution and
yresolution.  If no resolution is specified, it will save at 300 DPI.

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcepdf" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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6.3.29 Command Line PDF To TIFF

PDF To TIFF Command Line Format

win2pdfd.exe pdf2tiff "sourcepdf" "desttiff" pagenumber
win2pdfd.exe pdf2tiff "sourcepdf" "desttiff" startpage endpage
win2pdfd.exe pdf2tiff "sourcepdf" "desttiff" pagenumber xresolution yresolution
win2pdfd.exe pdf2tiff "sourcepdf" "desttiff" startpage endpage xresolution yresolution

Convert the PDF specified by "sourcepdf" to a TIFF image file named
"desttiff". The "pdf2tiff" command can be one of:
pdf2tiff PDF to color TIFF
pdf2tiffmonoPDF to black and white TIFF
pdf2tiffgray PDF to grayscale TIFF
pdf2tifftrans
parent

PDF to color TIFF with transparent background

If "pagenumber" is 0, all pages are saved to the filename specified by
"desttiff" in a multi-page TIFF. If the "pagenumber" is greater than zero,
the specified page number is saved to the filename specified by "desttiff".

To convert a page range, specify the startpage and endpage instead of a
pagenumber.

To set the output resolution of the TIFF file, set the xresolution and
yresolution.  If no resolution is specified, it will save at 300 DPI.

The "pdf2tiffmono" variation is identical to "pdf2tiff", but the resulting TIFF
file is saved as a monochrome 1 bit/pixel image file. Similarly, the
"pdf2tiffgray" saves the destination TIFF file as a gray scale 8 bit/pixel
image file.

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcepdf" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.30 Command Line PDF To DOCX

PDF To DOCX Command Line Format  

https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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win2pdfd.exe pdf2docx "source.pdf" "dest.docx"

Convert the PDF specified by "source.pdf" to a Microsoft Word DOCX
document named "dest.docx". 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.31 Command Line PDF To RTF

PDF To RTF Command Line Format  

win2pdfd.exe pdf2rtf "source.pdf" "dest.rtf"

Convert the PDF specified by "source.pdf" to a Rich Text Format document
named "dest.rtf". 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.32 Command Line PDF To ODT

PDF To ODT Command Line Format  

win2pdfd.exe pdf2odt "source.pdf" "dest.odt" 

Convert the PDF specified by "source.pdf" to a OpenDocument Format
document named "dest.odt". 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF Pro. Contact us for a

https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
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time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.33 Command Line TIFF To PDF

TIFF To PDF Command Line Format

win2pdfd.exe tiff2pdf "sourcetiff" "destpdf"
win2pdfd.exe tiff2pdfa "sourcetiff" "destpdf"

Convert the TIFF image file specified by "sourcetiff" to a PDF file named
"destpdf". 

The "tiff2pdfa" variation is identical to "tiff2pdf", but the resulting PDF is
saved using the PDF/A format.

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcetiff" can be a local file path, or an web address (URL) to an
existing TIFF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.34 Command Line JPG To PDF

JPG To PDF Command Line Format

win2pdfd.exe jpg2pdf "sourcejpg" "destpdf"
win2pdfd.exe jpg2pdfa "sourcejpg" "destpdf"

Convert the JPG image file specified by "sourcejpg" to a PDF file named
"destpdf". 

The "jpg2pdfa" variation is identical to "jpg2pdf", but the resulting PDF is
saved using the PDF/A format.

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcejpg" can be a local file path, or an web address (URL) to an
existing JPG.

This feature requires a licensed version of Win2PDF. Contact us for a time

https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
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limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.35 Command Line PNG To PDF

PNG To PDF Command Line Format

win2pdfd.exe png2pdf "sourcepng" "destpdf"
win2pdfd.exe png2pdfa "sourcepng" "destpdf"

Convert the PNG image file specified by "sourcepng" to a PDF file named
"destpdf". 

The "png2pdfa" variation is identical to "png2pdf", but the resulting PDF is
saved using the PDF/A format.

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcepng" can be a local file path, or an web address (URL) to an
existing PNG.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.36 Command Line BMP To PDF

BMP To PDF Command Line Format

win2pdfd.exe bmp2pdf "sourcebmp" "destpdf"
win2pdfd.exe bmp2pdfa "sourcebmp" "destpdf"

Convert the Windows bitmap BMP image file specified by "sourcebmp" to a
PDF file named "destpdf". 

The "bmp2pdfa" variation is identical to "bmp2pdf", but the resulting PDF is
saved using the PDF/A format.

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcebmp" can be a local file path, or an web address (URL) to an
existing BMP.

This feature requires a licensed version of Win2PDF. Contact us for a time

https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
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limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.37 Command Line GIF To PDF

GIF To PDF Command Line Format

win2pdfd.exe gif2pdf "sourcegif" "destpdf"
win2pdfd.exe gif2pdfa "sourcegif" "destpdf"

Convert the GIF image file specified by "sourcegif" to a PDF file named
"destpdf". 

The "gif2pdfa" variation is identical to "gif2pdf", but the resulting PDF is
saved using the PDF/A format.

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcegif" can be a local file path, or an web address (URL) to an
existing GIF.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.38 Command Line HTML To PDF

HTML To PDF Command Line Format

win2pdfd.exe html2pdf "sourcehtml" "destpdf"
win2pdfd.exe html2pdf "sourcehtml" "destpdf" "papersize"
win2pdfd.exe html2pdf "sourcehtml" "destpdf" "papersize" timeout

Convert the HTML file or web page specified by "sourcehtml" to a PDF file
named "destpdf". 

If the "papersize" is specified, it can be one of:
letter
letter-landscape
legal
legal-landscape
tabloid
tabloid-landscape

https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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A2
A2-landscape
A3
A3-landscape
A4
A4-landscape
A5
A5-landscape
CSheet
CSheet-landscape
DSheet
DSheet-landscape
ESheet
ESheet-landscape

The "-landscape" papersize variations change the orientation to landscape.

Any file names that contain spaces must be enclosed with quotation marks.

The optional timeout parameter is specified in milliseconds.  If no timeout is
specified, the default is 30000 (30 seconds).

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.39 Command Line SVG To PDF

SVG To PDF Command Line Format

win2pdfd.exe svg2pdf "sourcesvg" "destpdf"
win2pdfd.exe svg2pdf "sourcesvg" "destpdf" "papersize"

Convert the SVG file specified by "sourcesvg" to a PDF file named
"destpdf". 

If the "papersize" is specified, it can be one of:
letter
letter-landscape
legal
legal-landscape
tabloid
tabloid-landscape

https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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A2
A2-landscape
A3
A3-landscape
A4
A4-landscape
A5
A5-landscape
CSheet
CSheet-landscape
DSheet
DSheet-landscape
ESheet
ESheet-landscape

The "-landscape" papersize variations change the orientation to landscape.

Any file names that contain spaces must be enclosed with quotation marks.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.40 Command Line XPS To PDF

XPS To PDF Command Line Format

win2pdfd.exe xps2pdf "sourcexps" "destpdf"

Convert the XPS file specified by "sourcexps" to a PDF file named
"destpdf". 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcexps" can be a local file path, or an web address (URL) to an
existing XPS.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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6.3.41 Command Line DOCX To PDF

DOCX To PDF Command Line Format  

win2pdfd.exe docx2pdf "source.docx" "dest.pdf"

Convert the Microsoft Word DOCX file specified by "source.docx" to a PDF
file named "dest.pdf". 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.42 Command Line DOC To PDF

DOC To PDF Command Line Format  

win2pdfd.exe doc2pdf "source.doc" "dest.pdf"

Convert the Microsoft Word DOC file specified by "source.doc" to a PDF file
named "dest.pdf". 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.43 Command Line RTF To PDF

RTF To PDF Command Line Format  

win2pdfd.exe rtf2pdf "source.rtf" "dest.pdf"

https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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Convert the Rich Text Format file specified by "source.rtf" to a PDF file
named "dest.pdf". 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.44 Command Line ODT To PDF

ODT To PDF Command Line Format  

win2pdfd.exe odt2pdf "source.odt" "dest.pdf"

Convert the OpenDocument Format ODT file specified by "source.odt" to a
PDF file named "dest.pdf". 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF Pro. Contact us for a
time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.45 Command Line TXT To PDF

TXT To PDF Command Line Format  

win2pdfd.exe txt2pdf "source.txt" "dest.pdf"

Convert the text file specified by "source.txt" to a PDF file named
"dest.pdf". 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourcefile" can be a local file path, or an web address (URL) to an
existing PDF.

This feature requires a licensed version of Win2PDF Pro. Contact us for a

https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
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time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.46 Command Line Image To PDF

win2pdfd.exe image2pdf "sourceimage" "destpdf"

Convert an image file in the format TIFF, JPG, PNG, GIF, or BMP specified
by "sourceimage" to a PDF file named "destpdf". 

Any file names that contain spaces must be enclosed with quotation marks.
The "sourceimage" can be a local file path, or an web address (URL) to an
existing image file.

This feature requires a licensed version of Win2PDF. Contact us for a time
limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.47 Command Line Content Search

win2pdfd.exe getcontentsearch "sourcepdf" "password" "searchtext"
win2pdfd.exe getcontentsearch "sourcepdf" "password" "searchtext" "fieldlength"
win2pdfd.exe getcontentsearchbelow "sourcepdf" "password" "searchtext"
win2pdfd.exe getcontentsearchbelow "sourcepdf" "password" "searchtext" "fieldlength"
win2pdfd.exe getcontentsearches "sourcepdf" "password" "searchtext"
win2pdfd.exe getcontentsearches "sourcepdf" "password" "searchtext" "fieldlength"

Search the PDF file specified by "sourcepdf" for the text specified by
"searchtext". If the "searchtext" is found in the PDF file, the text
immediately to the right of "searchtext" (for getcontentsearch) or
immediately below the searchtext (for getcontentsearchbelow) is printed
to standard out (STDOUT). The search is stopped when a space, tab, or
newline character is encountered.

The "getcontentsearch" variation stops after the first text matching the
"searchtext" is found.  The "getcontentsearches" variation continues
searching the entire PDF and prints all instances of text matching the
"searchtext" to standard out.

If the "fieldlength" is specified, the search is stopped when the number of
characters specified by "fieldlength" have been printed or a newline
character is encountered. This allows you to search for fields that include
space characters.

https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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If the path to "sourcepdf" contains spaces, it must be enclosed with
quotation marks. The "sourcepdf" can be a local file path, or an web
address (URL) to an existing PDF.

If the PDF is password protected, the master password should be provided
in the "password" parameter. Otherwise, the parameter should be set to ""

The "searchtext" parameter is case sensitive. 

This command can be used by custom programs, plug-ins, or Power
Automate Desktop flows for operations such as renaming based on the
contents of the PDF. 

Requires a licensed version of Win2PDF version 10.0.100 or above. Contact
us for a time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.48 Command Line Set PDF Version

win2pdfd.exe setpdfversion "sourcepdf" pdfversion "destpdf"

Attempts to update PDF specified by "sourcepdf" to the version specified by
"pdfversion", and save updated PDF in "destpdf". Valid versions are:

"pdfversio
n"

Introduced
with:

Adds support for:

"1.0" Adobe Acrobat
1.0

"1.1" Adobe Acrobat
2.0

Adds support for links and password
protection.

"1.2" Adobe Acrobat
3.0

Adds support for Unicode.

"1.3" Adobe Acrobat
4.0

Adds support for digital signatures and 40 bit
encryption.

"1.4" Adobe Acrobat
5.0

Adds support for transparency, JBIG2
compression, and 128 bit encryption.

"1.5" Adobe Acrobat
6.0

Adds JPEG 2000 compression.

"1.6" Adobe Acrobat
7.0

Adds support for AES encryption.

"1.7" Adobe Acrobat
8.0

Improved support for security.

https://www.win2pdf.com/trial.html
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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Win2PDF sets the PDF version to the lowest PDF version possible to
support the features in the PDF file, usually "1.4".  Setting the PDF version
is not necessary for most viewers. New viewers should be backwards
compatible with older PDF versions, and old viewers will skip new features.
Some compliance software requires a specific PDF version, and this
command can be use to set the PDF to a specific version. You can only set
the PDF version to a higher version than the existing version of
"sourcepdf".

Requires a licensed version of Win2PDF version 10.0.121 or above. Contact
us for a time limited evaluation license.

Returns 0 on success, and a Windows system error code on failure.

6.3.49 Command Line Export Win2PDF Settings

Export Win2PDF Settings Command Line Format

win2pdfd.exe exportsettings "settingsfile"

Exports all Win2PDF settings to the file specified by “settingsfile”. These
settings include all Win2PDF settings including auto-name configuration
settings. This command can be used in conjunction with the importsettings
command to backup Win2PDF settings or deploy the same settings to
multiple computers.

Any file names that contain spaces must be enclosed with quotation marks.

Returns 0 on success, and a Windows system error code on failure.

6.3.50 Command Line Import Win2PDF Settings

Import Win2PDF Settings Command Line Format

win2pdfd.exe importsettings "settingsfile"

Imports all Win2PDF settings from the file specified by “settingsfile”
previously saved from the exportsettings command. These settings include
all Win2PDF settings including auto-name configuration settings. Any
existing Win2PDF configuration settings will be overwritten. This command
can be used in conjunction with the exportsettings command to backup
Win2PDF settings or deploy the same settings to multiple computers.

Any file names that contain spaces must be enclosed with quotation marks.

https://www.win2pdf.com/trial.html
https://www.win2pdf.com/trial.html
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
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Returns 0 on success, and a Windows system error code on failure.

6.4 Programming Environments

6.4.1
 
.NET Framework

You can set the PDF file name from VB.NET or C# using the .NET
framework Printersettings.PrintFileName property as documented by
Microsoft at:

https://docs.microsoft.com/en-
us/dotnet/api/system.drawing.printing.printersettings.printfilename

You should also set the PrinterSettings.PrintToFile property to TRUE:

PrintDocument.PrinterSettings.PrintFileName = "C:\Users\test\AppData\Local\Temp\aFile.pdf"
PrintDocument.PrinterSettings.PrintToFile = true;

You can set any Win2PDF string registry settings using the VB.NET
"SaveSetting" function. 

SaveSetting "Dane Prairie Systems", "Win2PDF", ValueName, Value

From C#, you can use the same fully qualified SaveSetting function
name:

Microsoft.VisualBasic.Interaction.SaveSetting("Dane Prairie Systems", "Win2PDF", ValueName, Value)

Win2PDF behaves the same as a paper printer for all other .NET interfaces.
Here's an example for creating a PDF from VB.NET:

Private Sub PrintPageHandler(ByVal sender As Object, ByVal args As Printing.PrintPageEventArgs)
  Static i As Integer = 0
  i = i + 1
  ' Print a line on this page
  args.Graphics.DrawString("Printed a Line on page " & i.ToString, New Font(Me.Font, FontStyle.Regular), Brushes.Black, 50, 50)

  ' Have we printed enough pages?
  If i >= 5 Then
   ' Done all the pages
   i = 0
   args.HasMorePages = False
  Else
  ' Not finished, yet
   args.HasMorePages = True

https://docs.microsoft.com/en-us/windows/desktop/Debug/system-error-codes
https://docs.microsoft.com/en-us/dotnet/api/system.drawing.printing.printersettings.printfilename
https://docs.microsoft.com/en-us/dotnet/api/system.drawing.printing.printersettings.printfilename
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  End If
End Sub
 
Private Sub Button1_Click(ByVal sender As System.Object, ByVal e As System.EventArgs) Handles Button1.Click
  Dim prn As New Printing.PrintDocument
  ' Select the Win2PDF Printer
  prn.PrinterSettings.PrinterName = "Win2PDF"
  ' Set the PDF file name
  prn.PrinterSettings.PrintFileName = "C:\Users\test\AppData\Local\Temp\aFile.pdf"
  prn.PrinterSettings.PrintToFile = True
  ' Handle the page events
  AddHandler prn.PrintPage, AddressOf Me.PrintPageHandler
  ' Do the print (Printing handled by the print page handler)
  prn.Print()
  ' Remove the page handler
  RemoveHandler prn.PrintPage, AddressOf Me.PrintPageHandler
End Sub

6.4.2 Visual Basic 6.0

6.4.2.1 Using the Printer object

The Visual Basic printer object greatly simplifies sending output to a printer.
The following is a very simple example of creating a PDF and specifying the
output file name.

Private Sub Command1_Click()
  'set the output file name
  SaveSetting "Dane Prairie Systems", "Win2PDF", "PDFFileName", "c:
\TEST.PDF"

  'output some text
  Printer.Print "hello world!"

  'save the PDF file
  Printer.EndDoc
End Sub

Win2PDF supports all of the standard Printer object methods and
properties. A more advanced example requires some support routines for
writing a Dword value to the registry. The following code must be added to
the declarations section of the sample form.

Option Explicit

Private Const REG_DWORD As Long = 4
Private Const HKEY_CURRENT_USER = &H80000001
Private Const KEY_ALL_ACCESS = &H3F
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Private Declare Function RegCloseKey Lib "advapi32.dll" _
            (ByVal hKey As Long) As Long
Private Declare Function RegOpenKeyEx Lib "advapi32.dll" Alias _
   "RegOpenKeyExA" (ByVal hKey As Long, ByVal lpSubKey As String, _
   ByVal ulOptions As Long, ByVal samDesired As Long, phkResult As _
   Long) As Long
Private Declare Function RegSetValueExLong Lib "advapi32.dll" Alias _
   "RegSetValueExA" (ByVal hKey As Long, ByVal lpValueName As String,
_
   ByVal Reserved As Long, ByVal dwType As Long, lpValue As Long, _
   ByVal cbData As Long) As Long

Private Sub SaveWin2PDFDword(sValueName As String, lValueSetting As
Long)
  Dim lRetVal As Long     'result of the SetValueExLong function
  Dim hKey As Long      'handle of open key

  lRetVal = RegOpenKeyEx(HKEY_CURRENT_USER, "Software\VB and VBA
Program Settings\Dane Prairie Systems\Win2PDF", 0, _
              KEY_ALL_ACCESS, hKey)
  lRetVal = RegSetValueExLong(hKey, sValueName, 0&, _
              REG_DWORD, lValueSetting, 4)
  RegCloseKey (hKey)
End Sub

Now we can use the subroutine to save a Dword value to the registry and
enable 128 bit encryption. The encryption options are only valid for
Win2PDF Pro.
  
Private Sub Command1_Click()
  'set the output file name
  SaveSetting "Dane Prairie Systems", "Win2PDF", "PDFFileName", "c:
\TEST.PDF"

  'enable 128 bit encryption (Win2PDF Pro only) and automatic url
detection
  SaveWin2PDFDword "file options", &H30

  'set a master password
  SaveSetting "Dane Prairie Systems", "Win2PDF", "master password",
"abracadabra"

  'set the PDF document title
  SaveSetting "Dane Prairie Systems", "Win2PDF", "PDFTitle", "Hello
World sample"

  'set landscape orientation
  Printer.Orientation = vbPRORLandscape

  'output some text
  Printer.Print "hello world!"
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  Printer.Print "www.win2pdf.com"

  'save the PDF file
  Printer.EndDoc
End Sub

The following example demonstrates how to append to an existing PDF file.

Private Sub Command2_Click()

  'set the output file name to create original PDF file
  SaveSetting "Dane Prairie Systems", "Win2PDF", "PDFFileName", "c:
\TEST.PDF"
  
  'output some text
  Printer.Print "hello world!"

  'save the PDF file
  Printer.EndDoc
  
  
  'Append new text to original PDF file
  'assign original PDF file
  SaveSetting "Dane Prairie Systems", "Win2PDF", "PDFAppendFile", "c:
\TEST.PDF"
  
  'set new output file to maintain the original PDF file
  SaveSetting "Dane Prairie Systems", "Win2PDF", "PDFFileName", "c:
\AppendedTest.PDF"
  
  Printer.Print "2nd page added"
  Printer.EndDoc

End Sub

The following example enables the "Send PDF" option, sets the email
subject, sets the email address, sets the email body text, and then creates
the PDF file:

  'enable sending the PDF file 
  'replace the file options with &H421 to email with no user interaction
using the Mail Helper application
  SaveWin2PDFDword "file options", &H21

  'set the email subject (optional)
  SaveSetting "Dane Prairie Systems", "Win2PDF", "PDFMailSubject", "Test
Subject"

  'set the recipient email address (optional)
  SaveSetting "Dane Prairie Systems", "Win2PDF", "PDFMailRecipients",
billg@microsoft.com
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  'set the email body text (optional)
  SaveSetting "Dane Prairie Systems", "Win2PDF", "PDFMailNote", "The
requested PDF file is attached."

  'set the PDF file name
  SaveSetting "Dane Prairie Systems", "Win2PDF", "PDFFileName", "c:\
\test.pdf"

  'output some text
  Printer.Print "hello world!"
  Printer.Print www.win2pdf.com

  'save the PDF file
  Printer.EndDoc

6.4.2.2 Using the Win32 API

The Microsoft Knowledgebase article Q175535 has information on using the
Win32 API from Visual Basic. The Win32 API can be used when the Printer
object does not provide the necessary functionality.

1. Create a Standard EXE project in Visual Basic 6.0. Form1 is created
by default. 

2. Add 2 CommandButtons to Form1. 
3. Add the following code to the General Declarations section of Form1:

 Option Explicit

  Private Const LF_FACESIZE = 32

  Private Type LOGFONT
   lfHeight As Long
   lfWidth As Long
   lfEscapement As Long
   lfOrientation As Long
   lfWeight As Long
   lfItalic As Byte
   lfUnderline As Byte
   lfStrikeOut As Byte
   lfCharSet As Byte
   lfOutPrecision As Byte
   lfClipPrecision As Byte
   lfQuality As Byte
   lfPitchAndFamily As Byte
   lfFaceName As String * LF_FACESIZE
  End Type
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  Private Type DOCINFO
   cbSize As Long
   lpszDocName As String
   lpszOutput As String
   lpszDatatype As String
   fwType As Long
  End Type

  Private Declare Function CreateFontIndirect Lib "gdi32" Alias _
  "CreateFontIndirectA" (lpLogFont As LOGFONT) As Long

  Private Declare Function SelectObject Lib "gdi32" _
  (ByVal hdc As Long, ByVal hObject As Long) As Long

  Private Declare Function DeleteObject Lib "gdi32" _
  (ByVal hObject As Long) As Long

  Private Declare Function CreateDC Lib "gdi32" Alias "CreateDCA" _
  (ByVal lpDriverName As String, ByVal lpDeviceName As String, _
  ByVal lpOutput As Long, ByVal lpInitData As Long) As Long

  Private Declare Function DeleteDC Lib "gdi32" (ByVal hdc As Long) _
  As Long

  Private Declare Function TextOut Lib "gdi32" Alias "TextOutA" _
  (ByVal hdc As Long, ByVal x As Long, ByVal y As Long, _
  ByVal lpString As String, ByVal nCount As Long) As Long ' or
Boolean

  Private Declare Function StartDoc Lib "gdi32" Alias "StartDocA" _
  (ByVal hdc As Long, lpdi As DOCINFO) As Long

  Private Declare Function EndDoc Lib "gdi32" (ByVal hdc As Long) _
  As Long

  Private Declare Function StartPage Lib "gdi32" (ByVal hdc As Long)
_
  As Long

  Private Declare Function EndPage Lib "gdi32" (ByVal hdc As Long) _
  As Long

  Const DESIREDFONTSIZE = 12   ' Could use variable, TextBox, etc.

  Private Sub Command1_Click()
  ' Combine API Calls with the Printer object
   Dim OutString As String
   Dim lf As LOGFONT
   Dim result As Long
   Dim hOldfont As Long
   Dim hPrintDc As Long
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   Dim hFont As Long

   Printer.Print "Printer Object"
   hPrintDc = Printer.hdc
   OutString = "Hello World"

   lf.lfEscapement = 1800
   lf.lfHeight = (DESIREDFONTSIZE * -20) / Printer.TwipsPerPixelY
   hFont = CreateFontIndirect(lf)
   hOldfont = SelectObject(hPrintDc, hFont)
   result = TextOut(hPrintDc, 1000, 1000, OutString, Len(OutString))
   result = SelectObject(hPrintDc, hOldfont)
   result = DeleteObject(hFont)

   Printer.Print "xyz"
   Printer.EndDoc
  End Sub

  Private Sub Command2_Click()
  ' Print using API calls only
   Dim OutString As String 'String to be rotated
   Dim lf As LOGFONT    'Structure for setting up rotated font
   Dim temp As String    'Temp string var
   Dim result As Long    'Return value for calling API functions
   Dim hOldfont As Long   'Hold old font information
   Dim hPrintDc As Long   'Handle to printer dc
   Dim hFont As Long    'Handle to new Font
   Dim di As DOCINFO    'Structure for Print Document info

   OutString = "Hello World"  'Set string to be rotated

  ' Set rotation in tenths of a degree, i.e., 1800 = 180 degrees
   lf.lfEscapement = 1800
   lf.lfHeight = (DESIREDFONTSIZE * -20) / Printer.TwipsPerPixelY
   hFont = CreateFontIndirect(lf) 'Create the rotated font
   di.cbSize = 20         ' Size of DOCINFO structure
   di.lpszDocName = "My Document" ' Set name of print job (Optional)

  ' Create a printer device context
   hPrintDc = CreateDC(Printer.DriverName, Printer.DeviceName, 0, 0)

   result = StartDoc(hPrintDc, di) 'Start a new print document
   result = StartPage(hPrintDc)  'Start a new page

  ' Select our rotated font structure and save previous font info
   hOldfont = SelectObject(hPrintDc, hFont)

  ' Send rotated text to printer, starting at location 1000, 1000
   result = TextOut(hPrintDc, 1000, 1000, OutString, Len(OutString))

  ' Reset font back to original, non-rotated
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   result = SelectObject(hPrintDc, hOldfont)

  ' Send non-rotated text to printer at same page location
   result = TextOut(hPrintDc, 1000, 1000, OutString, Len(OutString))

   result = EndPage(hPrintDc)   'End the page
   result = EndDoc(hPrintDc)    'End the print job
   result = DeleteDC(hPrintDc)   'Delete the printer device context
   result = DeleteObject(hFont)  'Delete the font object
  End Sub

  Private Sub Form_Load()
   Command1.Caption = "API with Printer object"
   Command2.Caption = "Pure API"
  End Sub
 

4.  Run the Project and click API with Printer object . This will print a single
page to the current default printer with "Printer Object" and "xyz" printed
normally and "Hello World" printed rotated 180 degrees. 

5.  Click Pure API . This will print a single page to the current default printer
with "Hello World" printed normally and rotated 180 degrees.

6.4.3 Crystal Reports

The following Visual C example shows how to print a document to Win2PDF
using Crystal Reports.
 
void CPrinting::PrintPDF(LPTSTR sPrintType, int iPrintMethod)
{

_TCHAR sFileName[PE_FILE_PATH_LEN] = "";

short hJob = 0;

PEPrintOptions PrintOptions;

PEOpenEngine();

hJob = PEOpenPrintJob("d:\\pics32\\pics32\\live\\quote.rpt");

PrintOptions.StructSize   = PE_SIZEOF_PRINT_OPTIONS;

PrintOptions.startPageN   = 1;

PrintOptions.stopPageN   = -1;

PrintOptions.nReportCopies = 1;

PrintOptions.collation   = PE_COLLATED;

_tcscpy(sFileName, "D:\\temp\\test.pdf"); // Here is the PDF
file name

_tcscpy(PrintOptions.outputFileName, sFileName);
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PESetPrintOptions(hJob, &PrintOptions);

PEOutputToPrinter(hJob, 1);

PEStartPrintJob(hJob, TRUE);

PECloseEngine();
}

The same example using Visual Basic follows.

Public Function printAPIReport(RptName As String, rptPath As String,
outPath As String) As Boolean
  Dim PrintOptions As PEPrintOptions 
  Dim hjob As Integer 

  PEOpenEngine()
  hjob = PEOpenPrintJob(rptPath & RptName)
  
  PrintOptions.StructSize = PE_SIZEOF_PRINT_OPTIONS
  PrintOptions.StartPageN = 1
  PrintOptions.stopPageN = -1
  PrintOptions.nReportCopies = 1
  PrintOptions.collation = PE_COLLATED
  PrintOptions.outputFileName = "c:\\Temp\\TEST.PDF" & Chr(0)
    
  PESetPrintOptions(hjob, PrintOptions)
  
  PEOutputToPrinter(hjob, 1)
  
  PEStartPrintJob(hjob, True)
  
  PECloseEngine
End Function

6.4.4 Microsoft Access

The following example shows the basic code to open and print an Access
report to Win2PDF. This example uses SaveSetting to set the PDF file name
and will suppress the Win2PDF File Save window.

Private Sub cmd_PrintToWin2PDF_Click()

'This code assumes that Win2PDF is set as the default printer.
On Error GoTo Err_cmd_PrintToWin2PDF_Click

  Dim stDocName As String
  
  'set the output file name
  SaveSetting "Dane Prairie Systems", "Win2PDF", "PDFFileName", "c:
\temp\AccessTest.pdf"
 
  stDocName = "Report to be converted"
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  DoCmd.OpenReport stDocName, acNormal
  
Exit_cmd_PrintToWin2PDF_Click:
  Exit Sub

Err_cmd_PrintToWin2PDF_Click:
  MsgBox Err.Description
  Resume Exit_cmd_PrintToWin2PDF_Click
  
End Sub

The following example shows how to merge two Access reports into a
single PDF file:

  'This sample assumes that Win2PDF is set as the default printer.

  'create first PDF file from report rpt_OriginalReport
  SaveSetting "Dane Prairie Systems", "Win2PDF", "PDFFileName", "c:
\temp\Report.pdf"
  DoCmd.OpenReport "rpt_OriginalReport", acNormal

  'Set registry to append 2nd report to PDF file just created
  SaveSetting "Dane Prairie Systems", "Win2PDF", "PDFFileName", "c:
\temp\MergedReports.pdf"
  SaveSetting "Dane Prairie Systems", "Win2PDF", "PDFPrependFile", "c:
\temp\Report.pdf"

  'print second report, rpt_ReportToAppend
  DoCmd.OpenReport "rpt_ReportToAppend", acNormal

The following sample shows how to email without user interaction using the
Win2PDF Mail Helper application. You need to install and configure the
Win2PDF Mail Helper application before running this code.

The SaveWin2PDFDword routine used in this example is listed in Using the
Printer object.

  'This sample assumes that Win2PDF is set as the default printer.

  Dim stDocName As String

  'enable sending the PDF file with no user interaction
  SaveWin2PDFDword "file options", &H420

  'set the output file name
  SaveSetting "Dane Prairie Systems", "Win2PDF", "PDFFileName",
txt_PDFFileName
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  SaveSetting "Dane Prairie Systems", "Win2PDF", "PDFMailRecipients",
txt_emailaddress
  SaveSetting "Dane Prairie Systems", "Win2PDF", "PDFMailSubject",
txt_EmailSubject
  SaveSetting "Dane Prairie Systems", "Win2PDF", "PDFMailNote",
txt_emailmessage

  stDocName = "rpt_Report_to_EMail"
  DoCmd.OpenReport stDocName, acNormal



Part

VII
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7 Dane Prairie Systems Company Information

Information on Win2PDF is available at https://www.win2pdf.com

For help on our products, including technical support, visit
https://helpdesk.win2pdf.com or send e-mail to support@win2pdf.com

For sales inquiries, send e-mail to sales@win2pdf.com

Our mailing address is:

Dane Prairie Systems, LLC
P.O. Box 24491
Minneapolis, MN 55424-0491

http://www.win2pdf.com
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